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1 信号発生器の概要

この章は以下のセクションに分かれており、Agilent E8257D/67D PSG 信号発生器のモデル、オプション、機能について

説明します。また、 動作モード、フロントパネル・ユーザ・インタフェース、フロントパネルとリアパネルのコネクタに

ついても説明します。

• 「信号発生器のモデルと機能」（1ページ）

• 「オプション」（4ページ）

• 「ファームウェアのアップグレード」（4ページ）

• 「動作モード」（5ページ）

• 「フロントパネル」（7ページ）

• 「フロントパネル・ディスプレイ」（14ページ）

• 「リアパネル」（18ページ）

注記 データ・シート、構成ガイド、アプリケーション・ノート、FAQ、テクニカル・サポート、ソフトウェアなど、

PSGの詳細については、Agilent PSGのウェブページhttp://www.agilent.co.jp/find/psgをご覧ください。

信号発生器のモデルと機能

表 1-1 に、PSG 信号発生器のモデルと周波数レンジ・オプションを示します。

表1-1 PSG信号発生器のモデル

モデル 周波数レンジ・オプション

E8257D PSGアナログ信号発生器 250 kHz～20 GHz（オプション520）

250 kHz～40 GHz（オプション540）

250 kHz～50 GHz（オプション550）

250 kHz～67 GHza（オプション567）

a. 67 GHzを超えても70 GHzまでは機能しますが、仕様としては示されていません。

E8267D PSGベクトル信号発生器 250 kHz～20 GHz（オプション520）

250 kHz～31.8 GHz（オプション532）

250 kHz～44 GHz（オプション544）
第1章 1



信号発生器の概要
信号発生器のモデルと機能
E8257D PSGアナログ信号発生器の機能

E8257D PSG には、下記の標準機能があります。

• 250 kHz～最高動作周波数（オプションによって異なる）のCW出力

• 0.001 Hzまでの周波数分解能

• 周波数および振幅のリスト/ステップ掃引、複数トリガ・ソース使用可能

• ユーザ・フラットネス補正

• 外部ダイオード・ディテクタ・レベリング

• 自動レベル制御（ALC）オン/オフ・モード、ALCオフ・モードでパワー校正使用可能（パワー・サーチなしでも）

• 外部出力付き10 MHz基準発振器

• RS-232、GPIB、10Base-T LAN入出力インタフェース

• Agilent 83550シリーズ・ミリ波信号源モジュール（110 GHzまでの周波数拡張）、およびOleson Microwave
Labs（OML）AGシリーズ・ミリ波モジュール（325 GHzまでの周波数拡張）と互換の信号源モジュール・イ

ンタフェース

E8257D PSG には、下記のオプション機能もあります。

オプション 007 －アナログ・ランプ掃引

オプション UNR －位相ノイズ性能改善

オプション UNT － AM、FM、位相変調、LF 出力

• 開ループまたは閉ループAM

• DC同期FM（最高周波数10 MHz）、最大偏移は搬送波周波数に依存

• AM、FM、ΦM用外部変調入力

• 同時変調設定（FMとΦM、リニアAMと指数関数AMの組合わせを除く）

• 下記の機能を持つデュアル・ファンクション・ジェネレータ

— 50 Ω低周波出力、0 ～ 3 Vp、LF 出力から出力

— 選択可能な波形 : 正弦波、2 重正弦波、掃引正弦波、三角波、正ランプ、負ランプ、方形波、一様ノイズ、ガ

ウシアン・ノイズ、DC

— 調整可能な FM 変調周波数

— リストおよびステップ掃引モードでの選択可能なトリガ : フリーラン（自動）、トリガ・キー（シングル）、バ

ス（リモート）、外部

オプション UNU －パルス変調

• パルス発生器内蔵

• 外部変調入力

• 選択可能なパルス・モード : 内部方形、内部フリーラン、内部トリガ、内部ダブレット、内部ゲート、外部パル

ス。内部トリガ、内部ダブレット、内部ゲートには外部トリガ・ソースが必要
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信号発生器のモデルと機能
• 調整可能なパルス周波数

• 調整可能なパルス周期

• 調整可能なパルス幅（最小値150 ns）

• 調整可能なパルス遅延

• 選択可能な外部パルス・トリガ : 正または負

オプション UNW －パルス変調

• PSGの動作周波数帯域に渡って狭パルス（最小値20 ns）を生成

• オプションUNUと同じ機能をすべて装備

オプション 1EA －高出力パワー

オプション 1E1 －ステップ・アッテネータ

オプション 1ED － N 型メス RF 出力コネクタ

オプション 1EH － 2 GHz 未満の高調波の改善

オプション 1EM －フロントパネル・コネクタをリアパネルに移動

E8267D PSGベクトル信号発生器の機能

E8267D PSG には、E8257D PSG と同じ標準機能に加えて、下記の標準機能があります。

• I/Q変調器内蔵

• 外部アナログ I/Q入力

• シングルエンドおよび差動アナログ I/Q出力

• 高出力パワー（E8257Dの場合はオプション）

• ステップ・アッテネータ（E8257Dの場合はオプション）

E8267D PSG には、E8257D PSG と同じオプション機能に加えて、下記のオプション機能があります。

オプション 601 － 8 M サンプル・メモリの内蔵ベースバンド・ジェネレータ

オプション 602 － 64 M サンプル・メモリの内蔵ベースバンド・ジェネレータ

オプション 003 － N5102A との PSG デジタル出力コネクティビティ

オプション 004 － N5102A との PSG デジタル入力コネクティビティ

オプション 005 － 6 GB 内蔵ハード・ディスク

オプション 015 －広帯域外部 I/Q 入力
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オプション
オプション

PSG 信号発生器には、ハードウェア・オプション、ファームウェア・オプション、ソフトウェア・オプション、ドキュメ

ンテーション・オプションがあります。 信号発生器に付属のデータシートに、使用可能なオプションの概要が示されてい

ます。 詳細については、Agilent PSG ウェブページ http://www.agilent.co.jp/find/psg をご覧ください。このウェブページ

で PSG モデルを選択し、モデルリストを表示をクリックします。 オプション・モデル一覧で、選択したモデルに使用可能

なオプションの最新リストが表示されます。

ファームウェアのアップグレード

新しいファームウェアがリリースされるごとに信号発生器内のファームウェアをアップグレードできます。 Agilentウェブ

サイトからダウンロードできる新しいファームウェアには、従来にはない機能が含まれる可能性があります。

新しいファームウェアの情報については、Agilent ファームウェア・アップグレード・アシスタント・ウェブページ

http://www.agilent.co.jp/find/upgradeassistant をご覧いただくか、計測お客様窓口までお問い合わせください。

ファームウェアをアップグレードする手順

以下の手順では、LAN 接続と PC を使って新しいファームウェアを PSG にダウンロードする方法を示します。 機器の要

件、および GPIB などファームウェアをダウンロードする別の方法については、『PSG/ESG ファームウェア・アップグレー

ド・ガイド』を参照してください。ガイドには http://www.agilent.co.jp/find/upgradeassistant からアクセスできます。 

1. 本器の IP アドレスを書き留めます。 PSG で IP アドレスを表示するには、Utility > GPIB/RS-232 LAN > LAN Setup を押し

ます。

2. インターネット・ブラウザを使用して http://www.agilent.co.jp/find/upgradeassistant に移動します。

3. 「ドキュメントとダウンロード」までスクロールし、E82x7D PSG、最新のファームウェア C.xx.xx をクリックします。 こ
れにより、別のウェブページがオープンします。このページでも同じ選択を行います。

4. 「ドキュメントとダウンロード」までスクロールし、E82x7D PSG、最新のファームウェア C.xx.xx をクリックします。

5. ファイルのダウンロード・ウィンドウで、Run this program from its current location を選択し、OK をクリックします。

6. セキュリティ警告ウィンドウで、Yes をクリックし、画面の指示に従います。 ファームウェア・ファイルが PC にダウ

ンロードされます。 Finish をクリックすると、ブラウザに最新ファームウェア・ページが表示されます。

7. ブラウザで、Back ボタンをクリックしてファームウェア・アップグレード・アシスタント・ページに戻ります。

8. 「ドキュメントとダウンロード」テーブルで、PSG/ESG アップグレード・アシスタント x.xx をクリックし、アップグ

レード・アシスタントをダウンロードします。

9. デスクトップ・ショートカット・プロンプトで、Yes をクリックします。

10. ユーティリティがダウンロードされたら、ブラウザを閉じ、デスクトップで PSG/ESG アップグレード・アシスタント

アイコンをダブルクリックします。
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動作モード
11. アップグレード・アシスタントで、ファームウェアのダウンロードに使用する接続タイプ、および選択した接続のタ

イプに対するパラメータを設定します。 LAN の場合、ステップ 1 で記録した機器の IP アドレスを入力します。

注記 PSGのDHCP（動的ホスト構成プロトコル）をオンにすると、電源投入時にネットワークが機器にIPアドレスを

割り当てます。 このため、DHCPがオンのときには、機器の電源を入れるたびにIPアドレスが異なる可能性があ

ります。 DHCPは、ホスト名に影響を与えません。

12. Browse をクリックし、ファームウェア・リビジョンをダブルクリックして本器をアップグレードします。

13. アップグレード・アシスタントで、Next をクリックします。

14. 機器への接続を確認したら、Next をクリックし、画面のプロンプトに従います。

注記 開始されたダウンロードを中止することはできません。

注記 ユーザの注意を喚起するメッセージが表示されたときには、最初に機器の電源を入れ直し、次にOKをクリック

します。

アップグレードが完了すると、アップグレード・アシスタントにサマリが表示されます。

15. OK をクリックし、アップグレード・アシスタントを閉じます。

動作モード

モデルおよびインストールされたオプションに応じて、PSG 信号発生器には連続波（CW）、掃引信号、アナログ変調、デ

ジタル変調の最大 4 つの基本動作モードが備わっています。

連続波

このモードでは、信号発生器が連続波信号を出力します。 信号発生器は 1 つの周波数とパワー・レベルに設定されます。

E8257D と E8267D のどちらも CW 信号を出力できます。

掃引信号

このモードでは、信号発生器がある範囲の周波数またはパワー・レベルを掃引します。 E8257D と E8267D のどちらにも

リスト / ステップ掃引機能があります。 オプション 007 によりアナログ・ランプ掃引機能が追加されます。

アナログ変調

このモードでは、信号発生器が CW 信号をアナログ信号で変調します。 使用可能なアナログ変調タイプは、インストール

されたオプションによって異なります。

オプション UNT では AM 変調、FM 変調、ΦM 変調が追加されます。 同時に使用できる変調もあります。 オプション UNU
と UNW では、それぞれ標準パルス変調機能と狭パルス変調機能が追加されます。
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デジタル変調

このモードでは、信号発生器が CW 信号をリアルタイム I/Q 信号または任意 I/Q 波形によって変調します。 I/Q 変調は

E8267D でのみ使用できます。 内蔵ベースバンド・ジェネレータ（オプション 601/602）により下記のデジタル変調フォー

マットが追加されます。

• カスタム任意波形発生器モードでは、変調された搬送波を1つまたは複数供給できます。 変調された搬送波波形

は、それぞれ出力の前に計算して生成しておく必要があります。信号生成は内蔵ベースバンド・ジェネレータ
で行われます。 作成した波形は保存して再生できるので、再現性のあるテスト信号が得られます。 詳細について

は、「カスタム任意波形発生器」（137ページ）を参照してください。

• カスタム・リアルタイム I/Qベースバンド・モードでは、単一の搬送波をリアルタイム・データで変調して出力

できるので、信号のすべてのパラメータをリアルタイムで制御できます。 出力される単一搬送波信号は、さま

ざまなデータ・パターン、フィルタ、シンボル・レート、変調タイプ、バースト形状を適用することによって
変化させることができます。 詳細については、「カスタム・リアルタイム I/Qベースバンド」（159ページ）を参

照してください。

• 2トーン・モードでは2つの異なる連続波信号（またはトーン）を出力します。 2つの信号の周波数間隔と振幅

が調整可能です。 詳細については、「2トーン波形発生器」（189ページ）を参照してください。

• マルチトーン・モードでは最大64の連続波信号（またはトーン）を出力します。 2トーン・モードと同様、信

号の周波数間隔と振幅が調整可能です。 詳細については、「マルチトーン波形発生器」（179ページ）を参照して

ください。

• デュアル任意波形モードは、内蔵ベースバンド・ジェネレータの任意波形メモリに書き込まれている波形セグ
メントの再生順序を制御するために用いられます。 これらの波形は、カスタム任意波形発生器モードを使って

内蔵ベースバンド・ジェネレータにより生成するか、リモート・インタフェース経由で任意波形メモリにダウ
ンロードします。 詳細については、「デュアル任意波形プレーヤの使用」（79ページ）を参照してください。
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フロントパネル

このセクションでは、PSG フロントパネルの各項目について説明します。 図 1-1 に、E8267D フロントパネルを示します。

ここには E8257D で使用可能な項目がすべて含まれています。

図 1-1 フロントパネルの図（E8267D PSGベクトル信号発生器）

1. ディスプレイ

LCD 画面には、現在の機能に関する情報が表示されます。 表示される情報には、ステータス・インジケータ、周波数 / 振
幅設定、エラー・メッセージなどがあります。 ディスプレイの右側にはソフトキーのラベルが表示されます。 フロントパ

ネル・ディスプレイの詳細については、「フロントパネル・ディスプレイ」（14 ページ）を参照してください。

1. ディスプレイ 10. Help 19. SYNC OUT 28. Local 

2. ソフトキー 11. EXT 1 INPUT 20. VIDEO OUT 29. Preset 

3. ノブ 12. EXT 2 INPUT 21. Incr Set 30. 電源LED 

4. Amplitude 13. LF OUTPUT 22. GATE/ PULSE/ TRIGGER INPUT 31. LINE 

5. Frequency 14. Mod On/Off  23. 矢印キー 32. スタンバイLED 

6. Save 15. ALC INPUT 24. Hold 33. SYMBOL SYNC 

7. Recall 16. RF On/Off 25. Return 34. DATA CLOCK 

8. Trigger 17. テンキー 26. コントラスト減少 35. DATA 

9. MENUS 18. RF OUTPUT 27. コントラスト増加 36. Q Input 

37. I Input 
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2. ソフトキー

ソフトキーは、各キーの左側に表示された機能を実行します。

3. ノブ

ノブは、数値の増減、強調表示された数字や文字の変更、リスト内の移動、リストの行の項目選択に用いられます。

4. Amplitude

このハードキーを押すと、振幅がアクティブになります。 出力振幅を変更したり、パワー・サーチ、ユーザ・フラットネ

ス、レベリング・モードなどの振幅属性をメニューを使って設定したりすることができます。

5. Frequency

このハードキーを押すと、周波数がアクティブになります。 出力周波数を変更したり、周波数倍率、オフセット、基準な

どの周波数属性をメニューを使って設定したりすることができます。

6. Save

このハードキーを押すと、本器のステート・レジスタにデータを保存するためのメニューが表示されます。 本器のステー

ト・レジスタは、メモリの一部を 10 個のシーケンス（番号 0 ～ 9）に分割したもので、それぞれに 100 個のレジスタ（番

号 00 ～ 99）が含まれます。 周波数設定、振幅設定、変調設定を保存し、リコールすることができます。

Save ハードキーを使うと、フロントパネルや SCPI コマンドから本器を再構成するよりもはるかに高速に、異なる信号構

成を切り替えることができます。 機器ステートを保存しておけば、Recall ハードキーを押すだけで、周波数、振幅、変調

のすべての設定がリコールされます。 機器ステートの保存とリコールの詳細については、「機器ステート・レジスタの使

用」（53 ページ）を参照してください。

7. Recall

メモリ・レジスタに保存されている機器ステートを回復します。 機器ステートをリコールするには、Recall を押し、目的

のシーケンス番号とレジスタ番号を入力します。 ステートを保存するには、Save ハードキーを使用します。 機器ステート

の保存とリコールの詳細については、「機器ステート・レジスタの使用」（53 ページ）を参照してください。

8. Trigger

リスト掃引、ステップ掃引、ランプ掃引（オプション 007 のみ）などの機能に対して、即座にトリガ・イベントを引き起

こすことができます。 このハードキーを使ってトリガ・イベントを引き起こすには、トリガ・モードが Trigger Key に設定

されている必要があります。 例 : Sweep/Listハードキーを押し、次に以下のソフトキー・シーケンスのいずれかを押します。

• More (1 of 2) > Sweep Trigger > Trigger Key 

• More (1 of 2) > Point Trigger > Trigger Key
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9. MENUS

これらのキーにより、さまざまな機能を設定するためのソフトキー・メニューがオープンします。 説明については、

『E8257D/67D PSG 信号発生器キー・リファレンス』を参照してください。

注記 オプションのメニューもあります。 詳細については、「オプション」（4ページ）を参照してください。

10. Help

このハードキーを押すと、ハードキーまたはソフトキーの簡単な説明が表示されます。ほとんどの場合、関連リモート動

作 SCPI コマンドのリストが示されます。 本器にはシングルと連続の 2 つのヘルプ・モードがあります。 初期設定はシング

ル・モードです。 シングル・モードと連続モードを切り替えるには、Utility > Instrument Info/Help Mode > Help Mode
Single Cont を押します。

• シングル・モードでは、次に押したキーのヘルプ・テキストが表示され、そのキーの機能は実行されません。

さらに別のキーを押すと、ヘルプ・モードが解除され、そのキーの機能が実行されます。

• 連続モードでは、もう一度 Help ハードキーを押すかシングル・モードに切り替えるまで、押したキーすべてに

関するヘルプ・テキストが表示されます。 さらに、押したキーはすべて有効、すなわちその機能が実行されま

す（Presetキーを除く）。

11. EXT 1 INPUT

このメス型 BNC 入力コネクタ（オプション UNT、UNU、UNW とのみ機能）には、AM、FM、ΦM 用の± 1 Vp の信号を

入力できます。 これらの変調に対して± 1 Vp のときに、指定された偏移または変調度が実現されます。 AM、FM、ΦM に

対して AC 結合入力が選択されていて、ピーク入力電圧と 1 Vp との違いが 3% より大きい場合、HI/LO ディスプレイ・イ

ンジケータがオンになります。 入力インピーダンスは 50 Ω または 600 Ω が選択可能であり、損傷レベルは 5 Vrms、10 Vp

です。 オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

12. EXT 2 INPUT

このメス型 BNC 入力コネクタ（オプション UNT、UNU、UNW とのみ機能）には、AM、FM、ΦM 用の± 1 Vp の信号を

入力できます。 AM、FM、ΦM に対して、± 1 Vp のときに、指定された偏移または変調度が実現されます。 AM、FM、ΦM

に対して AC 結合入力が選択されていて、ピーク入力電圧と 1 Vp との違いが 3% より大きい場合、ディスプレイで HI/LO

インジケータがオンになります。 入力インピーダンスは 50 Ωまたは 600 Ωが選択可能であり、損傷レベルは 5 Vrms、10

Vp です。 オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

表1-2 フロントパネルのMENUSグループのハードキー

E8257D PSGアナログ E8267D PSGベクトル

AM
Sweep/List

FM/ΦM
Utility
Pulse
LF Out

Mode
Mux
AM
Sweep/List
Mode Setup
Aux Fctn

FM/ΦM
Utility
I/Q
Pulse
LF Out
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13. LF OUTPUT

このメス型 BNC 出力コネクタ（オプション UNT とのみ機能）は、低周波（LF）信号源ファンクション・ジェネレータか

ら生成される変調信号を出力します。 この出力は、50 Ω 負荷に対して 3 Vp（公称値）をドライブできます。 オプション

1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

14. Mod On/Off

このハードキー（オプション UNT、UNU、または UNW 付きの E8257D および E8267D のみ）を押すと、RF Output コネ

クタから出力される搬送波信号に適用されるすべてのアクティブな変調フォーマット（AM、FM、ΦM、パルス、I/Q）の

オン / オフを切り替えることができます。 このハードキーは、AM、FM、ΦM、パルス、I/Q の各変調フォーマットの設定

やアクティブ化を行うものではありません。個々の変調フォーマットを（AM > AM On などで）設定してアクティブにし

ておかないと、Mod On/Off ハードキーをオンにしても出力搬送波信号は変調されません。 MOD ON/OFF インジケータは、

アクティブな変調フォーマットが Mod On/Off ハードキーでオンになっているかオフになっているかを示します。

15. ALC INPUT

このメス型 BNC 入力コネクタは、外部ネガティブ・ディテクタによるレベリングに用いられます。 このコネクタは－ 0.2
mV ～－ 0.5 V の入力に対応しています。公称入力インピーダンスは 120 kΩ、損傷レベルは± 15 V です。 オプション 1EM
の付いた信号発生器では、このコネクタはリアパネルに移動します。

16. RF On/Off

このハードキーを押すと、RF OUTPUT コネクタの RF 信号の動作状態を切り替えることができます。 各種の周波数、パ

ワー、変調フォーマットを設定してオンにしていても、RF On/Off をオンに設定しない限り RF OUTPUT コネクタから RF
およびマイクロ波信号は出力されません。 RFがオンかオフかを示すRF On/Offインジケータがディスプレイ上に常に表示

されています。

17. テンキー

テンキーは 0 ～ 9 のハードキーと小数点ハードキー、およびバックスペース・ハードキー（ ）からなっています。

バックスペース・ハードキーは、前の文字を消去する場合と、正の値と負の値を切り替える場合に使います。 負の数値を

指定する場合、数値の前に負符号を入力する必要があります。

18. RF OUTPUT

このコネクタは、RF およびマイクロ波信号を出力します。 公称出力インピーダンスは 50 Ω です。 逆電力損傷レベルは公

称値 0 Vdc、0.5 W です。 オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。コネクタ・

タイプは、周波数オプションによって変わります。

19. SYNC OUT

このメス型 BNC 出力コネクタ（オプション UNU、UNW とのみ機能）は、内部およびトリガ・パルス変調の際に、公称

50 ns 幅の同期用 TTL 互換パルス信号を出力します。 公称信号源インピーダンスは 50 Ω です。 オプション 1EM の付いた

信号発生器では、このコネクタはリアパネルに移動します。
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20. VIDEO OUT

このメス型 BNC 出力コネクタ（オプション UNU、UNW とのみ機能）は、すべてのパルス・モードで出力エンベロープ

に追随する TTL レベル互換のパルス信号を出力します。 公称信号源インピーダンスは 50 Ωです。 オプション 1EM の付い

た信号発生器では、このコネクタはリアパネルに移動します。

21. Incr Set

このハードキーは、現在のアクティブ機能の増分値を設定するために使います。 現在のアクティブ機能の増分値がディス

プレイのアクティブ入力エリアに表示されます。 テンキー、矢印ハードキー、ノブのどれかを使って増分値を設定します。

22. GATE/ PULSE/ TRIGGER INPUT

このメス型 BNC 入力コネクタ（オプション UNU、UNW のみ使用可能）は、パルスまたはトリガ入力として用いられる

外部からのパルス信号を受け入れます。 パルス変調の場合、＋ 1 V がオン、0 V がオフです（トリガしきい値 0.5 V、ヒス

テリシス 10%。したがって、0.6 V はオンで 0.4 V はオフ）。 損傷レベルは± 5 Vrms および 10 Vp です。 公称入力インピーダ

ンスは 50 Ω です。 オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

23. 矢印キー

上下の矢印ハードキーは、数値の増減、リスト内の移動、リストの行の項目選択に用いられます。 左右の矢印キーは、数

字や文字を強調表示するために使います。 強調表示した数字や文字の値は上下の矢印ハードキーを使って変更できます。

24. Hold

このハードキーは、ディスプレイのソフトキー・ラベル・エリアとテキスト・エリアを消去します。 このキーを押すと、

ソフトキー、矢印ハードキー、ノブ、テンキー、Incr Set ハードキーは無効になります。

25. Return

このハードキーを押すと、前にいたソフトキー・メニューに戻ります。 これを使うことで、メニュー階層を 1 つずつさか

のぼって最初に選択したメニューに戻ることができます。

26. コントラスト減少

このハードキーを押すと、ディスプレイの背景が暗くなります。

27. コントラスト増加

このハードキーを押すと、ディスプレイの背景が明るくなります。

28. Local

このハードキーを押すと、リモート動作がオフになり、本器はフロントパネル制御に戻ります。
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29. Preset

このハードキーを押すと、本器は既知の状態（工場設定またはユーザ定義）に設定されます。

30. 電源LED

この緑の LED は、本器の電源スイッチがオン位置になっているかどうかを示します。

31. LINE

このスイッチをオン位置にすると、本器へのフル・パワー入力がアクティブになります。スタンバイでは、本器のすべて

の機能が非アクティブになります。 スタンバイでは、本器は電源につながれたままであり、一部の内部回路に電力が供給

されています。

32. スタンバイLED

この黄色の LED は、本器の電源スイッチがスタンバイ状態になっているかどうかを示します。

33. SYMBOL SYNC

このメス型 BNC 入力コネクタ（E8267D のみ）は、CMOS 互換であり、内蔵ベースバンド・ジェネレータ（オプション

601/602）で使用する外部からのシンボル同期信号を入力します。 想定される入力は 3.3 V の CMOS ビット・クロック信号

（TTL 互換でもある）です。 SYMBOL SYNC は、各シンボルごとに 1 回ずつ発生してもよいし、最初のシンボルの最初のビッ

トに同期する 1ビット幅の 1 個のパルスでもかまいません。 最高クロック周波数は 50 MHz です。 損傷レベルは >＋ 5.5 V お

よび < － 0.5 V です。 公称入力インピーダンスは定義できません。 SYMBOL SYNC は下記の 2 つのモードで使用できます。

• データ・クロックと組み合わせてシンボル同期として使用する場合は、シンボルの最初のデータ・ビットの間
信号がハイである必要があります。 信号はデータ・クロック信号の立ち下がりエッジの間有効である必要があ

り、1個のパルスでも連続信号でもかまいません。

• SYMBOL SYNC自体を（シンボル）クロックとして使用する場合、CMOSの立ち下がりエッジを使ってDATA
信号のクロックが供給されます。

オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

34. DATA CLOCK

このメス型 BNC 入力コネクタ（E8267D のみ）は、CMOS 互換であり、内蔵ベースバンド・ジェネレータ（オプション

601/602）で使用するシリアル・データを同期するための外部からのデータ・クロック入力信号を入力します。 想定される

入力は 3.3 V の CMOS ビット・クロック信号（TTL 互換でもある）で、立ち上がりエッジが開始データ・ビットと一致し

ます。 立ち下がりエッジを使って DATA および SYMBOL SYNC 信号のクロックが供給されます。 最高クロック周波数は 50
MHz です。 損傷レベルは > ＋ 5.5 V および < － 0.5 V です。 公称入力インピーダンスは定義できません。 オプション 1EM の

付いた信号発生器では、このコネクタはリアパネルに移動します。

35. DATA

このメス型 BNC 入力コネクタ（オプション 601/602 付きの E8267D のみ）は、CMOS 互換であり、デジタル変調アプリ

ケーションのための外部からのシリアル・データを入力します。想定される入力は 3.3 V の CMOS 信号（TTL 互換でもあ

る）で、CMOS ハイがデータ 1、CMOS ローがデータ 0 に対応します。 最高入力データ・レートは 50 Mb/s です。 データは
12 第1章



信号発生器の概要
フロントパネル
データ・クロックの立ち下がりエッジで有効（ノーマル・モード）またはシンボル同期の立ち下がりエッジで有効（シン

ボル・モード）である必要があります。 損傷レベルは > ＋ 5.5 V および < － 0.5 V です。 公称入力インピーダンスは定義で

きません。 オプション 1EM の付いた信号発生器では、このコネクタはリアパネルに移動します。

36. Q Input

このメス型 BNC 入力コネクタ（E8267D のみ）には、直交位相（Q）成分として外部からのアナログ I/Q 変調を入力しま

す。 同相（I）成分は I INPUT から供給されます。 校正された出力レベルのための信号レベルは、 =0.5 Vrms です。 公

称入力インピーダンスは 50 Ω または 600 Ω です。 損傷レベルは 1 Vrms および 10 Vp です。 I および Q 入力コネクタに供

給する信号をアクティブにするには、Mux > I/Q Source 1 または I/Q Source 2 を押してから、Ext 50 Ohm または Ext 600 Ohm
を選択します。 オプション 1EM の付いた信号発生器では、これらのコネクタはリアパネルに移動します。

37. I Input

このメス型 BNC 入力コネクタ（E8267D のみ）には、同相（I）成分として外部からのアナログ I/Q 変調を入力します。直

交位相（Q）成分は Q INPUT から供給されます。 校正された出力レベルのための信号レベルは、 =0.5 Vrms です。 公

称入力インピーダンスは 50 Ω または 600 Ω です。 損傷レベルは 1 Vrms および 10 Vp です。 I および Q 入力コネクタに供

給する信号をアクティブにするには、Mux > I/Q Source 1 または I/Q Source 2 を押してから、Ext 50 Ohm または Ext 600 Ohm
を選択します。 オプション 1EM の付いた信号発生器では、これらのコネクタはリアパネルに移動します。
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フロントパネル・ディスプレイ

図 1-2 に、PSG ディスプレイのさまざまな領域を示します。 このセクションでは、それぞれの領域について説明します。

図 1-2 フロントパネル・ディスプレイの図

1. アクティブ入力エリア

このエリアには、現在のアクティブ機能が表示されます。 例えば、周波数がアクティブの場合、現在の周波数設定がここ

に表示されます。 現在のアクティブ機能に対応する増分値がある場合、その値も表示されます。 

1. アクティブ入力エリア 5. 振幅エリア

2. 周波数エリア 6. エラー・メッセージ・エリア

3. インジケータ 7. テキスト・エリア

4. デジタル変調インジケータ 8. ソフトキー・ラベル・エリア
14 第1章



信号発生器の概要
フロントパネル・ディスプレイ
2. 周波数エリア

この部分には、現在の周波数設定が表示されます。 また、周波数オフセットまたは倍率を使用している場合、周波数基準

モードがオンになっている場合、信号源モジュールを使用している場合には、このエリアにインジケータが表示されます。

3. インジケータ

ディスプレイ・インジケータは、機能の状態とエラー状態を示します。 1 つのインジケータ位置が複数の機能によって用

いられる場合もあります。 同じインジケータ位置を使用する機能が同時にアクティブになることはないので、混乱が生じ

るおそれはありません。

ΦM  このインジケータ（オプション UNT のみ）は、位相変調がオンになっているときに表示されます。

周波数変調がオンになっている場合、ΦMの代わりに FMインジケータが表示されます。

ALC OFF  このインジケータは、ALC 回路がオフになっているときに表示されます。 ALC がオンになっている

が出力レベルを維持できない場合は、UNLEVEL という別のインジケータが同じ位置に表示されま

す。

AM  このインジケータ（オプション UNT のみ）は、振幅変調がオンになっているときに表示されます。

ARMED  このインジケータは、掃引が開始され、本器が掃引トリガ・イベントを待っているときに表示され

ます。

ATTEN HOLD  このインジケータ（オプション 1E1 または E8267D のみ）は、アッテネータ・ホールド機能がオン

になっているときに表示されます。 この機能がオンの場合、アッテネータは現在の設定のままで保

持されます。 

DIG BUS  このインジケータ（オプション 003 または 004 のみ）は、デジタル・バスがアクティブのときに表

示されます。内部オーブン制御基準発振器の温度が冷たいと表示されません（同じ場所に OVEN
COLDが表示されます）。 

ENVLP  このインジケータは、バースト条件が存在する場合に表示されます。例えば、デュアル任意波形

フォーマットでマーカ 2 を使って RF をブランクにするように設定されている場合です。 

ERR  このインジケータは、エラー・キューにエラー・メッセージが存在するときに表示されます。 エ
ラー・メッセージをすべて表示するか、エラー・キューをクリアするまで、このインジケータはオ

フになりません。 エラー・メッセージを見るには、Utility > Error Info を押します。

EXT  このインジケータは、外部レベリングがオンになっているときに表示されます。

EXT1 LO/HI  このインジケータ（オプション UNT、UNU、UNW のみ）は、EXT 1 INPUT に入力される AC 結合

信号が <0.97 Vp または >1.03 Vp のときに、EXT1 LOまたは EXT1 HIとして表示されます。

EXT2 LO/HI  このインジケータ（オプション UNT、UNU、UNW のみ）は、EXT 2 INPUT に入力される AC 結合

信号が <0.97 Vp または >1.03Vp のときに、EXT2 LO または EXT2 HI として表示されます。 

EXT REF  このインジケータは、外部周波数基準が適用されているときに表示されます。

FM  このインジケータ（オプション UNT のみ）は、周波数変調がオンになっているときに表示されま

す。 位相変調がオンになっている場合、FMの代わりにΦMインジケータが表示されます。

I/Q  このインジケータ（E8267D のみ）は、I/Q 変調がオンになっているときに表示されます。
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L  このインジケータは、本器がリスナ・モードにあり、RS-232、GPIB、または VXI-11 LAN インタ

フェース経由で情報やコマンドを受信しているときに表示されます。

MOD ON/OFF  このインジケータ（オプション UNT、UNU、または UNW 付きの E8257D および E8267D のみ）は、

アクティブな変調フォーマットがオンになっているかオフになっているかを示します。 Mod On/Off
ハードキーを押すと、RF Output コネクタから出力される搬送波信号に適用されるすべてのアク

ティブな変調フォーマット（AM、FM、ΦM、パルス、I/Q）のオン / オフを切り替えることができ

ます。 Mod On/Off ハードキーは、AM、FM、ΦM、パルス、I/Q の各変調フォーマットの設定やアク

ティブ化を行うものではありません。個々の変調フォーマットを（AM > AM On などで）設定して

アクティブにしておかないと、Mod On/Off ハードキーをオンにしても出力搬送波信号は変調されま

せん。

OVEN COLD  このインジケータ（オプション UNR のみ）は、内部オーブン制御基準発振器の温度が許容レベル

を下回ったときに表示されます。 このインジケータが点灯している場合は、周波数確度が低下して

います。 この状態が発生するのは、最初に電源に接続してから数分間です。

PULSE  このインジケータ（オプション UNT、UNW のみ）は、パルス変調がオンになっているときに表示

されます。

R  このインジケータは、本器が GPIB、RS-232、または VXI-11/ ソケット LAN インタフェース経由で

リモート制御されているときに表示されます（TELNET 操作では R インジケータは表示されませ

ん）。 R インジケータがオンになっているときは、Local キーと電源スイッチ以外のフロントパネル・

キーは無効になります。 リモート動作の詳細については、『E8257D/67D PSG 信号発生器プログラ

ミング・ガイド』を参照してください。

RF ON/OFF  このインジケータは、RF OUTPUT コネクタに RF およびマイクロ波信号が出力されているか（RF
ON）、されていないか（RF OFF）を示します。 このインジケータはどちらかの状態で常にディスプ

レイに表示されています。

S  このインジケータは、本器が RS-232、GPIB、または VXI-11 LAN インタフェース経由でサービス・

リクエスト（SRQ）を生成したときに表示されます。

SWEEP  このインジケータは、本器がリスト掃引、ステップ掃引、ランプ掃引のいずれかのモードにあると

きに表示されます（ランプ掃引はオプション 007 でのみ使用できます）。 リスト・モードでは、本

器はリスト（ホップ・リスト）中のポイントからポイントへ移行します。リスト中のポイントをた

どる順序は昇順または降順にできます。 リストとしては、周波数リスト、パワー・レベル・リスト、

または両方が使用できます。 ステップ・モードでは、スタート、ストップ、ステップの 3 つの値（周

波数またはパワー・レベル）を指定して、スタート値に始まり、ステップ値だけ増加しながらス

トップ値に達する信号を出力させます。 ランプ掃引モード（オプション 007 のみ）では、スタート

値とストップ値（周波数またはパワー・レベル）を指定して、スタート値に始まり、連続的に変化

しながらストップ値に達する信号を出力させます。

T  このインジケータは、本器がトーカ・モードにあり、GPIB、RS-232、または VXI-11 LAN インタ

フェース経由で情報を送信しているときに表示されます。
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UNLEVEL  このインジケータは、本器が正しい出力レベルを維持できない場合に表示されます。 UNLEVELイン

ジケータが表示されても、機器に異常があるとは限りません。 機器の動作は正常でも、この状態が

発生する可能性があるからです。 ALC 回路がオフになっている場合は、同じ位置に ALC OFF とい

う別のインジケータが表示されます。

UNLOCK  このインジケータは、フェーズ・ロック・ループのどれかがフェーズ・ロックを維持できない場合

に表示されます。 どのループがロックできないかはエラー・メッセージを見ればわかります。

4. デジタル変調インジケータ

この位置にはすべてのデジタル変調インジケータ（E8267D ＋オプション 601/602 のみ）が表示されます。 これらのイン

ジケータは変調がアクティブになっているときだけ表示され、ある時点でアクティブになれるデジタル変調は 1 種類だけ

です。

5. 振幅エリア

この部分には、現在の出力パワー・レベル設定が表示されます。 振幅オフセットが用いられている場合、振幅基準モード

がオンになっている場合、外部レベリング・モードを使用している場合、信号源モジュールを使用している場合、ユーザ・

フラットネスを使用している場合には、このエリアにインジケータが表示されます。

6. エラー・メッセージ・エリア

この部分には簡略化されたエラー・メッセージが表示されます。 複数のエラー・メッセージが発生した場合、最も新しい

ものだけが表示されます。 表示されたすべてのエラー・メッセージとその詳細を見るには、Utility > Error Info を押します。

7. テキスト・エリア

ディスプレイ上のこのテキスト・エリアは、以下に用いられます。

• 変調ステータス、掃引リスト、ファイル・カタログなどの信号発生器ステータス情報の表示

• テーブルの表示

• 情報の管理、情報の入力、ファイルの表示や削除などの機能の実行

8. ソフトキー・ラベル・エリア

このエリアのラベルは、右隣にあるソフトキーの機能を示します。 ソフトキー・ラベルは、選択された機能に応じて変化

します。

ARB デュアル任意波形発生器 M-TONE マルチトーン波形発生器

CUSTOM カスタム・リアルタイムI/Qベースバンド T-TONE 2トーン波形発生器

DIGMOD カスタム任意波形発生器
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リアパネル

このセクションでは、PSG リアパネルの各項目について説明します。 図 1-3 は、標準 E8267D リアパネルを示します。 19
ページの図 1-4 は、オプション 1EM 付きの E8267D リアパネルを示します。 オプション 1EM は、すべてのフロントパネ

ル・コネクタがリアパネルに移動します。 どちらのリアパネルの図にも E8257D で使用可能な項目がすべて含まれていま

す。

図 1-3 標準リアパネルの図

1. EVENT 1 10. I OUT 19. 10 MHz IN

2. EVENT 2 11. Q OUT 20. AUXILIARY INTERFACE

3. PATTERN TRIG IN 12. I-bar OUT 21. 10 MHz OUT

4. BURST GATE IN 13. Q-bar OUT 22. LAN

5. BASEBAND GEN REF IN 14. COH CARRIER 23. STOP SWEEP IN/OUT

6. DIGITAL BUS 15. SMI（信号源モジュール・インタフェース） 24. Z-AXIS BLANK/MKRS

7. AUXILIARY I/O 16. AC電源差込み口 25. SWEEP OUT

8. WIDEBAND I INPUT 17. GPIB 26. TRIGGER OUT

9. WIDEBAND Q INPUT 18. 10 MHz EFC 27. TRIGGER IN

28. SOURCE SETTLED
18 第1章
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図 1-4 オプション1EMリアパネルの図

1. EVENT 1 15. SMI（信号源モジュール・インタフェース） 29. RF OUT

2. EVENT 2 16. AC電源差込み口 30. EXT 1 Input

3. PATTERN TRIG IN 17. GPIB 31. EXT 2 Input

4. BURST GATE IN 18. 10 MHz EFC 32. LF OUT

5. BASEBAND GEN REF IN 19. 10 MHz IN 33. PULSE SYNC OUT

6. DIGITAL BUS 20. AUXILIARY INTERFACE 34. PULSE VIDEO OUT

7. AUXILIARY I/O 21. 10 MHz OUT 35. PULSE/TRIG GATE INPUT

8. WIDEBAND I INPUT 22. LAN 36. ALC INPUT

9. WIDEBAND Q INPUT 23. STOP SWEEP IN/OUT 37. DATA

10. I OUT 24. Z-AXIS BLANK/MKRS 38. DATA CLOCK

11. Q OUT 25. SWEEP OUT 39. SYMBOL SYNC

12. I-bar OUT 26. TRIGGER OUT 40. I Input

13. Q-bar OUT 27. TRIGGER IN 41. Q Input

14. COH CARRIER 28. SOURCE SETTLED
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1. EVENT 1

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）で用いられます。

オプション 601/602 がない信号発生器では、このメス型 BNC コネクタは機能しません。

リアルタイム・モードの場合、EVENT 1 コネクタは外部機器のトリガまたはゲーティングに使用するパターンまたはフ

レーム同期パルスを出力します。 パターン、フレーム、またはタイムスロットの先頭で開始するように設定でき、± 1 タ

イムスロット以内に 1 ビットの分解能で調整できます。

任意波形モードの場合、EVENT 1 コネクタはマーカ 1 から生成されるタイミング信号を出力します。 マーカ１が波形でオ

ンになると、EVENT １コネクタからマーカ（正極性と負極性のどちらの場合も 3.3 V CMOS ハイ）が出力されます。

このコネクタの逆電圧損傷レベルは > ＋ 8 V および < － 4 V です。 公称出力インピーダンスは定義されません。

2. EVENT 2

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）で用いられます。

オプション 601/602 がない信号発生器では、このメス型 BNC コネクタは機能しません。

リアルタイム・モードの場合、EVENT 2 コネクタは外部機器のゲーティングに使用するデータ・イネーブル信号を出力し

ます。 これは内部生成されたタイムスロットに外部データを載せる場合に使用します。 信号がローのときにデータが有効

になります。

任意波形モードの場合、EVENT 2 コネクタはマーカ 2 から生成されるタイミング信号を出力します。 マーカ 2 が波形でオ

ンになると、EVENT 2 コネクタからマーカ（正極性と負極性のどちらの場合も 3.3 V CMOS ハイ）が出力されます。

このコネクタの逆電圧損傷レベルは > ＋ 8 V および < － 4 V です。 公称出力インピーダンスは定義できません。

3. PATTERN TRIG IN

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）で用いられます。

オプション 601/602 がない信号発生器では、このメス型 BNC コネクタは機能しません。 このコネクタには、内部パターン

またはフレーム・ジェネレータにシングル・パターン出力を開始させるトリガ信号を入力します。 最小パルス幅は 100 ns
です。 損傷レベルは > ＋ 5.5 V および < － 0.5 V です。 公称入力インピーダンスは定義できません。

4. BURST GATE IN

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）で用いられます。

オプション 601/602 がない信号発生器では、このコネクタは機能しません。 このコネクタには、バースト・パワーのゲー

ティングのための 3 V CMOS 信号を入力します。バースト・ゲーティングは、外部からデータおよびクロック情報を供給

する場合に使用します。

入力信号は、バースト期間中に出力される外部データ入力と同期している必要があります。 バースト・パワー・エンベロー

プと変調されるデータは、内部的に遅延されて再同期されます。 入力信号は、通常のバースト RF パワーまたは CW RF 出

力パワーに対して CMOS ハイ、RF オフに対して CMOS ローである必要があります。 損傷レベルは > ＋ 5.5 V および < － 0.5
V です。 公称入力インピーダンスは定義できません。
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5. BASEBAND GEN REF IN

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）で用いられます。

オプション 601/602 がない信号発生器では、このメス型 BNC コネクタは機能しません。 このコネクタには、外部タイム

ベース基準からの 0 ～＋ 20 dBm の正弦波または TTL 方形波信号を入力します。この外部タイムベース基準クロックは、

内蔵ベースバンド・ジェネレータの両方の成分で用いられ、レシーバ・テスト・アプリケーションにも用いられます（こ

の外部基準にロックできるのは内蔵ベースバンド・ジェネレータだけです。RF 周波数は 10 MHz 基準にロックされたまま

になります）。

このコネクタに入力可能な周波数は 250 kHz ～ 100 MHz の範囲です。公称入力インピーダンスは 13 MHz で 50 Ω、AC 結

合です。 任意波形設定で外部基準が選択されている場合、任意波形発生器の内部クロックはこの信号にロックされます。 最
小パルス幅は >10 ns です。 損傷レベルは > ＋ 8 V および < － 8 V です。

6. DIGITAL BUS

これは、Agilent Baseband Studio 製品の専用バスです。オプション 003/004 および 601/602 付きの E8267D が必要です。

このコネクタは、一般的な用途には使用できません。信号は、Baseband Studio オプションがインストールされていると

きにのみ存在します（詳細については、http://www.agilent.co.jp/find/basebandstudio を参照してください）。 DIG BUSイ

ンジケータは、デジタル・バスがアクティブのときに表示されます（内部オーブン制御基準発振器の温度が冷たいと表示

されません。同じ場所に OVEN COLDが表示されます）。

7. AUXILIARY I/O

このメス型 37 ピン・コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）を持つ機器

でのみアクティブになります。オプション 601/602 がない信号発生器では、このコネクタは機能しません。 このコネクタ

は、以下の図で説明する入力と出力へのアクセスを提供します。
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図 1-5 補助 I/Oコネクタ（メス型37ピン）

8. WIDEBAND I INPUT

このメス型 BNC コネクタ（E8267D のみ）は、広帯域外部 I/Q 入力（オプション 015）で用いられます。 3.2 ～ 44 GHz レ

ンジの広帯域アナログ入力を I/Q 変調器に直接供給するために使用できます（周波数リミットはオプションによって異な

ります）。 この入力は校正されません。 入力における推奨パワー・レベルは、最大振幅± 1 V で 0 dBm です。 オプション

015 がない信号発生器では、このコネクタは機能しません。 このコネクタの公称インピーダンスは 50 Ωです。

本器は、20 ～ 28.5 GHz 周波数レンジ（オプション 532 および 544）ではロー側ミキシングを使用します。このため、I 信

ALT PWR IN: 内蔵ベースバンド・ジェネレータで用いられま

す。 外部データとオルタネート・パワー信号のタイミング

を同期させるためのCMOS信号を入力します。 損傷レベル

は>＋8 Vおよび<－4 Vです。

リアパネルコネクタを見た

表示

DATA CLK OUT: 内蔵ベースバンド・ジェネレータで用いら

れます。 このピンは、シリアル・データを同期するため

のCMOSクロック信号を出力します。

DATA OUT: 内蔵ベースバンド・ジェネレータで用いられます。 

このピンは、内部データ・ジェネレータからのデータ

（CMOS）またはデータ入力を通じて外部から供給された信号

を出力します。 

EVENT 3: 内蔵ベースバンド・ジェネレータで用いられます。 任意波形モードの場合、こ

のピンはマーカ3から生成されるタイミング信号を出力します。 マーカ3が波形でオン

になると、このピンからマーカ（正極性と負極性のどちらの場合も3.3 V CMOSハイ）

が出力されます。 逆電圧損傷レベルは>＋8 Vおよび<－4 Vです。

PATT TRIG IN 2: 内部パターンまたはフレーム・ジェネ

レータにシングル・パターン出力を開始させるトリガ

信号を入力します。最小パルス幅は100 nsです。 損傷

レベルは>＋5.5 Vおよび<－0.5 Vです。

SYM SYNC OUT: 内蔵ベースバンド・ジェネレータで用いられ

ます。 このピンは、シンボル同期のための1データ・クロッ

ク周期幅のCMOSシンボル・クロックを出力します。

EVENT 4: 内蔵ベースバンド・ジェネレータで用いられます。 任意波

形モードの場合、このピンはマーカ4から生成されるタイミング信

号を出力します。 マーカ4が波形でオンになると、このピンから

マーカ（正極性と負極性のどちらの場合も3.3 V CMOSハイ）が出力

されます。 逆電圧損傷レベルは>＋8 Vおよび<－4 Vです。
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号と Q 信号の位相関係が逆になります。 内部生成された I/Q 信号の場合、本器のファームウェアがこれを補正します。 た
だし、広帯域外部 I/Q 入力（オプション 015）の場合、補正がありません。この周波数帯で正しい位相関係を保持するに

は、リアパネルの I 入力と Q 入力を交換する必要があります。 詳細については、『E8257D/67D PSG サービス・ガイド』の

A37 アップコンバータの説明とオプション 015 のデータシートを参照してください。

9. WIDEBAND Q INPUT

このメス型 BNC コネクタ（E8267D のみ）は、広帯域外部 I/Q 入力（オプション 015）で用いられます。オプション 015
がない信号発生器では、このメス型 BNC コネクタは機能しません。 メス型 BNC コネクタは、3.2 ～ 44 GHz 周波数レンジ

の広帯域アナログ入力を I/Q 変調器に直接供給するために使用できます（周波数リミットはオプションによって異なりま

す）。 この入力は校正されません。 入力における推奨パワー・レベルは、最大振幅± 1 V で 0 dBm です。 このコネクタの公

称インピーダンスは 50 Ω です。 詳細については、上の広帯域 I 入力の説明を参照してください。 

10. I OUT

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）使用時に、I/Q
変調のアナログ同相成分を出力するために使用できます。オプション 601/602 がない信号発生器では、このメス型 BNC
コネクタは I入力コネクタに供給された外部 I/Q変調の同相成分を出力するために使用できます。 I OUTコネクタの公称出

力インピーダンスは 50 Ω、DC 結合です。

11. Q OUT

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）使用時に、I/Q
変調のアナログ直交位相成分を出力するために使用できます。オプション 601/602 がない信号発生器では、このメス型

BNCコネクタはQ入力コネクタに供給された外部 I/Q変調の直交位相成分を出力するために使用できます。 Q OUTコネク

タの公称出力インピーダンスは 50 Ω、DC 結合です。

12. I-bar OUT

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）使用時に、I/Q
変調のアナログ同相成分の補信号を出力するために使用できます。オプション 601/602 がない信号発生器では、このメス

型 BNC コネクタは I 入力コネクタに供給された外部 I/Q 変調の同相成分の補信号を出力するために使用できます。 

I-bar OUT と I OUT とを組み合わせることで、平衡ベースバンド信号を供給できます。 平衡信号とは、2 本の導線の信号が

グランドに対して対称で、極性が逆（位相差が 180°）になっているものです。 I-bar OUT コネクタの公称出力インピーダ

ンスは 50 Ω、DC 結合です。
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13. Q-bar OUT

このメス型 BNC コネクタ（E8267D のみ）は、内蔵ベースバンド・ジェネレータ（オプション 601/602）使用時に、I/Q
変調のアナログ直交位相成分の補信号を出力するために使用できます。オプション 601/602 がない信号発生器では、この

メス型BNCコネクタはQ入力コネクタに供給された外部I/Q変調の直交位相成分の補信号を出力するために使用できます。

Q-bar OUT と Q OUT とを組み合わせることで、平衡ベースバンド信号を供給できます。 平衡信号とは、2 本の導線の信号

がグランドに対して対称で、極性が逆（位相差が 180°）になっているものです。 Q-bar OUT コネクタの公称出力インピー

ダンスは 50 Ω、DC 結合です。

14. COH CARRIER

このメス型 SMA コネクタ（オプション UNT 付き E8267D のみ）は、本器の搬送波とコヒーレントな位相を持つ RF 信号

を出力します。 コヒーレント搬送波コネクタが出力する RF は、AM、パルス、I/Q 変調では変調されませんが、FM または

ΦM（FM またはΦM がオンの場合）では変調されます。 

出力パワーは公称 0 dBm です。 出力周波数レンジは 249.99900001 MHz ～ 3.2 GHz です。 出力周波数が 3.2 GHz を超える

場合はこの出力は使用できません。 RF 出力周波数が 249.99900001 MHz を下回る場合、コヒーレント搬送波出力信号の周

波数は以下のようになります。

コヒーレント搬送波の周波数 =（1E9-RF 出力の周波数）Hz

損傷レベルは 20 Vdc および 13 dBm の逆 RF パワーです。 このコネクタの公称インピーダンスは 50 Ωです。

15. SMI（信号源モジュール・インタフェース）

このインタフェースは、互換性のある Agilent Technologies 83550 シリーズ・ミリ波信号源モジュールを接続するために

用いられます。

16. AC電源差込み口

AC 電源電圧をここに接続します。 この電源コード用差込み口には、本器に付属する 3 極電源ケーブルを接続します。

17. GPIB

GPIB インタフェースは、IEEE 488.2 デバイス互換のリスン / トーク機能を備えています。

18. 10 MHz EFC

このメス型 BNC 入力コネクタには、内部 10 MHz 基準発振器の電子周波数制御（EFC）のための－ 5 ～＋ 5 V の外部 DC
電圧を入力します。この電圧は、発振器を中心周波数の前後に約－ 0.0025 ppm/V の割合でチューニングします。 公称入

力インピーダンスは 1 MΩ より大きくなります。 このコネクタを使用しない場合は、動作周波数を安定させるため、付属

のショート・キャップでショートしておいてください。 このコネクタは、オプション UNR 付きの場合にのみ使用できます。
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19. 10 MHz IN

このメス型 BNC コネクタには、－ 3 dBm 以上の外部タイムベース基準入力信号レベルを入力します。 基準は 1、2、2.5、
5、10 MHz のいずれかで、± 1 ppm でなければなりません。 このコネクタに有効な基準信号が存在する場合、本器はそれ

を検出して自動的に内部基準動作から外部基準動作に切り替わります。

オプション UNR の場合、この BNC コネクタは公称入力レベル 5 ± 5 dBm です。外部周波数基準は 10 MHz で、± 1 ppm
でなければなりません。

公称入力インピーダンスは 50 Ω、損傷レベルは≧ 10 dBm です。

20. AUXILIARY INTERFACE

この 9 ピン D-sub メス型コネクタは、RS-232 シリアル・ポートであり、シリアル通信とマスタ / スレーブ信号源同期に使

用できます。

図 1-6

21. 10 MHz OUT

このメス型 BNC コネクタは、公称信号レベル > ＋ 4 dBm を出力し、出力インピーダンスは 50 Ω です。 確度は使用する

タイムベースによって決まります。

表1-3 補助インタフェース・コネクタ

ピン番号 信号説明 信号名

1 無接続（デフォルト動作）/
復帰（マスタ/スレーブ動作）

2 データ受信 RECV

3 データ送信 XMIT

4 ＋5V（デフォルト動作）/
掃引停止（マスタ/スレーブ動作）

5 グランド、0V

6 無接続

7 送信要求 RTS

8 送信可 CTS

9 無接続

リアパネルコネクタを見た

表示
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22. LAN

LAN インタフェースは、10Base-T LAN ケーブルによるイーサネット LAN への接続を可能にします。 データ伝送（送信ま

たは受信）が行われているときは、インタフェース上の黄色の LED が点灯します。 データ伝送に遅延がある場合、または

データ伝送が行われていない場合は、緑の LED が点灯します。

23. STOP SWEEP IN/OUT

このメス型BNCコネクタ（オプション007のみ）は、ランプ掃引動作中に用いられ、オープン・コレクタTTL互換入出力で

す。 掃引の復帰およびバンド交差期間中には低レベル（公称0 V）出力が供給されます。 掃引の進行中には高レベル（公称

＋5 V）出力が供給されます。 この入出力コネクタを外部からグランドに接続すると、掃引は停止します。 入力として動作

しているとき、このコネクタの公称インピーダンスは10 Ω未満です。 出力として動作しているとき、公称インピーダンス

は約4.2 kΩです。

24. Z-AXIS BLANK/MKRS

このメス型 BNC コネクタ（オプション 007 のみ）は、ステップ、リスト、ランプ掃引の復帰およびバンド切り替え期間

中に＋ 5 V（公称値）のレベルを供給します。 ランプ掃引の場合、このメス型 BNC コネクタは、RF 周波数がマーカ周波

数に一致し、強度マーカ・モードがオンになっているときに、－ 5 V（公称値）のレベルを供給します。 この出力は、オペ

アンプの出力ですので、負荷インピーダンスは 5 kΩ 以上にします。 このコネクタの最も一般的な用途は、Agilent 8757D
スカラ・ネットワーク・アナライザとのインタフェースです。

25. SWEEP OUT

このメス型 BNC コネクタは、RF パワーまたは周波数の掃引に比例した電圧を出力します。電圧の範囲は、掃引の幅とは

無関係に、掃引の開始時が 0 V で、掃引の終了時に＋ 10 V（公称）に達します。

公称出力インピーダンスは 1 Ω 未満で、2 kΩの負荷をドライブできます。

Agilent 8757D ネットワーク・アナライザと接続した場合、ランプ（アナログ）掃引の間に等間隔の 1 ms 10 V パルス（公

称値）を選択可能な数だけこのコネクタから生成できます。 パルス数は 8757D からのリモート制御で 101 ～ 1601 の範囲

内の値に設定できます。

26. TRIGGER OUT

このメス型 BNC コネクタは、ステップ / リスト掃引モードの場合、待ちシーケンスの開始時、または手動掃引モードでポ

イント・トリガを待っているときにハイになる TTL 信号を出力します。 待ちシーケンスが終了するか、ポイント・トリガ

が受信されると信号はローになります。 ランプ掃引モードの場合、ランプ掃引中に 1601 個の等間隔の 1 µs パルス（公称

値）が生成されます。 LF OUT を使用する場合、この出力は LF 掃引の開始時に 2 µs のパルスを供給します。 このコネクタ

の公称インピーダンスは 10 Ω未満です。

オプション 1EM の付いた信号発生器では、この出力が BNC から SMB コネクタに変更されます。
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27. TRIGGER IN

このメス型 BNC コネクタには、手動掃引モードのポイントツーポイント・トリガ、または低周波（LF 出力）またはアナ

ログ（AM、FM、ΦM）外部掃引トリガ設定で用いられる 3.3V CMOS 信号を入力します。信号の先頭の正または負のエッ

ジでトリガすることができます。 損傷レベルは≦－ 4 V または≧＋ 10 V です。 このコネクタの公称入力インピーダンスは

約 4.2 kΩ です。

28. SOURCE SETTLED

このメス型 BNC コネクタは、本器が新しい周波数またはパワー・レベルでセトリングしたことを示す 3 V CMOS 出力ト

リガを供給します。 信号がハイのときは本器がセトリングしていないことを示します。 信号がローになると本器がセトリ

ングしたことを示します。 このコネクタの公称出力インピーダンスは 10 Ω 未満です。

29. RF OUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「18. RF OUTPUT」（10
ページ）を参照してください。

30. EXT 1 Input

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「11. EXT 1 INPUT」（9
ページ）を参照してください。

31. EXT 2 Input

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「12. EXT 2 INPUT」（9
ページ）を参照してください。

32. LF OUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「13. LF OUTPUT」（10
ページ）を参照してください。

33. PULSE SYNC OUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「19. SYNC OUT」（10 ペー

ジ）を参照してください。

34. PULSE VIDEO OUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「20. VIDEO OUT」（11 ペー

ジ）を参照してください。

35. PULSE/TRIG GATE INPUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「22. GATE/ PULSE/
TRIGGER INPUT」（11 ページ）を参照してください。
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36. ALC INPUT

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「15. ALC INPUT」（10 ペー

ジ）を参照してください。

37. DATA

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「35. DATA」（12 ページ）

を参照してください。

38. DATA CLOCK

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「34. DATA CLOCK」（12
ページ）を参照してください。

39. SYMBOL SYNC

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「33. SYMBOL SYNC」（12
ページ）を参照してください。

40. I Input

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「37. I Input」（13 ページ）

を参照してください。

41. Q Input

標準機器では、このコネクタはフロントパネルに存在します。 このコネクタの説明については、「36. Q Input」（13 ページ）

を参照してください。
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2 基本操作

この章は以下のセクションに分かれており、Agilent PSG 信号発生器に共通の操作について説明します。

• 「テーブル・エディタの使用」（30ページ）

• 「連続波RF出力の設定」（32ページ）

• 「掃引RF出力の設定」（34ページ）

• 「ランプ掃引の使用（オプション007）」（39ページ）

• 「周波数レンジの拡大」（49ページ）

• 「変調フォーマットをオンにする」（49ページ）

• 「RF出力への変調フォーマットの適用」（50ページ）

• 「データ・ストレージ機能の使用」（51ページ）

• 「機器ステート・レジスタの使用」（53ページ）

• 「セキュリティ機能の使用」（55ページ）

• 「オプションの有効化」（61ページ）

• 「Webサーバの使用」（62ページ）
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テーブル・エディタの使用

テーブル・エディタを使うと、リスト掃引の作成などの構成作業をより簡単に行えます。 このセクションでは、リスト・

モード・テーブル・エディタを例に、テーブル・エディタの基本的な機能を紹介します。

Preset > Sweep/List > Configure List Sweep を押します。

下の図に示したリスト・モード・テーブル・エディタが表示されます。

図 2-1

アクティブ機能エリア  編集対象の値を含むアクティブなテーブル項目を表示

カーソル  選択や編集の対象となるテーブル項目を強調表示する反転表示マーク

テーブル・ソフトキー  テーブル項目の選択、テーブル値の初期設定、テーブル構造の変更

テーブル項目  番号付きの行とタイトル付きの列とで指定される値（列のことをデータ・

フィールドとも呼びます。 例えば、Frequency というタイトルの下の列を

Frequency データ・フィールドと呼びます）。

カーソル

テーブル・ソフトキーテーブル名 テーブル項目

アクティブ機能エリア
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テーブル・エディタ・ソフトキー

下記のテーブル・エディタ・ソフトキーを使って、テーブル項目の値のロード、選択、変更、保存が可能です。

Edit Item  選択した項目をディスプレイのアクティブ機能エリアに表示し、その値を編集可能にします。

Insert Row  現在選択されている行の上に、同じテーブル項目を持つ新しい行を挿入します。

Delete Row  現在選択されている行を削除します。

Goto Row  テーブル項目の間を簡単に移動するためのソフトキーのメニュー（Enter、Goto Top Row、Goto Middle
Row、Goto Bottom Row、Page Up、Page Down）を表示します。

Insert Item  現在選択されている項目の下の行に同じ項目を挿入します（38 ページ参照）。

Delete Item  現在選択されている項目が削除されます。

Page Upと
Page Down  10 行分のテーブル表示エリアの外にある行のテーブル項目を表示するために使います。

More (1 of 2)  Load/Store およびそれに関連するソフトキーを表示します。

Load/Store  メモリ・カタログのファイルからテーブル項目をロードしたり、現在のテーブル項目をファイルに

保存したりするためのソフトキーのメニュー（Load From Selected File、Store To File、Delete File、Goto
Row、Page Up、Page Down）を表示します。

データ・フィールドのテーブル項目の変更

1. リスト・モード・テーブル・エディタ（30 ページの図 2-1）が表示されていない場合、以下の手順でオープンします。 
Preset > Sweep/List > Configure List Sweep を押します。

2. 矢印キーまたはノブで目的の項目にテーブル・カーソルを移動します。

図 2-1 では、Frequency データ・フィールドの最初の項目が選択されています。

3. Edit Item を押します。

選択した項目がディスプレイのアクティブ機能エリアに表示されます。

4. ノブ、矢印キー、またはテンキーを使って値を変更します。

5. Enter を押します。

変更した項目がテーブルに表示されます。
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RF出力の設定

このセクションでは、連続波と掃引 RF（34 ページ）出力を作成する方法について説明します。 ミリ波信号源モジュール

を使って本器の周波数レンジ（ 49 ページ）を拡大する方法についても説明します。

連続波RF出力の設定

これらの手順では、以下のパラメータの設定方法を示します。

• RF 出力周波数

• 周波数基準と周波数オフセット（33 ページ）

• RF 出力振幅（33 ページ）

• 振幅基準と振幅オフセット（34 ページ）

RF出力周波数の設定

RF 出力周波数を 700 MHz に設定し、出力周波数を 1 MHz 刻みで増減します。

1. 本器を工場設定の状態に戻します。 Preset を押します。

注記 本器の初期設定状態は、ユーザ定義のステートに変更できます。 ただし、ここに紹介した例では、工場設定での

初期設定状態を使用してください（UtilityメニューのPreset Normal UserソフトキーをNormalに設定します）。

2. ディスプレイの FREQUENCYエリア（左上隅）を見てください。

ここに表示されているのが本器の最大仕様周波数です。

3. RF On/Off を押します。

RF OUTPUT コネクタに RF 信号を出力するには、RF On/Off ハードキーを押す必要があります。 ディスプレイ・インジ

ケータが RF OFFから RF ONに変わります。 これで最大仕様周波数が RF OUTPUT コネクタから（本器の最小パワー・

レベルで）出力されます。

4. Frequency > 700 > MHz を押します。

700 MHz の RF 周波数がディスプレイの FREQUENCYエリアとアクティブ入力エリアに表示されます。

5. Frequency > Incr Set > 1 > MHz を押します。

周波数増分値が 1 MHz に変更されます。

6. 上矢印キーを押します。

上矢印キーを 1 回押すたびに、Incr Set ハードキーで最後に設定した増分値だけ周波数が増加します。 増分値はアク

ティブ入力エリアに表示されます。

7. 下矢印を使うと、前のステップで設定した増分値だけ周波数が減少します。 1 MHz 刻みで周波数を増減してみてくだ

さい。

RF 出力周波数はノブを使っても調整できます。 周波数がアクティブ機能である（アクティブ入力エリアに周波数が表

示されている）間は、ノブを回すことで RF 出力周波数を増減できます。
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8. ノブを使って周波数を 700 MHz に戻します。

周波数基準と周波数オフセットの設定

以下の手順では、現在の RF 出力周波数を、他のすべての周波数設定に対する基準周波数として設定します。 周波数基準

が設定されると、ディスプレイに 0.00 Hz（本器のハードウェアの周波数出力から基準周波数を引いた値）と表示されま

す。 表示は変化しますが、実際の周波数出力は（上のステップ 8 により）700 MHz です。 これ以後の周波数変更は 0 Hz に

対する増減として示されます。

周波数規準設定機能はアクティブ機能ではありません。 設定すると、周波数設定への変更は、本器のフロントパネル・ディ

スプレイに周波数表示値として示されます。 例えば、

1. 本器を初期設定します。 Preset を押します。

2. 周波数基準を 700 MHz に設定します。 
次のように押します。 Frequency > 700 > MHz > More (1 of 3) > Freq Ref Set。

周波数基準モードがオンになり、出力周波数（700 MHz）が基準値として設定され、Freq Ref ソフトキーが On に切り

替わります。 FREQUENCYエリアに 0.000 Hzが表示されます。 この表示値は、本器のハードウェアの周波数出力（700
MHz）から基準値（700 MHz）を引いた値です。 本器の真の出力周波数は 700 MHz です。 Freq Ref ソフトキーを Off に
切り替えると、フロントパネルに実際の周波数である 700 MHz が示されます。 フロントパネル・ディスプレイに REF
インジケータが表示され、Freq Ref Off On ソフトキーが On に切り替わります。

3. RF 出力をオンにします。 RF On/Off を押します。

ディスプレイ・インジケータが RF OFFから RF ONに変わります。 RF OUTPUT コネクタの出力 RF 周波数は 700 MHz
です。

4. 周波数増分値を 1 MHz に設定します。 Frequency > Incr Set > 1 > MHz を押します。

5. 出力周波数を 1 MHz 増加します。 上矢印キーを押します。

FREQUENCYエリアの表示が 1.000 000 000 MHz に変わります。これはハードウェアの周波数出力（700 MHz ＋ 1 MHz）
から基準周波数（700 MHz）を引いた値です。 RF OUTPUT の周波数は 701 MHz になります。

6. 1 MHz のオフセットを入力します。 More (1 of 3) > Freq Offset > 1 > MHz を押します。

FREQUENCYエリアには 2.000 000 00MHzと表示されます。これはハードウェアの周波数出力（701 MHz）から基準周

波数（700 MHz）を引き、オフセット（1 MHz）を足した値です。 OFFSインジケータが表示されます。 RF OUTPUT コ

ネクタの周波数は 701 MHz のままです。

RF出力振幅の設定

1. 本器を初期設定します。 Preset を押します。

ディスプレイの AMPLITUDEエリアには本器の最小パワー・レベルが表示されています。 これが RF 出力振幅の通常の

初期設定状態です。

2. RF 出力をオンにします。 RF On/Off を押します。

ディスプレイ・インジケータが RF ONに変わります。 RF OUTPUT コネクタで、RF 信号が最小パワー・レベルで出力

されます。
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3. 振幅を－20 dBmに変更します。 Amplitude > －20 > dBmを押します。

新しい出力パワーが、ディスプレイの AMPLITUDEエリアとアクティブ入力エリアに表示されます。 フロントパネルの

他のファンクション・キーを押すまで、振幅がアクティブ機能のままです。 上下の矢印キーとノブを使っても振幅を

変更することができます。

振幅基準と振幅オフセットの設定

以下の手順では、現在の RF 出力パワーを、他のすべての振幅パラメータに対する振幅基準として設定します。 設定後最

初にディスプレイに表示される振幅は、0 dB（ハードウェアのパワー出力から基準パワーを引いた値）です。 設定により

表示は変化しますが、出力されるパワーは変わっていません。 これ以後のパワー変更は 0 dB に対する増減として示されま

す。 

1. Preset を押します。

2. 振幅を－20 dBmに設定します。 Amplitude >  －20  > dBmを押します。

3. 振幅基準モードがオンになり、現在の出力パワー（－20 dBm）が基準値に設定されます。 More (1 of 2) > Ampl Ref Set
を押します。

AMPLITUDEエリアには0.00 dBと表示されます。これはハードウェアのパワー出力（－20 dBm）から基準値（－20
dBm）を引いた値です。 REFインジケータが表示され、Ampl Ref Off OnソフトキーがOnに切り替わります。

4. RF 出力をオンにします。 RF On/Off を押します。

ディスプレイ・インジケータが RF ONに変わります。 RF OUTPUT コネクタの出力 RF パワーは－ 20 dBm です。 

5. 振幅増分値を 10 dB に変更します。 Incr Set > 10 > dB を押します。

6. 上矢印キーを押して、出力パワーを 10 dB 増やします。

AMPLITUDEエリアには10.00 dBと表示されます。これはハードウェアのパワー出力（－20 dBm足す10 dBm）から基

準パワー（－20 dBm）を引いた値です。 RF OUTPUTコネクタのパワーは－10 dBmに変化します。

7. 10 dBのオフセットを入力します。 Ampl Offset > 10 > dBを押します。

AMPLITUDEエリアには20.00 dBと表示されます。これはハードウェアのパワー出力（－10 dBm）から基準パワー（－

20 dBm）を引き、オフセット（10 dB）を足した値です。 OFFSインジケータが表示されます。 RF OUTPUTコネクタの

パワーは－10 dBmのままです。

掃引RF出力の設定

本器には最大 3 種類の掃引タイプがあります。 ステップ掃引、リスト掃引、ランプ掃引（オプション 007）です。

フロントパネル・ディスプレイの進捗度バーに掃引の進行状況が示されます。 掃引時間が 1 秒を超える場合、進捗度バー

の掃引は各セグメントの周波数スパンに基づいて進行します。 スパンのセグメントごとに進捗度バーにフル・セグメント

が表示され、掃引が実行されます。 掃引時間が 1 秒未満の場合、進捗度バーが表示され、掃引が実行され、進捗度バーが

ブランクになります。 
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注記 リスト掃引のデータは機器ステートには保存できませんが、メモリ・カタログに保存することができます。 リス

ト掃引データの保存方法については、「メモリ・カタログへのファイルの保存」（52 ページ）を参照してください。

掃引 RF 出力の際には、掃引の対象に応じて、本器のディスプレイの FREQUENCYエリアと AMPLITUDEエリアが

機能しなくなります。

ステップ掃引（35 ページを参照）とランプ掃引（37 ページを参照）では、スタート周波数 / 振幅とストップ周波数 / 振幅

との間で直線的な変化を実現できます。リスト掃引では、任意の周波数、振幅、待ち時間のリストを作成し、リストに基

づいて RF 出力を掃引できます。

リスト掃引の例では、新しいリスト掃引のベースとしてステップ掃引の例で作成したポイントを利用します。 

ランプ掃引（39 ページを参照）はステップ掃引やリスト掃引よりも高速であり、8757D スカラ・ネットワーク・アナライ

ザと組み合わせて使用できるように設計されています。

本器には、シングル掃引動作を設定できるソフトキーSweep Retrace Off On があります。 Sweep Retrace をオンにすると、

掃引後に最初のポイントに戻り、 オフにすると、最後のポイントのままになります。 

掃引設定でのスカラ・パルスのアクティブ化

掃引設定でスカラ・ネットワーク・アナライザと DC ディテクタを使用する場合、PSG は掃引信号を 27 kHz 方形波（ス

カラ・パルスとも呼びます）で変調する必要があります。 DC ディテクタが掃引信号を正しく検出するためには、このパル

ス変調が必要です。 PSG が GPIB で 8757D により制御されている場合、8757D で DC 検出を選択するとスカラ・パルスが

自動的にオンになります。 それ以外のスカラ・アナライザを使用するときには、以下のキー・シーケンスのいずれかを使っ

てスカラ・パルスを手動でオンにすることができます。

Sweep/List > Sweep Type > Scalar Pulse Off On を押して On にします。

または

Pulse > Pulse Source > Scalar > Pulse Off On を押して On にします。

ステップ掃引の使用

ステップ掃引を使うと、スタート周波数 / 振幅とストップ周波数 / 振幅との間で直線的な変化を実現できます。 掃引の方

向は上下に切り替えることができます。 Sweep Direction Down Up ソフトキーが Up に設定されている場合、値はスタート振

幅 / 周波数からストップ周波数 / 振幅に向かって掃引されます。 Down に設定されている場合、値はストップ振幅 / 周波数

からスタート周波数 / 振幅に向かって掃引されます。

ステップ掃引をアクティブにすると、RF 出力のスタート / ストップ周波数と振幅、ステップ（待ち動作が行われる等間隔

のポイント）、および各ポイントでの待ち時間の長さに基づいて、RF 出力が掃引されます。待ち時間とは、セトリング時

間の後に本器が現在の状態に留まる最小の時間の長さです。 RF 出力の周波数、振幅、または周波数と振幅の両方が、ス

タート振幅 /周波数からストップ振幅 /周波数まで掃引され、# Pointsソフトキーで設定した間隔で待ち動作が行われます。
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シングル・ステップ掃引を設定する手順

この手順では、9 個の等間隔のポイントと下記のパラメータを使ってステップ掃引を作成します。

• 周波数レンジ : 500 MHz～600 MHz
• 振幅 : －20 dBm～0 dBm
• 待ち時間 : 各ポイントで500 ms

1. Preset を押します。

2. Sweep/List を押します。

掃引ソフトキーのメニューがオープンします。

3. Sweep Repeat Single Cont を押します。

掃引が連続からシングルに切り替わります。

4. Configure Step Sweep を押します。

5. Freq Start > 500 > MHz を押します。

ステップ掃引のスタート周波数が 500 MHz に変更されます。

6. Freq Stop > 600 > MHz を押します。

ステップ掃引のストップ周波数が 600 MHz に変更されます。

7. Ampl Start > － 20 > dBm を押します。

ステップ掃引の開始時の振幅レベルが変更されます。

8. Ampl Stop > 0 > dBm を押します。

ステップ掃引の終了時の振幅レベルが変更されます。

9. # Points > 9 > Enter を押します。

掃引ポイント数が 9 に設定されます。

10. Step Dwell > 500 > msec を押します。

各ポイントでの待ち時間が 500 ms に設定されます。

11. Return > Sweep > Freq & Ampl を押します。

周波数と振幅の両方のデータのステップ掃引が設定されます。 このソフトキーを選択すると、前のメニューに戻り、掃

引機能がオンになります。

12. RF On/Off を押します。

ディスプレイ・インジケータが RF OFFから RF ONに変わります。

13. Single Sweep を押します。

ステップ掃引で設定された周波数と振幅の掃引が 1 回実行され、RF OUTPUT コネクタから出力されます。 掃引が行わ

れる間、ディスプレイには SWEEPインジケータが表示され、進捗度バーに掃引の進行状況が示されます。 Single Sweep
ソフトキーを押せば実行中の掃引を中止することができます。 もう一度周波数を掃引するには、Single Sweep を押して

掃引をトリガします。
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連続ステップ掃引を設定する手順

Sweep Repeat Single Cont を押します。

これにより、掃引方法がシングルから連続に切り替わります。 ステップ掃引で設定された周波数と振幅が RF OUTPUT コ

ネクタに連続的に出力されます。 掃引中であることを示す SWEEPインジケータがディスプレイに表示され、掃引の進行が

進捗度バーで表示されます。 

リスト掃引の使用

リスト掃引では、任意の周波数、振幅、待ち時間のリストを作成し、リスト・モード・テーブルの要素に基づいて RF 出

力を掃引します。 

ステップ掃引の場合、掃引全体を通じて直線的に増減する等間隔の周波数および振幅値を使用するのに対して、リスト掃

引の場合、周波数と振幅は等間隔である必要はなく、非直線的に増減してもランダムな順序でもかまいません。 

リスト・モード・テーブルを簡単に作成するため、定義済みのステップ掃引からテーブルに値をコピーする方法が用意さ

れています。 ステップ掃引の各ポイントに対応する周波数、振幅、待ち時間の値が、リスト・モード・テーブルの各行に

入力されます。このあとの例を参照してください。

ステップ掃引データを使ってシングル・リスト掃引を設定する手順

この手順では、ステップ掃引のポイントを利用し、リスト・モード・テーブル・エディタでいくつかのポイントの値を変

更します。 テーブル・エディタの使い方については、「テーブル・エディタの使用」（30 ページ）を参照してください。

1. Sweep Repeat Single Cont を押します。

掃引の繰返し方法が連続からシングルに切り替わります。 SWEEP インジケータがオフになります。 トリガするまで掃

引は実行されません。

2. Sweep Type List Step を押します。

掃引タイプがステップからリストに切り替わります。

3. Configure List Sweep を押します。

これにより、掃引ポイントの作成に使用する別のソフトキー・メニューがオープンします。 ディスプレイには現在の

リスト・データが表示されます （リストを一度も作成したことがない場合、本器の最大周波数、最小振幅、2 ms の

待ち時間に設定された 1 個のポイントからなるリストがデフォルトとして表示されます）。

4. More (1 of 2) > Load List From Step Sweep > Confirm Load From Step Data を押します。 

ステップ掃引で定義したポイントが自動的にリストにロードされます。

リスト掃引ポイントを編集する手順

1. Return > Sweep > Off を押します。

掃引をオフにするのは、リスト掃引ポイントを編集する際にエラーが発生するのを防ぐためです。 編集中に掃引がオ

ンになっていると、ポイントのどれかのパラメータ（周波数、パワー、待ち時間）が未定義の場合にエラーが発生します。

2. Configure List Sweep を押します。

掃引リスト・テーブルに戻ります。
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3. 矢印キーを使って行 1 の待ち時間を強調表示します。

4. Edit Item を押します。

ポイント 1 の待ち時間がアクティブ機能になります。

5. 100 > msec を押します。

行 1 の新しい待ち時間として 100 ms が入力されます。ターミネータ・ソフトキーを押すと、テーブルの次の項目（こ

の場合はポイント 2 の周波数値）が強調表示されます。

6. 矢印キーを使って、行 4 の周波数値を強調表示します。

7. Edit Item > 545 > MHz を押します。

行 4 の周波数値が 545 MHz に変更されます。

8. ポイント 7 の行の任意の列を強調表示して Insert Row を押します。 

これにより、ポイント 7 と 8 の間に新しいポイントが追加されます。ポイント 7 のコピーがポイント 7 と 8 の間に挿

入されて新たにポイント 8 となり、以降のポイントの番号が 1 ずつ下にずれます。

9. ポイント 8 の周波数項目を強調表示し、 Insert Item を押します。

Insert Item を押すと、ポイント 8 から下の周波数値が 1 行分下にずれます。ポイント 8 と 9 の元の周波数値がそれぞ

れ 1 行ずつ下にずれ、周波数値だけを持つ新しいエントリがポイント 10 に作成されます（パワーと待ち時間は下にず

れません）。

ポイント 8 の周波数が引き続きアクティブ機能です。

10. 590 > MHz を押します。

11. Insert Item > － 2.5 > dBm を押します。 

ポイント 8 に新しいパワー値が挿入され、ポイント 8 と 9 の元のパワー値が 1 行分下にずれます。

12. ポイント 9 の待ち時間を強調表示し、Insert Item を押します。

強調表示された待ち時間の複製がポイント 9 に挿入され、既存の値が下にずれてポイント 10 のエントリとなります。

シングル・リスト掃引を設定する手順

1. Return > Sweep > Freq & Ampl を押します。

掃引が再びオンになります。 さきほどの編集で全ポイントのすべてのパラメータが正しく定義されていれば、エラー

は発生しないはずです。

2. Single Sweep を押します。

リスト中のポイントのシングル掃引が実行されます。 掃引中は SWEEPインジケータがオンになります。

3. More (1 of 2) > Sweep Trigger > Trigger Key を押します。

これにより、Trigger ハードキーを押したときに掃引トリガが発生するようになります。

4. More (2 of 2) > Single Sweep を押します。

これにより掃引がアーミングされます。 ARMEDインジケータがオンになります。
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5. Trigger ハードキーを押します。

リスト中のポイントのシングル掃引が実行され、掃引中は SWEEPインジケータがオンになります。

連続リスト掃引の手順

Sweep Repeat Single Cont を押します。

掃引がシングルから連続に切り替わります。 リスト掃引で設定された周波数と振幅の連続的な繰り返しが RF OUTPUT コ

ネクタから出力されます。 掃引中であることを示す SWEEPインジケータがディスプレイに表示され、掃引の進行が進捗度

バーで示されます。 

ランプ掃引の使用（オプション007）

ランプ掃引では、スタート周波数 / 振幅からストップ周波数 / 振幅までの直線的な変化が起こります。 ランプ掃引はステッ

プ掃引やリスト掃引よりもはるかに高速であり、8757D スカラ・ネットワーク・アナライザと組み合わせて使用できるよ

うに設計されています。 このセクションでは、オプション 007 付きの PSG 信号発生器で使用可能なランプ掃引機能につい

て説明します。 基本ランプ掃引の使用方法、およびランプ掃引におけるマスタ / スレーブの設定方法（46 ページを参照）

が理解できます。

ランプ掃引システムでパススルー・コマンドを使用するサンプル・プログラムについては、『E8257D/67D PSG 信号発生

器プログラミング・ガイド』を参照してください（パススルー・コマンドを使うと、ランプ掃引のシステム動作を一時的

に中断して、PSG に操作命令を送ることができます）。

基本的なランプ掃引機能の使用

この手順では以下の作業を示します（それぞれの作業はその前の作業から続いています）。

• 「周波数掃引の設定」（39ページ）

• 「マーカの使用」（42ページ）

• 「掃引時間の調整」（44ページ）

• 「交互掃引の使用」（45ページ）

• 「振幅掃引の設定」（46ページ）

周波数掃引の設定

1. 機器を図 2-2 のように接続します。

注記 PSG信号発生器は、8757A、8757C、8757EのGPIBシステム・インタフェースとは互換性がありません。 これら

旧機種のスカラ・ネットワーク・アナライザを使用する場合、図2-2のGPIBケーブルは接続しないでください。

この方法では8757Dの機能の一部しか実現できません。 詳細については『PSGデータシート』を参照してくださ

い。 この手順の代わりに8757A/C/Eのドキュメントを使用してください。
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図 2-2 機器セットアップ

2. 8757D と PSG の電源をオンにします。

3. 8757D で、System > More > Sweep Mode を押し、SYSINTF ソフトキーが ON に設定されていることを確認します。

これは、8757D でシステム・インタフェース・モードがオンになっていることを確認するためです。 システム・イン

タフェース・モードでは、機器同士をシステムとして協調動作させることができます。

4. Utility > GPIB/RS-232 LAN を押して、GPIB Address ソフトキーの下に表示される PSG の GPIB アドレスを確認します。

変更する場合、GPIB Address を押して値を変更します。

5. 8757D で、LOCAL > SWEEPER を押し、GPIB アドレスをチェックします。 PSG の GPIB アドレスと一致しない場合、値

を変更します。

6. どちらかの機器を初期設定します。

一方の機器を初期設定すると、もう一方の機器も自動的に初期設定されるはずです。 どちらかが初期設定されない場

合、GPIB 接続と GPIB アドレスをチェックし、8757D がシステム・インタフェース・モードである（SYSINTF が ON
になっている）ことを確認してください。

PSG は、振幅が 0 dBm 一定で、2 GHz から最大周波数までのランプ掃引を自動的にオンにします。 PSG のディスプレ

イに RF ON、SWEEP、PULSE の 3 つのインジケータが表示されることを確認してください。 PULSE インジケータが表

示されるのは、8757D が AC モードで動作しているからです。

PSG はまた、リモート言語設定を 8757D System に切り替え、ランプ掃引動作中に 8757D に指示できるようにしま

す。 これを確認するには、Utility > GPIB/RS-232 LAN を押し、Remote Language ソフトキーの下の選択項目を見ます。
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注記 掃引RF出力の際には、掃引の対象に応じて、本器のディスプレイのFREQUENCYエリアとAMPLITUDEエリアが機

能しなくなります。 この場合、周波数が掃引されているので、ディスプレイのFREQUENCYエリアには何も表示

されません。

7. Frequency > Freq CW を押します。

現在の連続波周波数設定によって RF 出力が制御されるようになり、ランプ掃引はオフになります。

8. Freq Start を押します。

再びランプ掃引設定が RF 出力を制御するようになり、CW モードはオフになります。 Freq Start、Freq Stop、Freq Center、
Freq Span のどれかのソフトキーを押すと、現在の設定でランプ掃引がオンになります。

注記 周波数ランプ掃引の場合、スタート周波数はストップ周波数よりも小さくなければなりません。

9. Freq Center および Freq Span の設定を調整して、被試験デバイス（DUT）の周波数応答が 8757D のディスプレイにはっ

きり表示されるようにします。

これらの設定を調整すると、Freq Start および Freq Stop ソフトキーの設定も変更されます。 振幅をより正確に評価する

ために、8757D 上の応答のスケールを変更した方がよい場合もあります。42 ページの図 2-3 は、バンドパス・フィル

タの応答の例を示しています。
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図 2-3 8757D上のバンドパス・フィルタの応答

マーカの使用

1. Markers を押します。

テーブル・エディタと対応するマーカ制御ソフトキーがオープンします。 0 ～ 9 というラベルの 10 個までのマーカが

使用できます。

2. Marker Freq を押し、掃引の範囲内の周波数値を選択します。

テーブル・エディタで、マーカ 0 のステートが自動的にオンになります。 マーカは 8757D のディスプレイにも表示さ

れます。

3. 矢印キーを使って、テーブル・エディタのカーソルをマーカ 1 に移動し、掃引の範囲内でマーカ 0 とは別の周波数値

を選択します。

マーカ 1 がオンになり、下向きのマーカ矢印で示される現在選択されているマーカとなります。 矢印キーでマーカを

切り替えると、選択したマーカの矢印が下向きになり、他のマーカの矢印は上向きになります。

また、現在選択されているマーカの周波数および振幅データが 8757D に表示されます。
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4. カーソルをマーカ 0 に戻し、Delta Ref Set > Marker Delta Off On を押して On にします。

テーブル・エディタで、各マーカの周波数値がマーカ 0 を基準とした値になるはずです。右端の列（ラベルは Ref）
に Refが表示されているのが基準となるマーカです。 図 2-4 を参照してください。

図 2-4 マーカ・テーブル・エディタ

5. カーソルをマーカ 1 に戻し、Marker Freq を押します。 8757D 上のマーカ 1 を観察しながらフロントパネルのノブを

回します。

8757D 上で、トレースに沿ってマーカを移動したときに、マーカ 1 の振幅および周波数値がマーカ 0 を基準に表示さ

れることを確認します。 図 2-5 を参照してください。
第2章 43



基本操作
RF出力の設定
図 2-5 8757D上のデルタ・マーカ

6. Turn Off Markers を押します。

アクティブなマーカがすべてオフになります。 他のマーカ・ソフトキーの機能については『E8257D/67D PSG 信号発

生器キー・リファレンス』を参照してください。

掃引時間の調整

1. Sweep/List を押します。

掃引制御ソフトキーのメニューがオープンし、現在の掃引設定の一覧を示すステータス画面が表示されます。

2. Configure Ramp/Step Sweep を押します。

現在の掃引タイプはランプなので、このメニューのソフトキーはランプ掃引の設定を制御します。 掃引タイプとして

ステップが選択されている場合は、ソフトキーはステップ掃引の設定を制御します。 Freq Start および Freq Stop ソフト

キーは、Frequency ハードキー・メニューに加えてこのメニューにも表示されます。

3. Sweep Time を押して Manual にし、5 > sec を押します。

オート・モードでは、掃引時間は可能な最高速の値に自動的に設定されます。 マニュアル・モードでは、最高速まで

の任意の掃引時間を選択できます。 可能な最高速の掃引時間は、8757D で用いられるトレース・ポイントおよびチャ

ネルの数と、周波数スパンに依存します。
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4. Sweep Time を押して Auto にします。

掃引時間が可能な最高速の設定に戻ります。

注記 8757 ネットワーク・アナライザを手動掃引モードで使用している場合、フロントパネルのノブを使って掃引を

制御するには本器のManual Freqソフトキーをオンにする必要があります。 Sweep/List > More (2 of 3) > Manual
Freqを押します。

交互掃引の使用

1. Save ハードキーを押します。

テーブル・エディタと、機器ステートを保存するためのソフトキー・メニューがオープンします。 Select Reg ソフト

キーがアクティブになっています （機器ステートを保存する方法については、「機器ステート・レジスタの使用」（53
ページ）を参照してください）。

2. フロントパネル・ノブを回して使用可能なレジスタを探し、SAVE を押します。 保存したレジスタ番号を覚えておいて

ください。 使用可能なレジスタがない場合は、Re-SAVE を押すことで使用中のレジスタを上書きすることができます。

注記 PSGを8757ネットワーク・アナライザと使用している場合、ステートのセーブ/リコールに使用できるのはシー

ケンス0のレジスタ1～9だけです。

3. Sweep/List > Configure Ramp/Step Sweep を押し、ランプ掃引の新しいスタート / ストップ周波数値を入力します。

4. Alternate Sweep Register を押し、フロントパネル・ノブを回して先に保存した掃引ステートのレジスタ番号を選択しま

す。

5. Alternate Sweep Off On を押して On にします。

保存してある元の掃引と現在の掃引との間で交互掃引が実行されます。 両方の掃引を効果的に観察するために、8757D
の設定を調整したほうがよい場合があります。例えば、チャネル 2 でセンサ A を測定するなどです。図 2-6 を参照し

てください。
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図 2-6 8757D上の交互掃引

振幅掃引の設定

1. Return > Sweep > Off を押します。

これにより、現在の掃引と前の作業で設定した交互掃引の両方がオフになります。 RF 出力は現在の CW 設定で制御さ

れています。

2. Configure Ramp/Step Sweep を押します。

3. Ampl Start および Ampl Stop ソフトキーを使って、掃引する振幅範囲を設定します。

4. Return > Sweep > Ampl を押します。

新しい振幅ランプ掃引設定によって RF 出力が制御され、CW モードはオフになります。

ランプ掃引におけるマスタ/スレーブの設定

この手順では、2 台の PSG と 1 台の 8757D をマスタ / スレーブで動作させる方法を説明します。 マスタ / スレーブ制御

セットアップでは、2 台の PSG、2 台の 83640B、2 台の 83751B など、同じ信号発生器ファミリから 2 台の機器を使用す

る必要があります。 

注記 マスタ/スレーブ・セットアップはランプ掃引でのみ使用できます。ステップ掃引、リスト掃引では使用できま

せん。 このセットアップを使用するには、2台のPSG、2台の83640B、2台の83751Bなど、同じ信号発生器ファ

ミリから2台の信号源を使用する必要があります。
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1. 機器を図 2-7 のように接続します。 48 ページの図 2-8 に示すピン構成の 9 ピン D-sub オス型 RS-232 ケーブルを使っ

て、2 台の PSG の補助インタフェース同士を接続します。 このケーブルはアジレントから購入することもできます

（パーツ番号 8120-8806）。

マスタ PSG の 10 MHz 基準をスレーブ PSG の 10 MHz 基準入力に接続することにより、マスタのタイムベースが 2 台

の PSG の周波数基準の役割を果たします。

2. スレーブ PSG の周波数とパワーを設定します。

スレーブを先に設定するのは、同期の問題を避けるためです。

3. マスタ PSG の周波数、パワー、掃引時間を設定します。

2 台の PSG のランプ掃引の周波数とパワーの設定は異なっていてもかまいません。

4. スレーブ PSG の掃引時間をマスタと同じに設定します。

2 台の PSG の掃引時間は一致する必要があります。

5. スレーブ PSG を連続トリガに設定します。

スレーブは連続トリガに設定する必要がありますが、マスタは任意のトリガ・モードに設定できます。

6. スレーブ PSG で、Sweep/List > Sweep Type > Ramp Sweep Control > Slave を押します。

この PSG はスレーブ・モードで動作するように設定されます。

7. マスタ PSG で、Sweep/List > Sweep Type > Ramp Sweep Control > Master を押します。 この PSG はマスタ・モードで動

作するように設定されます。
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図 2-7 マスタ/スレーブ機器セットアップ

図 2-8 RS-232ピン構成
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周波数レンジの拡大

本器の周波数レンジは、Agilent 83550 シリーズ・ミリ波信号源モジュールまたは他のメーカのミリ波信号源モジュールを

使って拡大できます。 ミリ波信号源モジュールを装備した信号発生器の使用法については、「ミリ波信号源モジュール」

（230 ページ）を参照してください。 

信号の変調

このセクションでは、変調フォーマットをオンにする方法、および RF 出力に適用する方法について説明します。

変調フォーマットをオンにする

変調フォーマットは、信号パラメータを設定する前または後でオンにできます。

1. 変調フォーマットの最初のメニューを表示します。 
このメニューには、フォーマット名にオフとオンを付けたソフトキーが表示されます。 例えば、AM > AM Off On です。

フォーマットによっては、最初のメニュー以外のメニューにもオフ / オン・キーが存在する場合があります。

2. 変調フォーマット・オフ / オン・キーを押して On を強調表示します。

図 2-9 に示すのは、AM 変調フォーマットの最初のメニューの一部です。変調フォーマットのステートとアクティブ

変調フォーマット・インジケータが表示されています。

変調フォーマットを生成しても、RF 出力に適用しない限り搬送波信号は変調されません（50 ページを参照）。

変調フォーマットによっては、信号の生成に数秒間かかる場合があります。 デジタル・フォーマットの場合（オプション

601/602 付きの E8267D PSG のみ）、ディスプレイに BaseBand Reconfiguringステータス・バーが表示されることがあ

ります。 信号が生成されると、フォーマットの名前のインジケータがディスプレイに表示され、変調フォーマットがアク

ティブになったことを示します。 デジタル・フォーマットの場合（オプション 601/602 付きの E8267D PSG のみ）、変調

フォーマット名の他に I/Qインジケータも表示されます。
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図 2-9 AM変調フォーマット・オフおよびオンの例

RF出力への変調フォーマットの適用

搬送波信号が変調されるのは、Mod On/Off キーが On に設定され、かつ個々の変調フォーマットがアクティブである場合

です。 

Mod On/Off キーが Off に設定されている場合、MOD OFFインジケータがディスプレイに表示されます。 インジケータは単

に、どれかの変調フォーマットがオンになれば搬送波信号が変調されることを示しているに過ぎません。

RF出力の変調をオンにする手順

Mod On/Off キーを押して、MOD ONインジケータをディスプレイに表示させます。

アクティブな変調フォーマットすべてによって搬送波信号が変調されます。 これが工場設定状態です。

RF出力の変調をオフにする手順

Mod On/Off キーを押して、MOD OFFインジケータをディスプレイに表示させます。

アクティブな変調フォーマットがある場合でも、搬送波信号は変調されなくなります。

最初のAMメニュー変調

フォーマットはオフ

 

 変調フォーマットはオン

アクティブ変調フォーマット・インジケータ
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図 2-10 搬送波信号の変調ステータス

データ・ストレージ機能の使用

このセクションでは、信号発生器の 2 種類のデータ・ストレージ機能、すなわちメモリ・カタログと機器ステート・レジ

スタの使い方を説明します。

メモリ・カタログの使用

メモリ・カタログは、ファイルの表示、保存、保存のためのインタフェースです。本器のフロントパネルまたはリモート・

コントローラを通じてアクセスできます （これらの作業をリモートで実行する方法については、『E8257D/67D PSG 信号

発生器プログラミング・ガイド』を参照してください）。

Mod が On：搬送波は変調される

AM 変調フォーマットがアクティブ

AM 変調フォーマットがアクティブ

Mod が Off：搬送波は 
変調されない

Mod が Off：搬送波は 
変調されない

アクティブな変調フォーマットなし
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メモリ・カタログへのファイルの保存

メモリ・カタログにファイルを保存するには、まずファイルを作成します。 この例ではデフォルトのリスト掃引テーブル

を使用します。

1. Preset を押します。

2. Sweep/List > Configure List Sweep > More (1 of 2) > Load/Store を押します。

「Catalog of List Files」がオープンします。

3. Store to File を押します。

ファイル名を入力するための英字ソフトキーのメニューが表示されます。 Store to:がアクティブ機能エリアに表示

されます。

4. 英字ソフトキーとテンキー（数字 0 ～ 9 用）を使ってファイル名 LIST1を入力します。

5. Enter を押します。

「Catalog of List Files」にファイルが追加され、ファイル名、ファイル・タイプ、ファイル・サイズ、ファイルが変更

された日付と時間が表示されます。

表2-1 メモリ・カタログのファイル・タイプと対応するデータ

バイナリ バイナリ・データ

ステート 機器ステート・データ（周波数、振幅、モードなどの動作パラメータを

制御）

リスト 周波数、振幅、待ち時間などのリスト・モード・テーブルの掃引データ

ユーザ・フラットネス ユーザ・フラットネス校正補正ペア・データ（ユーザ定義周波数および対応

する振幅補正値）

FIR 有限インパルス応答（FIR）フィルタ係数

ARBカタログ・タイプ （オプション601/602付きのE8267D PSGのみ）ユーザが作成したファイル

波形カタログ・タイプ : WFM1（波形ファイル）、

NVARBカタログ・タイプ :

NVWFM（不揮発性ARB波形ファイル）、

NVMKR（不揮発性ARB波形マーカ・ファイル）、

Seq（ARBシーケンス・ファイル）、

MTONE（ARBマルチトーン・ファイル）、

DMOD（ARBデジタル変調ファイル）、

MDMOD（ARBマルチキャリア・デジタル変調ファイル）

変調カタログ・タイプ （オプション601/602付きのE8267D PSGのみ）I/QおよびFSK（周波数シフ

ト・キーイング）変調ファイルの関連データ

形状 パルスのバースト形状

ビット ビット
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メモリ・カタログに保存されているファイルの表示

1. Utility > Memory Catalog > Catalog Type を押します。

選択したカタログ・タイプに関わらず、メモリ・カタログ中のすべてのファイルがアルファベット順に表示されます。

ファイル情報として、ファイル名、ファイル・タイプ、ファイル・サイズ、ファイルが変更された日付と時間がディ

スプレイに表示されます。

2. List を押します。

「Catalog of List Files」が表示されます。

3. Catalog Type > State を押します。

「Catalog of State Files」が表示されます。

4. Catalog Type > All を押します。

「Catalog of All Files」が表示されます。 ファイル・タイプの一覧は 52 ページの表 2-1 にあります。

機器ステート・レジスタの使用

本器のステート・レジスタは、メモリの一部を 10 個のシーケンス（番号 0 ～ 9）に分割したもので、それぞれに 100 個

のレジスタ（番号 00 ～ 99）が含まれます。 機器ステート・シーケンスおよびレジスタは、機器設定の保存とリコールに

用いられます。異なる機器設定や信号設定を切り替える場合に便利です。 オプション 005（内蔵ハード・ディスク）付き

の信号発生器では、機器ステート・ファイルやその他のユーザ・データの保存に約 4 GB が使用可能です。 オプション 005
のない信号発生器では、データおよび機器ステート・ストレージに 20 MB が使用可能です。 機器ステート・ファイルの長

さは、信号発生器の構成に応じて変わる可能性があります。

変調フォーマット、任意波形設定、テーブル・エントリなどのファイル・データは、セーブ機能によって保存されません。

周波数、減衰、パワー、その他のユーザ定義設定など、電源を入れ直すか機器をリセットすると消えてしまう設定だけを

シーケンスおよびレジスタに保存できます。 任意波形フォーマット・ファイルなど、機器ステートと関連づけられたデー

タ・ファイルだけが、そのファイル名によって参照されます。 機器ステートが保存されると、そのステートをリコールす

れば保存された設定を使って本器がセットアップされ、関連ファイル・データがロードされます。 

変調フォーマット、任意波形設定、テーブル・エントリなどのファイル・データの保存方法については、「メモリ・カタロ

グへのファイルの保存」（52 ページ）を参照してください。 セーブ / リコール機能の詳細については、『E8257D/67D PSG
信号発生器プログラミング・ガイド』および『E7257D/67D PSG 信号発生器キー・リファレンス』を参照してください。 

注記 ファイルへの参照が機器ステートと一緒に保存されます。 ただし、データはセーブ機能によって保存されませ

ん。 storeコマンドを使って別のメモリ位置にファイル・データを保存する必要があります。 

機器ステートの保存

1. 本器を初期設定してから、振幅変調をオンにします（AMインジケータがオンになります）。

a. Frequency > 800 > MHz を押します。

b. Amplitude >  0  > dBm を押します。

c. AM > AM Off On を押します。
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2. Save > Select Seq を押します。

シーケンス番号がアクティブ機能になります。 最後に使用したシーケンスが表示されます。 矢印キーでシーケンスを1
に設定します。

3. Select Reg を押します。

シーケンス 1 のレジスタ番号がアクティブ機能になります。 使用中のレジスタがある場合は、最後に使用したレジス

タと（in use）という文字が表示されます。 使用中のレジスタがない場合は、レジスタ 00 と（available）という文

字が表示されます。 矢印キーでレジスタ 01 を選択します。

4. Save Seq[1] Reg[01] を押します。

機器ステート・レジスタのシーケンス 1、レジスタ 01 に機器ステートが保存されます。

5. Add Comment to Seq[1] Reg[01] を押します。

シーケンス 1、レジスタ 01 にコメントを付けることができます。

6. 英数字ソフトキーまたはノブを使ってコメントを入力し、Enter を押します。

7. Edit Comment In Seq[1] Reg[01] を押します。

シーケンス 1、レジスタ 01 のコメントを変更することができます。 

機器ステートを変更した場合、それを特定のレジスタに保存し直すには、レジスタを強調表示して Re-SAVE Seq[n] Reg[nn]
を押します。

機器ステートのリコール

この手順では、機器ステート・レジスタに保存した機器設定をリコールする方法を説明します。

1. Preset を押します。

2. Recall ハードキーを押します。

Select Seq ソフトキーにシーケンス 1（最後に使用したシーケンス）が表示されます。

3. RECALL Reg を押します。

リコールするシーケンス 1 のレジスタがアクティブ機能になります。 上矢印キーを 1 回押してレジスタ 1 を選択しま

す。保存されている機器ステート設定がリコールされます。

レジスタとシーケンスの削除

この手順では、機器ステート・レジスタに保存されているレジスタとシーケンスの削除方法を説明します。

シーケンス内の特定のレジスタの削除

1. Preset を押します。

2. Recall または Save ハードキーを押します。

Select Seq ソフトキーに最後に使用したシーケンスが表示されます。

3. Select Seq を押して、削除するレジスタを含むシーケンスの番号を入力します。

4. Select Reg を押して、削除するレジスタの番号を入力します。

Delete Seq[n] Reg[nn] に削除するシーケンスとレジスタがロードされます。
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5. Delete Seq[n] Reg[nn] を押します。

選択したレジスタが削除されます。

特定のシーケンスのすべてのレジスタの削除

1. Preset を押します。

2. Recall または Save ハードキーを押します。

Select Seq ソフトキーに最後に使用したシーケンスが表示されます。

3. Select Seq を押して、削除するレジスタを含むシーケンスの番号を入力します。

4. Delete all Regs in Seq[n] を押します。

選択したシーケンスのすべてのレジスタが削除されます。

すべてのシーケンスの削除

注意 機器ステート・レジスタのすべてのレジスタとすべてのシーケンスの内容が削除されます。

1. Preset を押します。

2. Recall または Save ハードキーを押します。

Select Seq ソフトキーに最後に使用したシーケンスが表示されます。

3. Delete All Sequences を押します。

機器ステート・レジスタに保存されたすべてのシーケンスが削除されます。

8757ネットワーク・アナライザのSave/Recall機能

8757 ネットワーク・アナライザ・ファミリでは、機器間の通信は制限されているものの信号発生器の機器ステートの保存

とリコールを行うことができます。 

8757 から clear register コマンドを送信すると、本器はレジスタの内容をデフォルト値に置き換えます。 Delete All ソフト

キー・メニューを使うか、対応する SCPI（Standard Commands for Programmable Instruments）コマンドを使って、デ

フォルト値を本器からクリアできます。

本器は、8757 ネットワーク・アナライザと直に通信を行いません。 8757 が機器ステートを信号発生器レジスタに保存し、

ユーザがこのレジスタを削除した場合、8757 は削除を認識しません。 8757 が削除されたステートをリコールしようとす

ると、PSG がエラー・メッセージ＋ 700 State Save Recall Error... を表示します。

セキュリティ機能の使用

このセクションでは、PSG のセキュリティ機能を使って機器に保存または表示される情報の保護や機密解除を行う方法に

ついて説明します。 このセクションで説明するすべてのセキュリティ機能には、リモート操作用の同等 SCPI コマンドも存

在します （詳細については、『E8257D/67D PSG Signal Generators SCPI Command Reference』の「System Commands」
の章を参照してください）。
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PSGのメモリ・タイプの理解

PSG は、複数のメモリ・タイプから構成されます。それぞれ特定タイプのデータの保存に使用されます。 機密データを削

除する前に、各メモリ・タイプが PSG でどのように使用されているかを理解することが重要です。 以下の表で、基本機器、

オプションのベースバンド・ジェネレータ、オプションのハード・ディスクで使用される各メモリ・タイプについて説明

します。

表2-2 基本機器メモリ

メモリ・タイ
プとサイズ

通
常

動
作

中
に

書
き

込
み

可
能

?

電
源

オ
フ

時
に

デ
ー

タ
を

保
持

?

目的/内容 データ入力方法 PSG内での場所と説明

メイン・
メモリ
（SDRAM）

64 MB

はい いいえ ファームウェア動作メ
モリ

オペレーティング・シ
ステム（ユーザではな
い）

CPUボード

メイン・
メモリ
（Flash）

20 MB

はい はい 工場校正/設定データ

ユーザ・ファイル・シ
ステム。フラットネス
校正、IQ校正、機器ス

テート、波形（ヘッダ
およびマーカ・データ
を含む）、変調定義、掃
引リストが含まれます。

ファームウェア・アッ
プグレードおよびユー
ザ保存データ

CPUボード（ファームウェア・メモリと同じ

チップ、管理は別）

ハード・ディスク（オプション005）がインス

トールされている場合、ユーザ・データはこのメ
モリに保存されません。

この32 MBメモリ・チップには20 MBのユーザ・

データ（ここで説明）と12 MBのファームウェ

ア・メモリが含まれるため、フル・チップ消去は
お奨めしません。 Erase and Sanitize機能を実行する

と、ユーザ・データ・エリアが選択的に完全に削
除されます。

ファーム
ウェア・
メモリ
（Flash）

12 MB

いいえ はい メイン・ファームウェ
ア・イメージ

工場インストールまた
はファームウェア・
アップグレード

CPUボード（メイン・フラッシュ・メモリと同

じチップ、管理は別）

通常動作中、このメモリを上書きすることはでき
ません。 ファームウェア・インストールまたは

アップグレード処理中にのみ上書きされます。

この32 MBメモリ・チップには20 MBのユーザ・

データと12 MBのファームウェア・メモリ（こ

こで説明）が含まれるため、フル・チップ消去は
お奨めしません。 Erase and Sanitize機能を実行する

と、ユーザ・データ・エリアが選択的に完全に削
除されます。

バッテリ・
バック
アップ・
メモリ
（SRAM）

512 KB

はい はい ユーザ編集可能データ
（テーブル・エディタ）

最後の機器ステートお
よび最後の機器ステー
ト・バックアップ

ユーザ保存機器ステー
ト

ファームウェア動作 CPUボード

メモリをクリアするためバッテリを除去できます
が、機器を動かすにはバッテリを再インストール
する必要があります。
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ブートロム・
メモリ

（Flash）

128 KB

いいえ はい CPUブートアップ・プ

ログラムおよびファー
ムウェア・ローダ/
アップデータ

工場プログラム済み CPUボード

通常動作中、このメモリを上書きまたは消去する
ことはできません。 この読み取り専用データは工

場でプログラムされます。

校正バック
アップ・
メモリ

（Flash）

512 KB

いいえ はい 工場校正/設定データ・

バックアップ

ユーザ・データなし

工場またはサービスの
み

マザーボード

ボード・
メモリ

（Flash）

512バイト

いいえ はい 工場校正および情報
ファイル、コード・イ
メージ、セルフテス
ト・リミット

ユーザ・データなし

工場またはサービスの
み

すべてのRFボード、ベースバンド・ジェネレー

タ、マザーボード

マイクロ
プロセッサ・
キャッシュ

（SRAM）

3 KB

はい いいえ CPUデータおよび命令

キャッシュ

メモリはユーザではな
くCPUが管理

CPUボード

表2-3 ベースバンド・ジェネレータ・メモリ（オプション601および602）

メモリ・タイ
プとサイズ

通
常

動
作

中
に

書
き

込
み

可
能

?

電
源

オ
フ

時
に

デ
ー

タ
を

保
持

?

目的/内容 データ入力方法 説明

波形メモリ
（SDRAM）

40～320 MB

はい いいえ 波形（ヘッダおよび
マーカ・データを含む）
とPRAM

通常ユーザ操作 Erase and Sanitize機能を実行すると、ユーザ・デー
タが完全に削除されます。

BBGファーム

ウェア・
メモリ

（Flash）

32 MB

いいえ はい ベースバンド・ジェネ
レータのファームウェ
ア・イメージ

ファームウェア・アッ
プグレード

コプロ
セッサ・
メモリ

（SRAM）

32 MB

はい いいえ ベースバンド・コプロ
セッサCPUの動作メモ

リ

通常動作中、ペイロー
ド・データなどの一部
のユーザ情報をメモリ
に保持できます。

このメモリは、ベースバンド・ジェネレータの通
常動作中に用いられます。 ユーザが直接アクセス

することはできません。

表2-2 基本機器メモリ

メモリ・タイ
プとサイズ

通
常

動
作

中
に

書
き

込
み

可
能

?

電
源

オ
フ

時
に

デ
ー

タ
を

保
持

?

目的/内容 データ入力方法 PSG内での場所と説明
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PSGメモリからの機密データの除去

PSG を安全な開発環境から移動するときに、機器に保存された機密扱いの独占情報を除去することができます。 このセク

ションでは、機器から機密データを除去するために使用できる複数のセキュリティ機能について説明します。

Erase All

この機能は、すべてのユーザ・ファイル、ユーザ・フラットネス校正、ユーザ I/Q 校正を除去し、すべてのテーブル・エ

ディタを元の工場値によってリセットします。これにより、ユーザ・データと設定をアクセス不能または表示不能にする

ことができます。 機器は元の工場ステートにあるかのように見えますが、メモリはサニタイズされていません。 この動作

は比較的高速で、所要時間は 1 分未満です。

この機能を実行するには、Utility > Memory Catalog > More (1 of 2) > Security > Erase All > Confirm Erase を押します。

バッファ・
メモリ
（SRAM）

5×512 KB

いいえ いいえ ARBおよびリアルタイ

ム・アプリケーション
のサポート・バッファ・
メモリ

通常ユーザ操作 このメモリは、ベースバンド・ジェネレータの通
常動作中に用いられます。 ユーザが直接アクセス

することはできません。

表2-4 ハード・ディスク・メモリ（オプション005）

メモリ・タイ
プとサイズ

通
常

動
作

中
に

書
き

込
み

可
能

?

電
源

オ
フ

時
に

デ
ー

タ
を

保
持

?

目的/内容 データ入力方法 説明

メディア・
ストレージ
（内蔵ハード・
ディスク）

6 GBまたは
10 GB
（どちらの
ケースも4 GB
が使用可能）

はい はい ユーザ・ファイル。フ
ラットネス校正、IQ校

正、機器ステート、波
形（ヘッダおよびマー
カ・データを含む）、変
調定義、掃引リストな
ど

ユーザ保存データ 磁気が残留するため、数回のリライト・サイクル
またはドライブの除去と破壊が必要となります。

ハード・ディスクはオプションであるため、ハー
ド・ディスクがインストールされていない機器が
あります。 インストールされている場合、これら

のファイルはフラッシュ・メモリではなくハー
ド・ディスクに保存されます。

Erase and Sanitize機能を実行すると、ユーザ・デー
タが完全に削除されます。

バッファ・メ
モリ
（DRAM）

512 KB

いいえ いいえ バッファ（キャッシュ）
メモリ

ハード・ディスクを介
した通常動作

表2-3 ベースバンド・ジェネレータ・メモリ（オプション601および602）

メモリ・タイ
プとサイズ

通
常

動
作

中
に

書
き

込
み

可
能

?

電
源

オ
フ

時
に

デ
ー

タ
を

保
持

?

目的/内容 データ入力方法 説明
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注記 この機能は、Utility > Memory Catalog > More (1 of 2) > Delete All Filesを押した場合と異なり、すべてのユーザ・

ファイルを削除しますが、テーブル・エディタをリセットしません。

Erase and Overwrite All

この機能は Erase All と同じ動作を実行してから、以下に説明するように DoD（Department of Defense）規格に従って各

種メモリ・タイプをクリアし、上書きします。

SRAM：すべてのアドレス可能位置がランダムな文字によって上書きされます。

CPU Flash：すべてのアドレス可能位置がランダムな文字によって上書きされてから、フラッシュ・ブロックが消去

されます。 これはチップ消去と同じ目的を果たしますが、使用されなくなったエリアだけが消去され、工場校正ファ

イルはそのまま残ります。

DRAM：すべてのアドレス可能位置がランダムな文字によって上書きされます。

ハード・ディスク：すべてのアドレス可能位置が 1 つの文字によって上書きされます （DoD 規格に従えば、最高機密

データには不十分です。 最高機密データの場合、ハード・ディスクを除去し、破壊する必要があります）。

この機能を実行するには、Utility > Memory Catalog > More (1 of 2) > Security > Erase and Overwrite All > Confirm Overwrite を押

します。

Erase and Sanitize All

この機能は、Erase and Overwrite All と同じ動作を実行してから、さらに上書き動作を追加します。 この機能の実行後、DoD
（Department of Defense）規格に準拠するためサニタイズ用の追加ステップを手動で実行する必要があります。 これらの

動作とステップを以下に説明します。

SRAM：この機能を適用後、機器を十分長いあいだ安全なエリアに置いて、機密データがメモリに存在した期間より

も長い期間、メモリのランダム上書きが行われるようにします。 別の方法として、SRAM バッテリを除去してから手

動で再インストールすることもできます。ただし、これには機器を開ける必要があります。

DRAM：すべてのアドレス可能位置が 1 つの文字によって上書きされます。 次に機器の電源をオフにして、メモリの

内容を削除する必要があります。

ハード・ディスク：すべてのアドレス可能位置が 1 つの文字、次にランダムな文字によって上書きされます （DoD 規

格に従えば、最高機密データには不十分です。 最高機密データの場合、ハード・ディスクを除去し、破壊する必要が

あります）。

この機能を実行するには、Utility > Memory Catalog > More (1 of 2) > Security > Erase and Sanitize All > Confirm Sanitize を押し

ます。

セキュア・モードの使用

セキュア・モードは、次に機器の電源を入れ直したときに選択された Security Level 動作を自動的に適用します。

セキュア・モードのレベルを設定するには、Utility > Memory Catalog > More (1 of 2) > Security > Security Level を押し、以下

の選択肢から選択します。

None：工場初期設定と同じです。ユーザ情報は失われません。

Erase： Erase All と同じです。

Overwrite： Erase and Overwrite All と同じです。

Sanitize：Erase and Sanitize All と同じです。
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セキュア・モードをアクティブにするには、Utility > Memory Catalog > More (1 of 2) > Security > Enter Secure Mode > Confirm
を押します。 Enter Secure Mode ソフトキーが Secure Mode Activated に変わります。

注意 セキュリティ・レベル動作を選択し、Confirmを押してセキュア・モードをアクティブにすると、セキュリ

ティ・レベルを非アクティブにすることも、セキュリティ・レベルを下げることもできなくなります。 こ
のセキュリティ・レベルに対する消去動作は、次に電源を入れ直すときに実行されます。 セキュア・モー

ドがアクティブのときだけセキュリティ・レベルを増加できます。 例えば、EraseをOverwriteに変更できま

すが、逆の変更はできません。

注記 電源を入れ直すと、セキュリティ・レベル選択は同じですが、セキュア・モードがアクティブになりません。

機器が機能していない場合

機器が機能しておらず、セキュリティ機能を使用できない場合、ストレージ・メディアを機器から物理的に除去する必要

があります。 これには、ハード・ディスクとプロセッサ・ボードの除去が必要となります。次にこれらを使用不能にして、

破棄します。 機器は、部品交換、修理、校正のため修理施設に送ることができます。 分解手順については、『E8257D/67D
PSG 信号発生器サービス・ガイド』を参照してください。

セキュア・ディスプレイの使用

この機能は、権限のないユーザが機器のディスプレイを見たり、現在の設定をフロントパネルから無断で書き換えること

を防ぎます。 ディスプレイが、メッセージ *** SECURE DISPLAY ACTIVATED ***を除いてブランクになり、フロントパ

ネルのキーが無効になります。 この機能をアクティブにした場合、ディスプレイとフロントパネルのキーを再度有効にす

るには、電源を入れ直す必要があります。

この機能を適用するには、Utility > Display > More (1 of 2) > Activate Secure Display > Confirm Secure Display を押します。
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図 2-11 セキュア・ディスプレイをアクティブにしたときのPSG画面

オプションの有効化

本器を購入した後に新しい機能を追加することができます。 一部の新しいオプション機能はハードウェアで実現されてお

り、インストールが必要です。 一部のオプションはソフトウェアで実現されていますが、オプションのハードウェアが存

在する必要があります。 この例では、ソフトウェア・オプションを有効化する方法を説明します。

ソフトウェア・オプションの有効化

各ソフトウェア・オプションを有効化するには、ライセンス・キー（ライセンス・キー証書に記載）が必要です。 

1. Software Options メニューにアクセスします。

Utility > Instrument Adjustments > Instrument Options > Software Options. 
以下に信号発生器の表示の例を示します。表示には、有効になっているソフトウェア・オプション、有効にすること

ができるソフトウェア・オプションがリストされています。
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2. ディスプレイに表示されるホスト ID がライセンス・キー証書のホスト ID と一致することを確認します。 ホスト ID は

各機器に固有の番号です。 ライセンス・キー証書に記載されたホスト ID が機器のものと一致しない場合、ライセン

ス・キーでソフトウェア・オプションを有効化することはできません。

3. 必要なハードウェアがインストールされていることを確認します。 一部のソフトウェア・オプションは特定のハード

ウェア・オプションとリンクされているため、適切なハードウェア・オプションをインストールしないと、ソフトウェ

ア・オプションを有効化することができません。 例えば、オプション 420（レーダ・シミュレーション変調フォーマッ

ト）には、オプション 601/602（内蔵ベースバンド・ジェネレータ）が必要です。 インストールしようとしているソ

フトウェア・オプションがグレーの文字で表示されている場合、必要なハードウェアがインストールされていない可

能性があります（Hardware Options メニューで該当するハードウェア・オプションの "Selected" 列に X があるかど

うか確認してください）。

4. ソフトウェア・オプションを有効にします。

a. 目的のオプションを強調表示します。

b. Modify License Key を押し、（ライセンス・キー証書に記された）12 文字のライセンス・キーを入力します。

c. 信号発生器を新しいオプションで再構成することを確認します。
Proceed With Reconfiguration > Confirm Change

オプションが有効になり、機器がリブートされます。

Webサーバの使用

Web サーバを使って信号発生器と通信することができます。 このサービスは、TCP/IP（Transmission Control
Protocol/Internet Protocol）を使って信号発生器とインターネット経由で通信を行います。 

Web サーバは、クライアント / サーバ・モデルを使います。ここではクライアントは PC またはワークステーション上の

ウェブ・ブラウザで、サーバは信号発生器です。 Web サーバを有効化すると、信号発生器に存在するウェブページにアク

セスできます。 
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図 2-12 に示す Web イネーブル PSG ウェブページで、本器に関する一般的な情報と、リモート・フロントパネル・インタ

フェースまたは SCPI（Standard Communication for Programmable Instruments）コマンドによる機器制御手段が得られ

ます。 ウェブページには、Agilent の製品、サポート、マニュアル、ウェブサイトへのリンクもあります。 

注記 Webサーバ・サービスは、最新バージョンのMicrosoft© Internet Explorerウェブ・ブラウザと互換性がありま

す。1

Web イネーブル PSG ウェブページの Signal Generator Web Control メニュー・ボタンで 2 番目のウェブページにアクセ

スします。 図 2-13 に示すこのウェブページには、信号発生器の制御に使用できる仮想機器インタフェースがあります。 マ
ウスを使って、信号発生器のフロントパネルのハードキー、ソフトキー、テンキーをクリックできます。 機器への SCPI コ
マンドの送信に使用できるテキスト・ボックスもあります。 

Webサーバのアクティブ化

以下のステップを実行して Web サーバにアクセスします。 

1. Utility > GPIB/RS-232 LAN > LAN Services Setup > Web Server On を押して、Web サーバをオンにします。

2. Proceed With Reconfiguration ソフトキーを押します。

3. Confirm Change（Instrument will Reboot）ソフトキーを押します。 信号発生器がリブートします。 

4. PC またはワークステーションのウェブ・ブラウザを起動します。 

5. ウェブ・ブラウザのアドレス・フィールドに信号発生器の IP アドレスを入力します。 例えば、信号発生器の IP アド

レスが 101.101.101.101 の場合に、http://101.101.101.101 と入力します。 コンピュータのキーボードの Enter キーを

押します。

注記 IP（Internet Protocol）アドレスは、LAN構成に応じて変化します。 
LAN Config Manual DHCPソフトキーを使用して、ManualまたはDHCP（dynamic host communication protocol）
LAN構成を選択します。 詳細については、『E8257D/67D PSG信号発生器キー・リファレンス』を参照してくだ

さい。

6. コンピュータのキーボードの Enter キーを押します。 ウェブ・ブラウザに、以下の図 2-12 に示すような信号発生器の

ホームページが表示されます。 ウェブページには、信号発生器に関する情報が表示されます。Agilent のウェブサイト

へのアクセスもあります。 

1. Microsoftは、Microsoft Corp.の登録商標です。
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図 2-12 信号発生器ウェブページ
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7. ページの左にある Signal Generator Web Control メニュー・ボタンをクリックします。 以下の図 2-13 に示すような新

しいウェブページが表示されます。 

図 2-13 ウェブページのフロントパネル 

このウェブページから信号発生器のすべての機能や操作にリモートアクセスできます。 マウス・ポインタを使って信号発

生器のハードキーとソフトキーをクリックします。 各マウス・クリック選択の結果がウェブページに表示されます。 例え

ば、Frequency ハードキーをクリックし、フロントパネルのテンキーを使って周波数を入力します。 上下矢印キーを使っ

て周波数を増減することもできます。 

フロントパネル表示の一番下にある SCPI Command テキスト・ボックスを使ってコマンドを信号発生器に送信すること

もできます。 有効な SCPI コマンドを入力してから、SEND ボタンをクリックします。 コマンドの結果が SCPI Command
Processedというタイトルの別のウェブページに表示されます。 このウェブページを使ってさらに SCPIコマンドを入力す

るか、フロントパネル・ウェブ・ページに戻ります。 

注記 ウェブページが新しい設定で更新されない場合は、ウェブ・ブラウザの更新機能を使用します。
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3 基本デジタル操作

この章では、オプション 601 または 602 付きの E8267D PSG ベクトル信号発生器で使用可能な機能について説明します。

• 「カスタム変調」（67ページ）

• 「任意（ARB）波形ファイルのヘッダ」（68ページ）

• 「デュアル任意波形プレーヤの使用」（79ページ）

• 「波形マーカの使用」（84ページ）

• 「波形のトリガ」（98ページ）

• 「波形クリッピングの使用」（104ページ）

• 「波形スケーリングの使用」（112ページ）

以下も参照してください。 

• 「カスタム任意波形発生器」（137ページ）

• 「マルチトーン波形発生器」（179ページ）

• 「2トーン波形発生器」（189ページ）

カスタム変調 

カスタム変調を作成する場合、信号発生器で任意波形発生器モードとリアルタイム I/Q ベースバンド・モードの 2 つの動

作モードを使用できます。任意波形発生器モードには、NADC または GSM などの内蔵変調フォーマット、信号の作成に

使用できる BPSK、16QAM などの定義済み変調タイプがあります。リアルタイム I/Q ベースバンド・モードは、内蔵 PN
シーケンスやカスタム・ユーザ・ファイルを各種変調タイプおよびガウシアン、ナイキストなどの異なる内蔵フィルタと

共に使って、カスタム・データ・フォーマットを作成するために使用できます。 

両方の動作モードを使って、既存のデジタル・フォーマットの変更、デジタル変調信号の定義または作成、信号雑音の追

加など、柔軟に通信規格をシミュレートする複素デジタル変調信号を生成できます。
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カスタム任意波形発生器

信号発生器の任意波形発生器モードは、チャネル外テスト・アプリケーション用に設計されています。このモードを使用

して、ランダム通信トラフィックをシミュレートするデータを生成できます。またこのモードは、コンポーネント・テス

ト用のスティミュラスとしても使用できます。さらに任意波形発生器モードには、以下の機能もあります。

単一またはマルチキャリア信号の設定。最大 100 の搬送波を設定できます。 

信号発生器のフロントパネル・インタフェースを使った波形ファイルの作成 

ランダム・データとして作成された波形ファイルを、隣接チャネル漏洩電力（ACP）などのコンポーネント・テスト用の

スティミュラスとして使用できます。任意波形発生器をオンにしたときに自動的に作成される AUTOGEN_WAVEFORM
ファイルの名前を変更し、信号発生器の不揮発性メモリに保存できます。このファイルは、後から揮発性メモリにロード

し、デュアル任意波形プレーヤを使って再生できます。 

詳細については、「デュアル任意波形プレーヤの使用」（79 ページ）と「動作モード」（5 ページ）を参照してください。

カスタム・リアルタイム I/Qベースバンド

リアルタイム・モードでは、ユーザ定義変調タイプとカスタム FIR フィルタ、シンボル・レートを使って単一チャネルの

通信をシミュレートできます。データは、外部信号源から PRAM メモリにダウンロードするか、外部入力を使ってリアル

タイム・データとして入力します。リアルタイム I/Q ベースバンド・モードでは、PN9、FIX4 などの定義済みデータ・

フォーマットも生成できます。このモードで生成される連続データ・ストリームをレシーバ・ビット・エラー解析に使用

できます。このモードは、単一搬送波に制限されます。リアルタイム I/Q ベースバンド・モードには以下の特長があります。

任意波形発生器モードよりも多くのデータおよび変調タイプを使用できます。 

カスタム I/Q コンスタレーション・フォーマットをサポートしています。

ビット・エラー・レート・テスト（BERT）用の連続 PN シーケンスを生成できます。 

信号パラメータを変更したときに波形生成時間が不要です。 

詳細については、カスタム任意波形セクション「概要」（137 ページ）、カスタム・リアルタイム・セクション「概要」（159
ページ）、「デジタル変調」（6 ページ）のセクションを参照してください。 

任意（ARB）波形ファイルのヘッダ

ARB 波形ファイルのヘッダには、機器設定情報（重要なフォーマット設定）も波形と一緒に保存されます。保存された波

形を呼び出すとヘッダ情報をもとに設定が行われ、波形の再生が始まったときにデュアル任意波形プレーヤが毎回同じよ

うに設定されます。

ヘッダには、32 文字までの説明を追加することもできます。

デフォルト・ヘッダは、波形を生成したとき、波形シーケンスを作成したとき、波形ファイルを PSG にダウンロードした

ときに自動的に作成されます（ファイルのダウンロードの詳細については、『E8257D/67D PSG 信号発生器プログラミン

グ・ガイド』を参照してください）。

以下の信号発生器の設定がファイル・ヘッダに保存されます。

• ARBサンプル・クロック周波数

• ランタイム・スケーリング（デュアル任意波形プレーヤでのみ）
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マーカ設定およびルーティング機能（84 ページ）

— 極性

— ALC ホールド

— RF ブランキング

• ハイ・クレスト・モード（デュアル任意波形プレーヤでのみ）

• 変調器減衰

• 変調器フィルタ

• I/Q出力フィルタ（信号をリアパネル I/Q出力にルーティングするときに使用）

• ユーザが設定できないその他の機器最適化設定（PSGによって生成されたファイル用）

変調波形のファイル・ヘッダの作成

変調フォーマットをオンにすると、PSG がデフォルト・ファイル・ヘッダを使ってテンポラリ波形ファイル

（AUTOGEN_WAVEFORM）を生成します。デフォルト・ヘッダには、信号発生器の設定は保存されていません。 

この手順（すべての ARB フォーマットに共通です）では、カスタム・デジタル変調フォーマット用のファイル・ヘッダ

を作成する方法を示します。

1. 本器を初期設定します。

2. カスタム変調フォーマットをオンにします。

Mode > Custom > ARB Waveform Generator > Digital Modulation Off On を押して On にします。

デフォルト・ファイル・ヘッダが作成され、テンポラリ波形ファイル（AUTOGEN_WAVEFORM）が再生されます。図

3-1 に、PSG の表示を示します。

図 3-1 カスタム・デジタル変調の第1レベルのソフトキー・メニュー

この時点では、信号発生器の設定とは異なるデフォルト設定（未定義）でファイル・ヘッダが作成されています。ア

クティブ変調の設定を保存するには、デフォルト設定を変更する必要があります（「変調フォーマットでのヘッダ情報

の変更」（70 ページ）を参照）。

第1レベルのソフトキー・
メニュー

（一部のARBフォーマット
には2ページ目があります）
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注記 ARB変調フォーマットをオンにするたびに、新しいテンポラリ波形ファイル（AUTOGEN_WAVEFORM）とファ

イル・ヘッダが生成され、前のテンポラリ・ファイルとファイル・ヘッダに上書きされます。すべてのARB
フォーマットが同じファイル名を使用するので、前のAUTOGEN_WAVEFORMファイルが別のARB変調フォー

マットによって作成された場合でも、同じことが起こります。

変調フォーマットでのヘッダ情報の変更

この手順は、前の手順から続いています。ファイル・ヘッダの別のエリアについて説明します。ヘッダ情報へアクセスし、

変更して保存する方法を説明します。

変調フォーマットでは、その変調フォーマットがアクティブ（オン）の間だけファイル・ヘッダにアクセスできます。こ

の手順では、カスタム・デジタル変調フォーマットを使用します。ARB 変調フォーマットとデュアル任意波形プレーヤが

ファイル・ヘッダにアクセスする方法は、どれも同じです。ただし、第 1 レベル・ソフトキー・メニューの 2 ページ目に

移動しなければならない変調フォーマットもあります。

1. 第 1 レベル・ソフトキー・メニュー（69 ページの図 3-1 を参照）から、Header Utilities メニューをオープンします。

ARB Setup > Header Utilities を押します。

図 3-2 に、カスタム・デジタル変調波形のデフォルト・ヘッダを示します。Saved Header Settings列は、アクティ

ブ・フォーマットの信号発生器設定が Unspecified であることを示しています。すなわち、ファイル・ヘッダには

設定が保存されていません。

注記 ファイル・ヘッダに設定が指定されていない場合、今後波形を選択して再生したときにその設定に対する信号発

生器の現在の値が変化しません。

Current Inst. Settings 列は、アクティブ変調に対する現在の信号発生器設定を示します。これらの設定は、（ス

テップ 2 に示すように）ファイル・ヘッダに保存されたときに保存済みヘッダ設定になります。 
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図 3-2 カスタム・デジタル変調のデフォルト・ヘッダ表示

2. Current Inst. Settings列の情報をファイル・ヘッダに保存します。

Save Setup To Header を押します。

Saved Header Settings 列と Current Inst. Settings 列の両方に同じ設定が表示されます。Saved Header
Settings列には、ファイル・ヘッダに保存された設定が表示されます。

ファイル・ヘッダには以下の信号発生器設定があります。

32文字の
Description:

波形の機能など、ヘッダに対して入力された説明（Edit Descriptionキーを使って保存/編集します。71ペー

ジの図3-2を参照してください）。

Sample Rate: ARBサンプル・クロック周波数。

Runtime Scaling: ランタイム・スケーリング値。ランタイム・スケーリングは、波形の再生中にリアルタイムで適用され
ます。この設定は、デュアル任意波形プレーヤ内のファイルに対してのみ変更できます。

Marker 1...4 Polarity: 正または負のマーカ極性（98ページで説明）。 

ALC Hold Routing: PSGのALCホールド・マーカ(存在する場合)を指定（86ページで説明）。 

RF Blank Routing: PSGのRFブランキング・マーカ(存在する場合)を指定（96ページで説明）。

I/Q Mod Filter: I/Q変調器フィルタ設定。変調器フィルタは、RF搬送波に変調を加える I/Q信号に影響を与えます。

I/Q Output Filter: I/Q出力フィルタ設定。I/Q出力フィルタは、リアパネルのIおよびQ出力にルーティングされるI/Q信号

に使用されます。

Mod Attenuation: I/Q変調器減衰設定。

 

Descriptionフィールドへの入力
とフィールドの編集が行えます

Saved Header Settings列をクリア
してデフォルト設定にします

Current Inst. Settings列をSaved 
Header Settings列に保存します

現在の信号発生器設定

ページ1

デフォルト・ヘッダ設定

注記 :
非アクティブなパラメータ（ランタイ
ム・スケーリングなど）は、デュアル
任意波形プレーヤでのみ設定できま
す。

ページ2
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3. ARB Setup メニューに戻ります。Return を押します。

ARB Setup メニュー（図 3-3 を参照）で、現在の機器設定を変更できます。図 3-3 に、ステップ 4 ～ 9 で使用される

ソフトキー・パスも示します。

4. ARB サンプル・クロック周波数を 5 MHz に設定します。ARB Sample Clock > 5 > MHz を押します。

5. 変調器減衰を 15 dB に設定します。

More (1 of 2) > Modulator Atten n.nn dB Manual Auto を Manual に設定し、 15 > dB を押します。

6. I/Q 変調フィルタをスルーに設定します。

I/Q Mod Filter Manual Auto を Manual に設定し、 Through を押します。

7. 設定マーカ・ポイントでの RF 出力をブランクにするようにマーカ 1 を設定します。

More (2 of 2) > Marker Utilities > Marker Routing > Pulse/RF Blank > Marker 1 を押します。

マーカの設定方法については、「波形マーカの使用」（84 ページ）を参照してください。

8. マーカ 1 の極性を負に設定します。 
Return > Marker Polarity > Marker 1 Polarity Neg Pos を押して Neg にします。

9. Header Utilities メニューに戻ります。Return > Return > Header Utilities を押します。

Current Inst. Settings列には、ステップ 4～ 8で現在の信号発生器設定に対して行った変更が反映されています。

しかし、（74 ページの図 3-4 に示すように）保存済みヘッダ値は変化しません。

10. 現在の設定をファイル・ヘッダに保存します。Save Setup To Header ソフトキーを押します。

Current Inst. Settings列からの設定が Saved Header Settings列に表示されています。ファイル・ヘッダが変

更され、現在の機器設定が保存されています。これを 74 ページの図 3-4 に示します。

変調フォーマットがアクティブ（オン）の間、波形ファイル（AUTOGEN_WAVEFORM）の再生とヘッダ情報の変更がで

きます。変調フォーマットをオフにすると、ヘッダ情報は、デュアル任意波形プレーヤを通してのみ使用可能になります。 

注記 変調フォーマットをオフにしてからオンにした場合、前の AUTOGEN_WAVEFORM ファイルとそのファイル・

ヘッダが上書きされます。これを避けるには、変調フォーマットをオンに戻す前にファイルの名前を変更します

（84ページを参照）。

波形ファイルを保存する（83 ページを参照）と、保存済みヘッダ情報が波形と一緒に保存されます。 
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図 3-3 ARB設定ソフトキー・メニューおよびマーカ・ユーティリティ

デュアル任意波形プレーヤのソフトキー
（ARBフォーマットでは表示されません）
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図 3-4 ヘッダ設定列と現在の設定列の値の違い

図 3-5 ファイル・ヘッダを保存した場合

値が
2つの列で異なる

ページ1

ページ2

値が
2つの列で異なる

ページ1

ページ2
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デュアル任意波形プレーヤの波形シーケンスのヘッダ情報の保存

波形シーケンスを作成したとき（81 ページで説明）、PSG がデフォルト・ファイル・ヘッダを自動的に作成します。この

ヘッダが、波形シーケンスを構成する波形セグメントのヘッダよりも優先されます。波形シーケンスの再生中、波形セグ

メントのヘッダは無視されます（必要なオプションがすべてインストールされていることを確認する場合は除きます）。波

形シーケンスを保存するとき、ファイル・ヘッダも同時に保存されます。

デュアル任意波形プレーヤでのヘッダ情報の変更と表示

変調フォーマットをオフにすると、波形ファイルはデュアル任意波形プレーヤでのみ使用可能になります。これは、ダウ

ンロードされた波形ファイルにもあてはまります。このため、以降の波形のヘッダ情報の編集は、デュアル任意波形プレー

ヤを使って行う必要があります。

デュアル任意波形プレーヤでヘッダ情報を変更するには、デュアル任意波形プレーヤで波形ファイルを再生する必要があ

ります（デュアル任意波形プレーヤでヘッダ情報を表示する場合には、ファイルの再生は不要です）。

保存されているヘッダ情報を再設定するには、再生用の波形ファイルを再度選択します。これを実行すると、Saved
HeaderSettings 列からの値が PSG に設定されます。

ヘッダ情報の変更

「変調フォーマットでのヘッダ情報の変更」（70 ページ）のヘッダ特性がすべて、デュアル任意波形プレーヤで有効です。

この作業では、波形ファイルを選択し、選択したファイルのヘッダにアクセスします。次に前述の手順に戻って変更を実

行します。

1. 波形を選択します。

a. Mode > Dual ARB > Select Waveform を押します。

b. 矢印キーを使って、目的の波形ファイルを強調表示します。

c. Select Waveform ソフトキーを押します。

2. 波形を再生します。ARB Off On を押して On にします。

3. ヘッダにアクセスします。ARB Setup > Header Utilities を押します。

4. ヘッダ情報を編集するには、「変調フォーマットでのヘッダ情報の変更」を参照してください。

• デフォルト・ヘッダの場合、70ページのステップ1の情報を読み、手順の残りのステップを実行します。

• 既存のファイル・ヘッダを変更するには、72ページのステップ3から開始します。

このセクションの残りの部分では、デュアル任意波形プレーヤにおけるその他のファイル・ヘッダの操作について説明し

ます。
第3章 75



基本デジタル操作
任意（ARB）波形ファイルのヘッダ
デュアル任意波形プレーヤをオフにした場合のヘッダ情報の表示

変調フォーマットとデュアル任意波形プレーヤとの違いの 1 つとして、デュアル任意波形プレーヤがオフのときでもファ

イル・ヘッダを表示できます。ただし、デュアル任意波形プレーヤがオンで、かつ表示されたヘッダが再生用として選択

されていない限り、表示されたファイル・ヘッダを編集することはできません。デュアル任意波形プレーヤをオフにした

状態で、以下のステップを実行します。

1. 波形を選択します。

a. Mode > Dual ARB > Select Waveform を押します。

b. 目的の波形ファイルを強調表示します。

c. Select Waveform ソフトキーを押します。

2. ファイル・ヘッダにアクセスします。ARB Setup > Header Utilities を押します。

ヘッダ情報が PSG ディスプレイに表示されます。図 3-6 に示すように、ヘッダ編集ソフトキーが淡色表示になります。

すなわちソフトキーは操作できません。

図 3-6 ヘッダ情報の表示

ヘッダ編集ソフトキーが

淡色表示

ファイル・ヘッダ情報と現在

の信号発生器設定

ページ1

ページ2

注記 :デュアル任意波形プレー

ヤをオフにすると、現在の機器
設定列が更新されません。表示
された値は、有効でない可能性
があります。
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異なる波形ファイルのヘッダ情報の表示

波形をデュアル任意波形プレーヤで再生中、別の波形ファイルのヘッダ情報を表示できます。ただし変更できるのは、現

在再生中の波形のヘッダ情報だけです。別の波形ファイルを選択すると、ヘッダ編集ソフトキーが淡色表示になります（図

3-6 を参照）。この作業では、使用可能な表示選択肢について説明します。

1. 波形ファイル・リストを表示します。Mode > Dual ARB > ARB Setup > Header Utilities > View Different Header を押します。

図 3-7 に示すように、テーブルには波形ファイルのアルファベット順のリストがあります。 

図 3-7 異なるヘッダを表示するための波形ファイル・リスト

2. 不揮発性メモリ内のすべての波形セグメントを表示します。

a. Catalog Type ソフトキーを押します。図 3-7 に示すように、ステップ 1 でアクセスしたテーブルに表示できる波形

ファイルには 3 種類あります。

NVWFM  不揮発性メモリに保存されたすべての波形セグメントを表示します。

Seq  すべての波形シーケンス・ファイルを表示します。

WFM1  揮発性メモリに保存されたすべての波形セグメントを表示します。

b. NVWFM ソフトキーを押します。テーブルに、不揮発性メモリ内の波形ファイルが表示されます。

3. 波形ファイルのヘッダ情報を表示します。ファイルを強調表示し、View Header ソフトキーを押します。

選択した波形ファイルのヘッダ情報が PSG ディスプレイに表示されます。再生中の波形がある場合、そのヘッダ情報

がこの情報に置き換わります。ただし、信号発生器によって使用される波形設定は変化しません。再生中の波形のヘッ

ダ情報に戻るには、View Different Headerを押し、現在再生中の波形ファイルを選択して、View Headerを押します。または

Return > Header Utilities を押します。

現在の波形ファイル・タイプ

波形ファイル・タイプ :

テーブル
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ヘッダを含む波形ファイルの再生

変調された波形ファイル（AUTOGEN_WAVEFORM）は、そのフォーマットがオフの場合、デュアル任意波形プレーヤを

使用しないと再生できません。これは、ダウンロードされた波形ファイルにあてはまります（ファイルのダウンロードに

ついては、『E8257D/67D PSG 信号発生器プログラミング・ガイド』で説明しています）。再生のため波形を選択すると、

信号発生器で保存済みヘッダ情報が使用されます。これらの設定の一部は、パラメータの設定に使用するソフトキーのラ

ベルの一部として表示されます。また、ARB サマリ表示にも表示されます（図 3-8 を参照）。

注記 保存された波形ファイルの再生に使用する信号発生器には、ファイルの生成に必要なオプションと同じオプショ

ンが装備されていなければなりません。

ファイル・ヘッダ設定の適用と波形の再生の詳細については、「波形の再生」（82 ページ）を参照してください。

機器を正しく設定する手順

1. 波形を選択します。

2. 信号発生器の設定を必要に応じて変更します。

3. デュアル任意波形をオンにします。

図 3-8 ファイル・ヘッダ設定

ヘッダ設定は初期設定と同じ

適用されたヘッダ設定

サマリ表示

波形が選択されています。 

保存済みヘッダ設定が

適用されます。

波形を選択したときに変更可能

サマリ表示

波形が選択されていません。

初期設定が適用されます。
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デュアル任意波形プレーヤの使用

デュアル任意波形（ARB）プレーヤは、波形ファイルの作成、編集、再生に用いられます。セグメントとシーケンスの 2
種類の波形ファイルがあります。セグメントは、信号発生器の ARB フォーマットを使って作成される波形ファイルです。

シーケンスは、複数のセグメントを 1 つの波形ファイルに結合したものです。波形ファイルは、別の信号発生器またはコ

ンピュータを使って作成し、PSG にダウンロードしてデュアル任意波形プレーヤで再生することもできます。波形のダウ

ンロード方法の詳細については、『E8257D/67D PSG 信号発生器プログラミング・ガイド』を参照してください。

任意波形変調フォーマットをオンにするたびに、波形ファイルが自動的に生成されます。この自動生成されたファイルに

は AUTOGEN_WAVEFORM という名前が付けられます。このデフォルト・ファイル名はすべての ARB フォーマットで共

有されるので、情報を保存する場合にはファイル名の変更が必要です。ファイルの名前を変更しないと、別の ARB フォー

マットをオンにしたときにファイルが上書きされます。

デュアル任意波形プレーヤには、マーカ（84 ページ）、トリガ（98 ページ）、クリッピング（104 ページ）の機能があります。

波形ファイルを操作するには、ファイルが揮発性メモリに存在する必要があります。信号発生器には、WFM1（揮発性波

形メモリ）と NVWFM（不揮発性波形メモリ）の 2 種類のメモリがあります。任意波形発生器をオンにしたときに作成さ

れる、新しい生成波形ファイル（AUTOGEN_WAVEFORM）は、最初に WFM1 に存在します。このファイルを保存する場合、

名前を変更し、それを NVWFM に保存します。保存された波形ファイルを NVWFM から揮発性メモリ（WFM1）にロード

します。WFM1 で任意波形プレーヤを使ってファイルの編集や再生が行えます。詳細については、「カスタム変調」（67
ページ）を参照してください。

デュアル任意波形プレーヤへのアクセス

Mode > Dual ARB を押します。

以下の図に、その第 1 レベル・ソフトキー・メニューを示します。ほとんどの手順は、このメニューから開始します。 
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波形セグメントの作成

波形シーケンサで使用する波形セグメントは 2 通りの方法で得られます。リモート・インタフェース経由で波形をダウン

ロードするか、ARB 変調フォーマットのいずれかを使って波形を生成することができます。リモート・インタフェース経

由での波形のダウンロード方法の詳細については、『E8257D/67D PSG 信号発生器プログラミング・ガイド』を参照して

ください。

波形シーケンスは、セグメントから構成されますが、他のシーケンスを含めることもできます。シーケンスの作成には任

意の数のセグメント（最大 32768）を使用できます。このリミット数は、波形シーケンス内のセグメントの数によって決

まります。セグメントとシーケンスは、波形シーケンス内で繰り返すことができます。すべてのセグメントと繰り返され

るセグメントの総数がリミット数を超えてはいけません。以下の図に、2 つのシーケンスと 3 つのセグメントから成る波

形シーケンスを示します。この例では、セグメント数は 11 です。 

図 3-9 波形シーケンスの図

以下の手順では、2 つの波形セグメントを作成し、名前を付けて ARB メモリに保存する方法について説明します。2 つの

波形セグメントに名前を付けて ARB メモリに保存した後、それらを使って 81 ページに説明するように波形シーケンスを

作成することができます。

1. 最初の波形を生成します。

a. Preset > Mode > Two Tone > Alignment Left Cent Right を押して Right にします。

b. Two Tone Off On を押して On にしてから、Off にします。

生成後に 2 トーン・モードをオフにしているのは、波形の使用中には波形セグメントの名前を変更できないから

です。

これにより、右側のトーンが搬送波周波数にある 2 トーン波形が生成されます。波形生成中には T-TONEと I/Qの 2
つのインジケータがオンになります。波形はデフォルトのファイル名 AUTOGEN_WAVEFORMで揮発性メモリに保存され

ます。

注記 ある時点でメモリ上に存在できるAUTOGEN_WAVEFORM波形は1つだけであるため、2番目の波形を生成するため

にこのファイルの名前を変更する必要があります。 
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2. 最初の波形セグメントを作成します。

a. Mode > Dual ARB > Waveform Segments > Load Store を押して Store にします。

b. デフォルトのセグメント AUTOGEN_WAVEFORMを強調表示します。

c. Rename Segment > Editing Keys > Clear Text を押します。

d. ファイル名（TTONEなど）を入力し、Enter > Store Segment To NVWFM Memory を押します。

これにより、波形セグメントの名前が変更され、コピーが不揮発性メモリに保存されます。

3. 2 番目の波形を生成します。

a. Mode > Multitone > Initialize Table > Number Of Tones > 9 > Enter > Done を押します。

b. Multitone Off On を押して On にしてから、Off にします。

波形の使用中には波形セグメントの名前を変更できません。

これにより、9 個のトーンを持つマルチトーン波形が生成されます。波形生成中には M-TONEと I/Qの 2 つのインジ

ケータがオンになります。波形はデフォルトのファイル名 AUTOGEN_WAVEFORMで揮発性メモリに保存されます。

4. 2 番目の波形セグメントを作成します。

ステップ 2 を繰り返し、このセグメントにわかりやすい名前（例えば、MTONE）を付けます。

波形シーケンスの作成と保存

この例では、80 ページで作成した 2 個の波形セグメントを使って波形シーケンスを作成し、編集する方法を説明します。

シーケンスのセグメントを使用するには、セグメントが揮発性メモリに存在する必要があります。波形セグメントを不揮

発性メモリから揮発性メモリにロードする方法については、83 ページを参照してください。

1. 波形セグメントを選択します。

2 トーン波形セグメントの 1 回の繰り返しと 9 トーン・マルチトーン波形セグメントの 1 回の繰り返しからなるシー

ケンスを定義します。

a. Mode > Dual ARB > Waveform Sequences > Build New Waveform Sequence > Insert Waveform を押します。

b. 波形セグメント（TTONEなど）を強調表示し、Insert Selected Waveform を押します。

c. 2 番目の波形セグメント（MTONEなど）を強調表示し、Insert Selected Waveform を押します。

d. Done Inserting を押します。

2. オプション : 新しいシーケンスのセグメントに対して、必要に応じてマーカをオンにできます。93 ページを参照して

ください。

3. 波形シーケンスに名前を付け、メモリ・カタログの Catalog of Seq Filesに保存します。

a. Name and Store を押します。

b. ファイル名（TTONE+MTONEなど）を入力します。

c. Enter を押します。
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波形の再生

この手順は、波形セグメントまたは波形シーケンスの再生に使用します。

この例では、前の手順で作成した波形シーケンスを再生します。

1. 波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveform を押します。

b. Select Waveformカタログの Sequence列で波形シーケンス（TTONE+MTONEなど）を強調表示し、Select Waveform
を押します。

ディスプレイには現在選択されている波形が表示されます

（Selected Waveform:SEQ:TTONE+MTONEなど）。

2. 波形を生成します。 
ARB Off On を押して On にします。 

これにより選択された波形シーケンスが再生されます。 
波形シーケンス生成中には ARBと I/Qの 2 つのインジケータがオンになります。

波形シーケンスの編集

この例では、波形シーケンス内の波形セグメントを編集し、編集したシーケンスを新しい名前で保存する方法を説明しま

す。編集ディスプレイ内では、各セグメントの再生（繰り返し）回数の変更、セグメントの削除、セグメントの追加、マー

カの切り替え（93 ページで説明）、変更の保存が可能です。

注記 波形シーケンス編集ディスプレイを終了する前に波形シーケンスへの変更を保存しないと、変更内容が削除され

ます。

1. Waveform Sequences > Edit Selected Waveform Sequence を押し、最初のエントリを強調表示します。

2. Edit Repetitions > 100 > Enter を押します。2 番目のセグメントが自動的に選択されます。

3. Edit Repetitions > 200 > Enter を押します。

4. 編集されたファイルを新しい波形シーケンスとして保存します。

a. Name And Store を押します。

b. Editing Keys > Clear Text を押し、新しいファイル名（TTONE100+MTONE200など）を入力します。

c. Enter を押します。

各波形セグメント・エントリの繰り返し回数が、1 からそれぞれ 100 と 200 に変更されました。シーケンスは、本器のメ

モリ・カタログの Catalog of Seq Filesに新しい名前で保存されました。

波形シーケンスの再生については、82 ページを参照してください。

リアルタイム・ノイズのデュアル任意波形への追加

オプション 403 付きの信号発生器は、変調波形ファイルをデュアル任意波形プレーヤによって再生しながら、AWGN（相

加性白色ガウス雑音）を搬送波にリアルタイムで追加することができます。AWGN は、フロントパネル・ソフトキーを

使って設定できます。Carrier to Noise Ratio ソフトキーを使用すると、信号に追加する搬送波パワーに対するノイズ・パワー

の量を指定することができます。Carrier Bandwidth ソフトキーによって、ノイズを積分する帯域幅を設定します。
82 第3章



基本デジタル操作
デュアル任意波形プレーヤの使用
Noise Bandwidth Factor ソフトキーを使うと、フラットなノイズ帯域幅を選択できます。これらのソフトキーについては、

『E8257D/67D PSG 信号発生器キー・リファレンス』で説明しています。 

以下の手順では、搬送波を設定し、定義済み SINE_TEST_WFM 波形ファイルを使って搬送波を変調します。次に AWGN
を搬送波に追加します。 

AWGNの設定

1. 本器を初期設定にします。Preset ハードキーを押します。

2. Frequency ハードキーを押し、15 GHz を入力します。 

3. Amplitude ハードキーを押し、－ 10 dBm を入力します。

4. RF On Off を押して On にします。

5. Mode > Dual ARB > Select Waveform を押し、SINE_TEST_WFM 波形を選択します。

6. Select Waveform を押します。

7. ARB Off On を押して On にします。

8. ARB Setup > ARB Sample Clock を押し、50 MHz を入力します。

9. Real-time Noise Setup > Carrier to Noise Ratio を押し、30 dB を入力します。

10. Carrier Bandwidth を押し、40 MHz を入力します。

11. Real-time Noise Off On を押して On にします。

この手順では、AWGNが15 GHz搬送波に追加されます。信号発生器の表示パワー・レベル（－10 dBm）には、30 dBの

搬送波対ノイズ比（C/N）として設定されたノイズ・パワーが含まれます。C/Nの場合、ノイズ・パワーは搬送波帯域幅

40 MHzに渡って適用されます。デフォルトのノイズ帯域幅ファクタは1です。これにより、50 MHzサンプリング・レー

トの0.8倍以上のフラットなノイズ信号帯域幅が得られます。

波形セグメントの保存とロード

波形セグメントは、揮発性メモリに WFM1 ファイルとして置いておくことも、不揮発性メモリに NVWFM ファイルとし

て保存することも、その両方に置くこともできます。波形ファイルを再生または編集するには、揮発性メモリに置く必要

があります。揮発性メモリ上のファイルは電源を入れ直すと消えてしまうため、重要なファイルは不揮発性メモリに保存

し、必要なときに揮発性メモリにロードすることをお勧めします。

不揮発性メモリへの波形セグメントの保存

1. Mode > Dual ARB > Waveform Segments を押します。

2. 必要なら Load Store を押して Store にします。

3. Store All To NVWFM Memory を押します。

すべての WFM1 波形セグメント・ファイルのコピーが、不揮発性メモリに NVWFM ファイルとして保存されます。ファ

イルを個別に保存するには、ファイルを強調表示して Store Segment To NVWFM Memory を押します。
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不揮発性メモリからの波形セグメントのロード

1. 揮発性メモリをクリアし、WFM1 ファイルをすべて削除するため本器の電源を入れ直します。

2. Mode > Dual ARB > Waveform Segments を押します。

3. 必要なら Load Store を押して Load にします。

4. Load All From NVWFM Memory を押します。

すべての NVWFM 波形セグメント・ファイルのコピーが、揮発性メモリに WFM1 ファイルとしてロードされます。 
ファイルを個別にロードするには、ファイルを強調表示して Load Segment From NVWFM Memory を押します。

波形セグメントの名前の変更

1. Mode > Dual ARB > Waveform Segments を押します。

2. 目的のファイルを強調表示し、Rename Segment > Editing Keys > Clear Text を押します。

3. 必要なファイル名を入力し、Enter を押します。

波形マーカの使用

信号発生器では、波形セグメント上の特定ポイントをマークするため 4 個の波形マーカを使用できます。信号発生器がオ

ンになっているマーカを検出すると、補助出力信号がマーカ番号に対応するリアパネル・イベント・コネクタ（「リアパネ

ル」（18 ページ）で説明）に出力されます。この補助出力信号は、別の機器を波形と同期させる場合、あるいは波形の特

定ポイントで測定を開始するためのトリガ信号として使用できます。

各マーカで ALC の ホールドや RF のブランキング（ALC ホールドを含む）が可能です。 

波形セグメントを作成すると（80 ページ）、セグメントの最初のサンプル・ポイントにマーカ 1 と 2 が配置されたマーカ・

ファイルが作成されます。関連付けられたマーカ・ファイルがない波形ファイルをダウンロードした場合、信号発生器が

マーカ・ポイントのないマーカ・ファイルを作成します。Agilent から提供されているセグメントでは、4 つのマーカすべ

てに対して最初のサンプルにマーカ・ポイントがあります。

以下の手順では、デュアル任意波形プレーヤでの作業中にマーカを使用する方法を示します。ただし、プロセスはどの

ARB フォーマットで作業を行うときでも同じです。 

これらの手順では、マーカ・ポイントとサンプル・ポイントの 2 種類のポイントについても説明します。マーカ・ポイン

トは、波形上の所定マーカが設定されているポイントです。各マーカに対して 1 つ以上のマーカ・ポイントを設定できま

す。サンプル・ポイントは、波形を構成するポイントの 1 つです。

波形マーカの使用方法には 3 つの基本ステップがあります。

「1. 波形セグメントからのマーカ・ポイントのクリア」（90 ページ）

「2. 波形セグメントのマーカ・ポイントの設定」（91 ページ）

「3. 波形シーケンスでのマーカの制御（デュアル ARB のみ）」（93 ページ）

このセクションには、以下の情報もあります。

• 「波形マーカの概念」（85ページ）

• 「マーカ・ユーティリティへのアクセス」（88ページ）

• 「波形セグメントのマーカの表示」（89ページ）

• 「マーカ・パルスの表示」（95ページ）
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• 「RFブランキング・マーカの使用」（96ページ）

• 「マーカ極性の設定」（98ページ）

波形マーカの概念

信号発生器の ARB フォーマットでは、波形セグメント上の特定ポイントをマークするため 4 個の波形マーカを使用でき

ます。各マーカの極性とマーカ・ポイント（単一サンプル・ポイントまたはサンプル・ポイントの範囲）を設定できます。

各マーカで ALC の ホールドや RF のブランキングと ALC のホールドが可能です。

マーカ・ファイル生成

波形セグメントを生成すると（80 ページを参照）、セグメントの最初のサンプル・ポイントにマーカ 1 と 2 が配置された

マーカ・ファイルが自動的に作成されます。

関連付けられたマーカ・ファイルがない波形ファイルを（『8257D/67D PSG 信号発生器プログラミング・ガイド』の説明

に従って）ダウンロードした場合、マーカ・ポイントがないマーカ・ファイルが作成されます。

マーカ・ポイントの編集要件

波形セグメントのマーカ・ポイントを変更するには、セグメントが揮発性メモリに存在する必要があります（「不揮発性メ

モリからの波形セグメントのロード」（84 ページ）を参照）。

デュアル任意波形プレーヤでは、波形を再生せずに、または ARB 変調フォーマットで波形を再生中に波形セグメントの

マーカ・ポイントを変更できます。 

ARB 変調フォーマットでは、セグメントのマーカ・ポイントを変更するには波形を再生する必要があります。 

マーカ・
ファイル
ビットN

マーカ
極性

マーカN 
RF Blank Off On

マーカ N
マーカがローの
ときにRFをブラ

ンクにする

EVENT N

負

正

マーカの
On Offを設定

マーカN 
ALC Hold Off On

マーカ N
マーカがローの
ときにALCを

ホールドします

信号発生器がオンになっているマーカを検出すると（93ページで説明）、補助

出力信号が作成され、マーカ番号（N）に対応するリアパネル・イベント・コ

ネクタに出力されます。 

EVENT 3および4コネクタは、AUXILIARY I/Oコネクタ上のピンです（コネクタ

位置を18ページの図1-3に示します）。

RFブランクのみ。ALCホールドを含み

ます
第3章 85



基本デジタル操作
波形マーカの使用
マーカ極性とルーティング設定の保存

マーカ極性とルーティング設定は、再設定するか、本器を初期設定するか、PSG パワーを入れ直すまで残ります。波形の

再生時に正しい設定が使用されるようにするには、マーカ極性またはルーティング（RF ブランキングと ALC ホールド）

を設定し、情報をファイル・ヘッダ（68 ページ）に保存します。これは、セグメントをシーケンスの一部として再生する

場合に特に重要です。前に再生されたセグメントが異なるマーカとルーティング設定を持つ可能性があるからです。

ALCホールド・マーカ機能

マーカ機能（ソフトキー・ラベルの Marker Routing として説明）はマーカ・ポイント（91 ページ）を設定する前でも後で

も設定できますが、マーカ・ポイントの設定前にマーカ機能を設定すると、RF 出力でパワー・スパイクまたはパワーの

損失が発生する場合があります。

波形信号にアイドル周期があるとき、またはダイナミック・レンジを拡大するため RF ブランキング（96 ページ）を使用

したくないときには、ALC ホールド機能を単独で使用します。 

ALC ホールド・マーカ機能は、マーカによって設定されたサンプル・ポイントの平均（RMS）値で ALC 回路を制御しま

す。マーカ極性が正と負のどちらの場合でも、ALC はマーカ信号がハイになるときに RF 出力信号（搬送波と任意の変調

信号）をサンプリングします。

マーカ信号の応答には、波形信号応答を基準として最小限の 2 サンプル・ポイント遅延があります。マーカ信号遅延を補

正するには、ALC サンプリングを開始したい波形サンプルからのマーカ・ポイントをオフセットします。

注記 波形の出力振幅に影響する可能性があるため、ALCホールドを100 msより長く使用しないでください。タイム・

インターバルをこれより長くする場合は、「パワー・サーチ・モードの設定」（241ページ）を参照してください。

注意 ALCサンプリングが正しくないと、突然レベリングされない状態が起こってRF出力にスパイクが発生し、

DUTや接続された機器が損傷を受ける可能性があります。この状態を防止するには、信号内で検出される

より高いパワー・レベルを考慮した振幅でALCサンプリングが行われるようにマーカを設定します。

正 : オン・マーカ・ポイント中に信号がサンプリングされます。

負 : オフ・マーカ・ポイント中に信号がサンプリングされます。

　 正極性
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アベレージングの詳細

ALC は、マーカ信号がハイになるときに波形をサンプリングし

ます。サンプリングされた波形の平均を使って ALC 回路を設定

します。

オン・マーカ・ポイント（正極性）中の ALC サンプルです。

É}Å[ÉJ É}Å[ÉJ

É}Å[ÉJÉ}Å[ÉJ

正しい使い方の例

波形 :1022 ポイント

マーカ範囲 : 95-97
マーカ極性 : 正

この例では、最高振幅の波形エリアをサンプリングするよう設定さ
れたマーカを示します。最低振幅の波形エリアの十分前にマーカが
設定されています。マーカと波形信号との応答の差が考慮されてい
ます。

レベリングされないパルス

正しくない使い方の例

波形 :1022 ポイント

マーカ範囲 : 110-1022
マーカ極性 : 正

この例では、同じ波形のロー部分をサンプリングするよう設定
されたマーカを示します。ALC 変調器回路がそのレベル用に設

定されます。このため通常、信号発生器が高振幅のパルスを検
出したときに、信号発生器に対してレベリングされない状態が
起こります。

マーカマーカ
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マーカ・ユーティリティへのアクセス

以下の手順を使ってマーカのパラメータを表示します。この手順ではデュアル任意波形プレーヤを使用しますが、すべて

の ARB フォーマットで ARB Setup ソフトキーを介してマーカ・ユーティリティにアクセスできます。

1. 任意波形プレーヤを選択します。

Mode > Dual ARB を押します。

2. ARB Setup > Marker Utilities を押します。

サンプル範囲は信号の最初のポイントで

始まります。

負の範囲を信号と

オフ時間のあいだに設定

正しくない使い方の例

波形 :1022 ポイント

マーカ範囲 : 110-1022
マーカ極性 : 負

この図では、マーカ・オンポイント中に負極性マーカがローにな
り、オフ・ポイント中にマーカ信号がハイになることを示します。
ALC は、オフ・マーカ・ポイント中に波形をサンプリングします。 マーカがオン マーカがオン

オン時間とオフ時間の両方のサンプリングでは、変調器回路がよ
り高い信号レベルに対して不適切に設定されます。パルスの最初
で振幅が増加しています。

マーカ
オフ

マーカがオン
マーカマーカ

オフ オン
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注記 このセクションのほとんどの手順は、Marker Utilitiesソフトキー・メニューから開始します。

波形セグメントのマーカの表示

マーカが波形セグメントに適用されます。以下のステップを使って、セグメント（この例では、Agilent から提供されて

いるセグメント SINE_TEST_WFMを使用します）に設定されたマーカを表示します。

1. Marker Utilities メニュー（88 ページ）で、Set Markers を押します。

2. 目的の波形セグメントを強調表示します。 
ARB フォーマットでは、存在するファイルは 1 つだけで（AUTOGEN_WAVEFORM）、すでに強調表示されています。

3. Display Markers > Zoom in Max を押します。最大ズームイン範囲は 28 ポイントです。

ズーム機能を使ってマーカがどのように表示されるかを試してください。

ディスプレイに最大 460 ポイントを表示できます。460 ポイントを超えるサンプル・ポイント範囲を持つ表示波形では、

マーカ位置を表示できない可能性があります。

Dual ARB以外のARBフォーマットを使用

するときには、そのフォーマットをオン

にしてSet Markersソフトキーを有効にす

る必要があります。
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1. 波形セグメントからのマーカ・ポイントのクリア

マーカ・ポイントを設定するときには、マーカ・ポイントは、すでに存在するポイントと置き換えられずに、既存ポイン

トに追加して設定されます。マーカは累積されるので、ポイントを設定する前にセグメントを表示（89 ページ）して不要

なポイントを削除します。すべてのマーカをクリアした場合、イベント出力信号のレベルは 0V です。

すべてのマーカ・ポイントのクリア

1. Marker Utilities メニュー（88 ページ）で、Set Markers を押します。

2. 目的の波形セグメントを強調表示します。 
ARB フォーマットでは、存在するファイルは 1 つだけで（AUTOGEN_WAVEFORM）、すでに強調表示されています。

3. 目的のマーカ番号を強調表示します。 
Marker 1 2 3 4 を押します。

Set Marker表示

これらのソフト

キーにより、マー

カ表示に表示され

ている波形サンプ

ル・ポイントの範

囲を変更します。

ソフトキーを押す

たびにサンプル範

囲が約2倍変化し

ます。

最初の

サンプル・

ポイント

のマーカ・

ポイント

ディスプレイに表

示された最初のサ

ンプル・ポイント

セグメントを選択

します。

以下のディスプレイに波形の I成分とQ成分、および

セグメントに設定されたマーカ・ポイントを示します。
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4. 選択したマーカ番号に対して、選択したセグメントのすべてのマーカ・ポイントを削除します。

Set Marker Off All Points を押します。

5. 削除する残りのマーカ・ポイントに対してステップ 3 から繰り返します。

マーカ・ポイントの範囲のクリア

以下の例では、マーカ・ポイント（Marker 1）がポイント 10 ～ 20 のあいだに設定された波形を使用します。これにより、

影響を受けるマーカ・ポイントが見やすくなります。既存ポイントが範囲（91 ページ）に設定されているか、個別ポイン

ト（92 ページ）として設定されているかに関係なく、同じ方法が使用できます。

1. Marker Utilities メニュー（88 ページ）で、目的のマーカ（この例では Marker 1）を選択します。

2. オフにする最初のサンプル・ポイント（この例では 13）を設定します。

Set Marker Off Range Of Points > First Mkr Point > 13 > Enter を押します。

3. オフにする範囲の最後のマーカ・ポイントを、波形のポイント数以下の値で、かつステップ 2 で設定した値以上の値

（この例では 17）に設定します。

Last Mkr Point > 17 > Enter > Apply To Waveform > Return を押します。

これにより、以下の図に示すように、ステップ 2 と 3 で設定した範囲内のアクティブ・マーカに対するすべてのマー

カ・ポイントがオフになります。

単一マーカ・ポイントのクリア

「マーカ・ポイントの範囲のクリア」（91 ページ）で説明したステップを使用しますが、最初と最後のマーカ・ポイント

を、クリアするポイントの値に設定します。例えば、ポイント 5 のマーカをクリアする場合、最初の値と最後の値を両方

とも 5 に設定します。

2. 波形セグメントのマーカ・ポイントの設定

セグメントにマーカ・ポイントを設定するには、セグメントが揮発性メモリに存在する必要があります（84 ページ）。

マーカ・ポイントを設定するとき、マーカ・ポイントは、すでに存在するポイントと置き換えられずに、既存ポイントに

追加して設定されます。マーカは累積されるので、セグメント内にマーカ・ポイントを設定する前にセグメントを表示

（89 ページ）して不要なポイントを削除します（90 ページ）。

ある範囲のポイントにわたるマーカの配置

1. Marker Utilities メニュー（88 ページ）で、Set Markers を押します。

2. 目的の波形セグメントを強調表示します。

ARB フォーマットでは、存在するファイルは 1 つだけで（AUTOGEN_WAVEFORM）、すでに強調表示されています。

マーカの表示は89ページで説明しています。
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3. 目的のマーカ番号を強調表示します。

Marker 1 2 3 4 を押します。

4. 範囲の最初のサンプル・ポイント（この例では 10）を設定します。

Set Marker On Range Of Points > First Mkr Point > 10 > Enter を押します。

5. 範囲の最後のマーカ・ポイントを、波形のポイント数以下の値で、かつ最初のマーカ・ポイント以上の値（この例で

は 20）に設定します。

Last Mkr Point > 20 > Enter を押します。

6. Apply To Waveform > Return を押します。

これにより、波形マーカ・ポイントの範囲が設定されます。マーカ信号は以下の図に示すようにサンプル・ポイント 10 で

開始し、サンプル・ポイント 20 で終了します。

単一ポイントへのマーカの配置

最初のポイント上

1. Marker Utilities メニュー（88 ページ）で、Set Markers を押します。

2. 目的の波形セグメントを強調表示します。

ARB フォーマットでは、存在するファイルは 1 つだけで（AUTOGEN_WAVEFORM）、すでに強調表示されています。

3. 目的のマーカ番号を強調表示します。

Marker 1 2 3 4 を押します。

4. Set Marker On First Point を押します。

これにより、ステップ 3 で選択したマーカ番号のセグメントの最初のポイントにマーカが設定されます。

任意のポイント上

「ある範囲のポイントにわたるマーカの配置」（91 ページ）で説明したステップを使用しますが、最初と最後のマーカ・ポ

イントを、設定するポイントの値に設定します。例えば、マーカをポイント 5 に設定する場合、最初の値と最後の値を両

方とも 5 に設定します。

繰り返し間隔マーカの配置

以下の例では、ある範囲のポイントにわたってマーカを設定し、各マーカ間の間隔（スキップされるポイント）を指定し

ます。マーカ設定の前に間隔を設定する必要があります。スキップされるポイントを前に設定したポイント範囲に適用す

ることはできません。

マーカの表示は89ページで説明しています。
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1. 既存マーカ・ポイント（90 ページ）を削除します。

2. Marker Utilities メニュー（88 ページ）で、Set Markers を押します。

3. 目的の波形セグメントを強調表示します。

ARB フォーマットでは、存在するファイルは 1 つだけで（AUTOGEN_WAVEFORM）、すでに強調表示されています。 

4. 目的のマーカ番号を強調表示します。Marker 1 2 3 4 を押します。

5. 範囲の最初のサンプル・ポイント（この例では 5）を設定します。

Set Marker On Range Of Points > First Mkr Point > 5 > Enter を押します。

6. 範囲の最後のマーカ・ポイントを、波形のポイント数以下の値で、かつ 最初のマーカ・ポイント以上の値（この例で

は 25）に設定します。

Last Mkr Point > 25 > Enter を押します。

7. スキップするサンプル・ポイントの数（この例では 1）を入力します。

# Skipped Points > 1 > Enter を押します。

8. Apply To Waveform > Return を押します。

これにより、以下に示すようにマーカ・ポイント範囲内のポイント 1 つおきにマーカが発生します（1 個のサンプル・ポ

イントがスキップされます）。

スキップ・ポイント機能の 1 つのアプリケーションが、補助出力としてのクロック信号の作成です。

3. 波形シーケンスでのマーカの制御（デュアルARBのみ）

波形セグメントでは、オンになっているマーカ・ポイントで信号が作成され、マーカ番号に対応するリアパネル・イベン

ト・コネクタ（「リアパネル」（18 ページ）で説明）に出力されます。波形シーケンスの場合、セグメントごとにマーカを

オンまたはオフにすることができます。これにより、シーケンス内の一部のセグメントのマーカを出力し、その他を出力

しないようにすることができます。マーカ設定は変更するか、電源を入れ直さない限り、次にロードされたシーケンスに

もそのまま同じ設定が使用されます。

波形シーケンスを作成するとき

波形シーケンスを作成するため波形セグメントを選択した後、シーケンスに名前を付けて保存する前に、各セグメントの

マーカを個別にオンまたはオフにすることができます。マーカ・ポイント（91 ページ）がないマーカをオンにしても、補

助出力には影響しません。

1. 波形セグメントを選択します（81 ページのステップ 1）。

マーカの表示は89ページで説明しています。
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2. 必要に応じてマーカを切り替えます。 

a. 最初の波形セグメントを強調表示します。

b. Enable/Disable Markers を押します。

c. 必要に応じて Toggle Marker 1、Toggle Marker 2、Toggle Marker 3、Toggle Marker 4 を押します。

マーカ・ポイント（91 ページ）がないマーカを切り替えても、補助出力には影響しません。 

Mkr列のエントリ（以下の図を参照）は、マーカがそのセグメントに対してオンであることを示します。列にエン

トリがなければ、そのセグメントに対するすべてのマーカはオフです。

d. 残りのセグメントをそれぞれ強調表示し、ステップ c を繰り返します。

3. Return を押します。

4. 波形シーケンスに名前を付け、保存します（81 ページのステップ 3）。

以下の図に、セグメントを再利用して作成されたシーケンスを示します。Agilent が提供するセグメントでは、4 つのマー

カすべての最初のサンプルにマーカ・ポイントがあります。この例では、最初のセグメントではマーカ 1 が、2 番目のセ

グメントではマーカ 2 が、3 番目のセグメントではマーカ 3 と 4 がオンになっています。

各セグメントでは、そのセグメントに対してオンになっているマーカだけがリアパネルから信号を出力します。この例で

は、マーカ 1 補助信号は、最初のセグメントに対してのみ出力されます。残りのセグメントに対してはオフになっている

からです。マーカ 2 補助信号は 2 番目のセグメントに対してのみ出力されます。マーカ 3 および 4 補助信号は 3 番目のセ

グメントに対してのみ出力されます。

既存波形シーケンス内

まだ作成していない場合、3 個以上のセグメントを含む波形シーケンスを作成して保存します（81 ページ）。セグメント

を揮発性メモリで使用できるようにします（84 ページ）。

1. Mode > Dual ARB > Waveform Sequences を押し、目的の波形シーケンスを強調表示します。

2. Edit Selected Waveform Sequence を押し、最初の波形セグメントを強調表示します。

3. Enable/Disable Markers > Toggle Marker 1, Toggle Marker 2、Toggle Marker 3、Toggle Marker 4 を押します。

マーカ・ポイント（91 ページ）がないマーカを切り替えても、補助出力には影響しません。 

Mkr 列のエントリは、マーカがそのセグメントに対してオンであることを示します。列にエントリがなければ、その

セグメントに対するすべてのマーカはオフです。

4. 次の波形セグメントを強調表示し、目的のマーカ（この例ではマーカ 1 と 4）を切り替えます。

5. 必要に応じてステップ 4 を繰り返します（この例の場合、3 番目のセグメントを選択し、マーカ 3 を切り替えます）。

6. Return > Name And Store > Enter を押します。

選択に従ってマーカがオンまたはオフに切り替わり、選択したシーケンス・ファイルに変更が保存されます。

Sequence Marker列

このエントリは、このセグメ

ントに対してマーカ3と4がオ

ンであることを示します。
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マーカ・パルスの表示

波形が再生しているとき（82 ページ）、オンになっている設定マーカのパルスをマーカ番号に対応するリアパネル・イベ

ント・コネクタで検出できます。この例では、1 個以上の設定マーカ・ポイント（91 ページ）を持つ波形セグメントに

よって生成されたマーカ・パルスを表示する方法を示します。波形シーケンスのプロセスも同じです。 

この例では、デュアル任意波形プレーヤでセグメント SINE_TEST_WFM を使用します。このセグメントでは、以下に示す

ように 4 つのマーカすべてに対して最初のサンプル・ポイントにマーカ・ポイントがあります。

1. Mode > Dual ARB > Select Waveform を押し、目的のセグメント（この例では SINE_TEST_WFM）を強調表示します。

2. ARB Off On を押して On にします。

3. EVENT 1 コネクタにオシロスコープを接続し、イベント 1 信号でトリガします。

マーカが存在する場合、以下の例に示すように、マーカ・パルスがオシロスコープに表示されます。

 
Sequence Marker列

このエントリは、このセグメ

ントに対してマーカ3だけがオ

ンであることを示しています。

波形セグメントの

最初のサンプル・

ポイント上の

マーカ・ポイント

マーカの表示は89ページで説明しています。
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RFブランキング・マーカの使用

マーカ機能（ソフトキー・ラベルの Marker Routing として説明）はマーカ・ポイント（91 ページ）を設定する前でも後で

も設定できますが、マーカ・ポイントの設定前にマーカ機能を設定すると、RF 出力が変化する場合があります。RF ブラ

ンキングには ALC ホールドが含まれます（86 ページで説明しています。レベリングされないパワーに関する注意に注意

してください）。RF ブランキング・マーカを使用すると信号発生器は、マーカ信号がローになるときに RF 出力をブラン

クにします。

1. セグメント SINE_TEST_WFMを使用し、ポイント 1 ～ 180（91 ページ）にわたってマーカ 1 を設定します。

2. Marker Utilities メニュー（88 ページ）から、RF Blanking を Marker 1 に割り当てます。 
Marker Routing > Pulse/RF Blank > Marker 1 を押します。

RF出力

イベント1信号のマーカ・パルス
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マーカ極性=正

マーカ極性が正（デフォルト設定）のと

き、オフ・マーカ・ポイントのあいだ、RF

出力がブランクになります。

200180ポイント1
マーカ

セグメント

RF信号

RF信号

200180ポイント1
マーカ

セグメント

マーカ極性=負

マーカ極性が負のとき、オン・マーカ・

ポイントのあいだ、RF出力がブランクに

なります。

≈3.3V

0V

≈3.3V

0V
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マーカ極性の設定

負マーカ極性を設定するとマーカ信号が反転します。

1. Marker Utilities メニュー（88 ページ）で、Marker Polarity を押します。

2. 必要に応じて各マーカ番号のマーカ極性を選択します。

96 ページで示したように、

正極性 :  オン・マーカ・ポイントはハイ（≈3.3V）です。 

負極性 :  オン・マーカ・ポイントはロー（0V）です。

波形のトリガ

トリガは、ARB フォーマットとリアルタイム・フォーマットで使用できます。ARB トリガは、波形ファイルの再生を制

御します。リアルタイム・カスタム・トリガは、データ・パターンの伝送を制御します。このセクションでは例や説明に

デュアル任意波形プレーヤを使用しますが、機能とアクセス方法（100 ページで説明）はすべての（ARB およびリアルタ

イム）フォーマットでほぼ同じです。 

トリガは、変調信号をいつ送信するかを PSG に知らせることにより、データ伝送を制御します。トリガ設定に応じて、

データ伝送が 1 回発生するか、連続して発生するか、または PSG が伝送の開始と停止を繰り返します（ゲート・モード）。

トリガ信号は、正と負の信号遷移（ステート）からなります。これらはハイ周期およびロー周期とも呼ばれます。どちら

かのステートでトリガするよう PSG を設定できます。信号発生器が単一トリガだけを必要とするときでも、トリガが何度

も発生することがあります。この場合、PSG は最初のトリガ・イベントを認識し、残りを無視します。

トリガ・モードを選択するときには、変調信号をトリガするまで RF 出力から信号（搬送波と変調）が得られない可能性

があります。これは、PSG が、最初のトリガ・イベントの前に I 信号と Q 信号を 0 ボルトに設定するためです。これによ

り搬送波が抑制されます。初期 I 電圧および Q 電圧をゼロ以外の値に設定した状態でデータ・パターンを作成した場合、

これは起こりません。最初のトリガ・イベントの後、信号の最終 I レベルと Q レベルにより、搬送波信号が表示されるか

どうかが決まります（ゼロ = 搬送波なし、その他の値 = 搬送波を表示）。ほとんどのデータ・パターンの最後に、最終 I ポ
イントと Q ポイントがゼロ以外の値に設定されます。 

波形トリガの設定には 4 つのパートがあります。 

• ソースは、PSGが波形の再生を引き起こすトリガを受信する方法を決定します。

• モードは、波形が再生するときの波形の全体の動作を決定します。

• 応答は、波形がトリガに応答する方法のスペックを決定します。

デフォルト・マーカ極性=正

各マーカ極性を個別に設定できます。

参照 : 「マーカ極性とルーティング設定の保存」（86ページ）
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• 極性は、波形が応答するトリガのステートを決定します（外部トリガ・ソースの場合にのみ使用されます）。
負または正を設定できます。

信号源

モードおよび応答

任意波形プレーヤには 4 つのトリガ・ モードがあります。各モードには、1 つ以上の可能な応答があります。

• Single は、波形を 1 回再生します。任意波形フォーマットには、以下の再トリガ・オプションがあります。

— Off は、再生中に受信したトリガを無視します。再生が終了した後に受信したトリガによって再生がリスタートし

ます。

— On では、再生中にトリガを受信すると現在の再生が終了した後に波形が繰り返されます。

— Immediate では、再生中にトリガを受信すると即座に波形をリスタートします。

• Gated では、波形は、最初のアクティブ・トリガ信号ステートが伝送を開始するのを待ってから、外部供給ゲート信号

（101 ページの例）に応答して開始と停止を繰り返します。Gate Active Low High ソフトキーでアクティブ・ステートを

選択します（101 ページを参照）。

ARB フォーマットでは、波形は非アクティブ・ステート中に再生し、アクティブ・ステート中は停止します。

リアルタイム・カスタムでは、動作は信号にフレーム・データまたは非フレーム・データが含まれるかどうかに依存

します。 

PSG は非フレーム・データだけを提供するので、フレーム・データ信号を送信するにはフレーミングを含む外部ファ

イルを作成し、それを PSG にダウンロードする必要があります（『E8257D/67D PSG 信号発生器プログラミング・ガ

イド』を参照してください）。

— 非フレーム・データは、アクティブ・ステート中に送信され、非アクティブ・ステート中は停止します。信号は、

最後に送信されたシンボルで停止し、次のシンボルでリスタートします。

— フレーム・データは、アクティブ・ステート中にフレームの最初で送信を開始し、非アクティブ・ステート中に

終了に達すると、フレームの最後で停止します。フレームの最後が次のアクティブ・ステートまで延長される場

合、信号が連続して送信されます。 

Triggerハードキー

コマンドは、リアパネルのGPIB、LAN、または補助（RS-232）インタフェース経由で送信されます。

PATTERN TRIG INコネクタ、またはAUXILIARY I/OコネクタのPATT TRIG IN2 ピンの外部トリガ信号が使用さ

れます（コネクタの位置を18ページの図1-3に示します）。

以下のパラメータが外部トリガ信号に影響します。

• 外部トリガ信号のソース（入力コネクタ）（100 ページを参照）

• 外部トリガの極性（101 ページで説明）

• PSG が外部トリガを受信した時間と波形がそれに応答した時間との遅延（100 ページを参照）
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• Segment Advance（デュアル ARB のみ）では、シーケンスのセグメントに再生のためのトリガが必要です。再生中に

セグメントからセグメントへ移動する方法（103 ページの例）はトリガ・ソースで制御されます。最後のセグメント

中に受信したトリガが、再生をシーケンスの最初のセグメントにループします。セグメントが再生する方法として 2
つの選択肢があります。

— Single では、シーケンス内のセグメントを 1 回再生すると、停止してトリガを待ちます。トリガを受け取ると次

のセグメントに進み、セグメントを最後まで再生します。再生中にトリガを受信すると、現在のセグメントを終

了してから次のセグメントの再生に進み、セグメントを最後まで再生します。

— Continuous では、波形が別のトリガを受信するまでシーケンス内のセグメントを連続して再生します。再生中に

トリガを受信すると、現在のセグメントを終了してから次のセグメントの再生に進み、セグメントを連続して再

生します。

• Continuous は、信号をオフにするか、別の波形、トリガ・モード、応答を選択するまで波形を繰り返します。Continuous
には以下のオプションがあります。

— Free Run は、即座に波形をトリガして、再生します。再生中に受信したトリガは無視されます。

— Trigger & Run は、トリガを受信したときに波形を再生します。後続のトリガは無視されます。

— Reset & Run（リアルタイム・カスタムでは使用できません）は、トリガを受信したときに波形を再生します。後

続トリガによって波形がリスタートします。

トリガ・ユーティリティへのアクセス

以下の図に、トリガ・パラメータのメニューを示します。これらの図にはデュアル任意波形プレーヤを示しますが、すべ

ての ARB フォーマットで Trigger ソフトキーを使って、Real Time I/Q Baseband (Custom) フォーマットで Pattern Trigger
ソフトキーを使ってトリガ・ユーティリティにアクセスできます。

• トリガ・モードを表示するには、Mode > Dual ARB > Trigger を押します。

• あるトリガ・モードで使用可能な選択を表示するには、Trigger Setup を押し、目的のトリガ・モードを選択します。

ARB フォーマットで Single モードの選択を表示するには、Retrigger Mode を選択します。リアルタイム Custom で、

Single モードを選択すると、トリガされたときにデータ・パターンが 1 回再生されます。

• トリガ・ソースのオプションを表示するには、Trigger Setup > Trigger Source を押します。

Extを選択した

ときのみアクティブ

AUXILARY I/O コネクタの

PAT TRIG IN 2 ピン

PATTERN TRIG IN コネクタ
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外部トリガの極性の設定

ゲート・モード

ゲート・パラメータでは、外部トリガ信号のロー・ステートとハイ・ステートを設定できます。例えばハイを選択すると、

トリガ信号のハイ中にアクティブ・ステートが発生します。 

ARB フォーマット  アクティブ・ステートが発生すると、PSG は、最後に再生されたサンプル・ポイントで波形

ファイルの再生を停止し、非アクティブ・ステートが発生すると次のサンプル・ポイントで再

生をリスタートします。 

リアルタイム・カスタム  アクティブ・ステートが発生すると、PSG は、データ・パターンを送信します。非アクティブ・

ステートが発生すると、最後に送信されたシンボルで送信が停止し、アクティブ・ステートが

発生すると次のシンボルでリスタートします。 

連続、単一、セグメント・アドバンス・モード

Ext Polarity Neg Pos ソフトキーで、外部トリガのロー（負）ステートとハイ（正）ステートを選択できます。Neg を選択す

ると（デフォルト）、PSG は、トリガ信号のロー・ステート中に応答します。

ゲート・トリガの使用

ゲート・トリガにより、変調波形のオン（再生）・ステートとオフ・ステートを定義できます。この例では、セグメント

SINE_TEST_WFMを使用します。

1. 以下の図に示すように、ファンクション・ジェネレータの出力を信号発生器のリアパネル PATTERN TRIG IN に接続

します。 

この接続は、すべての外部トリガ方法に適用可能です。オシロスコープにより、トリガ信号が RF 出力に与える影響

を表示できます。

2. 本器を初期設定します。
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3. 搬送波信号出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

4. 再生用の波形（シーケンスまたはセグメント）を選択します。

a. 本器を初期設定します。

b. Mode > Dual ARB > Select Waveform を押します。

c. 波形ファイル（この例では SINE_TEST_WFM）を強調表示します。

d. Select Waveform を押します。

5. 波形トリガ方法を選択します。

a. Trigger > Gated を押します。

b. Trigger > Trigger Setup を押します。Gate Active Low High ソフトキーの場合、デフォルト選択は High です。この例

ではこの選択肢を使用します。

6. トリガ・ソースとリアパネル入力を選択します。

a. Trigger Source ソフトキーの場合、デフォルト選択は Ext です。この例ではこの設定を使用します（ゲート・トリ

ガには外部トリガが必要です）。 

b. Trigger Source を押します。Ext Source ソフトキーの場合、デフォルト選択は Patt Trig In 1 です。この例ではこの設

定を使用します。 

7. 波形を生成します。 

ARB Off On を押して On にします。

8. ファンクション・ジェネレータで、外部ゲート・トリガの TTL 信号を設定します。

9. （オプション）現在の波形をモニタします。

信号発生器の出力と外部トリガ信号を表示するようオシロスコープを設定します。ゲート非アクティブ周期（ロー）

中に出力を変調する波形が表示されます。

以下の図にサンプル・ディスプレイを示します。
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注記 リアルタイム・カスタム・モードでは、動作が逆になります。ゲート信号がハイのとき、変調された波形が表示

されます。

セグメント・アドバンス・トリガの使用

セグメント・アドバンス・トリガを使用すると、波形シーケンス内でセグメントの再生を制御できます。以下の例では、

2 つのセグメントを持つ波形シーケンスを使用します。

波形シーケンスをまだ作成していない場合は、セクションの「波形セグメントの作成」（80 ページ）と「波形シーケンス

の作成と保存」（81 ページ）を実行してください。

1. 本器を初期設定します。

2. RF 出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

3. 再生用の波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveform を押します。

b. 波形シーケンス・ファイルを強調表示します。

c. Select Waveform を押します。

4. 波形トリガ方法とトリガ・ソースを選択します。

a. Trigger > Segment Advance を押します。

b. Trigger > Trigger Setup を押します。Seg Advance Mode ソフトキーの場合、デフォルト選択（Continuous）が表示さ

れます。この例ではこの設定を使用します。

c. Trigger Source > Trigger Key を押します。

外部供給ゲート信号

ゲート・アクティブ = ハイ

RF出力変調波形
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5. 波形シーケンスを生成します。

Return > Return > ARB Off On を押して On にします。

6. 最初の波形セグメントをトリガして再生を繰り返し開始します。 
Trigger ハードキーを押します。

7. （オプション）現在の波形をモニタします。

信号発生器の出力をオシロスコープの入力に接続し、信号発生器の出力を表示できるようにオシロスコープを設定し

ます。

8. 2 番目のセグメントをトリガします。 
Trigger ハードキーを押します。

シーケンスの 2 番目のセグメントが再生されます。Trigger ハードキーを押すと、現在の再生が終了し、次のセグメン

トが開始します。最後のセグメントが再生されているときに Trigger ハードキーを押すと、現在のセグメントの終了後

に波形シーケンスの最初のセグメントが開始します。

波形クリッピングの使用 

高いパワー・ピークを持つ波形からは相互変調歪みが生じ、スペクトラム・リグロースの原因となることがあります（こ

の条件では隣接周波数帯域の信号との干渉が生じます）。クリッピング機能を使えば、I および Q データの最高ピークを指

定したパーセンテージまでクリッピングすることにより、高パワー・ピークを下げることができます。 

クリッピング機能はデュアル任意波形モードでのみ使用できます。 

パワー・ピークが生じる仕組み

クリッピングにより高いパワー・ピークが下がる理由を理解するには、信号が構築されるときにどのようにピークが生じ

るかを知っておくことが重要です。

I/Q 波形は複数のチャネルが加算されている場合があります（図 3-10 参照）。各チャネルの波形のほとんどまたはすべて

が同時に同じステート（ハイまたはロー）のビットを持つ場合、異常に高いパワー・ピーク（正または負）が加算された

波形に現れます。ただし、このようなことはまれにしか起きません。各チャネル波形のビットのハイとローのステートは

ランダムなので、通常は打ち消し合うからです。
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図 3-10 複数チャネルの加算

I と Q の波形は I/Q 変調器で組み合わされて 1 つの RF 波形になります。この RF エンベロープの振幅は、式 で決

まります。ここで、I と Q の 2 乗は常に正の値です。 

図 3-11 に示すように、I と Q の波形に同時に正と負のピークがあると、これらは打ち消し合わず、組み合わされてさらに

大きいピークを生じます。
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図 3-11 組み合わされる IとQの波形

ピークからスペクトラム・リグロースが生じる仕組み

高いパワー・ピークは比較的まれなので、波形のピーク・アベレージ・パワー比は大きい値になります（図 3-12 参照）。

トランスミッタのパワー・アンプ利得は特定の平均パワーを供給するように設定されているので、高いピークが来るとパ

ワー・アンプが飽和します。これにより相互変調歪みが生じ、スペクトラム・リグロースの原因となります。
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図 3-12 ピーク・アベレージ・パワー比

スペクトラム・リグロースとは、搬送波の両側に生じる周波数範囲（側波帯に類似）で、隣接する周波数帯域まで延びて

います（図 3-13 参照）。このため、スペクトラム・リグロースは隣接帯域の通信に干渉します。この問題を解決するため

にはクリッピングが有効です。

図 3-13 スペクトラム・リグロースと隣接帯域の干渉

クリッピングがピーク・アベレージ・パワー比を低下させる仕組み

ピーク・パワーに対するパーセンテージを指定して波形をクリッピングすることにより、ピーク・アベレージ・パワー比

を低下させ、スペクトラム・リグロースを減らすことができます。PSG ベクトル信号発生器には、円形と方形の 2 つのク

リッピング方法が用意されています。

円形クリッピングでは、I と Q の複合波形（|I ＋ jQ|）にクリッピングが適用されます。図 3-14 からわかるように、ク

リッピング・レベルはベクトル表現のすべての位相に対して一定であり、円を描きます。これに対して方形クリッピング

では、I と Q の波形に独立に（|I| と |Q|）クリッピングが適用されます。109 ページの図 3-15 からわかるように、I と Q
のクリッピング・レベルは異なっています。このため、ベクトル表現では長方形になります。どちらの方法でも、スペク

トラム・リグロースを有効に減少させながら、信号の品質を損なわないレベルに波形をクリッピングすることが目標とな
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ります。110 ページの図 3-16 では、2 つの相補累積分布プロットを使って、波形に円形クリッピングを適用した後のピー

ク・アベレージ・パワー比の低下を示しています。

クリッピング値を小さくするほど、通過するピークのパワーは低くなります（すなわち、より多くの信号がクリッピング

されます）。多くの場合、ピークをクリッピングしても、波形の残りの部分には有意な干渉を起こさずに済みます。クリッ

ピングによって失われるはずのデータは、コード化システムに内在するエラー訂正機能によって復元されます。しかし、

クリッピングされる波形の部分が多すぎると、失われたデータが復元できなくなります。適切なパーセンテージが見つか

るまで、いくつかのクリッピング設定を試してみる必要があります。

図 3-14 円形クリッピング
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図 3-15 方形クリッピング
第3章 109



基本デジタル操作
波形クリッピングの使用
図 3-16 ピーク・アベレージ・パワー比の低下

円形クリッピングの設定

この手順では、円形クリッピングを設定する方法を説明します。円形設定は、コンポジット I/Q データをクリッピングし

ます（I と Q のデータが同じだけクリッピングされます）。円形クリッピングの詳細については、「クリッピングがピーク・

アベレージ・パワー比を低下させる仕組み」（107 ページ）を参照してください。

1. Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On を押して On にします。これにより、この

手順で使用するカスタム任意波形が生成されます。前に保存した波形またはダウンロードした波形も使用できます。
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2. Mode > Dual ARB > Select Waveform を押し、表示で AUTOGEN_WAVEFORM が強調表示されていることを確認します。

AUTOGEN_WAVEFORM は、前のステップで生成した波形に割り当てられたデフォルト名です。

3. Select Waveform を押します。これにより波形が選択され、前のソフトキー・メニューに戻ります。

4. ARB Off On を押して On にします。以下のステップで CCDF プロットを表示するには、デュアル任意波形プレーヤを

オンにする必要があります。

5. ARB Setup > Waveform Utilities > Waveform Statistics を押し、表示で AUTOGEN_WAVEFORMが強調表示されていることを

確認します。 

6. CCDF Plot を押し、一番暗いラインである波形の曲線の位置を観察します。

7. Return > Return > Clipping を押します。

8. Clipping Type |I+jQ| |I|,|Q| ソフトキーを |I+jQ|（円形クリッピング）に設定します。

9. Clip |I+jQ| To > 80 > % > Apply to Waveform を押します。I と Q のデータがともに 80% クリッピングされます。クリッ

ピングを波形に適用すると、それをやり直すことはできません。クリッピング機能を繰り返し使用するたびに、波形

への影響が累積されます。

10. Waveform Statistics > CCDF Plot を押し、波形の曲線を観察します。クリッピングを適用すると、前のプロットと比較し

てピーク・アベレージ・パワー比が低下します。 

方形クリッピングの設定

この手順では、方形クリッピングを設定する方法を説明します。方形設定は、I データと Q データを独立にクリッピング

します。方形クリッピングの詳細については、「クリッピングがピーク・アベレージ・パワー比を低下させる仕組み」（107
ページ）を参照してください。

1. Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On を押して On にします。これにより、この

手順で使用するカスタム任意波形が生成されます。前に保存した波形またはダウンロードした波形も使用できます。

2. Mode > Dual ARB > Select Waveform を押し、表示で AUTOGEN_WAVEFORM が強調表示されていることを確認します。

AUTOGEN_WAVEFORM は、前のステップで生成した波形に割り当てられたデフォルト名です。

3. Select Waveform を押します。これにより波形が選択され、前のソフトキー・メニューに戻ります。

4. ARB Off On を押して On にします。以下のステップで CCDF プロットを表示するには、デュアル任意波形プレーヤを

オンにする必要があります。

5. ARB Setup > Waveform Utilities > Waveform Statistics を押し、表示で AUTOGEN_WAVEFORMが強調表示されていることを

確認します。 

6. CCDF Plot を押し、一番暗いラインである波形の曲線の位置を観察します。

7. Return > Return > Clipping を押します。

8. Clipping Type |I+jQ| |I|,|Q| ソフトキーを |I|,|Q| に設定します。これにより、Clip |I| To と Clip |Q| To の 2 つのソフト

キーがアクティブになり、I と Q のデータの方形（独立）クリッピングが可能になります。

9. Clip |I| To > 80 > % を押します。

10. Clip |Q| To > 40 > % > Apply to Waveform を押します。I と Q のデータが独立に、それぞれ 80% と 40% にクリッピング

されます。クリッピングを波形に適用すると、それをやり直すことはできません。クリッピング機能を繰り返し使用

するたびに、波形への影響が累積されます。
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11. Waveform Statistics > CCDF Plot を押し、波形の曲線を観察します。クリッピングを適用すると、前のプロットと比較し

てピーク・アベレージ・パワー比が低下します。 

波形スケーリングの使用

波形スケーリングは、DAC オーバレンジ・エラーを除去するために使用されます。PSG では 2 つの波形スケーリング方法

が用意されています。現在再生中の波形をリアルタイムでスケーリング調整できるランタイム・スケーリングと揮発性メ

モリに存在する再生中でない波形ファイルを永久的にスケーリングする方法です。このセクションでは、DAC オーバレン

ジ・エラーが発生する仕組みと波形スケーリングを使ってこれらのエラーを効率的に除去する方法について説明します。

スケーリング機能はデュアル任意波形モードでのみ使用できます。

DACオーバレンジ・エラーが発生する仕組み

PSG は、デジタル I/Q ベースバンド波形をアナログ波形に変換する際、補間器フィルタを使用します。補間器のクロック

周波数は、ベースバンド・クロックの 4 倍です。このため補間器は、より高速のクロック周波数と等しくなるように入力

ベースバンド・サンプル間のサンプル・ポイントを計算し、波形をスムースにして外観をより曲線に近づけます（図 3-17
参照）。

図 3-17 波形補間

DAC の補間フィルタにはオーバシュートがあります。ベースバンド波形に高速立ち上がりエッジがある場合、補間フィル

タのオーバシュートまたは周波数応答が、補間されたベースバンド波形の成分となります。この応答により、立ち上がり

エッジのピークでリップルまたはリンギングが起こります。このリップルが DAC の範囲の上限値を超える（またはオー

バシュートする）場合、補間器がエラーのあるサンプル・ポイントを計算しますが、リップルの真の形状を複製できませ

ん（図 3-18 参照）。このため、PSG が DAC オーバレンジ・エラーを表示します。
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図 3-18 波形オーバシュート

スケーリングでDACオーバレンジ・エラーが除去される仕組み

スケーリングは、ピーク・アベレージ・パワー比などその基本形状や特性を維持したまま、ベースバンド波形の振幅を減

少または縮小します。高速立ち上がりベースバンド波形が十分にスケーリングされ、オーバシュートに対するマージンが

適切になれば、補間器フィルタがリップル効果を含むサンプル・ポイントを計算できるので、オーバレンジ・エラーが除

去されます（図 3-19 参照）。

図 3-19 波形スケーリング
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スケーリングでは波形の基本形状が保持されますが、あまりスケーリングしすぎると、ビット分解能が低下しすぎて波形

が量子化ノイズによって破壊される可能性があるため、信号の品質が損なわれます。最大の確度と最適なダイナミック・

レンジを実現するため、波形のスケーリングは DAC オーバレンジ・エラーの除去に必要な程度にとどめます。最適なス

ケーリングは波形成分によって異なります。

現在再生中の波形のスケーリング（ランタイム・スケーリング）

この手順では、現在再生中の波形に対してリアルタイムのスケーリング調整を実行できます。このタイプのスケーリング

は波形ファイルに影響しません。DAC オーバレンジ・エラーの除去に最適です。

1. Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On を押して On にします。これにより、この

手順で使用するカスタム任意波形が生成されます。前に保存した波形またはダウンロードした波形も使用できます。

2. Mode > Dual ARB > Select Waveform を押し、表示で AUTOGEN_WAVEFORM が強調表示されていることを確認します。

AUTOGEN_WAVEFORM は、前のステップで生成した波形に割り当てられたデフォルト名です。

3. Select Waveform を押します。これにより波形が選択され、前のソフトキー・メニューに戻ります。

4. ARB Off On を押して On にします。これにより選択された波形が再生されます。

5. ARB Setup > More (1 of 2) > Waveform Runtime Scaling を押し、フロントパネル・ノブを調整するか、数字キーを使って

新しい値を入力します。新しいスケーリング値が再生中の波形に即座に適用されます。値は常に波形ファイルの元の

振幅を基準とするため、ランタイム・スケーリング調整は累積されません。

揮発性メモリの波形ファイルのスケーリング

この手順では、波形ファイルを永久的にスケーリングできます。スケーリングした波形セグメントを不揮発性メモリに保

存して後で使用することができます。スケーリングは累積され、やり直すことはできません。

1. Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On を押して On にします。これにより、この

手順で使用するカスタム任意波形が生成されます。前に保存した波形またはダウンロードした波形も使用できます。

2. Mode > Dual ARB > Select Waveform を押し、表示で AUTOGEN_WAVEFORM が強調表示されていることを確認します。

AUTOGEN_WAVEFORM は、前のステップで生成した波形に割り当てられたデフォルト名です。

3. Select Waveform を押します。これにより波形が選択され、前のソフトキー・メニューに戻ります。

4. ARB Setup > Waveform Utilities を押し、表示で AUTOGEN_WAVEFORMが強調表示されていることを確認します。

5. Scale Waveform Data > Scaling > 70 > % > Apply to Waveform を押します。波形は、元の振幅の 70 パーセントに減少しま

す。このタイプのスケーリングを波形に適用すると、それをやり直すことはできません。スケーリングを繰り返すた

びに、波形への影響が累積されます。
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この章は以下のセクションに分かれており、Agilent PSG 信号発生器の性能を改善する手順を説明します。

• 「ALCの使用」（115ページ）

• 「外部レベリングの使用」（116ページ）

• 「ユーザ・フラットネス補正の作成と適用」（119ページ）

• 「基準発振器帯域幅の調整（オプションUNR）」（130ページ）

ALCの使用

ALC帯域幅の選択

内部レベリングを使用する場合、RF 出力の前に自動レベル制御（ALC）回路が適用されます。ALC の帯域幅は、自動、

100 Hz、1 kHz、10 kHz、100 kHz の 5 種類から選択できます。自動モード（初期設定状態）では、構成と設定に応じて

ALC 帯域幅が自動的に選択されます（図 4-1 を参照）。

図 4-1 自動ALC帯域幅選択の決定手順

ALC帯域幅を選択する手順

Amplitude > ALC BW > 100 Hz, 1 kHz, 10 kHz, 100 kHz を押します。 
これにより、選択した帯域幅が用いられ、自動 ALC 帯域幅選択はオフになります。

振幅が変動する波形やクレスト・ファクタが大きい波形に対しては、100 Hz の ALC ループ帯域幅が適しています。ALC
回路のループ帯域幅を制限すると、802.11b、CDMA、OFDM などのフォーマットに見られる大きいクレスト・ファクタ

RF 出力
< 2 MHz

AM OFF
PULSE OFF

AM OFF
PULSE ON

AM ON
PULSE ON

AM ON
PULSE OFF

ALC BW
100 Hz

ALC BW
1 kHz

ALC BW
10 kHz

いいえ いいえ いいえ

はい はい はい はい

ALC BW
 100 kHz

ARB On

はい

いいえ
いいえ

はい
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のパルス波形の高速な立ち上がりエッジを ALC がサンプリングしなくなります。帯域幅を狭く制限することにより、ALC
サンプル時間が短くなり、信号のレベルをより正確に表現できます。 

注記 10 kHzのALC帯域幅は、I/Q変調信号に対しては使用しないでください。ALC積分時間が短すぎるからです。

CW信号の場合、大きいALC帯域幅を使用してもかまいません。 

外部レベリングの使用

PSG 信号発生器の外部レベリングを行うには、レベリングされた RF 出力が必要となるポイントに、外部センサを接続し

ます。センサは RF 出力パワーの変化を検出し、信号発生器の ALC 入力に補正電圧を返します。外部センサから入力され

た電圧に応じて ALC 回路が RF 出力パワーを増減（レベリング）することにより、検出ポイントでのパワーが一定に保た

れます。

PSG では 2 種類の外部レベリングが使用可能です。1 つはディテクタとカプラ／パワー・スプリッタを使う方法、もう 1
つはミリ波信号源モジュールを使用する方法です。

ディテクタとカプラ／パワー・スプリッタを使ったレベリング

図 4-2 は、外部レベリングの代表的セットアップです。ALC 回路へのパワー・レベリング・フィードバックは、信号発生

器の内部ディテクタではなく、外部ネガティブ・ディテクタから取られます。このフィードバック電圧は ALC システムを

制御し、検出ポイントでの RF 出力パワーをレベリングする役割を果たします。

このセクションの手順を実行することにより、ディテクタとカプラ / スプリッタを使って、RF 出力を周波数 10 GHz、振

幅 0 dBm に外部レベリングすることができます。

必要機器

• Agilent 8474Eネガティブ・ディテクタ

• Agilent 87301D方向性結合器

• 必要なケーブルとアダプタ

機器の接続

機器を図 4-2 のように準備します。

図 4-2 方向性結合器を使った外部ディテクタ・レベリング
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信号発生器の設定

1. Preset を押します。

2. Frequency > 10 > GHz を押します。

3. Amplitude > 0 > dBm を押します。

4. RF On/Off を押します。

5. Leveling Mode > Ext Detector を押します。

これにより、内部 ALC ディテクタがオフになり、ALC 入力がフロントパネルの ALC INPUT コネクタに切り替わりま

す。ディスプレイの AMPLITUDEエリアにある EXTインジケータがオンになります。

注記 オプション1E1の付いた信号発生器の場合、ATTN HOLD（アッテネータ・ホールド）インジケータが表示されま

す。外部レベリング中には、すべての外部レベリング・ポイントに対して、アッテネータがALCシステムから

自動的に切り離されます。このモードでのRF出力の振幅調整は、ALC回路の調整範囲である－20～＋25 dBm
に制限されます。詳細については、「オプション1E1付き信号発生器を使った外部レベリング」（118ページ）を

参照してください。

6. 方向性結合器のディテクタ・ポートに印字されている結合係数を読み取ります。一般的な値は－10～－20 dB程度で

す。

この値を正の dB 値で信号発生器に入力します。

7. More (1 of 2) > Ext Detector Coupling Factor > 16（実際には方向性結合器のディテクタ・ポートに記載されている値を正

に直したもの）> dB を押します。

これで、方向性結合器の出力にレベリング出力パワーが供給されます。

注記 外部レベリング・モードで動作している場合、信号発生器に表示されるRF出力振幅は結合係数の値によって変

化します。 これは、実際のRF出力振幅の近似値を計算して表示しているためです。検出ポイントでの実際のRF
出力振幅を知るには、外部ディテクタ出力の電圧を測定して図4-3を参照するか、パワー・メータを使って直接

パワーを測定してください。

レベリング出力パワーの測定

図4-3は、代表的なAgilent Technologies製ダイオード・ディテクタの入力パワー対出力電圧特性です。この図を使えば、

外部ディテクタ出力電圧を測定することにより、ダイオード・ディテクタ入力におけるレベリング・パワーを求めること

ができます。レベリング出力パワーを得るにはこれに結合係数を加算します。パワー調整のレンジは約－20～＋25 dBで

す。
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図 4-3 代表的なダイオード・ディテクタの25℃での応答

オプション1E1付き信号発生器を使った外部レベリング

オプション1E1付きの信号発生器は、RF出力コネクタの前にステップ・アッテネータを装備しています。外部レベリング

中は、RF振幅が変化しても現在のアッテネータ設定が自動的に保持されます（アッテネータの切替えに伴うパワーの過渡

応答を避けるため）。必要なRF出力振幅を得るには、減衰量と最適なALCレベルとの間のバランスを維持しなければなり

ません。確度を最高にし、雑音を最小限に抑えるには、ALCレベルを－10 dBmより上にする必要があります。
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例えば、利得30 dBの増幅器のCW出力を－10 dBmにレベリングするには、信号発生器の出力がレベリング時に約－40
dBmでなければなりません。これはALC変調器単体の振幅限界を超えているため、RF出力がレベリングなしになります。

45 dBの減衰を入れれば、ALCレベルは＋5 dBmとなり、ALC変調器のレンジ内に十分入ります。

注記 上の例では、減衰量としては55 dBが適切であり、ALCレベルは＋15 dBmとなります。これにより、RF出力振

幅を変化させるAMなどの機能に対して十分なダイナミック・レンジを確保できます。

信号発生器のRF出力が－40 dBmで非変調搬送波を使用する場合の最適なALCレベルの設定手順を以下に示します。

1. Amplitude > Set Atten > 45 > dB を押します。

2. Set ALC Level > 5 > dBm を押します。 

これにより、アッテネータが45 dB、ALCレベルが＋5 dBmに設定され、RF出力振幅は－40 dBmとなります。 この値は

ディスプレイのAMPLITUDEエリアに表示されます。

フラットネス補正されたパワーを得る方法については、「ユーザ・フラットネス補正の作成と適用」（119 ページ）を参照

してください。

ミリ波信号源モジュールによるレベリング

ミリ波信号源モジュールによるレベリングは、外部ディテクタによるレベリングと似ています。ALC 回路へのパワー・レ

ベル・フィードバック信号は、信号発生器の内部ディテクタではなく、ミリ波信号源モジュールから取られます。この

フィードバック信号は、信号発生器のリアパネルにある SOURCE MODULE インタフェース・コネクタを通じて、ミリ波

信号源モジュールの出力における RF 出力パワーをレベリングします。

手順とセットアップについては、第 11 章「周辺機器」（197 ページ）を参照してください。

ユーザ・フラットネス補正の作成と適用

ユーザ・フラットネス補正は、1601 個までの周波数ポイントでの RF 出力振幅をデジタル調整できる機能で、任意の周波

数または掃引モードで使用できます。Agilent E4416A/17A または E4418B/19B パワー・メータ（GPIB 経由で本器から制

御）を使って測定システムを校正することにより、パワー・レベルの変動や損失が発生する周波数に対してパワー・レベ

ル補正テーブルを作成します。これらの周波数は、連続した直線的ステップで定義することも、任意の間隔で定義するこ

ともできます。 

テスト・セットアップや周波数レンジに応じて異なる補正配列を使用するために、個々のユーザ・フラットネス補正テー

ブルを本器のメモリ・カタログに保存し、必要に応じてリコールすることもできます。

次のセクションの手順を実行することにより、本器の RF 出力に対するユーザ・フラットネス補正を作成して適用するこ

とができます。

その後で、「ユーザ・フラットネス補正配列のリコールと適用」（123 ページ）の手順を実行することにより、メモリ・カ

タログからフラットネス・ファイルをリコールして、本器の RF 出力に適用することができます。
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ユーザ・フラットネス補正配列の作成

この例では、ユーザ・フラットネス補正配列を作成します。フラットネス補正配列には、1 GHz から 10 GHz まで 1 GHz
間隔の 10 個の周波数補正ペア（指定した周波数での振幅補正値）が含まれます。 

Agilent E4416A/17A/18B/19B パワー・メータ（GPIB 経由で信号発生器から制御）と E4413A パワーセンサを使って、指

定した補正周波数での RF 出力振幅を測定し、結果を本器に転送します。信号発生器はパワー・レベル・データをパワー・

メータから読み取り、補正値を計算し、補正ペアをユーザ・フラットネス補正配列に保存します。

必要な Agilent パワー・メータがない場合、あるいはパワー・メータに GPIB インタフェースがない場合、補正値を手動

で入力することもできます。 

必要機器

• Agilent E4416A/17A/18B/19Bパワー・メータ

• Agilent E4413A EシリーズCWパワーセンサ

• GPIBインタフェース・ケーブル

• 必要なアダプタとケーブル

注記 外部レベリング構成を使用する場合、図4-4の機器セットアップでは、RF出力を正しくレベリングするための手

順が済んでいるものと仮定しています。外部レベリングに関して不明な点がある場合は、「外部レベリングの使

用」（116ページ）を参照してください。

パワー・メータの設定

1. パワー・メータのリモート言語として SCPI を選択します。

2. パワー・メータに対するパワーセンサのゼロ調整と校正を実行します。

3. 適切なパワーセンサ校正係数をパワー・メータに入力します。

4. パワー・メータの校正係数配列を有効にします。

注記 お使いのパワー・メータ/センサの操作方法については、それぞれの操作ガイドを参照してください。

機器の接続

図 4-4 のように機器を接続します。

注記 ユーザ・フラットネス補正配列の作成中には、パワー・メータはGPIB経由で信号発生器から制御されます。GPIB
インタフェース上に他のコントローラが存在することはできません。
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図 4-4 ユーザ・フラットネス補正の機器セットアップ

信号発生器の設定

1. Preset を押します。

2. パワー・メータとのインタフェースが可能なように信号発生器を設定します。

a. Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, E4417A, E4418B, E4419B を押します。

b. Meter Address > パワー・メータの GPIB アドレス > Enter を押します。

c. E4417A および E4419B モデルの場合、Meter Channel A B を押してパワー・メータのアクティブ・チャネルを選択

します。

d. Meter Timeout を押して、パワー・メータと通信できない場合に本器がタイムアウト・エラーを発生するまでの時

間を設定します。

3. More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset を押します。

これにより、ユーザ・フラットネス・テーブル・エディタがオープンし、校正配列の周波数／補正値リストが初期設

定されます。

4. Configure Step Array を押します。

ユーザ・フラットネス・ステップ配列データを入力するためのメニューがオープンします。

5. Freq Start > 1 > GHz を押します。

6. Freq Stop > 10 > GHz を押します。
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7. # of Points > 10 > Enter を押します。

ステップ 4、5、6 では、フラットネス補正の対象とする周波数をステップ配列に入力しています。

8. Return > Load Cal Array From Step Array > Confirm Load From Step Data を押します。

これにより、ステップ配列で定義した周波数設定がユーザ・フラットネス補正配列に設定されます。

9. Amplitude > More (1 of 2) > Ampl Offset を押します。

本器の RF 出力とパワーセンサの間に接続されるケーブルやその他のデバイスの利得または損失の公称（平均）値を

入力します。図 121 ページの図 4-4 を参照してください。利得は正の数、損失は負の数で入力します。 

10. RF On/Off を押します。

これにより RF 出力がオンになり、RF ONインジケータが表示されます。

ユーザ・フラットネス補正の実行

注記 Agilent E4416A/17A/18B/19Bパワー・メータを使用しない場合、あるいはパワー・メータにGPIBインタフェー

スがない場合、手動でユーザ・フラットネス補正を実行することもできます。手順については、「ユーザ・フラッ

トネス補正の手動実行」（122ページ）を参照してください。

1. More (1 of 2) > User Flatness > Do Cal を押します。

Do Cal ソフトキーを押すと、ユーザ・フラットネス補正ルーチンが実行されます。ルーチンの実行中にはフロント・

パネルに進捗度バーが表示されます。このルーチンは補正ポイントの表を作成します。各補正ポイントは、その周波

数に対する周波数と振幅の補正値から構成されます。各ポイントの補正値は、パワー・メータが測定したパワー・レ

ベルと、本器の出力パワーとの差です。 

注記 パワー・レベルが低い場合、パワー・メータのタイムアウトが発生することがあります。パワー・メータのタイ

ムアウト・エラー・メッセージが表示された場合、Amplitude  > More (1 of 2) > User Flatness > More (1 of 2) > Meter
Timeoutを押してタイムアウト値を大きくしてください。

2. Done を押します。

Done ソフトキーを押すと、ユーザ・フラットネス補正配列に振幅補正値がロードされます。

必要なら Configure Cal Array を押します。

これにより、ユーザ・フラットネス補正配列がオープンし、保存された振幅補正値を見ることができます。ユーザ・

フラットネス補正配列のタイトルには User Flatness: (UNSTORED) と表示されます。 これは、現在のユーザ・フ

ラットネス補正配列データがメモリ・カタログに保存されていないことを示します。

ユーザ・フラットネス補正の手動実行

Agilent E4416A/17A/18B/19B パワー・メータを使用しない場合、あるいはパワー・メータに GPIB インタフェースがな

い場合、このセクションの手順を実行した後、ユーザ・フラットネス補正のチュートリアルに進んでください。
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1. More (1 of 2) > User Flatness > Configure Cal Array を押します。

これにより、ユーザ・フラットネス・テーブル・エディタがオープンし、行 1 の周波数値

（1 GHz）にカーソルが置かれます。RF 出力の周波数が、カーソルが置かれているテーブル行の周波数に変わり、ディ

スプレイの AMPLITUDEエリアに 1.000 000 000 00と表示されます。 

2. パワー・メータの測定値を読み取って記録します。

3. 0 dBm から測定値を減算します。

4. テーブルのカーソルを行 1 の補正値に移動します。

5. Edit Item > ステップ 3 で計算した差を入力 > dB を押します。

入力した補正値に基づいて、RF 出力振幅が調整されます。

6. パワー・メータの表示値が 0 dBm になるまでステップ 2 ～ 5 を繰り返します。

7. 下矢印キーを押して、次の行の周波数値にカーソルを移動します。RF 出力の周波数が、カーソルが置かれているテー

ブル行の周波数に変わり、ディスプレイの AMPLITUDEエリアにその値が表示されます。 

8. ユーザ・フラットネス補正テーブルのすべてのエントリに対してステップ 2 ～ 7 を繰り返します。

ユーザ・フラットネス補正データのメモリ・カタログへの保存

このプロセスでは、ユーザ・フラットネス補正データを本器のメモリ・カタログに保存します。複数のユーザ・フラット

ネス補正ファイルをメモリ・カタログに保存しておいて、任意のファイルをリコールし、補正配列にロードして RF 出力

に適用することで、RF 出力の特定のフラットネス要件を満たすことができます。

1. Load/Store を押します。

2. Store to File を押します。

3. 英数字ソフト・キー、テンキー、またはノブを使って、ファイル名 FLATCAL1を入力します。

4. Enter を押します。

これにより、ユーザ・フラットネス補正配列ファイル FLATCAL1がUFLTファイルとしてメモリ・カタログに保存されます。

ユーザ・フラットネス補正配列の適用

Return > Return > Flatness Off On を押して On にします。

これにより、ユーザ・フラットネス補正配列が RF 出力に適用されます。本器のディスプレイの AMPLITUDEセクションに

UFインジケータが表示され、補正配列内の周波数補正データが RF 出力振幅に適用されます。

ユーザ・フラットネス補正配列のリコールと適用

このセクションの手順を実行する前に、「ユーザ・フラットネス補正配列の作成」（120 ページ）の手順を実行してください。

1. Preset を押します。

2. Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset を押します。

3. More (2 of 2) > Load/Store を押します。
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4. ファイル FLATCAL1が強調表示されていることを確認します。

5. Load From Selected File > Confirm Load From File を押します。

これにより、ファイル FLATCAL1 に保存されているデータがユーザ・フラットネス補正配列にロードされます。ユー

ザ・フラットネス補正配列のタイトルには User Flatness: FLATCAL1と表示されます。

6. Return > Flatness Off On を押して On にします。

これにより、FLATCAL1に記録されているユーザ・フラットネス補正データが適用されます。

信号発生器をGPIBリスナ・モードに戻す

ユーザ・フラットネス補正中には、パワー・メータは GPIB 経由で信号発生器から制御されます。 GPIB インタフェース上

に他のコントローラが存在することはできません。信号発生器は GPIB のトーカ・モードで動作し、パワー・メータに対

するデバイス・コントローラの役割を果たします。この動作モードでは、信号発生器が GPIB 経由で SCPI コマンドを受

信することはできません。

ユーザ・フラットネス補正を実行した後で本器をリモート・コントローラにつなぐ場合、本器の GPIB コントローラ・モー

ドを GPIB トーカから GPIB リスナに変更する必要があります。

RF 搬送波を設定してある場合、現在の機器ステートを保存してから本器を GPIB リスナ・モードに戻します。

1. 現在の機器ステートを機器ステート・レジスタに保存します。

手順については、「機器ステートの保存」（53 ページ）を参照してください。

2. Amplitude > More (1 of 2) > User Flatness > GPIB Listener Modeを押します。

これにより本器が初期設定され、GPIB リスナ・モードに戻ります。本器は、GPIB インタフェースに接続されたリ

モート・コントローラで実行されるリモート・コマンドを受信できるようになります。

3. 機器ステート・レジスタから機器ステートをリコールします。

手順については、「機器ステートの保存」（53 ページ）を参照してください。

ミリ波信号源モジュールによるユーザ・フラットネス補正配列の作成

この例では、ユーザ・フラットネス補正配列を作成することにより、E8257D 信号発生器から駆動される Agilent 83554A
ミリ波信号源モジュールの出力パワーをフラットネス補正します。 

フラットネス補正配列には、26.5 GHz から 40 GHz まで 500 MHz 間隔の 28 個の周波数補正ペア（指定した周波数での振

幅補正値）が含まれます。これにより、83554A ミリ波信号源モジュールから、26.5 GHz ～ 40 GHz の範囲で等間隔に配

置された 28 個のフラットネス補正済み周波数を出力できます。

Agilent E4416A/17A/18B/19B パワー・メータ（GPIB 経由で信号発生器から制御）と R8486A パワーセンサを使って、指

定した補正周波数でのミリ波信号源モジュールの RF 出力振幅を測定し、結果を信号発生器に転送します。信号発生器は

パワー・レベル・データをパワー・メータから読み取り、補正値を計算し、補正ペアをユーザ・フラットネス補正配列に

保存します。

必要な Agilent パワー・メータがない場合、あるいはパワー・メータに GPIB インタフェースがない場合、補正値を手動

で入力することもできます。 
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注記 ユーザ・フラットネス補正が使用できるのはAgilent 83550シリーズ・ミリ波信号源モジュールだけであり、OML
モジュールなどの他のミリ波モジュールでは使用できません。

必要機器

• Agilent 83554Aミリ波信号源モジュール

• Agilent E4416A/17A/18B/19Bパワー・メータ

• Agilent R8486Aパワーセンサ

• Agilent 8349Bマイクロ波増幅器（オプション1EAなしの信号発生器に必要）

• GPIBインタフェース・ケーブル

• 必要なアダプタとケーブル

注記 図4-5と図4-6の機器セットアップでは、RF出力を正しくレベリングするための手順が済んでいるものと仮定し

ています。ミリ波信号源モジュールを使ったレベリングに関して不明な点がある場合は、「ミリ波信号源モジュー

ルによるレベリング」（119ページ）を参照してください。

パワー・メータの設定

1. パワー・メータのリモート言語として SCPI を選択します。

2. パワー・メータに対するパワーセンサのゼロ調整と校正を実行します。

3. 適切なパワーセンサ校正係数をパワー・メータに入力します。

4. パワー・メータの校正係数配列を有効にします。

注記 お使いのパワー・メータ/センサの操作方法については、それぞれの操作ガイドを参照してください。

機器の接続

注意 信号発生器の損傷を避けるため、リアパネルのSOURCE MODULEインタフェース・コネクタに信号源モ

ジュール・インタフェース・ケーブルを接続する前に、信号発生器の電源をオフにしてください。

1. 信号発生器の電源をオフにします。

2. 機器を接続します。標準の信号発生器の場合、図 4-5 のセットアップを使用します。オプション 1EA 信号発生器の場

合、図 4-6 のセットアップを使用します。

注記 ユーザ・フラットネス補正配列の作成中には、パワー・メータはGPIB経由で信号発生器から制御されます。GPIB
インタフェース上に他のコントローラが存在することはできません。
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図 4-5 オプション1EAなしの信号発生器の場合のミリ波信号源モジュールを使ったユーザ・

フラットネス補正
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図 4-6 ミリ波信号源モジュールとオプション1EA付き信号発生器を使ったユーザ・フラットネス補正

注記 オプション1EA付きの信号発生器からミリ波信号源モジュールのRF入力に十分なRF振幅を供給するためには、

本器のRF出力とミリ波信号源モジュールのRF入力との間にあるアダプタとケーブルによる最大振幅損失が1.5
dB未満でなければなりません。

信号発生器の設定

1. 信号発生器の電源をオンにします。電源投入時に、信号発生器は自動的に下記の動作を実行します。

• ミリ波信号源モジュールを検出します。

• 信号発生器のレベリング・モードを外部/信号源モジュールに切り替えます。

• ミリ波信号源モジュールの周波数と振幅を信号源モジュールのプリセット値に設定します。

• ミリ波信号源モジュールから出力されるRF出力周波数および振幅を表示します。

信号発生器ディスプレイの FREQUENCYエリアにある MMMODインジケータと、AMPLITUDEエリアにある MMインジケー

タは、ミリ波信号源モジュールがアクティブであることを示しています。

注記 具体的な周波数／振幅レンジについては、ミリ波信号源モジュールの仕様を参照してください。
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2. パワー・メータとのインタフェースが可能なように信号発生器を設定します。

a. Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, E4417A, E4418B, E4419B を押します。

b. Meter Address > パワー・メータの GPIB アドレス > Enter を押します。

c. E4417A および E4419B モデルの場合、Meter Channel A B を押してパワー・メータのアクティブ・チャネルを選択

します。

d. Meter Timeout を押して、パワー・メータと通信できない場合に本器がタイムアウト・エラーを発生するまでの時

間を設定します。

3. More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset を押します。

ユーザ・フラットネス・テーブル・エディタがオープンし、校正配列の周波数 / 補正リストがリセットされます。

4. Configure Step Array を押します。

ユーザ・フラットネス・ステップ配列データを入力するためのメニューがオープンします。

5. Freq Start > 26.5 > GHz を押します。

6. Freq Stop > 40 > GHz を押します。

7. # of Points > 28 > Enter を押します。

これにより、フラットネス補正の対象とする周波数 (500 MHz 間隔で 26.5 GHz から 40 GHz まで ) がステップ配列に

入力されます。

8. Return > Load Cal Array From Step Array > Confirm Load From Step Data を押します。

これにより、ステップ配列で定義した周波数設定がユーザ・フラットネス補正配列に設定されます。

9. Amplitude > 0 > dBm を押します。

10. RF On/Off を押します。

これにより RF 出力がオンになり、RF ONインジケータが表示されます。

ユーザ・フラットネス補正の実行

注記 Agilent E4416A/17A/18B/19Bパワー・メータを使用しない場合、あるいはパワー・メータにGPIBインタフェー

スがない場合、手動でユーザ・フラットネス補正を実行することもできます。手順についてはこの後のユーザ・

フラットネス補正の手動実行を参照してください。

1. More (1 of 2) > User Flatness > Do Cal を押します。

これにより、ユーザ・フラットネス振幅補正値テーブルのエントリが作成されます。信号発生器がユーザ・フラット

ネス補正ルーチンの実行を開始し、進捗度を示すバーがディスプレイに表示されます。

2. プロンプトが表示されたら、Done を押します。

これにより、ユーザ・フラットネス補正配列に振幅補正値がロードされます。

必要なら Configure Cal Array を押します。

これにより、ユーザ・フラットネス補正配列がオープンし、定義した周波数とそれに対応する振幅補正値計算結果の

リストを見ることができます。ユーザ・フラットネス補正配列のタイトルには User Flatness: (UNSTORED)と表示
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されます。 これは、現在のユーザ・フラットネス補正配列データがメモリ・カタログに保存されていないことを示し

ます。

ユーザ・フラットネス補正の手動実行

Agilent E4416A/17A/18B/19B パワー・メータを使用しない場合、あるいはパワー・メータに GPIB インタフェースがな

い場合、このセクションの手順を実行した後、ユーザ・フラットネス補正のチュートリアルに進んでください。

1. More (1 of 2) > User Flatness > Configure Cal Array を押します。

これにより、ユーザ・フラットネス・テーブル・エディタがオープンし、行 1 の周波数値（26.5 GHz）にカーソルが

置かれます。RF 出力がカーソルのあるテーブル行の周波数値に変化し、ディスプレイの AMPLITUDEエリアに 26.500
000 000 00が表示されます。 

2. パワー・メータの測定値を読み取って記録します。

3. 0 dBm から測定値を減算します。

4. テーブルのカーソルを行 1 の補正値に移動します。

5. Edit Item > ステップ 3 で計算した差を入力 > dB を押します。

入力した補正値に基づいて、RF 出力振幅が調整されます。

6. パワー・メータの表示値が 0 dBm になるまでステップ 2 ～ 5 を繰り返します。

7. 下矢印キーを押して、次の行の周波数値にカーソルを移動します。RF 出力の周波数が、カーソルで強調表示されてい

る周波数に変わり、ディスプレイの AMPLITUDEエリアにその値が表示されます。

8. ユーザ・フラットネス補正テーブルのすべてのエントリに対してステップ 2 ～ 7 を繰り返します。

ユーザ・フラットネス補正データのメモリ・カタログへの保存

このプロセスでは、ユーザ・フラットネス補正データを本器のメモリ・カタログのファイルに保存します。複数のユーザ・

フラットネス補正ファイルをメモリ・カタログに保存しておいて、特定のファイルをリコールし、補正配列にロードして

RF 出力に適用することで、RF 出力のさまざまなフラットネス要件を満たすことができます。

1. Load/Store を押します。

2. Store to File を押します。

3. 英数字ソフト・キーとテンキーを使って、ファイル名 FLATCAL2を入力します。

4. Enter を押します。

これにより、ユーザ・フラットネス補正配列ファイル FLATCAL2がUFLTファイルとしてメモリ・カタログに保存されます。

ユーザ・フラットネス補正配列の適用

1. Return > Return > Flatness Off On を押します。

これにより、ユーザ・フラットネス補正配列が RF 出力に適用されます。信号発生器のディスプレイの AMPLITUDEセ

クションに UFインジケータが表示され、補正配列内の周波数補正データがミリ波信号源モジュールの RF 出力振幅に

適用されます。
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ユーザ・フラットネス補正配列のリコールと適用

このセクションの手順を実行する前に、「ミリ波信号源モジュールによるユーザ・フラットネス補正配列の作成」（124 ペー

ジ）の手順を実行してください。

1. Preset を押します。

2. Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset を押します。

3. More (2 of 2) > Load/Store を押します。

4. ファイル FLATCAL2が強調表示されていることを確認します。

5. Load From Selected File > Confirm Load From File を押します。

これにより、ファイル FLATCAL2に記録されているデータがユーザ・フラットネス補正配列に設定されます。ユーザ・

フラットネス補正配列のタイトルには User Flatness: FLATCAL2と表示されます。

6. Return > Flatness Off On を押します。

これにより、ファイル FLATCAL2に記録されているデータを使ったユーザ・フラットネス補正がオンになります。

基準発振器帯域幅の調整（オプションUNR）

オプション UNR（近傍位相ノイズ < 1 kHz に改善）付きの信号発生器の基準発振器帯域幅（ループ帯域幅とも呼ぶ）は、

内部または外部 10 MHz 周波数基準に対して固定ステップで調整可能です。基準発振器帯域幅は、25、55、125、300、650
Hz に設定できます。オプション UNR なしのモデルの場合、基準発振器帯域幅は約 15 Hz に固定されています。

約 1 kHz より下の周波数オフセットでは、安定度と位相ノイズは内部または外部周波数基準によって決定されます。1 kHz
より上の周波数オフセットでは、安定度と位相ノイズはシンセサイザ・ハードウェアによって決定されます。

本器の全体としての位相ノイズ性能をアプリケーションに合わせて最適化するには、搬送波からのさまざまな周波数オフ

セットに対する外部または内部基準の安定度と位相ノイズに対する信頼度を、シンセサイザ・ハードウェアと比較して、

この調整を行います。 

基準発振器帯域幅を選択する手順

 内部タイムベース基準を使用する場合 :

1. Utility > Instrument Adjustments > Reference Oscillator Adjustment > Internal Ref Bandwidth を押します。

2. 目的の帯域幅を選択します。

外部タイムベース基準を使用する場合 :

1. Utility > Instrument Adjustments > Reference Oscillator Adjustment > External Ref Bandwidth を押します。

2. 目的の帯域幅を選択します。

工場設定を復元する手順 :

内部タイムベース :125 Hz
外部タイムベース :25 Hz

Utility > Instrument Adjustments > Reference Oscillator Adjustment > Restore Factory Defaults を押します。
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この章は以下のセクションに分かれており、Agilent E8257D PSG アナログ /E8267D PSG ベクトル信号発生器の標準の連

続波形機能とオプションのアナログ変調機能について説明します。

• 「アナログ変調波形」（131ページ）

• 「AMの設定（オプションUNT）」（132ページ）

• 「FMの設定（オプションUNT）」（132ページ）

• 「ΦMの設定（オプションUNT）」（133ページ）

• 「パルス変調の設定（オプションUNU/UNW）」（134ページ）

• 「LF出力の設定（オプションUNT）」（135ページ）

アナログ変調波形

標準の内部波形として、以下が使用可能です。

正弦波  振幅と周波数が調整可能な正弦波

2重正弦波  周波数が個別に調整可能で、第2トーンの振幅をピークに対する割合で設定可能な2重正弦波（ファ

ンクション・ジェネレータでのみ使用可能）

掃引正弦波  開始 /終了周波数、掃引速度、掃引トリガ設定が調整可能な掃引正弦波（ファンクション・ジェネ

レータでのみ使用可能）

三角波  振幅と周波数が調整可能な三角波

ランプ波  振幅と周波数が調整可能なランプ波

方形波  振幅と周波数が調整可能な方形波

ノイズ  p-p値の振幅が調整可能なノイズ（実効値は表示値の約80%）

オプションUNT付きの場合、RF搬送波を振幅、周波数、位相で変調できます。オプションUNTは低周波出力機能も提供

します。 

オプションUNU付きの場合、RF搬送波を標準のパルス（最小パルス幅150 ns）で変調できます。

オプションUNW付きの場合、RF搬送波を高速パルス（最小パルス幅20 ns）で変調できます。 
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AMの設定（オプションUNT）

この例では、振幅変調されたRF搬送波を作成する方法を説明します。 

搬送波周波数を設定する手順

1. Presetを押します。

2. Frequency > 1340 > kHzを押します。

RF出力振幅を設定する手順

Amplitude > 0 > dBmを押します。

AM変調度と変調周波数を設定する手順

1. AMハードキーを押します。

2. AM Depth > 90 > %を押します。

3. AM Rate > 10 > kHzを押します。

これにより、本器は0 dBmの振幅変調された1340 kHzの搬送波を、AM変調度90%、AM変調周波数10 kHzで出力するよ

うに設定されます。波形の形状は正弦波です。なお、正弦波はAM Waveformソフトキーのデフォルト設定です。 このソフ

トキーはMore (1 of 2)を押すことで表示されます。

振幅変調をオンにする手順

下記の手順で、振幅変調された信号を出力します。

1. AM Off Onソフトキーを押してOnにします。

2. フロントパネルのRF On Offキーを押します。

AMとRF ONの2つのインジケータが表示されます。これより、振幅変調がオンになり、RF OUTPUTコネクタから信号が出

力されていることがわかります。

FMの設定（オプションUNT）

この例では、周波数変調されたRF搬送波を作成する方法を説明します。

RF出力周波数を設定する手順

1. Presetを押します。

2. Frequency > 1 > GHzを押します。

RF出力振幅を設定する手順

Amplitude > 0 > dBmを押します。
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FM偏移と変調周波数の設定

1. FM/ΦMハードキーを押します。

2. FM Dev > 75 > kHzを押します。

3. FM Rate > 10 > kHzを押します。

これにより、本器は0 dBmの周波数変調された1 GHzの搬送波を、偏移75 kHz、変調周波数10 kHzで出力するように設定

されます。波形の形状は正弦波です。（正弦波はFM Waveformソフトキーのデフォルトです。このソフトキーはMore (1 of 2)
を押すことで表示されます)。 

FMをオンにする手順

1. FM Off Onを押してOnにします。

2. RF On/Offを押します。

FMとRF ONの2つのインジケータが表示されます。これより、周波数変調がオンになり、RF OUTPUTコネクタから信号が

出力されていることがわかります。

DCオフセットと外部FM

外部FM信号にDCオフセットを適用すると、FM信号の周波数がDCレベルの極性に応じて搬送波周波数の上または下にシ

フトされます。周波数シフトの大きさは、DCレベルの振幅に直接関連します。DCオフセットが＋1.0 V以上の場合、外部

FM周波数のシフトの大きさは最大偏移設定に等しくなります。例えば、本器のCW周波数が1 GHzで、最大偏移設定が

100 kHzに設定されている場合、DCレベルが＋1.0 Vの外部DC結合信号を変調源として使用すると、FM信号の中心周波

数は1 GHz＋100 kHzになります。同じセットアップと設定で、DCレベルを＋0.5 Vに変更すると、FM信号の中心周波数

は1 GHz＋50 kHzになります。 

ΦMの設定（オプションUNT）

この例では、位相変調されたRF搬送波を作成する方法を説明します。

RF出力周波数を設定する手順

1. Presetを押します。

2. Frequency > 3 > GHzを押します。

RF出力振幅を設定する手順

Amplitude > 0 > dBmを押します。

ΦM偏移と変調周波数を設定する手順

1. FM/ΦMハードキーを押します。

2. FM ΦMソフトキーを押します。

3. ΦM Dev > .25 > pi radを押します。 

4. ΦM Rate > 10 > kHzを押します。
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これにより、本器は0 dBmの位相変調された3 GHzの搬送波を、偏移0.25 πラジアン、変調周波数10 kHzで出力するよ

うに設定されます。波形の形状は正弦波です。（正弦波はΦM Waveformソフトキーのデフォルトです。このソフトキーは

More (1 of 2)を押すことで表示されます)。 

ΦMをオンにする手順

1. ΦM Off Onを押します。

2. RF On/Offを押します。

ΦMとRF ONの2つのインジケータが表示されます。これより、位相変調がオンになり、RF OUTPUTコネクタから信号が出

力されていることがわかります。

パルス変調の設定（オプションUNU/UNW）

この例では、外部トリガによってゲートを使ったパルス変調RF搬送波を作成する方法を説明します。 

RF出力周波数を設定する手順

1. Presetを押します。

2. Frequency > 2 > GHzを押します。

RF出力振幅を設定する手順

Amplitude > 0 > dBmを押します。

パルス周期、パルス幅、トリガを設定する手順

1. Pulse > Pulse Period > 100 > usecを押します。

2. Pulse > Pulse Width > 24 > usecを押します。

3. Pulse > Pulse Source > Int Gatedを押します。

4. 本器のリア・パネルのTrigger InコネクタにTTL信号を接続します。トリガ信号の極性を設定するには、Utility >
Instrument Adjustments > Signal Polarity Setup > Trigger In Polarityを押します。

これにより、本器は0 dBmのパルス変調された2 GHzの搬送波を、パルス周期100 μs、パルス幅24 μsで出力するように

設定されます。パルス信号源は内部ゲートに設定されます。（Pulse SourceソフトキーのデフォルトはInternal Free Runで

す）。 

パルス変調をオンにする手順

下記の手順で、パルス変調された信号を出力します。

1. Pulse Off Onを押してOnにします。

2. RF On/Offを押します。

PulseとRF ONの2つのインジケータが表示されます。これより、パルス変調がオンになり、RF OUTPUTコネクタから信

号が出力されていることがわかります。TTLトリガ信号のステートがパルス変調出力を制御します。 
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LF出力の設定（オプションUNT）

オプションUNT付きの場合、本器には低周波（LF）出力があります（10ページで説明）。LF出力の信号源は、Internal 1
Monitor、Internal 2 Monitor、Function Generator 1、Function Generator 2のいずれかに切り替えることができます。

Internal 1 Monitorまたは Internal 2 MonitorをLF出力信号源として使用すると、LF出力はRF出力の変調に用いられている内

部信号源の信号と同じものになります。この信号の変調パラメータは、AM、FM、ΦMの各メニューで設定されます。

Function Generator 1またはFunction Generator 2をLF出力信号源として使用すると、LF出力は内部変調源のファンクション・

ジェネレータ部から直接駆動されます。周波数と波形は、AM、FM、ΦMメニューではなく、LF出力メニューで設定され

ます。下記の波形形状が選択できます。

正弦波  振幅と周波数が調整可能な正弦波

2重正弦波  周波数が個別に調整可能で、第2トーンの振幅をピークに対する割合で設定可能な2重正弦波（ファ

ンクション・ジェネレータ1でのみ使用可能）

掃引正弦波  開始 /終了周波数、掃引速度、掃引トリガ設定が調整可能な掃引正弦波（ファンクション・ジェネ

レータ1でのみ使用可能）

三角波  振幅と周波数が調整可能な三角波

ランプ波  振幅と周波数が調整可能なランプ波

方形波  振幅と周波数が調整可能な方形波

ノイズ  p-p値の振幅が調整可能なノイズ（実効値は表示値の約80%）

DC  振幅が調整可能な直流

注記 LF出力の動作状態はLF Out Off Onソフトキーで制御されます。ただし、LF出力信号源として Internal Monitorが選

択されている場合、出力は3つの方法で制御されます。変調源（AM、FM、ΦM）のオン/オフ・キー、LF出力

のオン/オフ・キー、またはMod On/Offソフトキーです。

RF On/OffハードキーはLF OUTPUTコネクタには影響しません。

内部変調源によってLF出力を設定する手順

この例では、内部FM変調をLF出力の信号源とします。

注記 内部変調（Internal Monitor）はLF出力信号源のデフォルト設定です。

内部変調をLF出力の信号源に設定

1. Presetを押します。

2. FM/ΦMハードキーを押します。

3. FM Dev > 75 > kHzを押します。

4. FM Rate > 10 > kHzを押します。 
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5. FM Off Onを押します。 

変調周波数が10 kHz、偏移が75 kHzのFM信号が設定されました。FMインジケータがオンになり、周波数変調がオンに

なったことを示します。

低周波出力の設定

1. LF Outハードキーを押します。

2. LF Out Amplitude > 3 > Vpを押します。 

3. LF Out Off Onを押します。

3 V正弦波（デフォルト波形）のLF出力信号が設定されました。 

ファンクション・ジェネレータ信号源によってLF出力を設定する手順

この例では、ファンクション・ジェネレータをLF出力の信号源とします。

ファンクション・ジェネレータをLF出力の信号源に設定

1. Presetを押します。

2. LF Outハードキーを押します。

3. LF Out Source > Function Generator 1を押します。

波形の設定

1. LF Out Waveform > Swept-Sineを押します。

2. LF Out Start Freq > 100 > Hzを押します。

3. LF Out Stop Freq > 1 > kHzを押します。

4. Return > Returnを押します。

LF Outputトップ・メニューに戻ります。 

低周波出力の設定

1. LF Out Amplitude > 3 > Vpを押します。

LF出力の振幅が3 Vpに設定されます。

2. LF Out Off Onを押します。

ファンクション・ジェネレータ1による信号がLF出力から出力されます。 ファンクション・ジェネレータ1は3 Vpの掃引

正弦波を供給します。この波形は100 Hzから1 kHzまで掃引されます。
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この章は以下のセクションに分かれており、カスタム任意波形発生器モードについて説明します。このモードは、オプショ

ン 601 または 602 付きの E8267D PSG ベクトル信号発生器だけで使用できます。

• 「概要」（137ページ）

• 「定義済み変調フォーマット（モード）の操作」（137ページ）

• 「フィルタの操作」（140ページ）

• 「シンボル・レートの操作」（147ページ）

• 「変調タイプの操作」（149ページ）

• 「ハードウェアの設定」（155ページ）

関連項目 : 第 3 章「基本デジタル操作」（67 ページ）

概要

カスタム任意波形発生器モードでは、変調された搬送波を 1 つまたは複数供給できます。変調された搬送波波形は、それ

ぞれ出力の前に計算して作成しておく必要があります。 信号作成は内蔵ベースバンド・ジェネレータ（オプション 601 ま

たは 602）で行われます。作成した波形は保存して再生できるので、再現性のあるテスト信号が得られます。

カスタム任意波形発生器モードの使用を開始するにあたって、変調された搬送波波形を 1 つ作成するか複数作成するかを

選択します。

• 変調された搬送波波形を 1 つ作成する場合、まず定義済みモード（セットアップ）の中からデジタル変調セッ

トアップを選択します。定義済みモードを選択したあと、変調タイプ、使用するフィルタ、シンボル・レート、
トリガのタイプを変更できます。 データ・パターンはデフォルトでランダムです。変更したセットアップは保

存して再使用できます。

• 変調された搬送波波形を複数作成する場合、まず定義済みモード（セットアップ）の中からマルチキャリア・
セットアップを選択します。定義済みモードを選択したあと、作成する搬送波の数、各搬送波の間の周波数間
隔、各搬送波の間の位相オフセットが固定かランダムか、トリガのタイプを変更できます。 データ・パターン

はデフォルトでランダムであり、フィルタはデフォルトで40 MHzに設定され、シンボル・レートは選択した変

調タイプによって自動的に指定されます。

定義済み変調フォーマット（モード）の操作

定義済み変調フォーマットを選択した場合、コンポーネントのデフォルト値（フィルタ、シンボル・レート、変調タイプ

など）が自動的に指定されます。
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カスタムARGセットアップまたはカスタム・デジタル変調フォーマットの選択

1. 本器を初期設定します。Preset を押します。

2. Mode > Custom > Arb Waveform Generator > Setup Select を押します。

3. 次のいずれかを選択します。

• 定義済み変調フォーマットの1つ : NADC、PDC、PHS、GSM、DECT、EDGE、APCO 25 w/C4FM、APCO 25 w/CQPSK、
CDPD、PWT、TETRA

この場合、定義済み変調フォーマットが選択され、フィルタ、シンボル・レート、変調タイプが選択した定義済

み変調フォーマット（モード）に従って定義され、カスタム変調トップレベル・メニューに戻ります。 バースト

とチャネル・コーディングは含まれません。

または

• Custom Digital Mod State

この場合、Catalog of DMOD Files に保存されたカスタム・セットアップが選択されます（カスタム・デジタ

ル変調フォーマットの作成については 138 ページを参照）。

ユーザ定義変調フォーマット（モード）の操作-カスタムARBのみ

シングルキャリアNADC変調フォーマットの変更

この手順では、シングルキャリア NADC デジタル変調フォーマットを変更して、変調タイプ、シンボル・レート、フィル

タをカスタマイズしたカスタム波形を作成する方法を説明します。

1. Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Setup Select > NADC を押します。

3. Digital Mod Define > Modulation Type > PSK > QPSK and OQPSK > QPSK を押します。

4. Symbol Rate > 56 > ksps を押します。

5. Filter > Select > Nyquist を押します。

6. Return > Return > Digital Modulation Off On を押します。

これにより、カスタム・シングルキャリア NADC デジタル変調フォーマットの波形が作成されます。表示が Dig Mod
Setup: NADC (Modified)に変わります。波形作成中には DIGMOD and I/Qの 2 つのインジケータが表示され、カスタ

ム・シングルキャリア・デジタル変調フォーマットが揮発性メモリに保存されます。

7. RF 出力周波数を 835 MHz に設定します。 

8. 出力振幅を 0 dBm に設定します。 

9. RF On/Off を押します。

ユーザ定義の NADC 信号が RF OUTPUT コネクタから出力されます。

10. Return > Return を押します。

これにより、Digital Modulation Off On を最初のソフトキーとするデジタル変調トップレベル・メニューに戻ります。
138 第6章



カスタム任意波形発生器
ユーザ定義変調フォーマット（モード）の操作 -カスタムARBのみ
11. Digital Mod Define > Store Custom Dig Mod State > Store To File を押します。

Catalog of DMOD Filesにあるファイル名がすでにアクティブ入力エリアに表示されている場合は、以下のキーを

押します。Edit Keys > Clear Text

12. 英字キーとテンキーを使って、ファイル名（例えば NADCQPSK）を入力します。

13. Enter を押します。

ユーザ定義のシングルキャリア・デジタル変調フォーマットが不揮発性メモリに保存されます。RF 出力の振幅、周波

数、動作状態の設定は、ユーザ定義デジタル変調フォーマット・ファイルには含まれません。

マルチキャリア変調フォーマットのカスタマイズ

この手順では、定義されたマルチキャリア・デジタル変調フォーマットをカスタマイズして、カスタム 2 搬送波 EDGE デ

ジタル変調フォーマットを作成する方法を説明します。

1. Preset を押します。

2. Mode > Custom > Arb Waveform Generator > Multicarrier Off On を押します。

3. Multicarrier Define > Initialize Table > Carrier Setup > EDGE > Done を押します。

4. 2行目の搬送波のFreq Offsetの値（500.000 kHz）を強調表示します。

Edit Item > －625 > kHzを押します。

5. 2行目の搬送波のPowerの値（0.00 dB）を強調表示し、Edit Item > －10 > dBを押します。

周波数オフセットが－625 kHzでパワー・レベルが－10.00 dBmの搬送波を持つカスタム2搬送波EDGE波形ができま

した。

6. Return > Digital Modulation Off On を押します。

これにより、カスタム・マルチキャリア EDGE フォーマットの波形が作成されます。表示は Dig Mod Setup:
Multicarrier (Modified)に変わります。波形作成中にはDIGMODとI/Qの2つのインジケータが表示され、新しい

カスタム・マルチキャリア EDGE フォーマットが揮発性メモリに保存されます。

7. RF 出力周波数を 890.01 MHz に設定します。 

8. 出力振幅を－ 10 dBm に設定します。 

9. RF On/Off を押します。

カスタム・マルチキャリア EDGE 波形が RF OUTPUT コネクタから出力されます。 バーストとチャネル・コーディン

グは含まれません。

10. Mode > Custom > Arb Waveform Generator を押します。Digital Modulation Off On が最初のソフトキーになります。

11. Multicarrier Off On > Multicarrier Define > More (1 of 2) > Load/ Store > Store To File を押します。

Catalog of MDMOD Files にあるファイル名がすでにアクティブ入力エリアに表示されている場合は、Edit Keys >
Clear Text を押します。
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12. 英字キーとテンキーを使って、ファイル名（例えば EDGEM1）を入力し、Enter を押します。

ユーザ定義のマルチキャリア・デジタル変調フォーマットが不揮発性メモリに保存されます。

注記 RF出力の振幅、周波数、動作状態の設定（RF On/Offなど）は、ユーザ定義デジタル変調フォーマット・ファ

イルには保存されません。詳細については、「データ・ストレージ機能の使用」（51ページ）を参照してください。

ユーザ定義カスタム・デジタル変調フォーマットのリコール

この手順では、以前に保存したカスタム・デジタル変調フォーマットをメモリ・カタログ（Catalog of DMOD Files）
から選択（リコール）する方法を説明します。

1. Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Setup Select を押します。

3. More (1 of 2) > Custom Digital Mod State を押します。

4. Select File を押して、Catalog of DMOD Filesからカスタム変調フォーマットを選択します。

ユーザ定義のカスタム・デジタル変調フォーマットが不揮発性メモリからリコールされます。RF 出力の振幅、周波

数、動作状態の設定はユーザ定義デジタル変調フォーマット・ファイルに保存されていないので、これらは別に設定

またはリコールする必要があります。詳細については、「データ・ストレージ機能の使用」（51 ページ）を参照してく

ださい。

フィルタの操作

このセクションでは、定義済み（141 ページ）とユーザ定義（142 ページ）の FIR フィルタの使用法について説明します。

注記 このセクションの手順は、カスタム任意波形発生器またはカスタム・リアルタイムI/Qベースバンド・モードで

作成されたフィルタだけに使用できます。Matlab などで作成してダウンロードしたファイルには使用できませ

ん。

Filter メニューを使うと、作成した信号にフィルタを適用したり、有限インパルス応答（FIR）フィルタを定義したり、ルー

ト・ナイキストまたはナイキスト・フィルタの α を変更したり、ガウシアン・フィルタの BbT を変更したり、すべての

フィルタ・パラメータをデフォルト状態に復元したりすることができます。カスタム・リアルタイム I/Q モードでは、FIR
フィルタをエラー・ベクトル振幅（EVM）または隣接チャネル漏洩電力（ACP）に対して最適化することもできます。

定義済みフィルタ（Filter > Select）

• Root Nyquistは、ルート・ナイキストFIRフィルタです。ルート・ナイキスト・フィルタは、フィルタの半分を

トランスミッタ、残りの半分をレシーバに置く場合に使用します。理想的なルート・ナイキスト・フィルタの
周波数応答は、低い周波数では単位利得、中間の周波数ではレイズド・コサイン関数の平方根、高い周波数で
は全減衰です。中間の周波数の幅は、ロールオフ・ファクタすなわちフィルタα（0 < フィルタα < 1）で定義

されます。

• Nyquistは、ナイキストFIRフィルタです。ナイキスト・フィルタは、信号に必要な帯域幅を情報の損失なしに

減らすために使用します。理想的なナイキスト・フィルタの周波数応答は、低い周波数では単位利得、中間の
周波数ではレイズド・コサイン関数、高い周波数では全減衰です。中間の周波数の幅は、ロールオフ・ファク
タすなわちフィルタα（0 < フィルタα < 1）で定義されます。
140 第6章



カスタム任意波形発生器
フィルタの操作
• Gaussianは、ガウシアンFIRフィルタです。

• ユーザ FIRを使うと、FIRフィルタのカタログからフィルタを選択できます。定義済みFIRフィルタでは必要を

満たせない場合に使用します。詳細については、この後のDefine User FIRを参照してください。

• Rectangleは、方形FIRフィルタです。

• APCO 25 C4FMは、APCO 25仕様のC4FMフィルタです。 これは、αが0.200のナイキスト・フィルタとシェーピ

ング・フィルタを組み合わせたものです。

フィルタ・パラメータ

• 定義済みFIRフィルタで必要を満たせない場合は、Define User FIRを使用します。FIR係数を定義したり、カスタム

FIRフィルタに適用するオーバサンプリング比（シンボル1個あたりのフィルタ係数の数）を設定したりできます。

• Filter Alphaを使うと、ナイキストまたはルート・ナイキスト・フィルタのフィルタαを調整できます。ガウシ

アン・フィルタを使用している場合、Filter BbTが表示されます。他のフィルタが選択されている場合はこの

ソフトキーは淡色表示になります。

• (カスタム・リアルタイム I/Qベースバンドのみ）Optimize FIR for EVM ACPを使うと、ナイキストまたはルー

ト・ナイキスト・フィルタを、エラー・ベクトル振幅（EVM）を最小にするように最適化するか、隣接チャネ

ル漏洩電力（ACP）を最小にするように最適化できます。他のフィルタが選択されている場合はこのソフトキー

は淡色表示になります。

• Restore Default Filtersは、現在のFIRフィルタを、選択されているフォーマットのデフォルトのFIRフィルタに置

き換えます。

定義済みFIRフィルタの使用

定義済みFIRフィルタの選択

1. 本器を初期設定します。Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Select を押します。

または

Mode > Custom > Real Time I/Q Baseband > Filter > Select > を押します。

3. 目的のフィルタを選択します。必要なフィルタが最初のリストにない場合、More (1 of 2) を押します。

定義済みルート・ナイキストまたはナイキスト・フィルタのフィルタαを調整する手順

1. 本器を初期設定します。Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Filter Alpha を押します。

または

Mode > Custom > Real Time I/Q Baseband > Filter > Filter Alpha を押します。

3. 新しいフィルタ αの値を入力し、Enter を押します。

定義済みガウシアン・フィルタの帯域幅ビット時間（BbT）積の調整

1. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Select > Gaussian を押します。

または

Mode > Custom > Real Time I/Q Baseband > Filter > Select > Gaussian を押します。

2. Filter BbT を押します。

3. フィルタの帯域幅ビット時間 (BbT) 積パラメータの新しい値を入力し、Enter を押します。
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ナイキストまたはルート・ナイキストFIRフィルタのEVMまたはACPに対する最適化

（カスタム・リアルタイム I/Qベースバンドのみ）

1. 本器を初期設定します。Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Filter > Optimize FIR For EVM or ACP を押します。

FIR フィルタが、エラー・ベクトル振幅（EVM）が最小になるように、または隣接チャネル漏洩電力（ACP）が最小

になるように最適化されます。この機能が使用できるのはナイキストおよびルート・ナイキスト・フィルタに対して

だけです。 他のフィルタが選択されている場合はソフトキーは淡色表示になります。

デフォルトのFIRフィルタ・パラメータの復元

1. 本器を初期設定します。Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Restore Default Filter を押します。

これにより、現在の FIR フィルタが、選択されている変調フォーマットのデフォルトの FIR フィルタに置き換えられ

ます。

ユーザ定義FIRフィルタの使用

FIR フィルタを作成、変更するには、FIR 係数を指定するか、独自のカスタム FIR フィルタに適用するオーバサンプリン

グ比（シンボルあたりのフィルタ係数の数）を指定します。

FIR値エディタを使ってガウシアン・フィルタの定義済みFIR係数を変更する手順

定義できる FIR 係数は 1 ～ 32 個で、シンボル数とオーバサンプリング比の組合わせの最大値は 1024 係数です。FIR 値エ

ディタでは最大 1024 係数までのフィルタを扱えますが、PSG のハードウェアによるリアルタイム機能は 64 シンボル、任

意波形発生は 512 シンボルまでに制限されています（シンボル数は、係数の数をオーバサンプリング比で割ったものにな

ります）。 

リアルタイムで 64、任意波形発生で 512 を超える数のシンボルを入力した場合、PSG はフィルタを使用できず、必要条

件が満たされるようにフィルタを間引き（係数を破棄）して使用します。この場合、インパルス応答の分解能が低下する

可能性があります。

本器のメモリに保存された FIR フィルタは、FIR 値エディタを使って容易に変更できます。この例では、FIR 値エディタ

にデフォルト FIR フィルタ（または、あらかじめメモリ・カタログに保存されているユーザ定義 FIR ファイル）の係数値

をロードし、係数値を変更し、新しいファイルをメモリ・カタログに保存します。 

1. Preset を押します。

2. Mode > Custom > Arb Waveform Generator > Digital Mod Define > Filter を押します。

または Mode > Custom > Real Time I/Q Baseband > Filter を押します。

3. Define User FIR > More (1 of 2) > Load Default FIR > Gaussian を押します。

4. Filter BbT > 0.300 > Enter を押します。

5. Filter Symbols > 8 > Enter を押します。

6. Generate を押します。 

注記 変調時の実際のオーバサンプリング比は自動的に決定されます。シンボル・レート、変調タイプのシンボルあた

りのビット数、シンボル数に基づいて、4～16の範囲の値が選択されます。
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7. Display Impulse Response を押します。現在の FIR 係数のインパルス応答がグラフに表示されます。

8. Return を押します。

9. 係数 15 を強調表示します。

10. 0 > Enter を押します。

11. Display Impulse Response を押します。

グラフィック表示はトラブルシューティングに役立つ場合があります（この例では、係数値が正しくないため、ガウ

シアン応答が不適切になっているのがわかります）。

12. Return を押します。

13. 係数 15 を強調表示します。

14. 1 > Enter を押します。 

15. Load/Store > Store To File を押します。 

16. ファイル名として NEWFIR2 を指定し、Enter を押します。

現在の FIR 値エディタの内容がメモリ・カタログのファイルに保存され、FIR ファイルのカタログが更新されて新し

いファイルが表示されます。
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FIR値エディタを使ってユーザ定義FIRフィルタを作成する手順

この手順では、FIR Valuesエディタを使って、オーバサンプリング比が 4 の 8 シンボル・ウィンドウ sinc 関数フィルタ

を作成し、保存します。オーバサンプリング比（OSR）とは、シンボルあたりのフィルタ係数の数です。

定義できる FIR 係数は 1 ～ 32 個で、シンボル数とオーバサンプリング比の組合わせの最大値は 1024 係数です。

FIR 値エディタでは最大 1024 係数までのフィルタを扱えますが、PSG のハードウェアによる任意波形発生は 512 シンボ

ル、リアルタイム波形発生は 64 シンボルまでに制限されています。シンボル数は、係数の数をオーバサンプリング比で

割ったものになります。最大数を超える数のシンボルを入力した場合、PSG はフィルタを使用できず、必要条件が満たさ

れるようにフィルタを間引き（係数を破棄）して使用します。この場合、インパルス応答の分解能が低下する可能性があ

ります。

1. Preset を押します。

2. Mode > Custom > Arb Waveform Generator > Digital Mod Define > Filter を押します。

または

Mode > Custom > Real Time I/Q Baseband > Filter を押します。

3. Define User FIR > More (1 of 2) を押します。 

4. Delete All Rows > Confirm Delete Of All Rows > More (2 of 2) を押します。 

FIR 値エディタが起動され、テーブルから既存の値がクリアされます。

5. Edit Item を押します。係数 0 の Valueフィールドが強調表示されます。

6. テンキーを使って、下の表の最初の値（－0.000076）を入力し、Enterを押します。テンキーを押すたびに、アクティ

ブ入力エリアに数字が表示されます。（間違ったキーを押した場合は、バックスペース・キーで修正できます）。表の

係数値を順番に入力し、16の値すべてを入力します。
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7. Mirror Table を押します。

ウィンドウ sinc 関数フィルタでは、係数の後半部は前半部の順序を逆にしたものに一致します。本器には、既存の係

数値を自動的に逆順でコピーするミラーリング機能があります。これにより、係数 16 ～ 31 が自動的に作成され、そ

の最初の係数（16 番目）が下の図のように強調表示されます。 

8. この例では、必要なオーバサンプリング比は 4 で、デフォルト値と一致するため、設定の必要はありません。

オーバサンプリング比（OSR）とは、シンボルあたりのフィルタ係数の数です。使用可能な値は 1 ～ 32 の範囲です。

FIR 値エディタで使用できるシンボルとオーバサンプリング比の組合わせの最大値は 1024 です。ただし、本器のハー

ドウェアによるリアルタイム波形発生は 64 シンボル、任意波形生成は 512 シンボルまでに制限されています。シン

ボル数は、係数の数をオーバサンプリング比で割ったものになります。

係数 値 係数 値 係数 値

0 −0.000076 6 0.043940 12 0.123414

1 −0.001747 7 0.025852 13 0.442748

2 −0.005144 8 −0.035667 14 0.767329

3 −0.004424 9 −0.116753 15 0.972149

4 0.007745 10 −0.157348

5 0.029610 11 −0.088484
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9. More (1 of 2) > Display FFT（高速フーリエ変換）を押します。 

現在の FIR 係数セットの高速フーリエ変換がグラフに表示されます。本器には、時間と周波数の両方の次元でフィル

タをグラフィカルに表示する機能があります。

10. Return > Display Impulse Response を押します。 

現在の FIR 係数セットのインパルス応答がグラフに表示されます。

11. Return > Load/Store > Store To File を押します。

FIR ファイルのカタログと、使用可能メモリ量が表示されます。

12. アクティブ入力エリアにすでにファイル名が表示されている場合は、以下のキーを押します。Edit Keys > Clear Text

13. 英字メニューとテンキーを使って、ファイル名 NEWFIR1を入力します。

14. Enter を押します。

NEWFIR1 が最初のファイル名として表示されます。（すでに別の FIR ファイルが保存されている場合は、それらの名

前が NEWFIR1 の後に表示されます）。ファイル・タイプは FIR で、ファイルのサイズは 260 バイトです。使用され

ているメモリ量も表示されます。保存可能なファイルの数は、ファイルのサイズと、使用されているメモリ量に依存

します。
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シンボル・レートの操作

Symbol Rate メニューでは、I/Q 変調器に I/Q シンボルが供給されるレートを設定できます。デフォルトの伝送シンボル・

レートを回復することもできます。

• シンボル・レート（Sym Rateに表示）とは、変調（Mod Typeに表示）およびフィルタとフィルタα（Filter
に表示）によって1秒あたりに伝送されるシンボルの数です。シンボル・レートは占有信号帯域幅に直接影響

します。

• シンボル・レートは、シンボルあたりの伝送ビット数でビット・レートを割ったものです。 これはボーレート

とも呼ばれます。

• ビット・レートとは、システム・ビット・ストリームの周波数です。内蔵ベースバンド・ジェネレータ（オプ
ション002）は、選択されたデータ・パターンを、シンボル・レート設定に合わせて自動的に適切なレートで

供給します（ビット・レート=シンボル/s×ビット数/シンボル）。

• 占有信号帯域幅=シンボル・レート×（1＋フィルタα）。すなわち、占有信号帯域幅は、使用するナイキスト

またはルート・ナイキスト・フィルタのフィルタαに依存します。（フィルタαを変更する方法については、
「定義済みルート・ナイキストまたはナイキスト・フィルタのフィルタαを調整する手順」（141ページ）の手

順を参照してください)。

シンボル・レートを設定する手順

1. Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Symbol Rate を押します。

または

Mode > Custom > Real Time I/Q Baseband > Symbol Rate を押します。

3. 新しいシンボル・レートを入力し、Msps、ksps、sps のどれかを押します。
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デフォルトのシンボル・レートを回復する手順（カスタム・リアルタイム I/Qのみ）

• Mode > Custom > Real Time I/Q Baseband > Symbol Rate > Restore Default Symbol Rate を押します。

現在のシンボル・レートが、選択されている変調フォーマットのデフォルトのシンボル・レートに置き換えられます。

変調タイプ

シンボル
あたりの
ビット数

ビット・レート=
シンボル/s×ビット数/
シンボル

内部シンボル・レート
（最小 最大）

カスタム・リアルタイムのみ
外部シンボル・レート

（最小 最大）

PSK

位相
シフト
キーイング

QPSKおよびOQPSK
（直交位相シフト・キーイング
およびオフセット直交位相シフト・
キーイング）
以下を含む :QPSK、IS95 QPSK、
グレー・コードQPSK、OQPSK、
IS95 OQPSK

2 90 bps～100 Mbps 45 sps～50 Msps 45 sps～25 Msps

BPSK
（バイナリ位相 シフト・キーイング）

1 45 bps～50 Mbps 45 sps～50 Msps 45 sps～50 Msps

π/4 DQPSK 2 90 bps～100 Mbps 45 sps～50 Msps 45 sps～25 Msps

8PSK
（8位相ステート・シフト・

キーイング）

3 135 bps～150 Mbps 45 sps～50 Msps 45 sps～16.67 Msps

16PSK
（16位相ステート・シフト・

キーイング）

4 180 bps～200 Mbps 45 sps～50 Msps 45 sps～12.5 Msps

D8PSK
（8位相ステート・シフト・

キーイング）

3 135 bps～150 Mbps 45 sps～50 Msps 45 sps～16.67 Msps

MSK

最小
シフト
キーイング

MSK

（GSM - Global System for 
Mobile Communications）

1 45 bps～50 Mbps 45 sps～50 Msps 45 sps～50 Msps

FSK

周波数
シフト
キーイング

2-Lvl FSK 1 45 bps～50 Mbps 45 sps～50 Msps 45 sps～50 Msps

4-Lvl FSK 2 90 bps～100 Mbps 45 sps～50 Msps 45 sps～25 Msps

8-Lvl FSK 3 135 bps～150 Mbps 45 sps～50 Msps 45 sps～16.67 Msps

16-Lvl FSK 4 180 bps～200 Mbps 45 sps～50 Msps 45 sps～12.5 Msps

C4FM 2 90 bps～100 Mbps 45 sps～50 Msps 45 sps～25 Msps
148 第6章



カスタム任意波形発生器
変調タイプの操作
変調タイプの操作

Modulation Type メニューでは、Mod On Off ハードキーがオンのときに搬送波信号に適用される変調のタイプを指定でき

ます。

Custom Off On ソフトキーがオンの場合 :

• カスタムARBの場合、BBG（ベースバンド・ジェネレータ）は、ランダムなデータ・パターンと選択された変

調タイプに基づいて、I/Q波形を作成します。

• カスタム・リアルタイムI/Qの場合、リアルタイム・カスタム I/Qシンボル・ビルダは、選択されたデータ・パ

ターンと変調タイプに基づいて、I/Qシンボルを作成します（データ・パターンの選択については「データ・パ

ターンの操作」（160ページ）を参照）。

カスタム・リアルタイム I/Q の場合、次のことも可能です。 

• ユーザ定義変調タイプの作成（150ページを参照）。作成した変調タイプは、すぐに使用することも、メモリ・

カタログに保存することもできます。

• すべての変調パラメータをデフォルト状態に戻す。

定義済み変調タイプを選択する手順

1. Preset を押します。

2. Mode > Custom > ARB Waveform Generator > Digital Mod Define > Modulation Type > Select を押します。

または

Mode > Custom > Real Time I/Q Baseband > Modulation Type > Select を押します。

3. 使用可能な変調タイプの 1 つを選択します。

注記 QPSK and OQPSKを選択した場合、表示されるメニューから具体的な選択を行う必要があります。

QAM

直交
振幅
変調

4QAM 2 90 bps～100 Mbps 45 sps～50 Msps 45 sps～25 Msps

16QAM 4 180 bps～200 Mbps 45 sps～50 Msps 45 sps～12.5 Msps

32QAM 5 225 bps～250 Mbps 45 sps～50 Msps 45 sps～10 Msps

64QAM 6 270 bps～300 Mbps 45 sps～50 Msps 45 sps～8.33 Msps

128QAM
この変調の定義済み値はないので
ユーザ定義が必要。

7 315 bps～350 Mbps 45 sps～50 Msps 45 sps～7.14 Msps

256QAM 8 360 bps～400 Mbps 45 sps～50 Msps 45 sps～6.25 Msps

変調タイプ

シンボル
あたりの
ビット数

ビット・レート=
シンボル/s×ビット数/
シンボル

内部シンボル・レート
（最小 最大）

カスタム・リアルタイムのみ
外部シンボル・レート

（最小 最大）
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ユーザ定義変調タイプを使用する手順（リアルタイム I/Qのみ）

128QAM I/Q変調タイプのユーザ・ファイルを I/Q値エディタを使って作成

I/Q 変調方式では、シンボルは I/Q 平面のデフォルト位置に出現します。I/Q Values エディタを使うと、いくつかのシ

ンボルの位置を変更して独自のシンボル・マップを作成することができます。以下の手順で、128 シンボルの QAM 変調

を作成して保存します。

注記 この手順では128QAM変調フォーマットを簡単に実現できますが、I/Q変調器のダイナミック・レンジ全体を利

用することはできません。これは、256QAMのコンスタレーションから出発して、不要な点を削除するからで

す。128QAMを構成する残りの点は、それぞれの点を独自にマッピングした場合よりも互いに近くなります。さ

らに、この方法では、128QAMのコンスタレーションを1点ずつ定義した場合と異なり、各シンボル・ポイント

に対応するビット・パターンを定義することはできません。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q >More (1 of 2) > Load Default I/Q Map > QAM
> 256QAM を押します。

デフォルトの 256QAM I/Q 変調が I/Q Valuesエディタにロードされます。

3. More (2 of 2) > Display I/Q Map を押します。

以下の手順では、この I/Qコンスタレーションの特定部分を削除し、128の I/Qステートを持つ 128QAMに変更します。

4. Return > Goto Row > 0011 0000 > Enter を押します。これは 48 行目です。
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5. Delete Row ソフトキーを 16 回押します。

下の表に従ってこの手順を繰り返します。

6. Display I/Q Map を押して、作成した新しいコンスタレーションを表示します。

この例の I/Q ステート・マップには 128 個のシンボルがあります。

7. Return を押します。I/Q Valuesテーブルの内容が保存されていない場合、画

面上に I/Q Values (UNSTORED)と表示されます。

8. More (1 of 2) > Load/Store > Store To File を押します。

Catalog of IQ Filesにあるファイル名がすでにアクティブ入力エリアに表

示されている場合は、以下のキーを押します。

Editing Keys > Clear Text

9. 英字キーとテンキーを使って、ファイル名（例えば 128QAM）を入力します。

10. Enter を押します。

ユーザ定義の I/Q ステート・マップが Catalog of IQ Filesに保存されます。

QPSK I/Q変調タイプのユーザ・ファイルを I/Q値エディタを使って作成

I/Q 変調方式では、シンボルは I/Q 平面のデフォルト位置に出現します。I/Q Values エディタを使うと、いくつかのシ

ンボルの位置を変更して独自のシンボル・マップを作成することができます。以下の手順で、4 シンボルの不平衡 QPSK
変調を作成して保存します。

1. Preset を押します。

Goto Rowの後に押すキー Delete Rowソフトキーを押す回数

0110 0000 (96) 16回

1001 0000 (144) 16回

1100 0000 (192) 16回

0001 0000 (16) 4回

0001 0100 (20) 4回

0001 1000 (24) 8回

0011 0000 (48) 4回

0011 0100 (52) 4回

0011 1000 (56) 4回

0101 1000 (88) 8回

0111 0000 (112) 4回

0111 0100 (116) 4回

0111 1000 (120) 8回
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2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) > Delete All Rows > Confirm
Delete All Rows を押します。

デフォルトの 4QAM I/Q 変調がロードされ、I/Q Valuesエディタがクリアされます。

3. 次の表に示す I と Q の値を入力します。

a. 0.5 > Enter を押します。

b. 1 > Enter を押します。 
c. 残りの I と Q の値を入力します。

I 値を更新すると、強調表示が最初の Q のエントリに移り（そしてデフォルト値の 0 が表示され）、1 行目の下に空の

データ行が表示されます。Q 値を更新すると、強調表示は次の I 値に移ります。テンキーを押すたびに、アクティブ

入力エリアに数字が表示されます。間違ったキーを押した場合は、バックスペース・キーを押したあと正しいキーを

押します。

また、Distinct Valuesのリストの最初のエントリに 0.000000が表示され、0.500000と 1.000000が固有の値の

リストに表示されることに注意してください。

4.  More (2 of 2) > Display I/Q Map を押します。

I/Q Valuesテーブルの現在の値を元に I/Q ステート・マップが表示されます。

この例の I/Qステート・マップには、4個のシンボルがあります。この I/Qステート・マップには4つの固有の値0.5、
1.0、－0.5、－1.0があり、4個のシンボルを構成します。マップ上のシンボルの数を決めるのは値の数ではなく、値

の組合わせです。

5. Return を押します。

I/Q Valuesテーブルの内容が保存されていない場合、画面上に I/Q Values (UNSTORED)と表示されます。

6. More (1 of 2) > Load/Store > Store To File を押します。

Catalog of IQ Files にあるファイル名がすでにアクティブ入力エリアに表示されている場合は、以下のキーを押

します。Editing Keys > Clear Text

7. 英字キーとテンキーを使って、ファイル名（例えば NEW4QAM）を入力します。

8. Enter を押します。ユーザ定義の I/Q ステート・マップが Catalog of IQ Filesに保存され、本器の電源をオフにし

た後でもリコールできるようになります。

シンボル データ I値 Q値

0 0000 0.500000 1.000000

1 0001 －0.500000 1.000000

2 0010 0.500000 －1.000000

3 0011 －0.500000 －1.000000
152 第6章



カスタム任意波形発生器
変調タイプの操作
定義済み I/Q変調タイプ（I/Qシンボル）を変更して振幅エラーと位相エラーをシミュレート

以下の手順では、シンボル位置を操作して振幅および位相エラーをシミュレートします。この例では、4QAM コンスタ

レーションを編集して、1 個のシンボルを原点に近づけます。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) > Load Default I/Q Map > QAM
> 4QAM を押します。

デフォルトの 4QAM I/Q 変調が I/Q Valuesエディタにロードされます。

3. More (2 of 2) を押します。

4. I/Q Valuesエディタで、Data 00000000に移動し、Edit Item を押します。

5. .235702 > Enter、 .235702 > Enter を押します。

Enter を 1 回目に押したときには、I 値が更新され、強調表示は最初の Q エントリに移ります。2 回目には、Q 値が更

新され、強調表示は次の I エントリに移ります。

6. Display I/Q Map を押します。図に示すように、1 個のシンボルが移動しています。

FSK変調タイプのユーザ・ファイルを周波数値エディタを使って作成

この手順では、データ 00、01、10、11の周波数偏移を設定して、ユーザ定義 FSK 変調を構成します。 

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User FSK > More (1 of 2) > Delete All Rows > Confirm
Delete All Rows を押します。

Frequency Valuesエディタが表示され、前の値がクリアされます。

3. 600 > Hz を押します。

4. 1.8 > kHz を押します。

5. －600 > Hzを押します。
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6. －1.8 > kHzを押します。

値を入力するたびに、Data列は次の2進数に増加し、全部で16個のデータ値（0000から1111まで）が入ります。カ

スタム4レベルFSKファイルが作成されました。

7. Load/Store > Store To Fileを押します。

Catalog of FSK Filesにあるファイル名がすでにアクティブ入力エリアに表示されている場合は、以下のキーを押

します。

Edit Keys > Clear Text

8. 英字キーとテンキーを使って、ファイル名（例えばNEWFSK）を入力します。

9. Enterを押します。

ユーザ定義のFSK変調がCatalog of FSK Filesに保存されます。

定義済みFSK変調タイプのユーザ・ファイルを周波数値エディタを使って変更

Frequency Valuesエディタを使うことにより、ユーザ定義の周波数シフト・キーイング変調を定義し、変更し、保存す

ることができます。Frequency Valuesエディタはカスタム・リアルタイムI/Qベースバンド・モードで使用できますが、

カスタム任意波形発生器モードで生成された波形に対しては使用できません。この例では、デフォルトのFSK変調にエ

ラーを追加する方法を説明します。

1. Presetを押します。

2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User FSK > More (1 of 2) > Load Default FSKを押しま

す。

3. Freq Dev > 1.8 > kHz を押します。

4. 4-Lvl FSK を押します。

周波数偏移が設定され、Frequency Valuesエディタがオープンして、4 レベル FSK のデフォルト値が表示されます。

データ 0000の周波数値が強調表示されます。

5. － 1.81 > kHz を押します。

6. － 590 > Hz を押します。

7. 1.805 > kHz を押します。

8. 610 > Hz を押します。

値を変更するたびに、カーソルは次のデータ行に移動します。カスタム 4 レベル FSK ファイルが作成されました。

9. Load/Store > Store To File を押します。

Catalog of FSK Filesにあるファイル名がすでにアクティブ入力エリアに表示されている場合は、以下のキーを押

します。

Edit Keys > Clear Text

10. 英字キーとテンキーを使って、ファイル名（例えば NEWFSK）を入力します。

11. Enter を押します。

ユーザ定義の FSK 変調が Catalog of FSK Filesに保存されます。
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広帯域 IQ（オプション015）

オプション 015 付きの信号発生器は、2 チャネル任意波形発生器などの外部 I/Q 変調源を使って、RF で最大 2 GHz の変

調帯域幅を実現できます。広帯域 I/Q 入力を有効にする手順 :

1. フロント・パネルの I/Q ハードキーを押します。

2. I/Q Off を押します。

3. I/Q Path Wide (Ext Rear Inputs) を押します。

4. I/Q On を押します。

外部 I/Q 変調源を本器のリア・パネルにある Wideband I および Wideband Q 入力に接続します。入力の電圧レベルは±

1 Vdc です。広帯域 IQ（オプション 015）は 3.2 GHz より上の RF で使用できます。詳細についてはオプション 015 デー

タシートを参照してください。 

RF の広帯域入力を使用しながら、本器の内蔵任意波形発生器（ARB）をベースバンド信号源として利用できます。内蔵

ARB の I/Q 信号は、本器のリア・パネルに出力されます。以下の手順で、内蔵 ARB をベースバンド信号源として設定し、

広帯域入力を有効にします。 

1. 内蔵ベースバンド・ジェネレータに目的の信号を設定

2. Mux ハードキーを押します。

3. I/Q Out を押します。

4. BBG1 を押します。

5. フロント・パネルの I/Q ソフトキーを押します。

6. I/Q Off を押します。

7. I/Q Path Wide (Ext Rear Inputs) を押します。

8. I/Q On を押します。

ハードウェアの設定
• 「ARB 基準を設定する手順 」157 ページを参照

外部シングル・トリガの遅延、極性を設定する手順

この手順では、外部ファンクション・ジェネレータを使って、カスタム・マルチキャリア波形に遅延シングル・トリガを

適用する方法を説明します。

1. Agilent 33120A または同等のファンクション・ジェネレータを図 6-1 のように本器の PATT TRIGGER IN ポートに接

続します。
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図 6-1

2. 本器で Preset を押します。

3. Mode > Custom > Arb Waveform Generator を押します。

4. Multicarrier Off On を押して On を強調表示させます。

5. Trigger > Single を押します。

6. Trigger > Trigger Setup >Trigger Source > Ext を押します。

7. Ext Polarity Neg Pos を押して Pos を強調表示させます。

8. Ext Delay Off On を押して On を強調表示させます。

9. Ext Delay Time > 100 > msec を押します。

これにより、カスタム任意波形発生器が、リアパネルの PATT TRIG IN コネクタの TTL ステートがローからハイに変

化したのを検出してから 100 ms 後にシングル・マルチキャリア波形を再生するように設定されます。

10. ファンクション・ジェネレータの波形を、出力レベル 0 ～ 5 V の 0.1 Hz 方形波に設定します。 

11. 本器で Mode > Custom > Arb Waveform Generator > Digital Modulation Off On を押して On を強調表示させます。

カスタム・マルチキャリア・ステートの波形が生成され、表示が Dig Mod Setup: Multicarrierに変わります。

波形作成中には DIGMODと I/Qの 2 つのインジケータがオンになり、新しいマルチキャリア・ステートが揮発性任意

波形メモリに保存されます。この波形が RF 搬送波を変調します。

12. RF On/Off を押します。

PATT TRIG IN コネクタの TTL ステートがローからハイに変化してから 100 ms 後に、本器の RF OUTPUT コネクタか

らカスタム・マルチキャリア波形が出力されます。
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ARB基準を設定する手順

外部または内部基準の設定

1. Custom > Arb Waveform Generator > More (1 of 2) を押します。

2. Arb Reference Ext Int を押して、外部または内部の波形サンプル・クロック基準を選択します。

• Extを選択した場合、基準周波数（250 kHz～100 MHz）を入力し、リアパネルのBASEBAND GEN REF INコネ

クタに基準信号を印加する必要があります。

• Intを選択した場合、内部クロックが任意波形（ARB）の周波数基準として用いられます。

外部周波数の設定

外部任意波形基準周波数は、Arb Reference Ext Int ソフトキーが Ext（外部）に設定されている場合のみ使用されます。

1. Custom > Arb Waveform Generator > More (1 of 2) を押します。

2. Reference Freq を押し、必要な周波数（250 kHz ～ 100 MHz）を入力し、MHz、kHz、Hz のどれかを押します。
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7 カスタム・リアルタイム I/Qベースバンド

この章は以下のセクションに分かれており、カスタム・リアルタイム I/Q ベースバンド・モードについて説明します。こ

のモードは、オプション 601 または 602 付きの E8267D PSG ベクトル信号発生器だけで使用できます。

• 「概要」（159ページ）

• 「定義済み変調フォーマット（モード）の操作」（159ページ）

• 「データ・パターンの操作」（160ページ）

• 「バースト形状の操作」（165ページ）

• 「ハードウェアの設定」（169ページ）

• 「位相極性の操作」（171ページ）

• 「差分データ・エンコーディングの操作」（171ページ）

関連項目 : 第 3 章「基本デジタル操作」（67 ページ）

概要

カスタム・リアルタイム I/Q ベースバンド・モードでは、単一の搬送波をリアルタイム・データで変調して出力できるの

で、信号のすべてのパラメータをリアルタイムで制御できます。出力される単一搬送波信号は、さまざまなデータ・パター

ン、フィルタ、シンボル・レート、変調タイプ、バースト形状を適用することによって変化させることができます。

カスタム・リアルタイム I/Q ベースバンド・モードを使用するには、最初に定義済み変調フォーマットから 1 つを選択す

るか、Data Pattern、Filter、Symbol Rate、Modulation Type、Burst Shape、Configure Hardware、Phase Polarity、Diff
Data Encode Off On の各ソフトキーを選択して値を設定します。

定義済み変調フォーマット（モード）の操作

定義済み変調フォーマットを選択した場合、コンポーネントのデフォルト値（フィルタ、シンボル・レート、変調タイプ

など）が自動的に指定されます。

定義済みリアルタイム変調フォーマットの選択

以下の手順では、APCO 25 w/C4FM デジタル変調規格に基づいてフィルタ、シンボル・レート、変調タイプが定義された

変調フォーマットを選択し、カスタム変調トップレベル・メニューに戻ります。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband を押します。

3. More (1 of 3) > More (2 of 3) > Predefined Mode > APCO 25 w/C4FM を押します。

4. More (3 of 3) を押します。
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定義済みリアルタイム変調フォーマットの選択解除

以前に選択した変調フォーマットを選択解除してトップ・レベル・カスタム変調メニューに戻る手順 :

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband を押します。

3. More (1 of 3) > More (2 of 3) > Predefined Mode > None を押します。

4. More (3 of 3) を押します。

データ・パターンの操作

このセクションでは、以下の内容を説明します。

• 「定義済みデータ・パターンの使用」（161ページ）

• 「ユーザ定義データ・パターンの使用」（161ページ）

• 「外部供給データ・パターンの使用」（165ページ）

Data メニューを使うと、定義済みデータ・パターンおよびユーザ定義データ・パターンを選択できます。データ・パター

ンは、非フレーム化データの連続ストリームを送信するために用いられます。Custom Off On ソフトキーを On に設定す

ると、リアルタイム・カスタム I/Q シンボル・ビルダが、選択されているデータ・パターンと変調タイプに基づいて I/Q
シンボルを生成します。変調タイプの選択については、「変調タイプの操作」（149 ページ）を参照してください。

• 以下のデータ・パターンが使用できます。

• PN Sequenceを選択すると、疑似ランダム・シーケンス（疑似ランダム・ノイズ・シーケンス）の内部データ

生成のメニュー（PN9、PN11、PN15、PN20、PN23）が表示されます。 疑似ランダム・ノイズ・シーケンスと

は、等確率の周期的なバイナリ・シーケンスです。

• FIX4 0000を選択すると、4ビットの繰り返しシーケンス・データ・パターンを定義し、アクティブ機能にする

ことができます。選択された4ビット・パターンが必要に応じて繰り返され、連続データ・ストリームが生成

されます。

• Other Patternsでは、メニュー（4 1’s & 4 0’s、8 1’s & 8 0’s、16 1’s & 16 0’s、32 1’s & 32 0’s、64 1’s & 64 0’s）
からデータ・パターンを選択できます。各パターンには、1と0が同じ数だけ含まれています。選択されたパ

ターンが必要に応じて繰り返され、連続データ・ストリームが生成されます。

• User Fileを選択すると、メニューが表示され、ファイルを作成してビット・ファイルのカタログに保存するか、

ビット・ファイルのカタログからファイルを選択して使用するか、ビット・ファイルのカタログからファイル
を選択して編集して再保存するかを選択できます。

• Extを選択すると、データ・パターンをDATAポートからリアルタイムで I/Qシンボル・ビルダに供給すること

ができます。
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定義済みデータ・パターンの使用

定義済みPNシーケンス・データ・パターンの選択

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > PN Sequence を押します。

3. 下記のどれかを押します。PN9、PN11、PN15、PN20、PN23

定義済み固定4ビット・データ・パターンの選択

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > FIX4 を押します。

3.  1010 > Enter > Return を押します。

1と0の数が等しい定義済みデータ・パターンの選択

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > Other Patterns を押します。

3. 下記のどれかを押します。

4 1’s & 4 0’s、8 1’s & 8 0’s、16 1’s & 16 0’s、32 1’s & 32 0’s、64 1’s & 64 0’s

ユーザ定義データ・パターンの使用

ユーザ・ファイル（ユーザ定義のデータ・パターン・ファイル）は、本器のビット・ファイル・エディタを使って作成・変

更するか、リモート・コンピュータで作成して本器に転送することができます。 リモートで作成したデータ・パターン・

ファイルをビット・ファイル・エディタで変更することもできます。リモート・コンピュータでユーザ定義データ・ファ

イルを作成する方法については、『E8257D/67D PSG 信号発生器プログラミング・ガイド』を参照してください。

以下の手順では、ビット・ファイル・エディタを使って、カスタム・リアルタイム I/Q ベースバンド・ジェネレータの変調

に使用するユーザ定義データ・パターン・ファイルを作成、編集、保存する方法を説明します。この例では、カスタム・

デジタル通信でユーザ・ファイルを定義します。

ビット・ファイル・エディタによるデータ・パターン・ユーザ・ファイルの作成

この手順では、ビット・ファイル・エディタを使ってデータ・パターン・ユーザ・ファイルを作成し、結果のファイルを

メモリ・カタログ（51 ページで説明）に保存します。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > User File > Create File を押します。 

ビット・ファイル・エディタがオープンし、下の図のように 3 つの列が表示されます。
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注記 新規ファイルを作成したときは、デフォルトの名前がUNTITLED、UNTITLED1のように表示されます。これは前

のファイルを上書きしないためです。

3. テンキー（ソフトキーではなく）を使って、示された 32 ビット値を入力します。

ビット・ファイル・エディタではビット・データを 1 ビット形式で入力します。2 進データの現在の 16 進値が Hex
Data列に、カーソル位置（16 進）が Positionインジケータに示されます。

 
 16 進データ ファイル名インジケータビット・データ

カーソル位置イン

ジケータ（16進）

オフセット

（16進）
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4. More (1 of 2) > Rename > Editing Keys > Clear Text を押します。

5. 英字キーとテンキーを使って、ファイル名（例えば USER1）を入力します。

6. Enter を押します。

ユーザ・ファイルの名前が変更され、USER1という名前でファイルがメモリ・カタログに保存されます。

ビット・ファイルのカタログからのデータ・パターン・ユーザ・ファイルの選択

この手順では、ビット・ファイルのカタログからデータ・パターン・ユーザ・ファイルを選択する方法を説明します。ユー

ザ定義データ・ファイルをまだ作成して保存していない場合は、前のセクションの「ビット・ファイル・エディタによる

データ・パターン・ユーザ・ファイルの作成」（161 ページ）を先に実行してください。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > User File を押します。

3. 選択するファイル（USER1など）を強調表示します。

4. Edit File を押します。

選択したファイル（USER1など）がビット・ファイル・エディタでオープンします。

既存のデータ・パターン・ユーザ・ファイルの変更

この例では、既存のデータ・パターン・ユーザ・ファイルを変更するために、特定のビット位置に移動し、その値を変更

する方法を説明します。次に、既存のデータ・パターン・ユーザ・ファイルのビット値を反転する方法を説明します。

データ・パターン・ユーザ・ファイルの作成、保存、リコールをまだ実行していない場合は、前のセクションの「ビット・

ファイル・エディタによるデータ・パターン・ユーザ・ファイルの作成」（161 ページ）と「ビット・ファイルのカタログ

からのデータ・パターン・ユーザ・ファイルの選択」（163 ページ）を先に実行してください。

これらのビット値を入力  16 進データ

カーソル位置インジケータ
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既存のデータ・パターン・ユーザ・ファイルのビット値への移動

1. Goto > 4 > C > Enter を押します。

カーソルが下の図のようにテーブルのビット位置 4C に移動します。

既存のデータ・パターン・ユーザ・ファイルのビット値の反転

1. キーパッドで、1011 を押します。

4Cから 4Fまでの位置のビット値が反転されます。下の図のように、この行の 16進値が 76DB6DB6に変わっています。

カーソルが新しい位置に移動 位置インジケータが変化

ビット 4C から 4F までを反転 16 進データが変化
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既存のデータ・パターン・ユーザ・ファイルにビット・エラーを適用する手順

この例では、既存のデータ・パターン・ユーザ・ファイルにビット・エラーを適用する方法を説明します。データ・パター

ン・ユーザ・ファイルをまだ作成して保存していない場合は、前のセクションの「ビット・ファイル・エディタによるデー

タ・パターン・ユーザ・ファイルの作成」（161 ページ）を先に実行してください。

1. Apply Bit Errors を押します。

2. Bit Errors > 5 > Enter を押します。

3. Apply Bit Errors を押します。

2 つの Bit Errors ソフトキーは連動しているのでともに値が変わります。

外部供給データ・パターンの使用

この手順では、DATA、DATA CLOCK、SYMBOL SYNC の各コネクタから、外部リアルタイム・データ・パターンを供給

します。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Data > Ext を押します。

3. リアルタイム・データを DATA 入力に接続します。

4. データ・クロック・トリガ信号を DATA CLOCK 入力に接続します。

5. シンボル同期トリガを SYMBOL SYNC 入力に接続します。

バースト形状の操作

• 「バースト立ち上がり／立ち下がりパラメータの設定」（166ページ）

• 「ユーザ定義バースト形状曲線の使用」（166ページ）

Burst Shape メニューでは、立ち上がり／立ち下がり時間、立ち上がり／立ち下がり遅延、バースト形状（正弦波または

ユーザ・ファイル定義）を変更できます。また、Rise Shape エディタを使ってバースト形状を定義してプレビューしたり、

バースト形状のすべてのパラメータを元のデフォルト状態に戻したりすることもできます。

立ち上がり時間  バーストが－70 dB（0）の最小値からフル・パワー（1）まで上昇するのにかかる時間をビット単

位で表したもの。

立ち下がり時間  バーストがフル・パワー（1）から－ 70 dB（0）の最小値まで下降するのにかかる時間をビット単

位で表したもの。

立ち上がり遅延  バーストの立ち上がりの開始を遅延する時間をビット単位で表したもの。立ち上がり遅延は負また

は正の値を取れます。0 以外の遅延を指定すると、フル・パワー・ポイントが最初の有効シンボル

の先頭よりも前または後に移動します。

立ち下がり遅延  バーストの立ち下がりの開始を遅延する時間をビット単位で表したもの。立ち下がり遅延は負また

は正の値を取れます。0 以外の遅延を指定すると、フル・パワー・ポイントが最後の有効シンボル

の末尾よりも前または後に移動します。

ユーザ定義

バースト形状  指定された立ち上がりまたは立ち下がり時間内の曲線の形状を定義するためにユーザが指定する

最大 256 個の値。値は 0（パワーなし）から 1（フル・パワー）までの範囲で、直線的にスケーリ

ングされます。指定された値は必要に応じて再サンプリングされ、すべてのサンプル・ポイントを

通る 3 次スプラインが作成されます。

各フォーマットのデフォルトのバースト形状は、選択したフォーマットの標準に基づいて実現されています。ただし、ユー

ザはバースト形状の以下の要素を変更できます。
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バースト形状の立ち上がり／立ち下がり時間の最大値は、以下の要素に影響されます。

• シンボル・レート

• 変調タイプ

立ち上がり／立ち下がり遅延が 0 の場合、バースト形状の最大パワーが最初の有効シンボルの先頭と最後の有効シンボル

の末尾に同期されます。 

バーストをオンにするとエラー・ベクトル振幅（EVM）または隣接チャネル漏洩電力（ACP）が増加する場合、バースト

形状を調整するとトラブルシューティングに役立つ可能性があります。

バースト立ち上がり／立ち下がりパラメータの設定

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Burst Shape を押します。

3. Rise Time > 5 > bits を押します。

4. Rise Delay > 1 > bits を押します。

5. Fall Time > 5 > bits を押します。

6. Fall Delay > 1 > bits を押します。

カスタム・リアルタイム I/Q ベースバンド・デジタル変調フォーマットのバースト形状が構成されます。ユーザ定義バー

スト形状曲線の作成と適用の方法については、「ユーザ定義バースト形状曲線を作成して保存する手順」（167 ページ）を

参照してください。

ユーザ定義バースト形状曲線の使用

立ち上がり曲線と立ち下がり曲線の形状を調整するには、Rise Shapeおよび Fall Shapeエディタを使います。これら

のエディタでは、最大 256 個の時間的に等間隔の値を入力して、曲線の形状を定義します。これらの値は再サンプリング

され、すべてのサンプル・ポイントを通る 3 次スプラインが作成されます。

Rise Shapeおよび Fall Shapeエディタは、カスタム・リアルタイム I/Q ベースバンド・ジェネレータの波形に対して使

用できます。デュアル任意波形発生器で作成された波形に対しては使用できません。

0

1

パ
ワ
ー 立ち上

がり
遅延

立ち上がり
時間

立ち下がり
時間

立ち
下がり
遅延

時間

ユーザ定義
の値 ユーザ定義

の値
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バースト形状ファイルを外部で作成して、データを本器にダウンロードすることもできます。詳細については、

『E8257D/67D PSG 信号発生器プログラミング・ガイド』を参照してください。

ユーザ定義バースト形状曲線を作成して保存する手順

この手順では、立ち上がり形状のサンプル値を入力し、立ち下がり形状の値に反転して対称なバースト形状を作成する方

法を説明します。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Burst Shape を押します。

3. Define User Burst Shape > More (1 of 2) > Delete All Rows > Confirm Delete Of All Rows を押します。

4. 次の表に示すサンプル値を入力します。

a. サンプル 1 の値（1.000000）を強調表示します。

b. .4 > Enter を押します。

c. .6 > Enter を押します。

d. 上の表のサンプル 3 から 9 までの残りの値を入力します。

e. More (2 of 2) > Edit Fall Shape > Load Mirror Image of Rise Shape > Confirm Load Mirror Image of Rise Shape を押します。

立ち下がり形状の値が、立ち上がり形状の値の逆順に設定されます。

立ち上がり形状エディタ

サンプル 値 サンプル 値

0 0.000000 5 0.900000

1 0.400000 6 0.950000

2 0.600000 7 0.980000

3 0.750000 8 0.990000

4 0.830000 9 1.000000
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図 7-1

5. More (1 of 2) > Display Burst Shape を押します。

波形の立ち上がり／立ち下がり特性のグラフィック表現が示されます。

図 7-2

注記 バースト形状をデフォルト状態に戻すには、Return > Return > Confirm Exit From Table Without Saving > Restore
Default Burst Shapeを押します。

6. Return > Load/Store > Store To File を押します。

Catalog of SHAPE Filesにあるファイル名がすでにアクティブ入力エリアに表示されている場合は、以下のキーを

押します。Editing Keys > Clear Text

7. 英字キーとテンキーを使って、ファイル名（例えば NEWBURST）を入力します。
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8. Enter を押します。

Rise ShapeおよびFall Shapeエディタの現在の内容がCatalog of SHAPE Filesに保存されます。このバースト形

状は、変調をカスタマイズしたり、新しいバースト形状デザインの基礎としたりするために使用できます。

ユーザ定義バースト形状曲線をメモリ・カタログから選択してリコールする手順

メモリ・カタログに保存したユーザ定義バースト形状曲線は、リコールしてリアルタイム I/Q ベースバンド生成のデジタ

ル変調で使用できます。

この例では、ユーザ定義バースト形状ファイルがメモリに保存されている必要があります。ユーザ定義バースト形状ファ

イルをまだ作成して保存していない場合は、前のセクションの手順を先に実行してください。

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Burst Shape > Burst Shape Type > User File を押します。

3. 目的のバースト形状ファイル（例えば NEWBURST）を強調表示します。

4. Select File を押します。

選択したバースト形状ファイルが現在のリアルタイム I/Q ベースバンド・デジタル変調フォーマットに適用されます。

5. Return > Custom Off On を押します。

これにより、前の手順で作成したユーザ定義バースト形状を持つカスタム変調が生成されます。波形生成中には

CUSTOMと I/Qの 2 つのインジケータがオンになります。波形は RF 搬送波を変調しています。

6. RF On/Off を押します。

ユーザ定義バースト形状を持つ現在のリアルタイム I/Q ベースバンド・デジタル変調フォーマットが、本器の RF
OUTPUT コネクタから出力されます。

ハードウェアの設定

• 「BBG基準を設定する手順」（169ページ）

• 「外部データ・クロック入力をノーマルまたはシンボルに設定する手順」（170ページ）

• 「BBGデータ・クロックを外部または内部に設定する手順」（170ページ）

• 「I/Qスケーリングを調整する手順」（170ページ）

BBG基準を設定する手順

外部または内部基準の設定

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware を押します。

Configure Hardware で表示されるメニューから、BBG 基準を外部または内部に設定できます。
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2. BBG Ref Ext Int を押して、データ・ジェネレータの基準ビット・クロックを外部にするか内部にするかを選択します。

外部を選択した場合、基準信号をリア・パネルの BASEBAND GEN REF IN コネクタに入力します。

外部周波数の設定

BBG 基準外部周波数が用いられるのは、BBG Ref Ext Int ソフトキーが Ext（外部）に設定されている場合だけです。

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware を押します。

Configure Hardware で表示されるメニューから、外部 BBG 基準周波数を設定できます。

2. Ext BBG Ref Freq を押します。

3. テンキーを使って必要な周波数を入力し、MHz、kHz、Hz のどれかを押します。

外部データ・クロック入力をノーマルまたはシンボルに設定する手順

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware を押します。

Configure Hardware を押すと、外部データ・クロック入力をノーマルまたはシンボルに設定するためのメニューが表

示されます。

2. Ext Data Clock を押して、Normal または Symbol を選択します。 この設定は内部クロック・モードでは無意味です。

• Normalに設定した場合、DATA CLOCK入力コネクタにビット・クロックを供給する必要があります。

• Symbolに設定した場合、SYMBOL SYNC入力コネクタに単発または連続のシンボル同期信号を供給する必要があ

ります。

BBGデータ・クロックを外部または内部に設定する手順

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware を押します。

Configure Hardware を押すと、BBG データ・クロック入力を外部または内部に設定するためのメニューが表示され

ます。

2. BBG Data Clock Ext Int を押して、外部または内部を選択します。

• Ext（外部）に設定した場合、DATA CLOCKコネクタにBBGデータ・クロックを供給します。

• Int（内部）に設定した場合、内部データ・クロックが用いられます。

I/Qスケーリングを調整する手順

I/Q スケーリング（I/Q 出力の振幅）を調整すると、選択した I/Q スケーリング・ファクタによって I および Q データが乗

算され、隣接チャネル漏洩電力（ACP）を改善する効果があります。スケーリング値が小さい方が ACP が改善されます。

この設定は、MSK または FSK 変調では無視されます。

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware を押します。

Configure Hardware を押すと、I/Q スケーリングを調整するためのメニューが表示されます。

2. I/Q Scaling を押し、必要な I/Q スケーリング・レベルを入力し、% を押します。
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位相極性の操作

位相極性をノーマルまたは反転に設定する手順

1. Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Phase Polarity Normal Invert を押します。

Phase Polarity Normal Invert を押すと、位相極性を Normal（I/Q 信号の間の位相関係を位相極性機能で変更しない）

のままにするか、あるいは Invert に設定して内部 Q 信号を反転し、位相変調ベクトルの回転方向を逆にするかを選択

できます。

Invert を選択した場合、結果の変調では同相成分が直交位相成分よりも 90°遅れます。位相極性の反転は一部の無線

規格で要求されており、下側波帯ミキシング・アプリケーションで役立ちます。反転を選択すると、I、I-bar、Q、

Q-bar の各出力信号もそれに従います。

差分データ・エンコーディングの操作

Diff Data Encoding Off On メニューを使うと、本器の差分データ・エンコーディングの動作状態を切り替えることができ

ます。

• Offに設定した場合、データ・ビットは変調前にエンコードされません。

• Onに設定した場合、データ・ビットは変調前にエンコードされます。差分エンコーディングでは、排他的論理

和演算を使って変調されるビットを生成します。変調されるビットは、データ・ビットが前のビットと異なる
値の場合は1、同じ値の場合は0の値を取ります。

このセクションでは、以下の内容を説明します。

• 差分エンコーディングの理解

• 「差分エンコーディングの使用」（175ページ）

差分エンコーディングの理解

差分エンコーディングとは、信号の特定の状態でなく信号の変化によってバイナリ値を表現するデジタル・エンコーディ

ング方式です。差分エンコーディングを使った場合、ユーザ定義の I/Q または FSK 変調のデータを、差分ステート・マッ

プに定義されたシンボル・テーブル・オフセットに基づいて変調プロセスの間にエンコードすることができます。

例えば、本器のデフォルト 4QAM I/Q 変調を考えます。デフォルトの 4QAM テンプレートに基づくユーザ定義変調では、

I/Q Valuesエディタには 4 個のシンボル（00、01、10、11）を表現するデータが含まれます。 これらのシンボルは、2 つ

の固有の値 1.000000 および－ 1.000000 によって I/Q 平面上にマッピングされます。これら 4 個のシンボルを変調プロセ

ス中に差分エンコードするには、各データ値に対応するシンボル・テーブル・オフセット値を割り当てます。172 ページ

の図 7-3 は、4QAM 変調を I/Q Valuesエディタに表示したところです。
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図 7-3

注記 シンボルあたりのビット数は、下記の式で表されます。この式はシーリング関数なので、xの値に小数部分があ

る場合、xは次の整数に切り上げられます。 

ここで、x はシンボルあたりのビット数、y は差分ステートの数です。

下の図は、4QAM 変調の I/Q ステート・マップを表します。

差分データ・エンコーディング

リアルタイム I/Q ベースバンド・デジタル変調波形においては、データ（1 と 0）はエンコードされ、変調されて搬送波

周波数に載せられた後、レシーバに送信されます。差分エンコーディングに対して差分データ・エンコーディングでは、

データ・ストリームを I/Q マッピングの前に変更します。差分エンコーディングではシンボル・テーブル・オフセット値

を使って変調の時点で I/Q マッピングを操作することによって生データをエンコードするのに対して、差分データ・エン

12

3 4

1番目のシンボル

データ=00000000

固有の値 : ＋1, ＋1

4番目のシンボル

データ=00000011

固有の値 : ＋1, －1

2番目のシンボル

データ=00000001

固有の値 : －1, ＋1

3番目のシンボル

データ=00000010

固有の値 : －1, －1
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コーディングでは 1 つのビット値から別のビット値への遷移によって生データをエンコードします。

差分データ・エンコーディングでは、デジタイズされた生データから、エンコードされた 2 次的なデータ・ストリームを

作成します。 このデータ・ストリームは、生データ・ストリームのデジタル・ステートの 1 から 0 または 0 から 1 の変化

によって定義されます。この差分エンコードされたデータ・ストリームが変調され、送信されます。

差分データ・エンコーディングでは、生データ・ビットのデジタル・ステートが 1 から 0 または 0 から 1 に変化したとき

にエンコードされたデータ・ストリームに 1 が生じます。生データのデジタル・ステートがビットからビットで変化しな

い場合、すなわち 1 のビットの後に 1 のビット、0 のビットの後に 0 のビットが続いた場合は、エンコードされたデータ

は0になります。例えば、01010011001010というデータ・ストリームを差分エンコードすると、1111010101111となります。

差分データ・エンコーディングは次の式で記述されます。

ビット単位のエンコーディング・プロセスを下の図に示します。 

差分エンコーディングの仕組み

差分エンコーディングでは、シンボル・テーブル中のオフセットを使って、ユーザ定義変調方式をエンコードします。

Differential State Mapエディタを使ってシンボル・テーブル・オフセット値が定義され、それらに対応するデータ値

に基づいて I/Q ステート・マップ上の遷移が起こります。データ値が変調されるたびに、差分ステート・マップに保存さ

れているオフセット値を使って、シンボル・テーブル・オフセット値で定義される方向と距離だけ I/Q ステート・マップ

上でデータを遷移させることによりエンコーディングが行われます。

＋ 1 の値を入力すると、I/Q ステート・マップ上で順方向に 1 ステートの遷移が起こります。次のデータ／シンボル・テー

ブル・オフセット値を例に取ります。これらのシンボル・テーブル・オフセットからは、以下の図の遷移のどれかが生じます。

transmittedbit i( ) databit i 1–( )= databit i( )⊕

1 0 1 0 0 1 1 0 0 11 0

生（エンコード前）データ

差分エンコードされたデータ

1 1 11 1 1 1 1 110 0 0

変化あり =

変化なし =

0
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注記 以下のI/Qステート・マップの図は、特定のシンボル・テーブル・オフセット値から起こりうるすべてのステー

ト遷移を示します。実際のステート間遷移は、変調が開始されたときのステートによって異なります。

例2

1ステート逆方向の遷移
例1

1ステート順方向の遷移

例3

2ステート順方向の遷移

例4

遷移なし

xx

例 データ オフ
セット

値

1 00000000 ＋1

2 00000001 −1

3 00000010 ＋2

4 00000011 0
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上の図は、ユーザ定義デフォルト 4QAM I/Q マップにおいて、1 番目のシンボル（データ 00）から始まるデータ・スト

リーム（2 ビット・シンボルで）0011100001 に対する差分エンコーディングによる遷移を示します。 

図からわかるように、1 番目と 4 番目のシンボルは同じデータ値（00）を持つので、同じステート遷移（1 ステート順方

向）を生じます。差分エンコーディングでは、シンボル値は位置を定義するのではなく、I/Q ステート・マップ上の遷移

の方向と距離を定義します。

差分エンコーディングを構成する方法については、「差分エンコーディングの理解」（171 ページ）を参照してください。

差分エンコーディングの使用

差分エンコーディングとは、信号の特定の状態でなく信号の変化によってバイナリ値を表現するデジタル・エンコーディ

ング方式です。これはカスタム・リアルタイム I/Q ベースバンド・モードで使用できます。任意波形発生器モードで作成

された波形に対しては使用できません。

本器の Differential State Mapエディタを使えば、ユーザ定義 I/Q 変調およびユーザ定義 FSK 変調に対応する差分ス

テート・マップを変更できます。この手順では、ユーザ定義 I/Q 変調を作成し、そのユーザ定義変調に対して差分エンコー

ディングを構成し、アクティブにし、適用します。詳細については、「差分エンコーディングの理解」（171 ページ）を参

照してください。

このセクションでは、以下の内容を説明します。

• ユーザ定義 I/Q変調の設定

• 「差分ステート・マップ・エディタへのアクセス」（176ページ）

• 「差分ステート・マップの編集」（177ページ）

データ値 シンボル・テーブル・オフセット
00
01
10
11

＋ 1
－ 1
＋ 2
＋ 0

データ = 0011100001
{{

{ {

{
5 番目のシンボル1 番目のシンボル

3 番目のシンボル

4 番目のシンボル2 番目のシンボル

1st 

2nd

3rd
5th 4th
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ユーザ定義 I/Q変調の設定

1. Preset を押します。

2. Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) > Load Default I/Q Map >
QAM > 4QAM を押します。

デフォルトの 4QAM I/Q 変調がロードされ、I/Q 値エディタに表示されます。デフォルトの 4QAM I/Q 変調には、2 つの

固有の値（1.0000000 と－ 1.0000000）によって I/Q 平面上にマッピングされる 4 個のシンボル（00、01、10、11）を表

すデータが含まれます。変調プロセスは、各データ・シンボルに対応するシンボル・テーブル・オフセット値に基づいて、

これら 4 個のシンボルの上をたどります。

差分ステート・マップ・エディタへのアクセス

• Configure Differential Encodingを押します。 

これにより、Differential State Map エディタがオープンします。この時点では、1 番目のシンボル（00000000）の

データと、オフセット値を入力するためのカーソルが表示されます。 ここから、ユーザ定義デフォルト 4QAM I/Q 変調の

ためのカスタム差分エンコーディングを作成することができます。
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差分ステート・マップの編集

1. 1 > Enter を押します。

シンボル・テーブル・オフセット 1 が入力され、1 番目のシンボルがエンコードされます。 データ値 0 が変調される

と、シンボルはステート・マップ上で値 1 だけ順方向に回転します。

2. ＋ / － > 1 > Enter を押します。 

シンボル・テーブル・オフセット－ 1 が入力され、2 番目のシンボルがエンコードされます。 データ値 1 が変調され

ると、シンボルはステート・マップ上で値 1 だけ逆方向に回転します。

注記 この時点では、この変調はシンボルあたり1ビットです。最初の2つのデータ値（00000000と00000001）にお

いて、意味があるのは最後のビット（0と1）だけです。 

3. 2 > Enter を押します。

シンボル・テーブル・オフセット 2 が入力され、3 番目のシンボルがエンコードされます。データ値 10 が変調される

と、シンボルはステート・マップ上で値 2 だけ順方向に回転します。

4. 0 > Enter を押します。

シンボル・テーブル・オフセット 0 が入力され、4 番目のシンボルがエンコードされます。データ値 11 が変調される

と、シンボルはステート・マップ上で回転しません。

注記 この時点では、この変調はシンボルあたり 2 ビットです。最初のデータ値 00000000、00000001、00000010、
00000011において、シンボル値は00、01、10、11です。

シンボル・テーブル・オフセット値入力エリアデータ
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5. Return > Differential Encoding Off On を押します。 

カスタム差分エンコーディングがユーザ定義変調に適用されます。 

注記 本器画面の Differential State Mapの隣に (UNSTORED)) と表示されていることに注意してください。差

分ステート・マップは、適用対象のユーザ定義変調に関連づけられています。 

カスタム差分ステート・マップを保存するには、適用対象のユーザ定義変調を保存する必要があります。保

存しておかないと、I/Q または FSK エディタを終了させるときに Confirm Exit From Table Without Saving を押

した時点で、シンボル・テーブル・オフセット・データは削除されます。
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この章は以下のセクションに分かれており、マルチトーン・モードについて説明します。このモードは、オプション 601
または 602 付きの E8267D PSG ベクトル信号発生器だけで使用できます。

• 「概要」（179ページ）

• 「マルチトーン波形の作成、表示、最適化」（180ページ）

関連項目 : 第 3 章「基本デジタル操作」（67 ページ）

概要

マルチトーン・モードでは、64 個までの CW 信号すなわちトーンをもつ波形を作成できます。Multitone Setupテーブ

ル・エディタを使って、波形の定義、変更、保存、再生ができます。マルチトーン波形は内部 I/Q ベースバンド・ジェネ

レータによって作成されます。

マルチトーン波形発生器は、ミキサや増幅器などのマルチチャネル・デバイスの相互変調歪み特性をテストするために多

く用いられます。相互変調歪み（IMD）が発生するのは、複数の入力周波数を持つ非線形デバイスが、他の周波数に不要

な出力を生じたり、隣接チャネルに干渉したりする場合です。マルチトーン波形発生器から供給されるユーザ指定の数の

トーンを持つ波形の IMD 成分をスペクトラム・アナライザで測定することで、被試験デバイスから生成される IMD を測

定する際の基準として使用できます。 

マルチトーン波形は内部 I/Q ベースバンド・ジェネレータで生成され、任意波形メモリに保存されて再生されます。マル

チトーン・モードでは高品質の波形が生成されますが、わずかな IMD、キャリア・フィードスルー、フィードスルー関連

の IMD が発生します。キャリア・フィードスルーは生成するトーンの数が偶数の場合に見られます。これは、フィードス

ルーをマスクするトーンが中心搬送波周波数に存在しないからです。偶数マルチトーン信号のキャリア・フィードスルー

を最小化するには、中心搬送波周波数をスペクトラム・アナライザで観察しながら I と Q のオフセットを手動で調整する

必要があります。 

64 個を超えるトーンが必要な測定、あるいは IMD とキャリア・フィードスルーが存在しない測定が必要な場合は、Agilent
Signal Studio ソフトウェア・オプション 408 を使って、1024 個までの歪みのないマルチトーン信号を作成できます。

注記 マルチトーン波形の特性および PSG ベクトル信号発生器のマルチトーン・フォーマットの詳細については、ア

プリケーション・ノート1410（カタログ番号：5988-7689JA）を参照してください。 
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マルチトーン波形の作成、表示、最適化

このセクションでは、スペクトラム・アナライザで波形を観察しながら、マルチトーン波形の設定、作成、最適化の方法

を説明します。作成したマルチトーン信号を観察するスペクトラム・アナライザは、十分な周波数レンジを持つものであ

れば何でもかまいませんが、この説明では Agilent PSA ハイパフォーマンス・スペクトラム・アナライザを使用していま

す。信号を作成する前に、図 8-1 のようにスペクトラム・アナライザを本器に接続します。

図 8-1 スペクトラム・アナライザのセットアップ

カスタム・マルチトーン波形を作成する手順

Multitone Setup テーブル・エディタを使って、ユーザ定義マルチトーン波形の定義、変更、保存を行うことができま

す。マルチトーン波形はデュアル任意波形発生器によって作成されます。

1. 本器を初期設定します。

2. 本器の RF 出力周波数を 20 GHz に設定します。

3. 本器の RF 出力振幅を 0 dBm に設定します。

4. Mode > Multitone > Initialize Table > Number of Tones > 9 > Enter を押します。

5. Freq Spacing > 1 > MHz を押します。

6. Initialize Phase Fixed Random を押して Random にします。

7. Done を押します。

8. Multitone Off On を押して On にします。

9. RF 出力をオンにします。

本器の RF OUTPUT コネクタからマルチトーン信号が出力されます。

図 8-2 は、上記の手順を終了した時点での本器の画面を示します。M-TONE、I/Q、RF ON、MOD ON の各インジケータが

表示され、信号のパラメータ設定が画面のステータス・エリアに表示されています。マルチトーン波形は揮発性任意波形

メモリに保存されています。
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波形には 9 個のトーンがあり、それぞれの間隔は 1 MHz で、初期位相値はランダムに決められます。中心トーンは搬送波

周波数にあり、他の 8 個のトーンは中心トーンから 1 MHz ずつの間隔をおいて配置されます。作成するトーンの数が偶数

の場合は、真ん中の 2 つのトーンの中心が搬送波周波数になります。

図 8-2

マルチトーン波形を表示する手順

この手順では、スペクトラム・アナライザを設定してマルチトーン波形とその IMD 成分を表示する方法を説明します。実

際に押すキーは、使用するスペクトラム・アナライザのモデルによって異なります。

1. スペクトラム・アナライザを初期設定します。

2. 搬送波周波数を 20 GHz に設定します。

3. 周波数スパンを 20 MHz に設定します。

4. 振幅を 4 dBm 基準の 10 dB スケールに設定します。 

5. IMD 成分が観察できる程度にノイズ・フロアが小さくなるように分解能帯域幅を調整します。この例では 9.1 kHz の

設定を使用しています。

6. ピーク・ディテクタをオンにします。

7. スペクトラム・アナライザの入力ミキサをオーバドライブしないために、減衰を 14 dB に設定します。 

図 8-3 のように、中心搬送波周波数が 20 GHz の 9 個のトーンを持つ波形が表示されるはずです。また、最高と最低のトー

ンから上下に 1 MHz 間隔で IMD 成分が見られるはずです。
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図 8-3

マルチトーン・セットアップ・テーブルを編集する手順

この手順は、前の手順から続いています。

1. Initialize Table > Number of Tones > 10 > Enter を押します。

2. Done を押します。

3. 2 行目のトーンの State列の値（On）を強調表示します。

4. Toggle State を押します。

5. 4 行目のトーンの Power列の値（0 dB）を強調表示します。

6. Edit Item > － 10 > dB を押します。

7. 4 行目のトーンの Phase列の値（0）を強調表示します。

8. Edit Item > 123 > deg を押します。

 

相互変調
歪み

マルチトーン
チャネル
182 第8章



マルチトーン波形発生器
マルチトーン波形の作成、表示、最適化
9. Apply Multitone を押します。

注記 マルチトーン発生器の動作中（Multitone Off OnがOnのとき）に設定を変更した場合、更新された波形を発生す

るには、Apply Multitoneソフトキーを押して変更を適用する必要があります。変更を適用すると、ベースバン

ド・ジェネレータは新しい設定を使ってマルチトーン波形を発生し、任意波形メモリ上の既存の波形を置き換え

ます。

上記の手順により、トーンの数が 10 に変更され、トーン 2 がオフになり、トーン 4 のパワーと位相が変更されます。図

8-4 は、上記の手順を終了した時点での本器のマルチトーン・セットアップ・テーブル画面を示します。スペクトラム・

アナライザに表示される波形は、184 ページの図 8-5 のようになるはずです。偶数マルチトーン波形の場合、中心搬送波

周波数にわずかなキャリア・フィードスルーが見られます。

図 8-4
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図 8-5

キャリア・フィードスルーを最小化する手順

この手順では、キャリア・フィードスルーを最小化し、トーンとその相互変調歪み成分との間のパワーの差を測定する方

法を説明します。キャリア・フィードスルーが観察されるのは偶数マルチトーン波形の場合だけです。

この手順は、前の手順から続いています。

1. スペクトラム・アナライザで、約 100 ～ 200 ms の掃引速度に合わせて分解能帯域幅を設定します。これにより、調

整を行いながら動的にキャリア・フィードスルー・スパイクを観察できます。

2. 本器で I/Q > I/Q Adjustments > I/Q Adjustments Off On を押して On にします。

3. I Offset を押し、スペクトラム・アナライザでキャリア・フィードスルーを観察しながら回転ノブを回します。I オフ

セットを正しい方向に変化させると、フィードスルーのレベルが下がります。レベルができるだけ低くなるように調

整します。

4. Q Offset を押し、回転ノブを回してさらにキャリア・フィードスルーのレベルを下げます。

5. キャリア・フィードスルーのレベルがそれ以上下がらなくなるまでステップ 3 と 4 を繰り返します。

6. スペクトラム・アナライザで、分解能帯域幅を元の設定に戻します。

キャリア・
フィードスルー

 

相互変調
歪み

トーン 1

キャリア・
フィードスルー
歪み

トーン 10
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7. 波形アベレージングをオンにします。

8. マーカを作成し、どちらかの端のトーンのピークに配置します。

9. デルタ・マーカを作成し、隣接する相互変調成分のピークに配置します。 これはマーカのあるトーンから 10 MHz 離れ

ているはずです。

10. トーンとその歪み成分との間のパワー差を測定します。 

図 8-6 のような画面が表示されるはずです。この最適化されたマルチトーン信号は、被試験デバイスから生成される IMD
成分を測定するために使用できます。 

なお、キャリア・フィードスルーは時間と温度によって変化します。したがって、信号を常に最適化しておくためには、

定期的に I と Q のオフセットを再調整する必要があります。

図 8-6

ピーク・アベレージ特性を求める手順

この手順では、マルチトーン波形のトーンの位相を設定し、相補累積分布関数（CCDF）をプロットすることでピーク・

アベレージ特性を求める方法を説明します。

1. Mode > Multitone > Initialize Table > Number of Tones > 64 > Enter を押します。

2. Freq Spacing > 20 > kHz を押します。

3. Initialize Phase Fixed Random を押して Fixed にします。

最小化された

 

キャリア・
フィードスルー

相互変調
歪み

トーン 1

キャリア・
フィードスルー
歪み

トーン 10
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4. Done を押します。

5. Apply Multitone を押します。

6. More (1 of 2) > ARB Setup > Waveform Utilities > Waveform Statistics > Plot CCDF を押します。

図 8-7 のような画面が表示されるはずです。この CCDF プロットは、すべての位相を 0 に設定したときの波形のピー

ク・アベレージ特性を示します。

図 8-7 固定位相を設定したCCDFプロット

7. Mode Setup > Initialize Table を押します。

8. Initialize Phase Fixed Random を押して Random にします。

9. Random Seed Fixed Random を押して Random にします。

10. Done を押します。

11. Apply Multitone を押します。

12. More (1 of 2) > Waveform Statistics > Plot CCDF を押します。

図 8-8 のような画面が表示されるはずです。この CCDF プロットは、ランダムなシードでランダムに位相を発生した

ときの波形のピーク・アベレージ特性を示します。 

ランダム位相設定は、マルチトーン波形に一般的なランダムな性質をシミュレートします。ランダムに分布した位相

の場合、固定位相の場合よりもピーク・アベレージ比がはるかに低いことに注目してください。ランダム位相のトー

ンの数が増えると、最大ピーク・パワーの発生確率が下がります。

 

ピーク・
パワー
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図 8-8 ランダム位相を設定したCCDFプロット

 

ピーク・
パワー
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9 2トーン波形発生器

この章は以下のセクションに分かれており、2 モードについて説明します。このモードは、オプション 601 または 602 付

きの E8267D PSG ベクトル信号発生器だけで使用できます。

• 「概要」（189ページ）

• 「2トーン波形の作成、表示、変更」（189ページ）

関連項目 : 「任意（ARB）波形ファイルのヘッダ」（68 ページ）

概要

2 トーン・モードでは、パワーが等しい 2 つの CW 信号すなわちトーンを持つ波形を作成できます。デフォルトの波形で

は、2 つのトーンが中心搬送波周波数に対して対称に配置され、振幅、搬送波周波数、周波数間隔がユーザ定義可能です。

また、搬送波周波数に対してトーンを左整列または右整列にできます。

2 トーン波形発生器は、ミキサや増幅器などの非線形デバイスの相互変調歪み特性をテストすることを目的としています。

相互変調歪み（IMD）が発生するのは、複数の入力周波数を持つ非線形デバイスが、隣接チャネルに干渉したり、他の周

波数に不要な出力を生じたりする場合です。2 トーン波形発生器から供給される信号の IMD 成分をスペクトラム・アナラ

イザで測定することで、被試験デバイスから発生する IMD を測定する際の基準として使用できます。 

2 トーン波形は内部 I/Q ベースバンド・ジェネレータで作成され、任意波形メモリに保存されて再生されます。2 トーン・

モードでは高品質の波形が作成されますが、わずかな IMD が発生します。このほかに、2 つのトーンの間の中心が搬送波

周波数にある場合は、わずかなキャリア・フィードスルーおよびフィードスルー関連の IMD が存在する場合があります。

2 トーン信号のキャリア・フィードスルーを最小化するには、中心搬送波周波数をスペクトラム・アナライザで観察しな

がら I と Q のオフセットを手動で調整する必要があります。IMD とキャリア・フィードスルーが存在しない測定が必要な

場合は、Agilent Signal Studio ソフトウェア・オプション 408 を使って、歪みのないマルチトーン信号を作成できます。

注記 2トーン波形の特性およびE8257D/67D PSGベクトル信号発生器の2トーン・フォーマットの詳細については、

アプリケーション・ノート1410（カタログ番号：5988-7689JA）を参照してください。 

2トーン波形の作成、表示、変更

このセクションでは、スペクトラム・アナライザで波形を観察しながら、2 トーン波形の設定、作成、変更の方法を説明

します。作成した 2 トーン信号を観察するスペクトラム・アナライザは、十分な周波数レンジを持つものであれば何でも

かまいませんが、この説明では Agilent PSA シリーズ・ハイパフォーマンス・スペクトラム・アナライザを使用していま

す。信号を作成する前に、図 9-1 のようにスペクトラム・アナライザを本器に接続します。
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図 9-1 スペクトラム・アナライザのセットアップ

2トーン波形を作成する手順

この手順では、中心整列の基本的な 2 トーン波形を作成する方法を説明します。

1. 本器を初期設定します。

2. 本器の RF 出力周波数を 20 GHz に設定します。

3. 本器の RF 出力振幅を 0 dBm に設定します。

4. Mode > Two Tone > Freq Separation > 10 > MHz を押します。

5. Two Tone Off On を押して On にします。

6. RF 出力をオンにします。

本器の RF OUTPUT コネクタから 2 トーン信号が出力されます。191 ページの図 9-2 は、上記の手順を終了した時点での

本器の画面を示します。T-TONE、I/Q、RF ON、MOD ON の各インジケータが表示され、信号のパラメータ設定が画面の

ステータス・エリアに表示されています。
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図 9-2

2トーン波形を表示する手順

この手順では、スペクトラム・アナライザを設定して 2 トーン波形とその IMD 成分を表示する方法を説明します。実際に

押すキーは、使用するスペクトラム・アナライザのモデルによって異なります。

1. スペクトラム・アナライザを初期設定します。

2. 搬送波周波数を 20 GHz に設定します。

3. 周波数スパンを 60 MHz に設定します。

4. 振幅を 4 dBm 基準の 10 dB スケールに設定します。 

5. IMD 成分が観察できる程度にノイズ・フロアが小さくなるように分解能帯域幅を調整します。この例では 9.1 kHz の

設定を使用しています。

6. ピーク・ディテクタをオンにします。

7. スペクトラム・アナライザの入力ミキサをオーバドライブしないために、減衰を 14 dB に設定します。 

192 ページの図 9-3 のように、中心搬送波周波数が 20 GHz の 2 トーン波形が表示されるはずです。また、作成されたトー

ンから上下に 10 MHz 間隔で IMD 成分が見られ、中心周波数にキャリア・フィードスルー・スパイク、中心搬送波周波数

から上下に 10 MHz の間隔でキャリア・フィードスルー歪み成分が見られるはずです。
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図 9-3

キャリア・フィードスルーを最小化する手順

この手順では、キャリア・フィードスルーを最小化し、トーンとその相互変調歪み成分との間のパワーの差を測定する方

法を説明します。キャリア・フィードスルーが観察されるのは中心整列の 2 トーン波形の場合だけです。

この手順は、前の手順から続いています。

1. スペクトラム・アナライザで、約 100 ～ 200 ms の掃引速度に合わせて分解能帯域幅を設定します。これにより、調

整を行いながら動的にキャリア・フィードスルー・スパイクを観察できます。

2. 本器で I/Q > I/Q Adjustments > I/Q Adjustments Off On を押して On にします。

3. I Offset を押し、スペクトラム・アナライザでキャリア・フィードスルーを観察しながら回転ノブを回します。I オフ

セットを正しい方向に変化させると、フィードスルーのレベルが下がります。レベルができるだけ低くなるように調

整します。

4. Q Offset を押し、回転ノブを回してさらにキャリア・フィードスルーのレベルを下げます。

5. キャリア・フィードスルーのレベルがそれ以上下がらなくなるまでステップ 3 と 4 を繰り返します。

キャリア・
フィードスルー

 

相互変調
歪み

2 トーン
チャネル

キャリア・フィードスルー
歪み
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6. スペクトラム・アナライザで、分解能帯域幅を元の設定に戻します。

7. 波形アベレージングをオンにします。

8. マーカを作成し、どちらかのトーンのピークに配置します。

9. デルタ・マーカを作成し、隣接する相互変調成分のピークに配置します。 これはマーカのあるトーンから 10 MHz 離れ

ているはずです。

10. トーンとその歪み成分との間のパワー差を測定します。 

193 ページの図 9-4 のような画面が表示されるはずです。この最適化された 2 トーン信号は、被試験デバイスから生成さ

れる IMD 成分を測定するために使用できます。 

なお、キャリア・フィードスルーは時間と温度によって変化します。そのため、信号を常に最適化しておくためには、定

期的に I と Q のオフセットを再調整する必要があります。

図 9-4

2トーン波形の整列方法を変更する手順

この手順では、2 トーン波形を中心搬送波周波数に対して左整列または右整列にする方法を説明します。トーンの 1 つの

周波数が搬送波周波数と同じなので、この配置ではキャリア・フィードスルーがなくなります。ただし、左整列または右

整列から生じるイメージ周波数干渉のために、2 トーン信号の鏡像歪みが生じる可能性があります。この手順は、前の手

順から続いています。

最小化された

 

デルタ・マーカ

メイン・マーカ

キャリア・
フィードスルー
第9章 193



2トーン波形発生器
2トーン波形の作成、表示、変更
1. 本器で Mode Setup > Alignment Left Cent Right を押して Left にします。

2. Apply Settings を押して波形を再作成します。

注記 2トーン発生器の動作中（Two Tone Off OnがOnのとき）に設定を変更した場合、更新された波形を作成するには、

Apply Settingsソフトキーを押して変更を適用する必要があります。変更を適用すると、ベースバンド・ジェネ

レータは新しい設定を使って2トーン波形を作成し、任意波形メモリ上の既存の波形を置き換えます。

3. スペクトラム・アナライザで、表示の更新を速くするために一時的に波形アベレージングをオフにします。図 9-5 の

ように、左整列の 2 トーン波形が表示されるはずです。

図 9-5

上のトーンは
搬送波

相互変調
歪み

2 トーン
チャネル

周波数に
整列

搬送波
周波数
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この章は以下のセクションに分かれており、AWGN 波形発生器の使用例を紹介します。AWGN 波形発生器は、オプション

601 または 602 とオプション 403 付きの E8267D ベクトル PSG だけで使用できます。

• 「任意波形発生器AWGN」（195ページ）

• 「リアルタイム I/QベースバンドAWGN」（196ページ）

デュアル ARB プレーヤを使ってリアルタイム AWGN を波形に追加する方法については、「リアルタイム・ノイズのデュア

ル任意波形への追加」（82 ページ）を参照してください。

AWGN発生器の設定

AWGN（相加性白色ガウス雑音）発生器は、任意波形発生器モードとリアルタイム I/Q ベースバンド・モードで使用でき

ます。AWGN 発生器では、雑音帯域幅、雑音波形長、雑音シード・パラメータを設定できます。 

• 帯域幅：雑音帯域幅を50 kHz～15 MHzの範囲内で設定できます。

• 波形長：波形長とは、サンプル数で表した雑音波形の長さです。波形長が大きいほど、統計的に正しい雑音波
形が得られます。 

• 雑音シード：雑音シードとしては、ランダムまたは固定のいずれかが選択できます。雑音シードは、雑音波形
データが再現性がある（固定を選択）かランダム（ランダムを選択）かを選択します。 

AWGN 発生器が動作している場合、AWGN というインジケータが本器のフロント・パネルに表示されます。 

任意波形発生器AWGN

1. Preset を押します。

2. Mode > More (1 of 2) > AWGN > Arb Waveform Generator AWGN を押します。

3. Bandwidth > 1.25 > MHz を押します。

4. Waveform Length > 131072 を押します。

5. Noise Seed Fixed Random を押して Ramdom を強調表示させます。

これにより、帯域幅が 1.25 MHz、波形長が 131072 ビットのランダム・シードの AWGN 波形が設定されます。

RF出力の設定

1. RF 出力周波数を 500 MHz に設定します。 

2. 出力振幅を－ 10 dBm に設定します。 

3. RF On/Off を押します。
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波形の発生

AWGN Off On を押して On を強調表示させます。

これにより、前の手順で定義したパラメータの AWGN 波形が発生されます。波形作成中には AWGNと I/Qの 2 つのインジ

ケータがオンになり、AWGN 波形が揮発性任意波形メモリに保存されます。波形は RF 搬送波を変調しています。

リアルタイム I/QベースバンドAWGN

1. Preset を押します。

2. Mode > More (1 of 2) > AWGN > Real Time I/Q Baseband AWGN を押します。

3. Bandwidth > 10 > MHz を押します。

RF出力の設定

1. RF 出力周波数を 500 MHz に設定します。 

2. 出力振幅を－ 10 dBm に設定します。 

3. RF On/Off を押します。

波形の発生

AWGN Off On を押して On を強調表示させます。

これにより、前の手順で定義したパラメータの AWGN 波形が発生されます。波形作成中には、AWGNと I/Qの 2 つのイン

ジケータがオンになります。波形は RF 搬送波を変調しています。
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この章では、PSG 信号発生器とともに使用する周辺機器について説明します。N5102A Baseband Studio デジタル信号イ

ンタフェース・モジュールと拡張周波数信号源モジュールの操作と機能について、以下の各セクションで説明します。

N5102A デジタル信号インタフェース・モジュール

• 「クロック・タイミング」（197ページ）

• 「クロック・ソースと被試験デバイスを接続」（210ページ）

• 「データ・タイプ」（212ページ）

• 「出力モードでのN5102Aモジュールの操作」（213ページ）

• 「N5102Aモジュールの入力モードでの操作」（222ページ）

ミリ波信号源モジュール

• 「Agilentミリ波信号源モジュールの使用方法」（230ページ）

• 「その他の信号源モジュールの使用」（234ページ）

N5102Aデジタル信号インタフェース・モジュール

クロック・タイミング

このセクションでは、デジタル・データに対するクロックの供給方法について説明します。さまざまなポート構成（シリ

アル、パラレル、パラレル・インタリーブ・データ伝送）と位相／スキュー設定におけるクロック・タイミングを説明し

ます。インタフェース・モジュールのすべての設定は、信号発生器のユーザ・インタフェース（UI）から使用できます。

クロック／サンプル・レート

サンプルとはビットのグループであり、サンプルのサイズは Word Size ソフトキーで設定されます。クロックとは、サン

プルのビットが有効である（遷移状態にない）タイミングを指示する信号です。クロック・レートとサンプル・レートは、

第 1 レベルとデータ・セットアップのソフトキー・メニューに表示されます。クロック・レートとサンプル・レートは通

常は一致します。シリアル・モードを選択した場合、またはサンプルあたり複数のクロック数を使用する場合は異なります。
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図 11-1 パラレル・ポート構成に対するデータ・セットアップ・メニュー

N5102A のクロック・レートは Clock Rate ソフトキーで設定され、範囲は 1 kHz ～ 400 MHz です。サンプル・レートは

自動的に計算され、範囲は 1 kHz ～ 100 MHz です。これらの範囲は、ロジック・タイプ、データ・パラメータ、クロック

構成によってはもっと狭くなることもあります。

最大クロック・レート

N5102A の最大クロック・レートは、ロジックおよび信号タイプによって異なります。表 11-1 と 表 11-2 に、各ロジック

／信号タイプに対する保証されるレートと最大クロック・レートを示します。保証されるレートと最大レートが一致する

のは、出力モードが LVDS で IF 信号を使用する場合だけです。

表11-1 保証されるパラレル出力レベル・クロック・レートと最大クロック・レート

ロジック・タイプ
保証されるレベル・クロック・レート 最大クロック・レート（代表値）

IQ信号タイプ IF信号タイプa

a. IF信号タイプは、シリアル・ポート構成では使用できません。

IQ信号タイプ IF信号タイプ

LVTTLおよびCMOS 100 MHz 100 MHz 150 MHz 150 MHz

LVDS 200 MHz 400 MHz 400 MHz 400 MHz

クロック／サンプル・レート最下位ビット

詳細については PSG ユーザーズ・ガイドを参照

最上位ビット
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保証されるレベル・クロック・レートより上ではレベルが低下しますが、それでも使用可能な場合があります。

シリアル・ポート構成クロック・レート

シリアル・ポート構成では、クロック・レートの下限はワード・サイズで決まります（ワード・サイズとサンプル・サイ

ズは同じ意味です）。これに対して、最大クロック・レートは、LVTTL および CMOS ロジック・タイプでは 150 MHz、
LVDS ロジック・タイプでは 400 MHz に固定されています。 

サンプル・レートに関しては逆のことが言えます。サンプル・レートの下限値は 1 kHz で固定されていますが、上限値は

ワード・サイズによって変わります。例えば、シリアル・モードの LVTTL および CMOS ロジック・タイプの 5 ビットの

サンプルでは、次の値が得られます。

• クロック・レートが5 kHz～150 MHz

• サンプル・レートが1 kHz～30 MHz

 シリアル・クロック・レートについては表 11-3 と表 11-4 を参照してください。

表11-2 保証されるパラレル入力レベル・クロック・レートと最大クロック・レート

ロジック・タイプ 保証されるレベル・クロック・レート 最大クロック・レート（代表値）

LVTTLおよびCMOS 100 MHz 100 MHz

LVDS 100 MHz 400 MHz

表11-3 出力シリアル・クロック・レート

ロジック・タイプ 最小レート 最大レート

LVDS 1×（ワード・サイズ） kHz 400 MHz

LVTTLおよびCMOS 1×（ワード・サイズ） kHz 150 MHz

表11-4 入力シリアル・クロック・レート

ロジック・タイプ データ・タイプ 最小レート 最大レート

LVDS サンプル 1×（ワード・サイズ） kHz 400 MHz

プレFIRサンプル 1×（ワード・サイズ） kHz 50a ×（ワード・サイズ） MHz

または

400 MHzのうち小さい方

a.データ・レートがプレFIRサンプルの場合、最大サンプル・レートは選択されたフィルタに依存します。詳細については「入力モード」

（212ページ）を参照してください。

LVTTLおよびCMOS － 1×（ワード・サイズ） kHz 150 MHz
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パラレルおよびパラレル・インタリーブ・ポート構成のクロック・レート 

パラレルおよびパラレル・インタリーブ・ポート構成の場合、クロック／サンプル・レートの制限要因が他にもあります。

• ロジック・タイプ

• サンプルあたりのクロック数の選択

• IQまたは IFデジタル信号タイプ

サンプルあたりのクロック数（クロック／サンプル）は、クロックとサンプル・レートの比です。IQ 信号タイプでは、サ

ンプルあたりのクロック数が 1 より大きい場合、サンプル・レートはサンプルあたりのクロック数の割合だけ小さくなり

ます。IF 信号または入力信号の場合、サンプルあたりのクロック数は常に 1 に設定されます。出力モードのパラレルおよ

びパラレル・インタリーブ・ポート構成の場合のクロック・レートについては表 11-5 を参照してください。

入力モードの場合、最大クロック・レートは次の要因で制限されます。

• サンプル・サイズ

• データ・タイプ

• プレFIRサンプルの場合は選択されたフィルタ

入力モードのパラレルおよびパラレル・インタリーブ・ポート構成の場合のクロック・レートについては表 11-6 を参照し

てください。

表11-5 出力パラレルおよびパラレル・インタリーブのクロック・レート

ロジック・タイプ 信号タイプ 最小レート 最大レート

LVDS IQ 1×（クロック／サンプル） 
kHz

次のうち小さい方 :100×（クロック／サンプル） MHz

または
400 MHz

IF 4 kHz 400 MHz

その他 IQ 1×（クロック／サンプル） 
kHz

次のうち小さい方 :100×（クロック／サンプル） MHz

または
150 MHz

IF 4 kHz 150 MHz

表11-6 入力パラレルおよびパラレル・インタリーブのクロック・レート

ロジック・タイプ データ・タイプ 最小レート 最大レート

－ サンプル 1 kHz 100 MHz

プレFIRサンプル 1 kHz 50a MHz

a.データ・レートがプレFIRサンプルの場合、最大サンプル・レートは選択されたフィルタに依存します。詳細については「入力

モード」（212ページ）を参照してください。
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クロック・ソース

N5102A のクロック信号は、次の選択によって、3 つの方法の 1 つで供給されます。

• Internal:インタフェース・モジュール内部で発生（外部基準が必要）

• External:Ext Clock Inコネクタを通じて外部から供給

• Device:Device Interfaceコネクタを通じて外部から供給

クロック・ソースは、図 11-2 のように、信号発生器の N5102A のユーザ・インタフェースを使って選択します。 

図 11-2 クロック・ソース選択

クロック・ソースを選択する場合、クロック信号の周波数を Clock Rate ソフトキーで N5102A に知らせる必要があります。

内部クロック・ソース・モードでは、このソフトキーを使って内部クロック・レートを設定します。デバイスおよび外部

クロック・ソースの場合、このソフトキーは印加するクロック信号の周波数を設定する必要があります。 

クロック・ソースが内部の場合、Freq Ref コネクタに周波数基準を印加する必要があります。この印加信号の周波数は、

Reference Frequency ソフトキーで指定します。現在の設定が印加信号と一致する場合は変更の必要はありません。 

選択したクロック・ソースにより、Clock Out コネクタと Device Interface コネクタのインタフェース・モジュール出力

クロックから信号が供給されます。

共通周波数基準

デジタル信号インタフェース・モジュールでは、被試験デバイスに対して任意のクロック・レートを設定できます。一般

的に、PSG 内部のクロック・レートはインタフェース・モジュールのクロック・レートと異なるため、インタフェース・

モジュールはレート変換を行います。この変換に関して重要なのは、データの損失を避けるために正確なクロック・レー

ト情報が必要なことです。モジュールは絶対でなく相対クロック精度に依存するため、テスト・セットアップに存在する

すべてのクロック・レートに対して単一の周波数基準を使用する必要があります。これを実現するにはいくつかの方法が

ありますが（203 ページの図 11-3 の 5 つの図を参照）、どの方法で実現するにしても、信号発生器内部のクロックが被試

験デバイスで使用するクロックと同じベース周波数基準を持つ必要があります。

外部およびデバイス選択 :
印加したクロック信号の

クロック・レートに一致するように

内部選択 : 内部

クロック・レートを設定

 

内部クロック・ソース
選択 : 印加する基準信号の

周波数を設定。
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PSGの周波数基準接続

PSG に周波数基準を接続する場合、周波数基準は次の 2 つのリア・パネル・コネクタの 1 つを使用できます。

• 10 MHz IN

• BASEBAND GEN REF IN

BASEBAND GEN REF IN コネクタには、1 ～ 100 MHz の周波数基準を接続できます。外部や被試験デバイスのクロック・

ソースが周波数基準用の入出力を持っていない場合、そのクロック信号をこのコネクタに印加して周波数基準として使用

できます。

外部クロック信号または周波数基準を BASEBAND GEN REF IN コネクタに接続した場合、その周波数を信号発生器の現

在の変調フォーマットに入力する必要があります。BASEBAND GEN REF IN コネクタの詳細については、「5. BASEBAND
GEN REF IN」（21 ページ）を参照してください。印加クロック信号または周波数基準の周波数を入力するためのソフト

キーとフィールドについては、『E8257D/67D PSG Signal Generators Key Reference』を参照してください。
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図 11-3 N5102Aのクロック信号の周波数基準セットアップ・ダイアグラム

注記 : 信号発生器の 2 つの周波数基準入力はどちらか一方だけを使用してください。

内部発生クロック

デバイス（DUT）供給クロック
第11章 203



周辺機器
N5102Aデジタル信号インタフェース・モジュール
パラレル・データのクロック・タイミング

一部のコンポーネントでは、1 つのサンプル周期中に複数のクロックが必要です。（1 つのサンプル周期は 1 つの I/Q サン

プルから構成されます）。パラレル・データ伝送の場合、サンプルあたりのクロック数を 1、2、4 の中から選択できます。

サンプルあたりのクロック数が 1 より大きい場合、増加したクロック周期に対応する I/Q サンプルは一定に保持されます。

これにより、クロック・レートを基準としたサンプル・レートは、サンプルあたりのクロック数の割合だけ小さくなりま

す。例えば、4 を選択した場合、サンプル・レートは 4 分の 1 になります（サンプル・レートとクロック・レートの比）。

図 11-4 に、サンプルあたりのクロック数の選択によるクロック・タイミングの違いを示します。入力モードの場合、サン

プルあたりのクロック数の設定は常に 1 です。

外部供給クロック

注記 : 信号発生器の 2 つの周波数基準入力はどちらか一方だけを使用してください。
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図 11-4 パラレル・ポート構成に対するクロック・サンプル・タイミング

1 サンプル周期

Q サンプル

1 クロック／サンプル

1 クロック

クロック・レートとサンプル・レートが等しい

I サンプル

クロック

4 ビット／ワード

4 ビット／ワード
第11章 205



周辺機器
N5102Aデジタル信号インタフェース・モジュール
1 サンプル周期

4 クロック／サンプル

4 クロック

サンプル・レートは 1/4 になる

I サンプル

Q サンプル

クロック

4 ビット／ワード

4 ビット／ワード

1 サンプル周期

2 クロック／サンプル

2 クロック

I サンプル

Q サンプル

サンプル・レートは 1/2 になる

クロック

4 ビット／ワード

4 ビット／ワード
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パラレル・インタリーブ・データのクロック・タイミング

N5102A には、デジタル I/Q サンプルのインタリーブ機能があります。次の 2 種類のインタリーブを選択できます。

• IQ：Iサンプルを先に伝送

• QI：Qサンプルを先に伝送

パラレル・インタリーブを選択した場合、すべてのサンプルが I データ・ラインで伝送されます。これにより、非インタ

リーブ・サンプルの場合に比べて、1 サンプル周期中に実効的に同じ数のサンプルを半分の数のデータ・ラインで伝送で

きます。（1 つのサンプル周期は 1 つの I/Q サンプルから構成されます）。パラレル・インタリーブ伝送の場合もサンプル

あたりのクロック数は有効なパラメータであり、クロック・レートを基準としたサンプル・レートを下げる効果がありま

す。選択したサンプルあたりのクロック数が減少率となります。図 11-5 に、パラレル IQ インタリーブ・ポート構成での

サンプルあたりのクロック数を示します。ワード・サイズは 4 ビットで、クロック・タイミングは I/Q サンプルを基準と

します。パラレル QI インタリーブ・ポート構成の場合は、I と Q のサンプル位置を単に逆にするだけです。入力モードの

場合、サンプルあたりのクロック数の設定は常に 1 です。

図 11-5 パラレル IQインタリーブ・ポート構成のクロック・タイミング

Q サンプル
4 ビット／ワード

I サンプル
4 ビット／ワード

1 サンプル周期

1 クロック／サンプル

1 クロック

I サンプルは 1 つのクロック遷移、Q サンプルはもう 1 つの

クロック

遷移で伝送されるため、サンプル・レートとクロックレートは同じ
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1 サンプル周期

4 クロック／サンプル

4 クロック

I サンプルは最初の 2 つのクロック周期、Q サンプルは次の 2 つの

クロック

Q サンプル
4 ビット／ワード

I サンプル
4 ビット／ワード

クロック周期で伝送されるため、サンプル・レートは 1/4 になる

1 サンプル周期

2 クロック／サンプル

2 クロック

I サンプルは 1 つのクロック周期、Q サンプルは次の

クロック

Q サンプル
4 ビット／ワード

I サンプル
4 ビット／ワード

クロック周期で伝送されるため、サンプル・レートは 1/2 になる
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シリアル・データのクロック・タイミング

図 11-6 に、シリアル・ポート構成のクロック・タイミングを示します。シリアル伝送には各サンプルの先頭を示すフレー

ム・パルスがあり、クロックは各ビットの先頭を示します。シリアル伝送の場合、クロック・レートとビット・レートは

同じですが、サンプル・レートは、Word Size ソフトキーで入力される 1 ワードあたりのビット数によって異なります。

ワードあたりのビット数は、サンプルあたりのビット数と同じです。

図 11-6 シリアル・ポート構成のクロック・タイミング

フェーズ／スキュー調整のクロック・タイミング

N5102A にはデータを基準としたクロックの位相／スキュー調整機能があり、データの有効部分にクロックを合わせるこ

とができます。位相の分解能は、クロック・レートが 10 ～ 200 MHz の場合は 90°（0°、90°、180°、270°）、クロッ

ク・レートが 10 MHz より下か 200 MHz より上の場合は 180°（0°、180°）です。 

スキューは ns 単位で表示され、最大レンジは± 5 ns で、最大± 127 の不連続ステップを使用します。スキュー・レンジ

と不連続ステップ数は、ともにクロック・レートに依存して変化します。スキュー・レンジは、クロック・レートが大き

いほど小さくなり、クロック・レートが小さいほど大きくなります。最大スキュー・レンジは、クロック・レートが約 99
MHz のときに達成され、クロック・レートが 25 MHz になるまで維持されます。クロック・レートが 25 MHz より低い場

合、スキュー調整は使用できません。 

不連続ステップは、次の式で計算されます。

最大スキュー・レンジに到達するのに必要な不連続ステップの数は、低い周波数では少なくなります。例えば、クロック・

レートが 50 MHz の場合、127 ステップでは± 5 ns の最大スキュー・レンジを超えるため、実際の不連続ステップ数は

127 より少なくなります。

図 11-7 は、位相／スキュー調整の例であり、元のクロックと、調整後のデータを基準としたその位相位置を示します。ス

キュー調整は位相設定に追加されることに注意してください。

クロック

4 ビット／ワード

1 サンプル

フレーム・マーカ

データ・ビット

 1
256 Clock Rate×
---------------------------------------------
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図 11-7 クロック位相／スキュー調整

クロック・ソースと被試験デバイスを接続

203 ページの図 11-3 に示すように、システム・コンポーネント（PSG、N5102A、被試験デバイス）に共通の周波数基準

を供給する方法はいろいろあります。図 11-8 に示すのは、信号発生器が共通周波数基準を供給し、N5102A がデバイスに

クロックを供給するセットアップ例です。

デバイス・インタフェース接続の詳細については、『N5102A Digital Signal Interface Module Installation Guide』を参照

してください。

注意 インタフェース・モジュールのDevice Interfaceコネクタは、高速デジタル・データを使って通信します。

接続の際には、損傷を避けるためESDに関する注意事項を守ってください。

注記 PSGにファームウェアをダウンロードする際には、デジタル・バス・ケーブルとデジタル・モジュールを取り外

す必要があります。

クロック・スキュー調整

90°位相調整

クロック

位相調整された

調整された

クロック

クロック

データ

位相とスキューを
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図 11-8 PSGの10 MHz周波数基準を使ったセットアップ例

1. 203 ページの図 11-3 の 5 つのセットアップ・ダイアグラムを参照し、クロック・ソースに応じて周波数基準ケーブル

を接続します。

2. 外部クロック・ソースを使用する場合、外部クロック信号をインタフェース・モジュールの Ext Clock In コネクタに

接続します。

3. アプリケーションに適した出力コネクタを持つブレークアウト・ボードを選択します。ブレークアウト・ボードの詳

細については、『N5102A Digital Signal Interface Module Installation Guide』を参照してください。

注記 Device Interfaceコネクタを被試験デバイスに使用する場合、図11-8のデバイス・インタフェース接続を参照し

て、デバイスをN5102Aモジュールに接続します。次に、「出力モードでのN5102Aモジュールの操作」（213ペー

ジ）または「N5102Aモジュールの入力モードでの操作」（222ページ）に進みます。

4. 図11-8を参照してください。ブレークアウト・ボードをN5102AモジュールのDevice Interfaceコネクタに接続します。

5. デバイスをブレークアウト・ボードに接続します。ブレークアウト・ボードの接続については、『N5102A Digital Signal
Interface Module Installation Guide』を参照してください。

信号発生器の 10 MHz 出力

周波数基準コネクタ

デバイス・インタフェース接続

被試験デバイス
ブレークアウト・ボード

ユーザが用意したリボン・ケーブル接続
デバイスとブレークアウト・ボード間

共通周波数基準ケーブル

デバイスのクロックはリボン・
ケーブルに存在。
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データ・タイプ

次のブロック・ダイアグラムは、PSG の信号発生プロセスの中で、入力モードでデータが挿入される場所と出力モードで

データが取り出される場所を示しています。

出力モード

ARB フォーマットを使用する場合、データ・タイプは常に Samples であり、データ・サンプルに対してフィルタは適用

されません。サンプルは ARB のサンプル・クロック・レートでデジタル・モジュールに送られます。

リアルタイム・フォーマットの場合、データ・タイプとして Samples を選択すると、フィルタされたサンプルが 50 MHz
～ 100 MHz のレートでデジタル・モジュールに送信されます。Pre-FIR Samples を選択すると、フィルタされないサンプ

ルが現在のフォーマットのサンプル・レートに等しいレートでデジタル・モジュールに送信されます。

入力モード

データ・タイプが Samples の場合、デジタル・モジュールを通ってくるサンプルは、フィルタ・プロセスをバイパスした

後にデジタル・モジュールに挿入されます。

Pre-FIR Samples を選択した場合、データ・サンプルはフィルタ・プロセスの前に挿入されます。最大レートは選択した

フィルタによって決まります。表 11-7 を参照してください。

データ FIR

DAC

RF

サンプル
サンプル

出力

サンプル サンプル
プレ FIR

モード

フィルタ

I、Q

変調器

LO 

入力
モード

プレ FIR

PSG

ジェネレータ
I/Q
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 Filter ソフトキーで表示されるメニューを使って、必要なフィルタ・パラメータを設定できます。 

出力モードでのN5102Aモジュールの操作

このセクションでは、出力モードでの N5102A オプション 003 モジュールのパラメータをフロント・パネル・キーを使っ

て設定する方法を説明します。それぞれの手順には、インタフェース・モジュール機能に対応したソフトキー・メニュー

構造を図で示しています。 

信号発生器のベースバンド・データの設定

デジタル信号インタフェース・モジュールは、ベースバンド信号源からデータを受信し、選択されたロジック・タイプを

基準としたデジタル IQ またはデジタル IF 信号を出力します。PSG はベースバンド・データを供給するので、インタフェー

ス・モジュールの操作の最初の手順は、リアルタイムまたは ARB 変調フォーマットの 1 つを使って PSG を設定するか、

保存されているファイルをデュアル ARB プレーヤを使って再生することです。リアルタイムまたは ARB 波形の設定方法

と、デュアル ARB プレーヤの使用方法については、本ガイドの対応する章を参照してください。

1. 本器を初期設定します。

2. 変調フォーマット（TDMA、カスタムなど）を選択し、必要なパラメータを設定します。

3. 変調フォーマットをオンにします。

N5102Aユーザ・インタフェースへのアクセス

Aux Fctn > N5102A Interface を押します。

これにより、デジタル信号インタフェース・モジュールの設定のためのユーザ・インタフェース（図 11-9 に示す第 1 レベ

ルのソフトキー・メニュー）が表示されます。PSG のディスプレイのグラフィックには、N5102A が独自の内部クロック

信号を発生するセットアップが示されています。このグラフィックは、現在のクロック・ソース選択を反映して変わります。

表11-7 選択したフィルタに対する最大サンプル・レート

フィルタ 最大レート

ガウシアン

ナイキスト

ルート・ナイキスト

方形

エッジ

UN3/4 GSMガウシアン

IS-95
IS 95 w/EQ

50 MHz

IS-95 Mod
IS-95 Mod w/EQ

25 MHz

APCO 25 C4FM 12.5 MHz
第11章 213



周辺機器
N5102Aデジタル信号インタフェース・モジュール
図 11-9 第1レベル・ソフトキー・メニュー

ロジック・タイプとポート構成の選択

図 11-10 ロジックおよびポート構成ソフトキー・メニュー

1. 図 11-10 を参照してください。Logic Type ソフトキーを押します。

このメニューから、ロジック・タイプを選択します。

Line は N5102A モジュール・インタフェースがオンになるまで淡色表示されます。
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注意 ロジック・タイプを変更すると、被試験デバイスに供給される信号電圧レベルが増減することがあります。

デバイスとN5102Aの損傷を避けるため、これら両方が電圧変化に耐えられることを確認してください。

2. 被試験デバイスに必要なロジック・タイプを選択します。

ロジック・タイプを変更すると、確認のために注意メッセージが表示されます。

3. 図 11-10 を参照してください。Port Configuration ソフトキーを押します。

このメニューでは、シリアル、パラレル、パラレル・インタリーブのいずれかのデータ伝送方式を選択します。

注記 データ／クロック・セットアップ・ソフトキー・メニューの中で、現在の構成に関連があるソフトキーだけがア

クティブになります。淡色表示のソフトキーは、現在のセットアップでは使用できません。ソフトキーが使用で

きない原因となっているパラメータを知るには、ヘルプ・テキストを参照してください。ヘルプ情報を表示する

には、Helpハードキーを押してから、使用できないソフトキーを押します。

4. デバイスのポート構成を選択します。

入出力方向の選択

Data Setup > Direction Input Output を押して Output にし、Return を押します。 

注記 オプション003だけがインストールされている場合は、方向ソフトキーは使用できず、モードは常に出力となり

ます。オプション003（出力モード）とオプション004（入力モード）の両方がインストールされている場合、

デフォルトの方向は出力です。 

データ・パラメータの選択

この手順では、データ・セットアップ・メニューの使用方法を説明します。ソフトキーの機能が名前からわかる場合につ

いては、通常は説明を省きます。例えば、Word Size（ワード・サイズ）ソフトキーなどです。すべてのソフトキーの詳細

については、『E8257D/67D PSG Signal Generators Key Reference』を参照してください。

1. 図 11-11 を参照してください。Data Setup ソフトキーを押します。
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図 11-11 データ・セットアップ・メニューの位置

このソフトキー・メニューは、被試験デバイスが受信するデータを決定するさまざまなパラメータにアクセスします。

ディスプレイのステータス・エリアには、I と Q に用いられるデータ・ラインの数と、データを基準としたクロック

の位置が表示されます。ポート構成がパラレルまたはパラレル・インタリーブの場合、表示されるデータ・ラインの

数はワード（サンプル）サイズに一致します。ポート構成がシリアルの場合、1 つの I と 1 つの Q のデータ・ライン

だけが使用されることと、サンプルの先頭を示すフレーム・マーカが表示されます。図 11-12 に、データ・セットアッ

プ・メニューの構造を示します。

データ・セットアップ・メニュー

にアクセス
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図 11-12 パラレル・ポート構成のデータ・セットアップ・ソフトキー・メニュー

2. リアルタイム変調フォーマットを使用する場合、Data Type ソフトキーを押します。（このソフトキーは、ARB 変調フォー

マットがオンの場合は非アクティブです）。

このメニューでは、信号発生器からのリアルタイム・ベースバンド・データがフィルタされるか（Samples）されない

か（Pre-FIR Samples）を選択します。この選択は、テスト・ニーズに依存します。Samples を選択すると、アクティブ

な変調フォーマットの通信規格に基づく FIR フィルタを通したベースバンド・サンプルが供給されます。これは初期

設定の選択であり、最も一般的に用いられるものです。ただし、被試験デバイスにすでに FIR フィルタが装備されて

いる場合は、2 重にフィルタを通すことを避けるため、Pre-FIR Samples を選択する必要があります。

3. テストに適したデータ・タイプを選択します。

4. Numeric Format ソフトキーを押します。

このメニューから、バイナリ値の表現方法を選択します。2 の補数を選択すると、正と負の両方のデータ値が使用で

きます。コンポーネントが負の値を処理できない場合は、オフセット・バイナリを選択します。

5. テストに必要な数値フォーマットを選択します。

シリアル・ポートでは
非アクティブ構成

シリアル・ポート構成の場合に、

ARB フォーマットでは

ワード・サイズが 16 ビット

の場合は非アクティブ

非アクティブ

フレーム極性はアクティブ
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6. More (1 of 2) ソフトキーを押します。

このソフトキー・メニューから、ビット順序の選択、I/Q の交換、伝送データの極性の選択、データ符号反転、スケー

リング、利得、オフセット、IQ 回転調整のためのメニューにアクセスできます。

7. Data Negation ソフトキーを押します。

符号反転は、I/Q極性の変更とは異なります。符号反転をサンプルに適用すると、サンプルは2の補数で表現され、－1
と乗算されてから、選択した数値フォーマットに戻されます。これは、Iサンプル、Qサンプル、またはその両方に適用

できます。 

 符号反転を使用するかどうかの選択は、被試験デバイスと、デバイスがデータを受信する方法に依存します。

8. Gain, Offset & Scaling ソフトキーを押します。

このメニューのソフトキーは以下の機能に使用します。

• Scaling ソフトキーを使って I と Q の両方のサンプル値を小さくする

• I Gain および Q Gain ソフトキーを使って I と Q のサンプル値を独立に増減する

• I Offset および Q Offset ソフトキーを使って DC オフセットを付加する

• Rotation ソフトキーを使ってデータを IQ 平面上で回転する

9. デバイスのテストの必要に応じて、スケーリング、利得、オフセット、回転を調整します。

10. Return > Return を押して、第 1 レベルのソフトキー・メニューに戻ります。

クロック信号の設定

1. 図 11-13 を参照してください。Clock Setup ソフトキーを押します。

図 11-13 クロック・セットアップ・メニューの位置

クロック・セットアップ・メニューに
アクセス
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このソフトキー・メニューから、N5102A と PSG のクロックを同期するクロック・パラメータを設定します。クロッ

ク信号の位相を変更して、クロックがデータの有効部分で発生するようにすることもできます。図 11-14 にクロック・

セットアップ・メニューを示します。

図 11-14 パラレル・ポート構成に対するクロック・セットアップ・ソフトキー・メニュー

ディスプレイ上部のグラフィックは、Clock Out および Device Interface コネクタに出力クロック信号を供給する現在

のクロック・ソースを示します。このグラフィックは、この手順の後の方で説明するクロック・ソース選択を反映し

て変わります。下部のグラフィックは、データを基準としたクロックの位置を示します。表示されたクロック信号は

以下の項目を反映して変わります。

• サンプルあたりのクロック数の選択

• クロック位相の選択

• クロック・スキュー調整

• クロック極性選択

デバイスまたは外部クロックの周波数が一致しない場合、次のいずれかのエラー・メッセージが PSG に表示されます。

805  Digital module output FIFO overflow error; There are more samples being
produced than can be consumed at the current clock rate.Verify that the
digital module clock is set up properly.

（デジタル・モジュールの出力 FIFO オーバーフロー・エラーです。現在のクロック・レート

で消費できるよりも多くのサンプルが供給されています。デジタル・モジュールのクロックが
正しく設定されているかどうかを確認してください。）

シリアル・ポート構成および IF 信号タイプに対しては非アクティブ

内部クロック・ソース選択に対してのみアクティブ

25 MHz より低いクロック・レートに対しては非アクティブ

10 MHz より下および 200 MHz より

上のクロック・レートに対しては
非アクティブ
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このエラーが報告されるのは、デジタル・モジュールの出力 FIFO がオーバーフローしている

場合です。このエラーは、外部クロックまたはその基準が正しく設定されていないか、内部

VCO がロックされていない場合に発生します。

806  Digital module output FIFO underflow error; There are not enough
samples being produced for the current clock rate.Verify that the
digital module clock is set up properly.

（デジタル・モジュールの出力 FIFO アンダーフロー・エラーです。現在のクロック・レート

に対して十分なサンプルが供給されていません。デジタル・モジュールのクロックが正しく設

定されているかどうかを確認してください。）

このエラーが報告されるのは、デジタル・モジュールの出力 FIFO がアンダーフローしている

場合です。このエラーは、外部クロックまたはその基準が正しく設定されていないか、内部

VCO がロックされていない場合に発生します。

2. ポート構成がパラレルまたはパラレル・インタリーブで、IQ 信号タイプを使用する場合、Clocks Per Sample ソフトキー

を押します。

サンプルあたり複数のクロックを選択することもできます。一部の DAC では、1 つのサンプルに対して複数のクロッ

クを供給する必要があります。サンプルあたりのクロック数の値を 1 より大きくすると、サンプル・レートがサンプ

ルあたりのクロック数の割合だけ小さくなります。サンプル・レートは、第 1 レベルおよび Data Setup ソフトキー・

メニューに表示されます。

3. テストに合わせてサンプルあたりのクロック数の値を選択します。

4. Clock Source ソフトキーを押します。

このメニューから、クロック信号のソースを選択します。選択を実行すると、信号発生器のクロック・セットアップ・

メニューのクロック・ルーティング表示が、現在のクロック・ソースを反映して変わります。これはグラフィックの

変化によってわかります。

5. クロック・ソースを選択します。

External または Device を選択した場合

Clock Rate ソフトキーを押し、外部から印加されるクロック信号のクロック・レートを入力します。 

注記 クロック・レート設定を変更した場合、クロック位相とクロック・スキューの再調整が必要になることがありま

す。「フェーズ／スキュー調整のクロック・タイミング」（209ページ）を参照してください。

External を選択した場合、信号は外部クロック・ソースから供給され、Ext Clock In コネクタに印加されます。Device
を選択した場合、クロック信号は Device Interface コネクタを通じて、通常は被試験デバイスから供給されます。

Internal を選択した場合

N5102A は、外部周波数基準を使って独自の内部クロック信号を発生します。基準周波数信号は、デジタル・モジュー

ルの Freq Ref コネクタに入力します。

a. Reference Frequency ソフトキーを押し、外部から供給される周波数基準の周波数を入力します。

b. Clock Rate ソフトキーを押し、クロック・レートを入力します。

表 11-8 に、クロック・ソースの選択に対応する設定と接続の一覧を示します。
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6. Clock Phase ソフトキーを押します。

表示されるメニューから、クロックの位相をデータを基準として 90°刻みで調整できます。これは、データの有効部

分に合わせてクロックの位置を大まかに調整する役割を果たします。180°を選択するのは、負のクロック極性を選択

するのと同じです。

クロック・レートが 10 MHz より下または 200 MHz より上の場合、90°と 270°は選択できません。クロック・レー

トが 10 MHz より下または 200 MHz より上に設定されている場合に 90°または 270°を選択すると、位相はそれぞれ

0°と 180°に変更されます。 

注記 クロック・レート設定を変更した場合、クロック位相とクロック・スキューの再調整が必要になることがありま

す。「フェーズ／スキュー調整のクロック・タイミング」（209ページ）を参照してください。

7. 必要な位相を入力します。

8. Return ソフトキーを押して、クロック・セットアップ・メニューに戻ります。

9. Clock Skew ソフトキーを押します。

これは、クロックを現在の位相位置を基準として微調整する役割を果たします。スキューは、時間単位による位相調

整です。これにより、高いクロック・レートでより細かいスキュー調整が可能になります。クロック・レートが 25
MHz より下の場合、このソフトキーは非アクティブです。

スキューは不連続な値を持ち、そのレンジはクロック・レートに依存します。スキュー設定の詳細については、「フェー

ズ／スキュー調整のクロック・タイミング」（209 ページ）を参照してください。

10. クロックをデータの有効部分に正確に合わせるためのスキューを入力します。

11. Clock Polarity Neg Pos ソフトキーを押して Neg にします。

これはクロック信号を 180°シフトし、データの開始位置が負のクロック遷移にあたるようにします。これは 180°
の位相調整を選択するのと同じです。

12. 被試験デバイスに必要なクロック極性を選択します。

13. Return ハードキーを押して、第 1 レベルのソフトキー・メニューに戻ります。

クロック・ソースの選択は、第 1 レベルのソフトキー・メニューのグラフィックにも反映されます。例えば、デバイ

スが新しいクロック・ソースの場合、グラフィックでは周波数基準が DUT に接続され、DUT の入力クロック・ライ

ンが N5102A に接続されます。

表11-8 クロック・ソース設定とコネクタ

クロック・

ソース

ソフトキー N5102Aの接続

周波数基準 クロック・レートa

a. Internalを選択した場合、内部クロック・レートを設定します。ExternalおよびDeviceを選択した場合、入力さ

れるクロック信号のレートを設定します。

Freq Ref Ext Clock In Device Interface

External ● ●

Device ● ●

Internalb

b. Ext Clock Inコネクタにはクロック信号が入力してはいけません。

● ● ●
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デジタル・データの発生

N5102A Off On ソフトキーを押して On にします。

デジタル・データが N5102A を通じてデバイスに伝送されます。緑のステータス・ライトが点滅しているはずです。これ

は、データ・ラインがアクティブであることを示します。ステータス・ライトが常時点灯している（点滅しない）場合、

すべてのデータ・ラインが非アクティブです。ステータス・ライトは、N5102A が最初にオンになったとき（N5102A Off
On が On になったとき）に点灯し、そのまま点灯（点滅または常時点灯）し続けます。ステータス・ライトは、モジュー

ルが電源から切り離されるまで点灯し続けます。

インタフェース・モジュールは、変調フォーマットがアクティブなときだけオンにできます。モジュールがオンのときに

変調フォーマットをオフにすると、モジュールはオフになり、エラーが表示されます。

注記 ベースバンド・データ・パラメータを変更する場合、パラメータの変更中に発生する信号の変化からデバイスと

N5102Aモジュールを保護するため、先にデジタル出力をオフにしておく（N5102A Off Onソフトキーをオフにす

る）ことをお勧めします。

N5102Aモジュールの入力モードでの操作

このセクションでは、入力方向での N5102A オプション 004 モジュールのパラメータを信号発生器のユーザ・インタフェー

スを使って設定する方法を説明します。それぞれの手順には、実行するインタフェース・モジュール機能に対応したソフ

トキー・メニュー構造を図で示しています。

「クロック・ソースと被試験デバイスを接続」（210 ページ）を参照して、テスト・セットアップを設定してください。

N5102Aユーザ・インタフェースへのアクセス

N5102A のすべてのパラメータは、PSG 信号発生器のソフトキーで設定されます。

Aux Fctn > N5102A Interface を押します。

これにより、デジタル信号インタフェース・モジュールの設定のためのユーザ・インタフェース（図 11-15 に示す第 1 レ

ベルのソフトキー・メニュー）が表示されます。PSG のディスプレイのグラフィックには、N5102A が独自の内部クロッ

ク信号を発生するセットアップが示されています。このグラフィックは、現在のクロック・ソース選択を反映して変わり

ます。
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図 11-15 第1レベル・ソフトキー・メニュー

入力方向の選択

オプション 003（出力モード）とオプション 004（入力モード）の両方がインストールされている場合、入力方向を選択

する必要があります。

Data Setup > Direction Input Output を押して Input にし、Return を押します。 

注記 オプション004だけがインストールされている場合は、方向ソフトキーは使用できず、モードは常に入力となり

ます。 

Line は N5102A モジュール・インタフェースがオンになるまで淡色表示されます。

DUT への内部クロック
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ロジック・タイプとポート構成の選択

図 11-16 ロジックおよびポート構成ソフトキー・メニュー

1. 図 11-16 を参照してください。Logic Type ソフトキーを押します。

このメニューから、ロジック・タイプを選択します。

注意 ロジック・タイプを変更すると、信号の電圧レベルが増減することがあります。デバイスと N5102A の損

傷を避けるため、これら両方が電圧変化に耐えられることを確認してください。

2. 被試験デバイスに必要なロジック・タイプを選択します。

ロジック・タイプを変更すると、確認のために注意メッセージが表示されます。

3. 図 11-16 を参照してください。Port Configuration ソフトキーを押します。

このメニューでは、シリアル、パラレル、パラレル・インタリーブのいずれかのデータ伝送方式を選択します。

注記 データ／クロック・セットアップ・ソフトキー・メニューの中で、現在の構成に関連があるソフトキーだけがア

クティブになります。淡色表示のソフトキーは、現在のセットアップでは使用できません。ソフトキーが使用で

きない原因となっているパラメータを知るには、ヘルプ・テキストを参照してください。ヘルプ情報を表示する

には、Helpハードキーを押してから、使用できないソフトキーを押します。

4. 被試験デバイスのポート構成を選択します。
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クロック信号の設定

1. 図 11-17 に示すように、Clock Setup ソフトキーを押します。 

図 11-17 クロック・セットアップ・メニューの位置

このソフトキー・メニューから、N5102A とデバイスのデータを同期するクロック・パラメータを設定します。この

メニューから、クロック信号の位相を変更して、クロックがデータの有効部分で発生するようにすることもできます。

図 11-18 にクロック・セットアップ・メニューを示します。

デバイスまたは外部クロックの周波数が一致しない場合、次のいずれかのエラー・メッセージが PSG に表示されます。

803  Digital module input FIFO overflow error; There are more samples being
produced than can be consumed at the current clock rate.Verify that the
digital module clock is set up properly.

（デジタル・モジュールの入力 FIFO オーバーフロー・エラーです。現在のクロック・レート

で消費できるよりも多くのサンプルが供給されています。デジタル・モジュールのクロックが

正しく設定されているかどうかを確認してください）

このエラーが報告されるのは、デジタル・モジュールのクロック設定が、サンプルがデジタル・

モジュールに供給されるレートと同期していない場合です。クロック・セットアップ・メニュー

で入力クロック・レートが指定されたクロック・レートに一致することを確認してください。

804  Digital module input FIFO underflow error; There are not enough samples
being produced for the current clock rate.Verify that the digital
module clock is set up properly.

（デジタル・モジュールの入力 FIFOアンダーフロー・エラーです。現在のクロック・レートに

対して十分なサンプルが供給されていません。デジタル・モジュールのクロックが正しく設定

されているかどうかを確認してください。）

このエラーが報告されるのは、デジタル・モジュールのクロック設定が、サンプルがデジタル・

モジュールに供給されるレートと同期していない場合です。クロック・セットアップ・メニュー

で入力クロック・レートが指定されたクロック・レートに一致することを確認してください。

クロック・セットアップ・メニューに
アクセス
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図 11-18 パラレル・ポート構成に対するクロック・セットアップ・ソフトキー・メニュー

ディスプレイ上部のグラフィックは、Clock Out および Device Interface コネクタに出力クロック信号を供給する現在

のクロック・ソースを示します。このグラフィックは、この手順の後の方で説明するクロック・ソース選択を反映し

て変わります。下部のグラフィックは、データを基準としたクロック・エッジを示します。表示されたクロック信号

は以下の項目を反映して変わります。

• クロック位相の選択

• クロック・スキュー調整

• クロック極性選択

2. Clock Source ソフトキーを押します。

このメニューから、クロック信号のソースを選択します。選択を実行すると、信号発生器のクロック・セットアップ・

メニューのクロック・ルーティング表示が、現在のクロック・ソースを反映して変わります。これはグラフィックの

変化によってわかります。

3. クロック・ソースを選択します。

External または Device を選択した場合

Clock Rate ソフトキーを押し、外部クロック信号のクロック・レートを入力します。 

注記 クロック・レート設定を変更した場合、クロック位相とクロック・スキューの再調整が必要になることがありま

す。「フェーズ／スキュー調整のクロック・タイミング」（209ページ）を参照してください。

入力モードでは非アクティブ

内部クロック・ソース選択に対してのみアクティブ

25 MHz より低いクロック・レートに対しては非アクティブ

10 MHz より下および 200 MHz より

上のクロック・レートに対しては
非アクティブ
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External を選択した場合、信号は外部クロック・ソースから供給され、Ext Clock In コネクタに入力されます。Device
を選択した場合、クロック信号は Device Interface コネクタを通じて、通常は被試験デバイスから供給されます。

Internal を選択した場合

N5102A は、外部周波数基準を使って独自の内部クロック信号を発生します。基準周波数信号は、デジタル・モジュー

ルの Freq Ref コネクタに入力します。

a. Reference Frequency ソフトキーを押し、外部から供給される周波数基準の周波数を入力します。

b. Clock Rate ソフトキーを押し、クロック・レートを入力します。

表 11-9 に、クロック・ソースの選択に対応する設定と接続の一覧を示します。

4. Clock Phase ソフトキーを押します。

表示されるメニューから、クロックの位相をデータを基準として 90°刻みで変更できます。これは、データの有効部

分に合わせてクロックの位置を大まかに調整する役割を果たします。180°を選択するのは、負のクロック極性を選択

するのと同じです。

クロック・レートが 10 MHz より下または 200 MHz より上の場合、90°と 270°は選択できません。クロック・レー

トが 10 MHz より下または 200 MHz より上に設定されている場合に 90°または 270°を選択すると、位相はそれぞれ

0°と 180°に変更されます。 

注記 クロック・レート設定を変更した場合、クロック位相とクロック・スキューの再調整が必要になることがありま

す。「フェーズ／スキュー調整のクロック・タイミング」（209ページ）を参照してください。

5. 必要な位相を入力します。

6. Return ソフトキーを押して、クロック・セットアップ・メニューに戻ります。

7. Clock Skew ソフトキーを押します。

これは、クロックを現在の位相位置を基準として微調整する役割を果たします。スキューは、時間単位による位相調

整です。これにより、高いクロック・レートでより細かいスキュー調整が可能になります。クロック・レートが 25
MHz より下の場合、このソフトキーは非アクティブです。

表11-9 クロック・ソース設定とコネクタ

クロック・
ソース

ソフトキー N5102Aの接続

周波数基準 クロック・レートa

a. Internalを選択した場合、内部クロック・レートを設定します。ExternalおよびDeviceを選択した場合、印加さ

れるクロック信号のレートを入力します。

Freq Ref Ext Clock In Device Interface

External ● ●

Device ● ●

Internalb

b. Internalを使用する場合、Ext Clock Inコネクタにはクロック信号を入力してはいけません。

● ● ●
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スキューは不連続な値を持ち、そのレンジはクロック・レートに依存します。スキュー設定の詳細については、「フェー

ズ／スキュー調整のクロック・タイミング」（209 ページ）を参照してください。

8. クロックをデータの有効部分に正確に合わせるためのスキューを入力します。

9. Clock Polarity Neg Pos ソフトキーを押して Neg にします。

これはクロック信号を 180°シフトし、データの開始位置が負のクロック遷移にあたるようにします。これは 180°
の位相調整を選択するのと同じです。

10. 被試験デバイスに必要なクロック極性を選択します。

11. Return ハードキーを押して、第 1 レベルのソフトキー・メニューに戻ります。

クロック・ソースの選択は、第 1 レベルのソフトキー・メニューのグラフィックにも反映されます。例えば、デバイ

スが新しいクロック・ソースの場合、周波数基準が DUT に接続され、DUT の入力クロック・ラインが N5102A に接

続されます。

データ・パラメータの選択

この手順では、データ・セットアップ・メニューの使用法を説明します。ソフトキーの機能が名前からわかる場合（例え

ば、Word Size（ワード・サイズ）ソフトキー）については、通常は説明を省きます。すべてのソフトキーの詳細について

は、『E8257D/67D PSG Signal Generators Key Reference』を参照してください。

1. 図 11-19 を参照してください。Data Setup ソフトキーを押します。

図 11-19 データ・セットアップ・メニューの位置

このソフトキー・メニューは、PSG が受信するデータを決定するさまざまなパラメータにアクセスします。ディスプ

レイのステータス・エリアには、I と Q に用いられるデータ・ラインの数と、データを基準としたクロックの位置が

表示されます。図 11-20 にデータ・セットアップ・メニューの構造を示します。

データ・セットアップ・メニューに
アクセス
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図 11-20 パラレル・ポート構成のデータ・セットアップ・ソフトキー・メニュー

2. Data Type ソフトキーを押します。 

このメニューでは、データ・タイプをフィルタされるか（Samples）されないか（Pre-FIR Samples）から選択します。

この選択は、テスト・ニーズと被試験デバイスに依存します。例えば、被試験デバイスにすでに FIR フィルタが装備

されている場合は、2 重にフィルタを通すことを避けるため、Pre-FIR Samples を選択する必要があります。詳細につ

いては「データ・タイプ」（212 ページ）を参照してください。

3. テスト・ニーズに適したデータ・タイプを選択します。

4. Numeric Format ソフトキーを押します。

このメニューから、バイナリ値の表現方法を選択します。2 の補数を選択すると、正と負の両方のデータ値が使用で

きます。コンポーネントが負の値を処理できない場合は、オフセット・バイナリを選択します。

5. テストに必要な数値フォーマットを選択します。

シリアル・ポートでは
非アクティブ構成

シリアル・ポート構成の場合に、

N5102A デジタル・モジュールが

オンのときだけ使用可能 データ・タイプがプレ FIR
サンプルの場合だけ使用
可能

フレーム極性はアクティブ
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6. More (1 of 2) ソフトキーを押します。

このソフトキー・メニューから、ビット順序の選択、I/Q の交換、伝送データの極性の選択、データ符号反転、スケー

リング、フィルタ・パラメータの設定のためのメニューにアクセスできます。

7. Data Negation ソフトキーを押します。

符号反転は、I/Q極性の変更とは異なります。符号反転をサンプルに適用すると、サンプルは2の補数で表現され、－1
と乗算されてから、選択した数値フォーマットに戻されます。これは、Iサンプル、Qサンプル、またはその両方に適

用できます。 

 符号反転を使用するかどうかの選択は、被試験デバイスに依存します。

8. I/Q スケーリングおよびフィルタ・パラメータにアクセスするには、Return > N5102A Off On を押して On にします。こ

れにより、PSG のベースバンド・ジェネレータでリアルタイム・カスタム・フォーマットが有効になります。これは、

データ・タイプとして Pre-FIR Samples を選択した場合に、フィルタ・パラメータを設定するために必要です。 

9. Baseband Setup ソフトキーを押します。

このソフトキー・メニューを使って、I/Q スケーリングおよびアクセス・フィルタ・パラメータを調整します。選択

したデータ・タイプが Samples の場合、Filter ソフトキーは淡色表示（非アクティブ）になります。

デジタル・データ

N5102A デジタル・モジュールがオンでない場合、Return > Return > N5102A Off On を押して On にします。

デジタル・データが N5102A を通じて PSG に伝送されます。緑のステータス・ライトが点滅しているはずです。これは、

データ・ラインがアクティブであることを示します。ステータス・ライトが常時点灯している（点滅しない）場合、すべ

てのデータ・ラインが非アクティブです。ステータス・ライトは、N5102A が最初にオンになったとき（N5102A Off On ソ

フトキーが On になったとき）に点灯し、そのまま点灯（点滅または常時点灯）し続けます。ステータス・ライトは、モ

ジュールが電源から切り離されるまで点灯し続けます。

注記 ベースバンド・データ・パラメータを変更する場合、パラメータの変更中に発生する信号の変化からデバイスと

N5102Aモジュールを保護するため、先にデジタル出力をオフにしておく（N5102A Off Onソフトキーをオフにす

る）ことをお勧めします。

ミリ波信号源モジュール

信号発生器の RF 周波数は、Agilent 8355x シリーズ・ミリ波信号源モジュールまたは他の外部信号源モジュールを使って

拡張できます。出力周波数レンジは、ミリ波信号源モジュールの周波数レンジに依存します。このセクションでは以下の

手順を説明します。

• Agilentミリ波信号源モジュールの使用方法

• その他の信号源モジュールの使用

Agilentミリ波信号源モジュールの使用方法

Agilent 8355x シリーズ・ミリ波信号源モジュールは、信号発生器のリアパネルの SOURCE MODULE INTERFACE コネク

タに接続され、機器との直接通信や、信号源モジュールの自動レベリング制御などの機能が利用できます。自動レベリン

グ機能や乗数選択機能のない 8355x シリーズ信号源モジュールを使用したい場合は、「その他の信号源モジュールの使用」

（234 ページ）のセクションを参照してください。
230 第11章



周辺機器
ミリ波信号源モジュール
以下に示すのは、信号発生器の周波数レンジの拡張に必要な機器のリストです。

• Agilent 8355x シリーズ・ミリ波信号源モジュール

• Agilent 8349Bマイクロ波増幅器（オプション1EAなしのE8257D PSGだけに必要）

• 必要なRF出力ケーブルとアダプタ

注記 オプション1EA付きのE8267D PSGまたはE8257D PSGに接続されるケーブルとアダプタの最大挿入損失は、1.5
dB未満でなければなりません。これは、外部信号源モジュールから最大のパワーを得るためです。

外部信号源モジュールの設定

注意 信号発生器の損傷を避けるため、リアパネルのSOURCE MODULE INTERFACEコネクタに信号源モジュー

ル・インタフェース・ケーブルを接続する前に、信号発生器の電源をオフにしてください。

1. 信号発生器の電源をオフにします。

2. 図に示すように機器を接続します。

• オプション1EAなしのE8257D PSGの場合は、図11-21のセットアップを使います。

• オプション1EA付きのE8257D PSGまたはE8267D PSGの場合は、図11-22のセットアップを使います。
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図 11-21 オプション1EAなしのE8257D PSGのセットアップ
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図 11-22 E8267D PSGおよびオプション1EA付きのE8257D PSGのセットアップ

信号発生器の設定

1. 信号発生器の電源をオンにします。 

注記 周波数と振幅の具体的な範囲については、ミリ波信号源モジュールの仕様を参照してください。

2. Frequency > (3 of 3) > Source Module を押し、Agilent 8355x Source Module Off On ソフトキーを On に切り替えます。信号

発生器は次の動作を実行します。 

• Agilentミリ波信号源モジュールを認識します。

• レベリング・モードを外部/信号源モジュールに切り替えます（ミリ波信号源モジュールの出力でのパワーがレベ

リングされます）。

• ミリ波信号源モジュールの周波数と振幅を信号源モジュールのプリセット値に設定します。

• ミリ波信号源モジュールから出力されるRF出力周波数および振幅（有効な場合）の値を表示します。
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フロント・パネルの Agilent 8355x Source Module Off On ソフトキーを使って 8355x シリーズ・ミリ波信号源モジュー

ルをオンにした場合、信号発生器のディスプレイの FREQUENCY エリアに MMOD インジケータ、AMPLITUDE エリ

アに MM インジケータが表示されます。 

3. RF OFFインジケータが表示されている場合、RF On/Off を押します。

これにより、ミリ波信号源モジュールの出力からレベリング・パワーが供給されます。

フラットネス補正されたパワーを得る方法については、「ユーザ・フラットネス補正の作成と適用」（119 ページ）を参照

してください。

その他の信号源モジュールの使用

PSG の周波数レンジを、任意の外部信号源モジュールを使って、または自動レベリング機能のない Agilent 8355x シリー

ズ・ミリ波信号源モジュールを使って拡張するには、以下の手順を使用します。以下に示すのは、信号発生器の周波数レ

ンジの拡張に必要な機器のリストです。

• 外部ミリ波信号源モジュール

• Agilent 8349Bまたは他のマイクロ波増幅器（オプション1EAなしのE8257D PSGだけに必要）

• 必要なRF出力ケーブルとアダプタ

外部信号源モジュールの設定

1. 信号発生器の電源をオフにします。

2. 図に示すように機器を接続します。

• オプション1EAなしのE8257D PSGの場合は、図11-23のセットアップを使います。

• オプション1EA付きのE8257D PSGまたはE8267D PSGの場合は、図11-24のセットアップを使います。
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図 11-23 オプション1EAなしのE8257D PSGのセットアップ

図 11-24 E8267D PSGおよびオプション1EA付きのE8257D PSGのセットアップ
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信号発生器の設定

以下の手順では、WR（導波管方形）周波数レンジが 90 ～ 140 GHz の任意の外部信号源モジュールを使用できるように

PSG を設定します。周波数レンジは使用する信号源モジュールに合わせて変更できます。

1. 信号発生器の電源をオンにします。 

注記 OEM Source Moduleを選択すると、信号源モジュール出力での自動レベリングは使用できなくなります。

2. Frequency > (3 of 3) > Source Module を押します。Agilent 8355x Source Module Off On ソフトキーを Off に切り替えます。

3. OEM Source Off On ソフトキーを On に切り替えます。 

4. OEM Source Module Config > Standard WR Freq Bands > WR8 90-140GHz を押します。 

Standard WR Freq Bands メニューの選択肢は、定義済みの周波数レンジと、最も一般的な外部信号源モジュールの

周波数レンジに対する乗数です。これらは設定の便宜のために用意されています。使用する信号源モジュールの周波

数レンジがリストにない場合、Min Band Freq、Max Band Freq、Freq Multiplier の各ソフトキーを使って、レンジと PSG
の周波数表示乗数を手動で設定します。これらの手動設定の詳細については、『E8257D/67D PSG Signal Generators
Key Reference』を参照してください。 

5. RF OFFインジケータが表示されている場合、RF On/Off を押します。

フラットネス補正されたパワーを得る方法については、「ユーザ・フラットネス補正の作成と適用」（119 ページ）を参照

してください。
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この章では、Agilent PSG 信号発生器の基本的なトラブルシューティング情報を記載します。ここで解決法が見つからな

い場合は、『E8257D/67D PSG 信号発生器サービス・ガイド』を参照してください。

注記 本器にエラーが表示された場合は、必ずUtility > Error Infoを押してエラー・メッセージ・テキストを見てください。

• 「RF出力パワーの問題」（237ページ）

• 「RF出力が変調されない」（241ページ）

• 「掃引の問題」（242ページ）

• 「データ・ストレージの問題」（243ページ）

• 「ヘルプ・モードをオフにできない」（244ページ）

• 「信号発生器がハングする」（244ページ）

• 「エラー・メッセージ」（245ページ）

• 「Agilentセールス／サービス・オフィスへの連絡」（247ページ）

• 「アジレント・テクノロジーに信号発生器を返送する場合」（247ページ）

RF出力パワーの問題

画面上の RF ON/OFFインジケータを調べます。RF OFFと表示されている場合は、RF On/Off を押して RF 出力をオンにし

ます。

波形ファイルの再生の際にRF出力パワーが存在しない

本器を初期設定にしてから、波形ファイルを再生します。

波形に対してヘッダ・ファイルが指定されていない場合、不特定の設定を持つデフォルトのヘッダ・ファイルが用いられ

ます。不特定の信号発生器設定を持つ波形ファイルを再生する場合（設定がファイル・ヘッダに保存されていない、82
ページを参照）、前に再生されたファイルのヘッダ・ファイル設定が用いられます。前のヘッダ・ファイルでマーカが RF
ブランクに設定されていた場合、RF 出力パワーはブランクになります。本器を初期設定して、RF ブランク・マーカ機能

をデフォルト状態のオフに戻してください。詳細については、『E8257D/67D PSG Signal Generators Key Reference』の

マーカのセクションを参照してください。

注記 デフォルトのマーカ・ファイルを使用する場合、Pulse/RF BlankソフトキーがNoneに設定されていることを確認

します。前のファイル・ヘッダでマーカがPulse/RF Blankに設定されている可能性があります。 
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RF出力パワーが小さい

1. 画面の AMPLITUDEエリアに OFFSまたは REFが表示されているかどうか見ます。

OFFSが表示されている場合、振幅オフセットが設定されています。振幅オフセットは AMPLITUDEエリアの値を変えま

すが、出力パワーには影響しません。表示されている振幅は、本器のハードウェアから現在出力されているパワーに

オフセット値を足したものです。

オフセットをなくすには、以下のキーを押します。

Amplitude > More (1 of 2) > Ampl Offset > 0 > dB

REF が表示されている場合、振幅基準モードがオンになっています。このモードがオンの場合、表示されている振幅

値は出力パワー・レベルに一致しません。表示されている値は、本器のハードウェアから現在出力されているパワー

から、Ampl Ref Set ソフトキーで設定された基準値を引いたものです。

基準モードを解除するには、以下の手順を実行します。

a. Amplitude > More (1 of 2) を押します。

b. Ampl Ref Off On を押して Off を強調表示します。

その後、出力パワーを必要なレベルに設定し直します。

2. 本器を外部ミキサと組み合わせて使用している場合、「ミキサとの組合わせで信号断が起きる」（238 ページ）を参照

してください。

3. 本器をスペクトラム・アナライザと組み合わせて使用している場合、「スペクトラム・アナライザとの組合わせで信号

断が起きる」（240 ページ）を参照してください。

電源がシャット・ダウンした

電源が動作していない場合、電源の修理または交換が必要です。交換可能な電源ヒューズはありません。詳細については、

『E8257D/67D PSG Signal Generators Service Guide』を参照してください。

ミキサとの組合わせで信号断が起きる

ミキサと組み合わせた小振幅結合動作で本器の RF 出力に信号断が発生する場合、アッテネータを追加して本器の RF 出

力の振幅を上げることにより解決する可能性があります。

図 12-1 に、本器からミキサに小振幅信号を供給する場合の仮想的な構成を示します。
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図 12-1 ALCに対する逆電力の影響

本器の内部レベリング RF 出力（および ALC レベル）は－ 8 dBm です。ミキサは＋ 10 dBm の LO でドライブされてお

り、LO と RF のアイソレーションは 15 dB です。このため、－ 5 dBm の LO フィードスルーが本器の RF 出力コネクタに

入り、内部ディテクタに到達します。

周波数によっては、この LO フィードスルーのエネルギーの大部分がディテクタに入ります。ディテクタは周波数に関わ

らず全入力パワーに反応するので、この余分のエネルギーに応じて ALC は本器の RF 出力を減少させます。この例では、

ディテクタを通る逆電力が ALC レベルよりも高いので、RF 出力の信号断をもたらす可能性があります。

240 ページの図 12-2 は、同様の構成に対して、本器の RF 出力とミキサの入力との間に 10 dB のアッテネータを追加した

ものです。本器の ALC レベルは＋ 2 dBm に上がっており、10 dB のアッテネータを通過することによってミキサ入力に

必要な－ 8 dBm の振幅を供給します。 

RF レベル 
制御

信号発生器の

出力制御

ミキサ

LO 

IF

ALC レベル
= － 8 dBm

ディテクタ
測定値
－ 8 dBm
ALC レベル

ディテクタ
測定値
－ 5 dBm
逆パワー

LO フィードスルー
= － 5 dBm

RF 出力
= － 8 dBm

LO レベル
= ＋ 10 dBm
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図 12-2 逆電力の解決法

元の構成と比べると、ALC レベルは 10 dB 高く、LO フィードスルー（および本器の RF 出力）はアッテネータによって

10 dB 減衰されます。アッテネータ付きの構成では、ディテクタが受け取る必要信号は＋ 2 dBm、不要な LO フィードス

ルーは－ 15 dBm です。このように必要エネルギーと不要エネルギーの間に 17 dB の差があるので、本器の RF 出力レベ

ルは最大でも 0.1 dB しかシフトしません。

スペクトラム・アナライザとの組合わせで信号断が起きる

プリセレクション機能がないスペクトラム・アナライザと組み合わせて本器を使用する場合、逆電力の影響で本器の RF
出力に問題が生じるおそれがあります。

一部のスペクトラム・アナライザには、周波数によって RF 入力ポートに＋ 5 dBm もの LO フィードスルーが生じるもの

があります。LO フィードスルーと RF 搬送波の周波数差が ALC の帯域幅よりも小さい場合、LO の逆電力によって本器の

RF 出力に振幅変調が生じるおそれがあります。この不要な AM の変調周波数は、スペクトラム・アナライザの LO フィー

ドスルーと本器の RF 搬送波の周波数差に一致します。

逆電力の問題を解決するには、ALC オフとパワー・サーチの 2 つのレベリングなし動作モードのどちらかを使用します。

ALCオフ・モードの設定

ALC オフ・モードでは、本器の RF 出力の前の自動レベリング回路（ALC）がオフになります。このモードでは、検出ポ

イントで必要な出力パワーを得るために、パワー・メータを使って本器の出力を測定する必要があります。 

本器を ALC オフ・モードに設定するには、以下の手順を実行します。

1. 本器を初期設定にします。Preset を押します。

2. 目的の周波数を選択します。Frequency を押し、目的の周波数を入力します。

3. 目的の振幅を選択します。Amplitude を押し、目的の振幅を入力します。

RF レベル 
制御

信号発生器の

出力制御

ミキサ

LO 

IF

ALC レベル／

ディテクタ
測定値
＋ 2 dBm
ALC レベル

ディテクタ
測定値
－ 15 dBm
逆パワー

LO フィードスルー
= － 5 dBm

RF 入力
= － 8 dBm

LO レベル
= ＋ 10 dBm

10 dB
アッテ

RF 出力
= ＋ 2 dBm

ネータ
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4. RF をオフにします。RF On/Off を Off にします。

5. 本器の自動レベリング制御（ALC）をオフにします。Amplitude > ALC Off On を押して Off にします。

6. パワー・メータの測定値を見て、RF 出力振幅をモニタします。

7. パワー・メータの測定値が目的の値になるように、Amplitude を押して本器の RF 出力振幅を調整します。

パワー・サーチ・モードの設定

パワー・サーチ・モードでは、ALC を一時的にオンにしてパワー・サーチ・ルーチンが実行され、現在の RF 出力のパ

ワーが校正された後、ALC 回路がオフになります。パワー・サーチ機能の詳細については、『E8257D/67D PSG Signal
Generators Key Reference』を参照してください。 

本器を手動固定パワー・サーチ・モードに設定するには、以下の手順を実行します。

1. 本器を初期設定にします。Preset を押します。

2. 目的の周波数を選択します。Frequency を押し、目的の周波数を入力します。

3. 目的の振幅を選択します。Amplitude を押し、目的の振幅を入力します。

4. 本器の自動レベリング制御（ALC）をオフにします。Amplitude > ALC Off On を押して Off にします。

5. RF をオンにします。RF On/Off を On にします。

6. Do Power Search を押します。

手動固定パワー・サーチ・ルーチンが実行されます。これはデフォルトのモードです。

パワー・サーチ・モードには、手動、自動、スパンの 3 種類があります。

Power Search が Manual に設定されている場合、Do Power Search を押すと、現在の RF 周波数および振幅に対してパワー・

サーチ校正ルーチンが実行されます。このモードでは、RF 周波数または振幅に変化があった場合、Do Power Search をも

う一度押す必要があります。

Power Search が Auto に設定されている場合、RF 出力の周波数または振幅が変化したときに自動的に校正ルーチンが実行

されます。

Power Search が Span に設定されている場合、Do Power Search を押すと、選択された周波数レンジに対してパワー・サー

チ校正ルーチンが 1 回実行されます。パワー・サーチ補正値が保存され、選択された周波数レンジ内に本器がチューニン

グされたときには常にその補正値が用いられます。

RF出力が変調されない

画面の MOD ON/OFFインジケータを調べます。MOD OFFと表示されている場合、Mod On/Off を押して変調をオンにします。 

各種の変調を設定して有効にしていても、Mod On/Off を On に設定していないと RF 搬送波は変調されません。

E8267D では、デジタル変調の場合、I/Q Off On が On に設定されていることを確認してください。
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掃引の問題

掃引が停止しているように見える

掃引の現在の状態は、進捗状況バーの陰影表示の長方形で示されます。進捗状況バーを見れば掃引が進行しているかどう

かを判断できます。掃引が停止しているように見える場合、以下のことを調べてください。

下記のどれかのキー・シーケンスを押して掃引をオンにしたかどうか。

  Sweep/List > Sweep > Freq

  Sweep/List > Sweep > Ampl

  Sweep/List > Sweep > Freq & Ampl

掃引が連続モードかどうか。掃引がシングル・モードの場合、前回の掃引の終了後に少なくとも 1 回 Single Sweep ソフ

トキーを押したかどうかをチェックしてください。モードを連続に設定してみて、シングル掃引が起動されなかった

ために掃引が停止しているのかどうかを調べてください。

本器が適切な掃引トリガを受信しているかどうか。Sweep Trigger ソフトキーを Free Run に設定してみて、掃引トリガ

が受信されなかったために掃引が停止しているのかどうかを調べてください。

本器が適切なポイント・トリガを受信しているかどうか。Point Trigger ソフトキーを Free Run に設定してみて、ポイン

ト・トリガが受信されなかったために掃引が停止しているのかどうかを調べてください。

待ち時間は適切か。待ち時間を 1 秒に設定してみて、待ち時間が長すぎるかまたは短すぎて見えなかったのかどうかを

調べてください。

ステップ掃引またはリスト掃引に 2 個以上のポイントが存在するかどうか。

掃引モードをオフにできない

Sweep/List > Sweep > Off を押します。

掃引モード・メニューからは、さまざまな掃引タイプを設定したり、掃引をオフにしたりすることができます。

リスト掃引の待ち時間が正しくない

掃引リストの各ポイントでの待ち時間が正しくない場合、以下の手順を実行してください。

1. Sweep/List > Configure List Sweep を押します。

掃引リストの値が表示されます。

2. 掃引リストの待ち時間の値が正しいかどうかを調べます。

3. 待ち時間の値が正しくない場合は編集します。

注記 RF OUTPUTコネクタでの実効待ち時間は、設定した待ち時間の値に処理時間とスイッチング時間とセトリング

時間を加えたものとなります。待ち時間に付加されるこれらの時間の長さは通常数ミリ秒です。一方、TRG OUT
コネクタのTTL/CMOS出力がハイにアサートされるのは、実際の待ち時間の間だけです。

リストの待ち時間の値が正しい場合は、次のステップに進みます。
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4. Dwell Type List Step ソフトキーが Step に設定されているかどうかを調べます。

Step が選択されている場合、リスト・ポイントの掃引に用いられる待ち時間は、掃引リストの値ではなく、ステップ

掃引に対して設定された値になります。

ステップ掃引の待ち時間を表示するには、以下の手順を実行します。

a. Configure Step Sweep を押します。

b. Step Dwell ソフトキーに設定された値を観察します。

リスト掃引の情報がリコールしたレジスタにない

リスト掃引の情報は、機器ステート・レジスタに保存される機器ステートには含まれません。本器が使用できるのは現在

のリスト掃引だけです。リスト掃引のデータは機器カタログに保存することができます。手順については、「メモリ・カタ

ログへのファイルの保存」（52 ページ）を参照してください。

データ・ストレージの問題

機器ステートを以前に保存したレジスタが空になっている

本器が電源に接続されていない場合は、セーブ / リコール・レジスタはバッテリによってバックアップされます。バッテ

リの交換が必要な可能性があります。 

バッテリが消耗しているかどうかを確認する手順 :

1. 本器の電源をオフにします。

2. 本器の電源コードを抜きます。

3. 電源コードを再び接続します。

4. 本器の電源をオンにします。

5. 画面にエラー・メッセージが表示されているかどうかを見ます。

エラー・メッセージ－ 311 または－ 700 がエラー・メッセージ・キューに存在する場合、本器のバッテリは消耗して

います。 

6. バッテリの交換手順については、『E8257D/67D PSG Signal Generators Service Guide』を参照してください。

機器ステートを保存したが、レジスタが空または間違ったステートが保存されている

99 より大きいレジスタ番号を選択した場合、自動的にレジスタ 99 に機器ステートが保存されます。

保存したはずのレジスタが空または正しくないステートが保存されている場合、レジスタ 99 をリコールしてください。

Recall > 99 > Enter を押します。

保存した情報はここにあるかもしれません。
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1. Utility > Instrument Info/Help Mode を押します。

2. Help Mode Single Cont を押して、Single を強調表示します。

本器のヘルプ・モードには、シングルと連続の 2 種類があります。 

シングル・モード（工場設定状態）で Help を押した場合、次に押したキーのヘルプ・テキストが表示されます。さらに別

のキーを押すと、ヘルプ・モードが解除され、そのキーの機能が実行されます。

連続モードで Help を押した場合、次に押したキーのヘルプ・テキストが表示されるとともに、そのキーの機能も実行され

ます（Preset を除く）。ヘルプ・モードを終了するには、もう一度 Help を押すか、シングル・モードに切り替えます。

信号発生器がハングする

本器がハングした場合、以下の点をチェックしてください。

• 本器がリモート・モードになっていないかどうか確認します（リモート・モードの場合、画面に Rインジケー

タが表示されます）。リモート・モードが解除してフロントパネルのキーパッドを使用可能にするには、Local
を押します。

• 本器がローカル・ロックアウト状態になっていないかどうか確認します。ローカル・ロックアウト状態では、
フロント・パネルの操作ができません。ローカル・ロックアウトの詳細については、『E8257D/67D PSG信号発

生器プログラミング・ガイド』を参照してください。

• 画面に進捗状況バーが表示されているかどうかを見ます。 バーが表示されていれば動作が進行中です。

• Presetを押します。

• 本器の電源を入れ直します。

フェール・セーフ回復シーケンス

フェール・セーフ回復シーケンスは、上記のチェックで問題が解決しなかった場合に使用します。 

注意 この手順を実行すると本器がリセットされ、以下のデータは失われます。

• すべてのユーザ・ファイル（機器ステートおよびデータ・ファイル） 
• DCFM/DCΦM校正データ

• 持続性ステート

注記 フェール・セーフ・シーケンス中は、他のフロントパネル操作やリモート操作はいっさい実行しないでください。 

フェール・セーフ・シーケンスを実行するには、以下の手順を実行します。

1. Preset キーを押しながら電源を入れ直します。 

2. 次のメッセージが表示されるまで Preset キーを押し続けます。

警告 You are entering the diagnostics menu which can cause unpredictable instrument behavior. Are you sure you want to
continue?

（診断メニューに入ります。これを実行すると、機器が予測できない動作をする可能性があります。続行し

ますか?）
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注意 表示されたメッセージを注意して読んでください。他にもこの手順に伴う別の危険が記載されている可能

性があります。

3. Preset キーを放します。

4. シーケンスを続行するには Continue を押します（続行しない場合は Abort を押します。 この場合ファイルは失われませ

ん）。

5. シーケンスが終了したら、以下の手順を実行します。

a. 電源を入れ直します。 

電源を入れ直すと、インストール済みのオプションがすべて回復されます。校正ファイルは EEPROM から回復さ

れるため、エラー・メッセージがいくつか表示されます。

b. DCFM/DCΦM 校正を実行します。 

『E8257D/67D PSG Signal Generators Key Reference』の DCFM/DCΦM Cal ソフトキーの説明を参照してください。

c. フェール・セーフ回復シーケンスが必要になった状況を Agilent までお知らせいただければ幸いです。連絡先電

話番号は http://www.agilent.co.jp/find/assist に記載されています。同様の事態の再発を防ぐためにお役に立てる

可能性があります。

エラー・メッセージ

本器にエラーが発生した場合、フロント・パネル・ディスプレイのエラー・キューと、SCPI（リモート・インタフェース）

のエラー・キューの両方にエラーが報告されます。これら 2 つのキューは、表示も管理も別々に行います。SCPI エラー・

キューの詳細については、『E8257D/67D PSG 信号発生器プログラミング・ガイド』を参照してください。

注記 フロント・パネルのエラー・キューに未表示のメッセージがある場合、本器のディスプレイにERRインジケータ

が表示されます。

性質 フロントパネル・ディスプレイのエラー・キュー

容量（エラー数） 30

オーバーフロー処理
循環型。
新しいエラーが入るといちばん古いエラーを削除。

エントリの表示 Utility > Error Info > View Next (or Previous) Error Pageを押す

キューのクリア Utility > Error Info > Clear Error Queue(s)を押す

未解決のエラーa

a.解決の必要があるエラー。例えばアンロック。

キューがクリアされた後で再報告。

エラーなし
キューが空（キューのすべてのエラーが読み取られたか、キューがクリアされた）の場合、次のメッセージ
がキューに存在 :
0 No Error Message(s) in Queue
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エラー・メッセージ・ファイル

すべてのエラー・メッセージのリストは、機器に付属する CD-ROM 上の errormessages.pdf ファイルに収録されています。

エラー・メッセージ・リストでは、それぞれのエラーに詳細な意味を記した説明文が付記されています。エラー・メッセー

ジは番号順に記載されています。同じエラー番号に複数の項目がある場合、メッセージはアルファベット順に並びます。 

エラー・メッセージのフォーマット

フロント・パネル・ディスプレイのエラー・キューのエラー・メッセージにアクセスする場合、エラー番号、メッセージ、

説明は、番号に基づいて（“1 of N”）表示されます。

エラー・メッセージは発生とともにディスプレイの左下隅に表示されます。

エラー・メッセージのタイプ

イベントが発生するエラーのタイプは 1 つに限られます。例えば、問合せエラーを発生するイベントは、デバイス固有、

実行、コマンドの各エラーは発生しません。

問合せエラー（－ 499 ～－ 400）は、機器の出力キュー制御が IEEE 488.2 第 6 章に記載されたメッセージ交換プロトコル

に関する問題を検出したことを示します。このクラスのエラーは、イベント・ステータス・レジスタの問合せエラー・ビッ

ト（ビット 2）をセットします（IEEE 488.2、セクション 11.5.1）。これらのエラーは、IEEE 488.2、6.5 に記載されたメッ

セージ交換プロトコル・エラーに対応します。この場合 :

• 出力が存在するか処理待ちの状態にないときに出力キューからデータを読み取ろうとしたか、

• 出力キューのデータが失われています。

デバイス固有エラー（－ 399 ～－ 300、201 ～ 703、800 ～ 810）は、デバイス動作が正しく完了しなかったことを示します。

原因としては、ハードウェアまたはファームウェアの異常な状態が考えられます。これらのコードは、セルフテスト応答

エラーにも用いられます。このクラスのエラーは、イベント・ステータス・レジスタのデバイス固有エラー・ビット（ビッ

ト 3）をセットします（IEEE 488.2、セクション 11.5.1）。

エラー・メッセージ・リストに記載された説明

（これは機器には表示されません）

エラー番号 エラー・メッセージ

エラー説明

（画面上では切り詰められる場合があります）
246 第12章



トラブルシューティング
Agilentセールス／サービス・オフィスへの連絡
正のエラーの <error_message> 文字列は、SCPI では定義されていません。正のエラーは、GPIB システム、機器ファーム

ウェアまたはハードウェア、ブロック・データの転送、または校正でエラーが検出されたことを示します。

実行エラー（－ 299 ～－ 200）は、機器の実行制御ブロックがエラーを検出したことを示します。このクラスのエラーは、

イベント・ステータス・レジスタの実行エラー・ビット（ビット4）をセットします（IEEE 488.2、セクション11.5.1）。この場合:

• ヘッダの後の<PROGRAM DATA>要素が、デバイスによって有効な入力の範囲外またはデバイスの機能に適合

しないと評価されたか、

• 有効なプログラム・メッセージが何らかのデバイス条件によって正しく実行されませんでした。

実行エラーは、丸めと式評価動作が終了した後で報告されます。例えば、数値データ要素の丸めは、実行エラーとしては

報告されません。

コマンド・エラー（－ 199 ～－ 100）は、機器のパーサが IEEE 488.2 のシンタックス・エラーを検出したことを示します。

このクラスのエラーは、イベント・ステータス・レジスタのコマンド・エラー・ビット（ビット 5）をセットします（IEEE
488.2、セクション 11.5.1）。この場合 :

• パーサが IEEE 488.2シンタックス・エラーを検出した（IEEE 488.2規格に違反したデバイス制御メッセージが

受信された。違反としては、デバイスのリスニング・フォーマットに違反するデータ要素や、デバイスが受け
入れられないタイプのデータ要素などが挙げられます）か、

• 認識されないヘッダが受信されました。これには、正しくないデバイス固有ヘッダや、正しくない、あるいは
未実装の IEEE 488.2共通コマンドが含まれます。

Agilentセールス／サービス・オフィスへの連絡

テスト／測定ニーズに関する支援や、最寄りのAgilent営業所に関する情報は、インターネットの次の場所で入手できます。

http://www.agilent.co.jp/find/assist

E8257D/67D PSG のアクセサリやドキュメントは、インターネットの次の場所で入手できます。

http://www.agilent.co.jp/find/psg

インターネットにアクセスできない場合は、計測お客様窓口にお問い合わせください。

注記 ご連絡の際には、本器のモデル番号とシリアル番号をお伝えください。この情報によって、Agilent の担当者は

当該機器が保証期間中かどうかを知ることができます。

アジレント・テクノロジーに信号発生器を返送する場合

サービスのために本器をアジレント・テクノロジーに返送する場合 :

1. 本器の問題についてできるだけ多くの情報を集めてください。 

2. インターネット（http://www.agilent.co.jp/find/assist）に記載された最寄りの窓口の電話番号にご連絡ください。イ

ンターネットにアクセスできない場合は、計測お客様窓口にお問い合わせください。 

本器と本器の問題について詳しく教えていただいた後、修理のための本器の送付先をお知らせします。

3. 本器を購入された際の梱包材が残っている場合は、その梱包材を使用して本器を返送してください。残っていない場

合は、同様の梱包を使用して本器を十分に保護してください。
第12章 247



トラブルシューティング
アジレント・テクノロジーに信号発生器を返送する場合
248 第12章



索引
記号

ΦM, 15, 133

番号

003、オプション , 3
004、オプション , 3
005、オプション , 3
007、オプション , 2, 5, 39
015、オプション , 3
10 MHzコネクタ , 24, 25
128QAM I/Q変調、作成 , 150
1410、アプリケーション・ノート , 179, 189
1E1、オプション , 3
1EA、オプション , 3
1ED、オプション , 3
1EH、オプション , 3
1EM、オプション , 3
27 kHzパルス , 35
2トーン , 6, 67
2の補数の説明 , 217, 229
601/602、オプション

2トーン・モード , 189
カスタム・リアルタイム・モード , 159
カスタム任意波形モード , 67, 137
シンボル・レート , 147
説明 , 3, 6
マルチトーン・モード , 179

802.11b, 115
8757Dスカラ・ネットワーク・アナライザ , 35, 

39–48
8757ネットワーク・アナライザ , 45

A

ACP, 67, 142, 166
AC電源差込み口 , 24
Agilent PSGウェブページ , 1
ALC

アッテネータ・オプション付き , 118
インジケータ , 15
オフ・モード、設定 , 240
制限、振幅 , 117
帯域幅選択 , 115
入力コネクタ , 10
入力コネクタ（リア）, 28

ALCホールド

設定の保存 , 86
説明 , 86

AM, 15, 132
ARB

AWGN, 195
カスタム任意波形発生器

基準、設定 , 157
デュアル任意波形発生器も参照

トリガ , 98
波形クリッピング , 104–112
波形スケーリング , 112–114
波形ファイルのヘッダ , 68–78
ファイル・カタログ , 51

ARMEDインジケータ , 15
ATTEN HOLDインジケータ , 15
AUTOGEN_WAVEFORMファイル , 79
AUXILIARY I/Oコネクタ , 21
AUXILIARY INTERFACEコネクタ , 25
AWGN

ARB, 195
デュアル任意波形プレーヤ , 82
リアルタイム , 195

B

BbT、調整 , 141
BURST GATE INコネクタ , 20

C

CCDF曲線 , 110–111, 185
CDMA, 115
COHコネクタ , 24
CWモード

設定 , 32
説明 , 5

D

DACオーバレンジ・エラー , 112–114
DATA

入力コネクタ , 12
入力コネクタ（リア）, 28

DATA CLOCK

入力コネクタ , 12
入力コネクタ（リア）, 28
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DCオフセット , 133
DCディテクタ , 35
Delete Itemソフトキー , 31
Delete Rowソフトキー , 31
DHCP, 62
DIG BUSインジケータ , 15
Digital Busコネクタ , 21
DMODファイル , 51

E

E8257D

オプション機能 , 2
標準機能 , 2

E8267D

オプション機能 , 3
標準機能 , 3

Edit Itemソフトキー , 31
Erase All, 58, 59, 60
ERRインジケータ , 15, 245
EVENTコネクタ , 20
EVM, 142, 166
EXT

INPUTコネクタ , 9
インジケータ , 15
入力コネクタ , 9
入力コネクタ（リア）, 27

F

FAQ, 1
FIR, 51, 140
FM, 15, 132
FM/ΦMハードキー , 9
FSK

ファイル , 51
変調 , 149, 153, 154

G

GATE/PULSE/TRIGGER

入力コネクタ , 11
入力コネクタ（リア）, 27

Goto Rowソフトキー , 31
GPIB, 24, 124

H

Helpハードキー , 9
Holdハードキー , 11

I

I OUTコネクタ , 23
I/Oコネクタ、補助 , 21
I/Q

4QAMステート・マップ , 172
インジケータ , 15
スケーリング、調整 , 170
入力コネクタ , 13
ファイル , 51
変調 , 153, 176

I/Q波形

クリッピング , 104–112
スケーリング , 112–114

I-bar OUTコネクタ , 23
IMD。相互変調歪み

Incr Setハードキー , 11
Insert Itemソフトキー , 31
Insert Rowソフトキー , 31
IQ

クロック・レート , 200
変調 , 155

IQ変調 , 155
I入力コネクタ , 13
I入力コネクタ（リア）, 28

L

LAN構成 , 62
LANコネクタ , 26
LED, 12
LF OUTコネクタ , 27
LF出力 , 10, 135–136
低周波出力。LF出力

Load/Storeソフトキー , 31
Localハードキー , 11
L（リスナ・モード）インジケータ , 16

M

manual freqソフトキー , 45
MDMODファイル , 51
MENUSハードキー , 9
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Mod On/Off, 10, 16
MSK変調 , 149
MTONEファイル , 51

N

N5102A, 197
位相／スキュー・クロック・タイミング , 209
インタリーブ・クロック・タイミング , 207
共通周波数基準 , 201
クロック・ソース

説明 , 201
クロック・タイミング , 197, 204
クロック・レート , 197
クロックおよびデバイスとの接続 , 210
クロック設定 , 218, 225
周波数基準コネクタ , 202
出力方向 , 215
出力モード , 212, 213
シリアル・クロック・タイミング , 209
データ・タイプ , 212
データ・パラメータ、設定 , 215, 228
データの発生 , 222
デジタル・データ , 230
入力方向 , 223
入力モード , 212, 222
ベースバンド・データ , 213
ユーザ・インタフェース , 213
ユーザ・インタフェース・モジュール , 222
ロジック・タイプ , 214
ロジック・タイプ、ポート構成 , 224

N5102Aデジタル信号インタフェース・

モジュール , 197
NVMKRファイル , 51
nvwfm, 79
NVWFMファイル , 51

O

OFDM, 115
OVEN COLDインジケータ , 16

P

Page Downソフトキー , 31
Page Upソフトキー , 31
PATTERN TRIG INコネクタ , 20

PRAM, 67
Presetハードキー , 12
PSG

ウェブページ , 1
オプション , 4
追加情報 , 1
動作モード , 5
ファームウェア , 4

PSK変調 , 149
PULSE SYNC OUT, 27
PULSE VIDEO OUT, 27
PULSE/TRIG GATE INPUT, 27

Q

Q OUTコネクタ , 23
QAM変調 , 149, 172
Q-bar OUTコネクタ , 24
QPSK I/Q変調、作成 , 151
Q入力コネクタ , 13
Q入力コネクタ（リア）, 28

R

Recallハードキー , 8
Returnハードキー , 11
RF出力

On/Offハードキー , 10
インジケータ , 16
コネクタ , 10
コネクタ（リア）, 27
設定 , 32
掃引 , 34
トラブルシューティング , 237
ミリ波信号源モジュール、使用 , 230
ユーザ・フラットネス補正 , 119–130
レベリング、外部 , 116–119

RFブランキング

設定、保存 , 86
マーカ機能 , 96

RFブランク , 237
RS-232コネクタ , 25
R（リモート）インジケータ , 16

S

Saveハードキー , 8
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SCPI, 62
SCPIコマンド , 9
Seqファイル , 51
Signal Studioソフトウェア , 179, 189
SMIコネクタ , 24
SOURCE SETTLED OUTPUTコネクタ , 27
STOP SWEEPコネクタ , 26
Sweep/Listハードキー , 9
SYMBOL SYNC

入力コネクタ , 12
入力コネクタ（リア）, 28

SYNC OUTコネクタ , 10
SYNC OUTコネクタ（リア）, 27
S（サービス・リクエスト）インジケータ , 16

T

TCP/IP, 62
T（トーカ・モード）インジケータ , 16

U

UNLEVELインジケータ , 17
UNLOCKインジケータ , 17
UNR、オプション , 2, 130
UNT、オプション , 2, 5, 131–??, 134, 135
UNU、オプション , 2, 5, 131, 134
UNW、オプション , 3, 5, 131, 134

V

VIDEO OUTコネクタ , 11
VIDEO OUTコネクタ（リア）, 27

W

Webサーバ , 62
wfm1, 79
WFM1ファイル , 51
WIDEBAND I INPUTコネクタ , 22
WIDEBAND Q INPUTコネクタ , 23

Z

Z-AXIS BLANK/MKRSコネクタ , 26

あ

アクティブ入力エリア（ディスプレイ）, 14
アッテネータ、外部レベリング , 118

アナログPSG
オプション機能 , 2
標準機能 , 2

アナログ変調 , 5, ??–136
アプリケーション・ノート

1410, 179, 189
取得 , 1

α調整（フィルタ）, 141
位相

変調。ΦMを参照

エラーのシミュレーション , 153
極性 , 171

位相クロック・タイミング , 209
インジケータ , 15
インタフェース、リモート , 124
インタフェース・コネクタ

AUXILIARY INTERFACE, 25
GPIB, 24
LAN, 26
RS-232, 25

ウェブサイト , 1
エラー・メッセージ

DACオーバレンジ , 112–114
概要 , 245
キュー , 245
タイプ , 246
ディスプレイ , 17
メッセージ・フォーマット , 246

円形クリッピング , 110
応答、トリガ・モード , 99
オーバレンジ・エラー , 112–114
オフセット , 33, 34, 133
オフセット・バイナリの使用 , 217, 229
オプション

UNR, 130
UNT, 131–??, 135
UNU, 131, 134
UNW, 131, 134
003, 3
004, 3
005, 3
007, 2, 5, 39
015, 3
601/602

2トーン・モード , 189
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カスタム・リアルタイム・モード , 159
カスタム任意波形モード , 137
基本デジタル操作 , 67
シンボル・レートの使用 , 147
説明 , 3, 6
マルチトーン・モード , 179

1E1, 3
1EA, 3
1ED, 3
1EH, 3
1EM, 3
UNR, 2
UNT, 2, 5
UNU, 2, 5
UNW, 3, 5
追加情報 , 4
有効化 , 61

オプション015, 155
オン/オフ・スイッチ , 12

か

回復シーケンス、フェール・セーフ , 244
カスタム・モード , 67
カスタム・リアルタイムI/Qベースバンド , 6
カスタム任意波形 , 68
カスタム任意波形発生器 , 6
カプラ／スプリッタ、使用 , 116
概念

FIRフィルタ , 140
差分データ・エンコーディング , 171
波形クリッピング , 104–110
波形スケーリング , 112–114
波形マーカ , 85

外部

ディテクタ、ダイオード応答 , 117
データ・クロック、設定 , 170

外部FM, 133
外部I/Q変調 , 155
外部クロック・ソース選択 , 220, 226
外部信号源モジュール , 230
外部トリガ

ゲート、設定 , 101
シングル、設定 , 155
接続 , 101
ソース・コネクタ , 102

ガウシアン・フィルタ、選択 , 141
キー

フロントパネル , 7–12
無効 , 60

キー、ライセンス , 61
キーパッド、数値 , 10
機器ステート , 45
機器ステート・レジスタ

コメント、追加と編集 , 54
使用 , 53
トラブルシューティング , 243
メモリ・カタログも参照

基準

周波数、設定 , 33
振幅、設定 , 34
発振器帯域幅、調整 , 130

機能、信号発生器 , 1
揮発性メモリ , 79
基本操作

デジタル , 67
標準 , 29

機密解除 , 55
機密データ , 55
キャリア・フィードスルー、最小化 , 184, 192
キュー、エラー , 245
共通周波数基準ダイアグラム , 203
極性

トリガ、外部 , 101
マーカ , 98
マーカ設定、保存 , 69

クリッピング

CCDF曲線 , 110–111
円形 , 107, 110
概念 , 104–110
手順 , 110, 111
方形 , 107, 111

クロック、周波数基準 , 201
クロック、周波数基準ダイアグラム , 203
クロック・ソース

設定 , 220, 226
クロック・タイミング

位相／スキュー , 209
シリアル・データ , 209
パラレル・インタリーブ・データ , 207
パラレル・データ , 204
索引 253
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クロック・レート・リミット、ロジック・タイプ出

力 , 198
クロック調整

位相／スキュー , 209
形状ファイル , 51
ゲート , 134
ゲート・トリガ , 99, 101
交互ランプ掃引 , 45
広帯域IQ, 155
個人的データ , 55
コネクタ

外部トリガ , 101
外部トリガ・ソース , 102
フロントパネル , 7
リアパネル , 18

コメント、追加と編集（機器ステート）, 54
コントラスト調整（ディスプレイ）, 11
コンポーネント・テスト , 67

さ

サービス、Agilentセールス／サービス・オフィス , 
247

サービス・リクエスト・インジケータ , 16
サンプル

タイプ選択 , 217, 229
ベースバンド , 112–113
補間済み , 112–113
レート , 197
レート、シリアル・ポート構成 , 199
レート、パラレル／パラレル・インタリーブ・

ポート構成 , 200
サンプルあたりのクロック数

パラレル・インタリーブ・データ , 207
パラレル・データ , 204

シーケンス

機器ステート・レジスタ , 53
再生 , 82
削除 , 54
作成と保存 , 81
トリガ , 98
編集 , 82
マーカ制御 , 93

シーリング関数、シンボルあたりのビット数 , 172
式、スキュー不連続ステップ , 209
自動レベリング制御。ACLを参照

周波数

RF出力、設定 , 32
オフセット , 33
基準 , 33
ハードキー , 8
表示エリア , 15
ランプ掃引 , 39
レンジ , 1

周波数拡張 , 49
周波数基準

共通 , 201
接続ダイアグラム , 203

周波数出力リミット、クロック・レートとロジッ

ク・レベル , 198
周波数の拡大 , 49
周波数レンジ , 49
周波数レンジの拡大 , 49
周辺機器 , 197
デジタル信号インタフェース・モジュール , 197
ミリ波信号源モジュール , 197

出力。 LF出力とRF出力を参照

出力パワー、トラブルシューティング , 238
出力レベル、ロジック・タイプ , 198
手動掃引 , 45
証書、ライセンス・キー , 61
シリアル

クロック・タイミング , 209
クロック／サンプル・レート , 199

シングル・ステップ掃引 , 36
シングル・トリガ、設定 , 155
信号源モジュール , 230
信号断、トラブルシューティング , 237
信号発生器

オプション , 4
ファームウェア , 4
概要 , 1
機能 , 1
モード , 5
モデル , 1

信号発生器の返送 , 247
振幅

変調。AMを参照

LF出力 , 136
基準とオフセット , 34
ハードキー , 8
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表示エリア , 17
ランプ掃引 , 46

振幅エラーのシミュレーション , 153
シンボル・レート , 147
シンボルあたりのビット数、式 , 172
情報

機密の保護 , 55
追加のPSG, 1

スイッチ、パワー , 12
数値フォーマットの選択 , 217, 229
スカラ・ネットワーク・アナライザ , 35, 39–48
スカラ・パルス , 35
スキュー

クロック・タイミング , 209
レンジ , 209

スケーリング

概念 , 112–114
手順 , 114
波形データ , 114
ランタイム , 114

スタンバイLED, 12
ステート・ファイル , 51
ステート・レジスタ , 45
ステートのセーブとリコール , 53
ステートのリコール , 45, 53
ステップ・アッテネータ、外部レベリング , 118
ステップ掃引 , 35–37
ステップ配列（ユーザ・フラットネス）, 120
ユーザ・フラットネス補正

ストレージ、トラブルシューティング , 243
スペクトラム・アナライザ、信号断のトラブル

シューティング , 240
スペクトラム・リグロース , 106
製品情報 , 1
セーブとリコール , 45
セキュア・ディスプレイ , 60
セキュア・モード , 59
セキュリティ・レベル , 59
セキュリティ機能 , 55, 59
セグメント・アドバンス・トリガ , 100, 103
接続

共通周波数基準 , 203
説明、追加と編集（機器ステート）, 54
掃引

27 kHzパルス , 35

8757Dスカラ・ネットワーク・アナライザ , 35
DCディテクタ , 35
RF出力 , 34
インジケータ , 16
出力 , 26
スカラ・ネットワーク・アナライザ , 35
スカラ・パルス , 35
ステップ , 35
トラブルシューティング , 242
トリガ , 38
モード , 5
ランプ , 39–48
リスト , 37

掃引進捗度バー , 34
相互変調歪み

減少させる方法 , 106
非線形デバイスのテスト , 179, 189

操作

基本 , 29
デジタル基本 , 67

ソース、外部トリガ , 100
ソフトウェア

オプション , 4
PSGに使用可能な , 1

ソフトキー , 8, 17, 31
増幅器、マイクロ波 , 231, 234

た

帯域幅

ALC、選択 , 115
基準発振器、調整 , 130

立ち上がり時間、バースト形状 , 166
立ち上がり遅延、バースト形状 , 166
立ち下がり時間、バースト形状 , 166
立ち下がり遅延、バースト形状 , 166
単一トリガ・モード , 99
ダイアグラム

共通周波数基準 , 203
クロック・タイミング、位相／スキュー , 209
クロック・タイミング、シリアル・データ , 209
クロック・タイミング、パラレル・インタリー

ブ・データ , 207
クロック・タイミング、パラレル・データ , 204
データ・タイプ , 212

ダイオード・ディテクタの応答 , 117
索引 255



索引
遅延、外部トリガ信号 , 100
調整、ディスプレイ , 11
追加と編集（機器ステート）, 54
テーブル・エディタ、使用 , 30–31
定義済みフィルタ , 140
定義済み変調フォーマット , 137, 159
テキスト表示エリア , 17
テクニカル・サポート , 1
テンキー , 10
ディスプレイ

概要 , 14
コントラスト減少 , 11
コントラスト増加 , 11
セキュア , 60
説明 , 14
ブランキング , 60

ディテクタ

使用 , 116
ダイオード応答 , 117

データ

エンコーディング、差分 , 171, 178
機密 , 55, 58
クロック , 170
除去 , 58
ストレージ

機器ステート・レジスタも参照

セキュリティ , 56
メモリ・カタログも参照

問題 , 243
入力方法 , 56
パターン

使用 , 160
トリガ , 98

非フレーム , 99
ファイル , 51
フィールド、編集 , 31
フレーム , 99

データ・タイプ , 212
データ・フィルタリング、FIRの前または後 , 217, 

229
データシート , 1
データの保護 , 55
デジタル信号インタフェース , 197
デジタル信号インタフェース・モジュール , 197
デジタル変調

2トーン , 189–194
カスタム , ??–157
インジケータ , 17
カスタム , 137–??, 159–178
フォーマット , 6
マルチキャリア , 137, 139, 155
マルチトーン , 179–187

デバイス・クロック・ソース選択 , 220, 226
デフォルトFIRフィルタ、復元 , 142
デュアル任意波形 , 67
デュアル任意波形発生器 , 6, 79–84
デュアル任意波形プレーヤ , 6, 79–84
デュアル任意波形リアルタイム・ノイズ , 82
電源LED, 12
トーカ・モード・インジケータ , 16
トラブルシューティング , 237–??
障害。トラブルシューティング

問題。トラブルシューティング

トリガ , 98–104, 155
出力 , 26
設定 , 38
入力
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